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Introduction

The Active Roles Administration Guide provides detailed information about how to
configure and maintain an installed Active Roles deployment for day-to-day administrative
operations.

The document describes how to:

Configure rule-based and role-based administration settings.

Configure automatic resource provisioning and deprovisioning.

Set up automation and approval workflows for administrators or helpdesk personnel.
Manage groups via temporal group memberships, group families or dynamic groups.
Configure and monitor Active Roles reporting and Management History settings.
Configure entitlement profiles to give access to specific information resources.

Use the Active Directory Recycle Bin with Active Roles.

Integrate Active Roles with One Identity Starling.

Configure linked and remote Exchange mailboxes.

Register Azure AD tenants with Active Roles to manage Azure AD objects and
resources.

Configure SQL Server replication.

Use Administrative Templates to set the behavior and appearance of the Active Roles
Console with Group Policies.

Integrate Active Roles with other One Identity, Quest or third-party products
and services.

Use optional utilities (the Configuration Transfer Wizard, Diagnostic Tools, Add-on
Manager or the Active Roles Language Pack) to enhance and maintain your Active
Roles deployment.

NOTE: For information about how to perform day-to-day administrative tasks, see the
following documents:

e For information about how to administer Active Directory resources in the Active

Roles Console, see the Active Roles Console User Guide.
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e For information about how to administer Active Directory and Azure AD
resources with the Active Roles Web Interface, see the Active Roles Web
Interface User Guide.

In addition, for information about how to configure and customize the Active Roles Web
Interface component, see the Active Roles Web Interface Configuration Guide.
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Getting started with Active Roles

This section describes how to start using Active Roles to prepare it for day-to-day
administration operations.

NOTE: The Active Roles Administration Guide only describes product configuration
procedures. For the in-depth description of its features and user interfaces, see the
following documents:

e For more information on the product features, see the Active Roles Feature Guide.

e For more information on the Active Roles Console and the day-to-day operations
you can perform with it, see the Active Roles Console User Guide.

e For more information on the Active Roles Web Interface and the day-to-day opera-
tions you can perform with it, see the Active Roles Web Interface User Guide.

e For more information on customizing and configuring the Web Interface and its
sites, see the Active Roles Web Interface Configuration Guide.

Starting the Active Roles Console

The Active Roles Console, also referred to as MMC Interface, is a comprehensive
administrative tool that you can use to:

» Manage Active Directory and Microsoft Exchange resources.
» Configure organization-level access and administration policies.

e Set up automation or approval workflows for your administrators or helpdesk
personnel.

To start the Active Roles Console

1. Login to the system where Active RolesConsole is installed.

2. Depending on the version of your operating system:
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» Inthe Apps page, click Active Roles 8.1.5 Console.

* From the Start menu, select All Programs > One Identity Active Roles
8.1.5 > Active Roles 8.1.5 Console.

NOTE: By default, the Active Roles Console automatically chooses an Administration
Service instance and establishes a connection. If the Console cannot connect to the
Administration Service or you want to manually select the Administration Service, see
Connecting to the Administration Service.

Restricting access to the Active Roles
Console

By default, after installing Active Roles, every user can log in to the Active Roles Console.
To restrict access:

1. Use the MMC Interface Access setting of the Active Roles Configuration Center.
This setting lets you restrict Console access only to Active Roles Admin users (or
allow Console access again for all users, if the access is restricted). For details, see
Restricting access to the Active Roles Console.

2. If Console access is already restricted to Active Roles Admin users, you can give
Console access to individual users by assigning them to the User Interface
Management - MMC Full controlAccess Template (AT). This AT gives access
permission to the Server Configuration > User Interfaces > MMC Interface
object. For details, see Restricting access to the Active Roles Console.

For more information, see Restricting access to the Active Roles Console in the Active Roles
Installation Guide.

Minimum required permissions of the
Active Roles service account

Active Roles performs operations on directory objects on behalf of delegated users.
Because of this, the Active Roles service account that is used to manage the Active
Directory domain requires adequate permissions.

NOTE: One Identity strongly recommends to manage the Active Directory domain using
an account that is a member of the Domain Admins role group. If this condition is not
met, the information and instructions provided in the official One Identity product
documentation may not be applicable to your Active Roles installation.

TIP: One Identity recommends using separate service accounts for service tasks and for
domain management duties. Doing so can ensure that you can use the service account
with the minimum required permissions listed below. However, consider that the proxy

@NE IDENTITY Active Roles 8.1.5 Administration Guide 31

by Quest Getting started with Active Roles



account must still be a member of the Domain Admins role group to stay within the
support model of Active Roles.

The service account credential has the following five main roles.

Accessing the Administration Service computer

To meet this requirement, the service account must be a member of the Administrators
group on the computer running the Active Roles Administration Service.

Service publication in Active Directory

Once configured, the Administration Service attempts to publish itself in Active Directory,
so that Active Roles clients can automatically discover the Administration Service instance.

NOTE: While this functionality is not critical, if the service publication permissions are not
granted, Active Roles clients will not be able to automatically discover the Active Roles
Administration Service instance. However, they can still connect to the Administration
Service if they specify in Active Roles Console either the service name or the IP address of
the computer running the instance.

For more information, see Service publication in Active Directory in the Active Roles
Installation Guide.

Running all Script Modules under the security context of the Active Roles
Service Account

The permissions required by custom scripts vary according to the requirements of the
individual scripts. As such, review them on a case-by-case basis as a Best Practice
security model.

Connecting to the Microsoft SQL database

In some Active Roles configurations, assigning the SQL database connection permissions to
the service account is optional, as you can also use an SQL Authentication credential (which
then receives the required permissions instead of the service account).

For more information on the necessary SQL Server permissions, see SQL Server
Permissions in the Active Roles Quick Start Guide.

Synchronizing native permissions to Active Directory

The service account must have the Read Permissions and Modify Permissions rights
on the Active Directory objects and containers where you want to use the Active Roles
security synchronization feature.
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Configuring rule-based
administrative views

To provide additional flexibility beyond the default Active Directory and Azure AD
capabilities in managing directory resources, Active Roles supports creating, editing
and deleting securable, flexible, rule-based administrative views, known as Managed
Units (MUs).

With MUs, administrators can configure distributed administration units independent of the
OU hierarchy. As such, MUs are dynamic virtual collections of AD or Azure AD directory
objects, and may include them regardless of their location in the organization network.

TIP: For more information on Managed Units and their main features, see Managed Units
in the Active Roles Feature Guide.

Administering Managed Units

This section guides you through the Active Roles Console to administer Managed Units.

Creating a Managed Unit

You can create a new Managed Unit (MU) in the Active Roles Console.

Prerequisites

To create MUs in the Active Roles Console, you must use an Active Roles Administration
Service account. For more information, see Configuring the Administration Service account
in the Active Roles Quick Start Guide.
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To create a new Managed Unit (MU) in the Active Roles Console

1. Inthe Active Roles Console, on the Console tree, navigate to Configuration >
Managed Units.

2. Toopenthe New Object - Managed Unit wizard, right-click the Managed Units
node, then click New > Managed Units.

TIP: If you need to manage a large number of MUs in your organization, One
Identity recommends creating separate MU containers for your specific MUs.
To create a new container for the configured MU, right-click on the Managed Units
node, then click New > Managed Unit Container.
Figure 1: Active Roles Console - Launching the Managed Unit
Container dialog
# Active Roles [AR1.rolesT.net] Marme Type Descripti
v ﬁ Configuration Ej Published Gr... Managed Unit Contains
| Access Rules
b Access Ternplates
w &gl Managed Units
w |5 Builtin Delegate Control...
Eﬁ Publis Enforce Policy...
w % Policies Find...
v = Administ
& Builtiy  MPOTE-
‘ip Workdlow Check Policy...
@ Script Modul Change History
@3l Server Confic _
v @ Active Directory Mew * Managed Unit
v @ rolest.net All Tasks » Managed Unit Container
Once the new container is created, right-click it in the Console tree and select
New > Managed Unit to create a new MU in the container. To move an existing,
non built-in MU to the container, right-click the MU, and select Move.

3. In the Name step, specify a Name and optionally, a Description for the new MU.
This name and description will appear in the Active Roles details pane when
selecting the MU.
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Figure 2: New Object - Managed Unit wizard - Specifying the Name and
Description

Mew Object - Managed Unit 7 >

7& Createin:  ConfigurationManaged Linits

Name:

| Europe Marketing

Description:

Azure users in the Marketing department located in Europe |

< Back Mext = Cancel Help

To continue, click Next.

4. To specify a new membership rule for the MU, in the Membership rule step,
click Add.

Membership rules define which directory objects get assigned to the MU. Active Roles
populates the MU dynamically based on the configured rules, adding objects that
match their criteria and removing those later that no longer do.
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Figure 3: New Object - Managed Unit wizard — Membership rule list

Mew Object - Managed Unit 7 X
Membership rules:
MName Type Folder

Bemove View/Edit...

| <Back |[ Net> | Cancel | | Hep

5. Inthe Membership Rule Type dialog, select the rule type used to populate the MU.
A membership rule can be a search query, a static object inclusion or exclusion rule,
or group membership inclusion and exclusion rule.
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Figure 4: New Object - Managed Unit wizard - Membership rule type

selection

# Membership Rule Type x

Select a rule type:

Rule Type Description
- Indude Explicitly Indude objects statically

yglndude by Query Incude objects returned from query
ﬂlndude Group Members  Indude members of selected groups
nﬁExdudE Explicitly Exdude objects statically

& Exclude by Query Exdude objects returned from query

ﬁ Exdude Group Members Excude members of selected groups
%F‘.Emin Deprovisioned Do not remove deprovisioned objects

Explanation of the selected rule type:
Select objects to add to the membership list.

Active Roles ensures that the selected objects are induded in
the membership list regardless of whether they are renamed,
moved to another container, or have any properties changed.

Cancel

Active Roles supports the following membership rule types:

Table 1: Managed Unit membership rules

Rule name

Description

Include Expli-
citly

Include by
Query

(GNE IDENTITY
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Includes the Active Directory (AD) or Azure Active Directory
(Azure AD) objects you select in the wizard.

Once selected, Active Roles will keep the objects included in the
MU even if they are updated, renamed, or moved elsewhere
within your organization directory.

Lets you define a custom query that the AD or Azure AD objects
must match to be included in the MU. The query editor dialog
lets you select the object type and location (such as AD domain
or Azure tenant), then dynamically populates the dialog with
settings according to the object type you selected.

The dialog also offers Advanced query settings to configure
queries by specifying the following elements to check:
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Rule name Description

e Object types and properties
e Logical conditions
e Specified values

Once you configure a query, you can test it with the Preview
Rule button.

NOTE: Consider the following when configuring a custom
query:

e The Include by Query membership rule does not
support Azure contacts and Azure distribution groups.
To include Azure contacts or Azure distribution groups
in an MU, use the Include Explicitly rule type.

» If you configure a Managed Unit with an Include by
Query rule, the following condition operators cannot
query Azure objects due to Graph API limitations:

« Contains
* Present

» The contents of the Condition drop-down list are
static, and may contain logical conditions that do not
work with the selected object attribute (for example,
selecting Greater or equal for the
edsaAzureManager Azure AD attribute returns no
results). Always make sure to select a logical condition
against which Active Roles can enumerate the value of
the selected Azure attribute.

¢« When querying Azure object attributes, the Ends with
condition returns results only if you specify whole
words. The only exceptions to this behavior are the
mail, otherMails, userPrincipalName and
proxyAddresses attributes, where Ends with can
properly query the values that end with your specified
string.

For more information, see Support for filter by
properties of Microsoft Entra ID (directory) objects in
the Microsoft Graph documentation.

¢ You can query the edsaAzureManager attribute with
the Is not condition only if the query rule is used in an
AND relationship with another query rule. Querying the
edsaAzureManager attribute with the Is not
condition returns no results if the query rule is used
alone or in an OR relationship.
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Rule name

Description

Include Group
Members

Exclude Expli-
citly

Exclude by
Query

Exclude Group
Members

Retain
Deprovisioned

(GNE IDENTITY

Quest

Includes the members of the selected AD or Azure AD groups.

Once selected, Active Roles will keep the MU membership
dynamically up-to-date: if new members are added to the
selected groups, Active Roles will also include them in the MU;
and likewise, members removed from the included groups will
also be removed from the MU.

Excludes the AD or Azure AD object you select in the MU.

Once selected, Active Roles will keep the objects excluded from
the MU even if they are updated, renamed, or moved elsewhere
within your organization directory.

NOTE: Consider the following when selecting this member-
ship rule:

e The Exclude Explicitly rule takes precedence over all
other membership rule types. Because of this, Active
Roles will exclude the objects specified with this rule,
even if another rule specifies that Active Roles must
include them in the MU.

e This rule excludes only objects that match one of the
inclusion rules of the MU.

Lets you define a custom query that the AD or Azure AD objects
must match to be excluded from the MU. Once configured,
Active Roles will automatically exclude objects that meet the
query conditions.

The query editor works and functions the same way as it does
when configuring an Include by Query rule, and also shares
the same limitations listed there.

NOTE: This rule excludes only objects that match one of the
inclusion rules of the MU.

Excludes the members of the selected AD or Azure AD groups.

Once selected, Active Roles will keep the MU membership
dynamically up-to-date: if new members are added to any of
the selected groups, Active Roles will exclude them from the
MU. Likewise, if a member is removed from all specified groups,
Active Roles will add them to the MU, provided that the
member meets a configured inclusion rule.

NOTE: This rule excludes only objects that match one of the
inclusion rules of the MU.

Configures the MU to also include and keep deprovisioned
objects that meet the membership rules.
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Rule name Description

If this rule is not selected, Active Roles automatically removes
deprovisioned objects from the MU.

NOTE: The exclusion rules affect only objects that match one of the inclusion rules
configured for the MU.

For example, if a container is explicitly included in an MU, then all objects held in
that container are also included in the MU. However, you cannot exclude any of
those objects themselves with exclusion rules, as it is their container that meets
the inclusion rules in this case. To exclude the objects of the container, you must
configure an exclusion rule for the container instead.

6. Configure the selected membership rule:

e If you selected the Include Explicitly or Exclude Explicitly rule type, the
Select Objects dialog appears. Select the objects you want to include or
exclude from the MU, click Add, and then click OK.

o If you selected the Include Group Members or Exclude Group Members
rule type, the Select Objects dialog appears, listing the available groups.
Select the AD or Azure AD groups you want to include, click Add, and then
click OK. All members of the selected groups will be included or excluded
from the MU.

o If you selected the Include by Query or Exclude by Query rule type, the
Create Membership Rule dialog appears. Use the dialog to configure your
inclusion or exclusion rule.

7. (Optional) To configure additional rules, click Add again.

NOTE: If you add several membership rules to an MU, Active Roles runs them in the
order you configured them. If some of the configured rules conflict with each other,
Active Roles resolves the conflict by prioritizing the configured Exclude rules over
the configured Include rules.

8. Once you finished adding all membership rules, click Next.

9. (Optional) In the Object Security / Policy Objects step, specify the permissions
and policy objects related to the configured MU.
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Figure 5: New Object - Managed Unit wizard - Access Template and Policy
Object links
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e For more information on object security permissions, see Applying Access
Templates.

e For more information on Policy Objects, see Applying Policy Objects.
10. To finish configuring the MU, click Next and Finish.

Modifying Managed Unit properties

You can modify the settings of a Managed Unit with the Properties window of the Active
Roles Console.

To modify properties of a Managed Unit

1. Inthe Active Roles Console, on the Console tree, navigate to Configuration >
Managed Units.

2. Under Managed Units, locate the Managed Unit you want to modify, right-click it,
and click Properties.

3. Use the tabs in the Properties dialog to view or modify properties of the
Managed Unit.

4. When finished, click OK.
| NOTE: Consider the following when modifying Managed Unit properties:
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e The Membership Rules tab displays a list of membership rules for a given
Managed Unit. You can add, remove, or modify membership rules as needed. For
more information, see later in this document.

e On the Administration tab, you can use Policy to add and remove Policy Object
links that determine which administrative policies are enforced on the Managed
Unit. For more information, see Modifying policy settings on a Managed Unit.

e On the Administration tab, you can use Security to add and remove Access
Template links that define Trustees and their permissions for the Managed Unit. For
more information, see Modifying permission settings on a Managed Unit.

Modifying permission settings on a
Managed Unit

You can modify the permission settings of a Managed Unit with the Delegate Control
window of the Active Roles Console.

To modify permission settings on a Managed Unit

1. Inthe Active Roles Console, on the Console tree, navigate to Configuration >
Managed Units.

2. Under Managed Units, locate the Managed Unit you want to modify, right-click it,
and click Delegate Control.

3. Inthe Active Roles Security dialog, do the following:

e To add permissions to the Managed Unit, click Add and follow the instructions
in the Delegation of Control wizard to create an Access Template link. For
information on how to use the Delegation of Control wizard, see Applying
Access Templates.

e To remove permissions from the Managed Unit, select Access Template links
from the list, and click Remove. Alternatively, you can revoke permissions
by disabling Access Template links. To do so, select or more links, and then
click Disable.

e To view or modify properties of an Access Template link on the Managed Unit,
select the link from the list and click View/ Edit.

e To modify an Access Template link so that the permissions defined by the
link are also added to Active Directory, select the link from the list and
click Sync to AD.

4. Click OK to close the Active Roles Security dialog.
NOTE: Consider the following when modifying permission settings on a Managed Unit:

e The Active Roles Security dialog displays a list of Access Template links, with
each list item indicating a Trustee and the Access Template that is used to specify
the Trustee’s permissions.
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» By default, the list of Access Template links displays all the links that determine the
permission settings on the Managed Unit, regardless of whether a link was created
on the Managed Unit itself or on a container that holds the Managed Unit. To
change the display of the list, clear the Show inherited check box.

e An Access Template link can be removed from a Managed Unit if the link was
created on that Managed Unit. Only the links that meet this condition are displayed
when you clear the Show inherited check box, so you can remove them by
clicking Remove.

e You can also use the advanced details pane to view, add, remove, or modify Access
Template links on a Managed Unit. To do so, select the Managed Unit, then on the
Active Roles Security tab in the advanced details pane, right-click an Access
Template link or a blank area and use the commands on the shortcut menu. For
information about the advanced details pane, see Advanced pane in the Active
Roles Feature Guide.

Modifying policy settings on a Managed Unit

You can modify the policy settings of a Managed Unit with the Enforce Policy dialog of the
Active Roles Console.

To modify policy settings on a Managed Unit

1. Inthe Active Roles Console, on the Console tree, navigate to Configuration >
Managed Units.

2. Under Managed Units, locate the Managed Unit you want to modify, right-click it,
and click Enforce Policy.

3. Inthe Active Roles Policy dialog, do the following:

e To add policies to the Managed Unit, click Add and select the Policy Object that
defines the policies. You can select multiple Policy Objects at a time.

e To remove policies from the Managed Unit, select the Policy Object that defines
the policies, and click Remove. Alternatively, you can remove the effect of a
Policy Object on the Managed Unit by selecting the Blocked check box next to
the name of the Policy Object.

» To modify policies, select the Policy Object that defines the policies, and
click View/Edit.

4. To close the Active Roles Policy dialog, click OK.

NOTE: The Active Roles Policy dialog box lists all the Policy Objects that define the
policy settings on the Managed Unit, regardless of whether a Policy Object was added on
the Managed Unit itself or on a container that holds the Managed Unit. You can view a list
of Policy Objects that were added directly on the Managed Unit: Click Advanced and
then clear the Show inherited check box.

Only the Policy Objects that were added directly on the Managed Unit can be removed.
However, even if the Remove button is unavailable, you can select the Blocked check
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box. In this way, you remove the effect of the Policy Object on the Managed Unit. At any
time, you can restore the effect of the Policy Object on the Managed Unit by clearing the
Blocked check box.

You can also use the advanced details pane to add, remove, block, or modify Policy
Objects that define the policy settings on a Managed Unit: Select the Managed Unit, and
then, on the Active Roles Policy tab in the advanced details pane, right-click a Policy
Object or a blank area, and use commands on the shortcut menu. For information about
the advanced details pane, see Advanced pane in the Active Roles Feature Guide.

Displaying members of a Managed Unit

Members of a Managed Unit are objects that match the criteria specified in the membership
rules for the Managed Unit. You can display and customize the list of members in the Active
Roles Console.

To display the members of a Managed Unit

1. Inthe Active Roles Console, on the Console tree, navigate to Configuration >
Managed Units.

2. Under Managed Units, locate and select the Managed Unit.

The members of the Managed Unit are listed in the details pane.

To customize the list of Managed Unit members in the details pane

1. Right-click the Managed Unit, and click Properties.
In the Properties dialog, click the Default Columns tab.

3. On the Default Columns tab, add or remove column names from the Displayed
Columns list.

4. Click OK.
NOTE: Consider the following when displaying members of a Managed Unit:

e For each Managed Unit, you can configure an individual list of the default columns
to display in the details pane, so you can perform the customization on a per-
Managed Unit basis.

e You can populate the Displayed columns list by double-clicking column names in
the Available columns list on the Default Columns tab. You can remove
columns by double-clicking column names in the Displayed columns list.

e To add column items to the Available Columns list, click Choose Columns. In
the Choose Columns dialog, you can select columns and, if necessary, modify
column names.

e For your changes to the Displayed columns list to take effect, the details pane
must be refreshed. To do so, right-click Managed Units in the Console tree and
click Refresh.
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Figure 6: Managed Unit - Preset columns
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Adding membership rules to a Managed Unit

Members of a Managed Unit are defined by membership rules. Therefore, to add or remove
members from a Managed Unit, add, delete, or modify membership rules.
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To add a membership rule to a Managed Unit

1. Inthe Active Roles Console, on the Console tree, navigate to Configuration >
Managed Units.

2. Under Managed Units, locate the Managed Unit you want to modify, right-click it,
and click Properties.

3. Onthe Membership Rules tab, click Add. This displays the Membership Rule
Type dialog.

4. Select the type of the membership rule you want to create. Do one of the following,
and then click OK:

To create a rule that statically adds members to the Managed Unit, click
Include Explicitly.

To create a rule that statically excludes members from the Managed Unit, click
Exclude Explicitly.

To create a rule that adds all members of a certain group to the Managed Unit,
click Include Group Members.

To create a rule that excludes all members of a certain group from the Managed
Unit, click Exclude Group Members.

To create a rule that populates the Managed Unit with the objects that match
certain search criteria, click Include by Query.

To create a rule that prevents the Managed Unit from including the objects that
match certain search criteria, click Exclude by Query.

To create a rule that prevents the deprovisioned objects, such as deprovisioned
users or groups, from being removed from the Managed Unit, click Retain
Deprovisioned.

If you select the Include by Query rule type or the Exclude by Query rule type,
the Create Membership Rule dialog is displayed. Otherwise (except for the Retain
Deprovisioned rule type), the Select Objects dialog is displayed.

5. Complete the Create Membership Rule or Select Objects dialog by following the
instructions that are given later in this topic.

6. Click OK to close the Properties dialog.

To complete the Create Membership Rule dialog

1. From the Find list, select the class of objects you want the membership rule to
include or exclude from the Managed Unit. For example, when you select Users,
the membership rule includes or excludes the users that match the conditions
you specify.

2. From the In list, select the domain or container that holds the objects you want the
membership rule to include or exclude from the Managed Unit. To add folders to the
In list, click Browse.

3. Define the criteria of the membership rule. For example, to include or exclude the
objects that have the letter T at the beginning of the name, type T in Name. You can
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use an asterisk (*) to represent any string of characters.

4. (Optional) To view a list of objects that match the criteria you have defined, click
Preview Rule.

5. Click Add Rule.

To complete the Select Object dialog

1. Inthe Look in list, click the domain or folder that holds the objects you want to
select. To add a folder to the list, click Browse.

2. Do one of the following, then click OK:
e In the list of objects, double-click the object you want to add.

e In the lower box, type the entire name, or a part of the name, of the object you
want to add. Then, click Check Names.

NOTE: Consider the following when adding membership rules to a Managed Unit:

e The only way to populate Managed Units is by adding membership rules. The
members of a Managed Unit are the objects that match the criteria defined by the
membership rules.

e To display members of a Managed Unit, click the Managed Unit in the console tree.
The members of the Managed Unit are displayed in the details pane.

e The Create Membership Rule dialog is similar to the Find dialog box you use to
search for objects in the directory. Once you have specified your search criteria,
Active Roles allows you to save them as a membership rule, forcing the
membership list to include the objects that match the search criteria. For
instructions on how to specify search criteria in the Create Membership Rule
dialog, see Finding objects in the Active Roles Console User Guide.

e The Find list includes the Custom Search entry. Selecting that entry displays the
Custom Search tab, enabling you to build custom membership rules using
advanced options, as well as to build advanced membership rules using the
Lightweight Directory Access Protocol (LDAP), which is the primary access protocol
for Active Directory. For more information about using advanced search options,
see Building a custom search and Using advanced search options in the Active
Roles Console User Guide.

Modifying membership rules of a Managed
Unit

You can modify the existing membership rules of a Managed Unit with the Properties
window of the Active Roles Console.
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To modify membership rules of a Managed Unit

1. Inthe Active Roles Console, on the Console tree, navigate to Configuration >
Managed Units.

2. Under Managed Units, locate the Managed Unit you want to modify, right-click it,
and click Properties.

3. Onthe Membership Rules tab, click View/Edit.

NOTE: Only query-based rules can be modified in that way. If you select a rule of a
different type, the View/Edit button is unavailable.

Figure 7: Managed Unit - Modifying membership rules
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Removing membership rules from a
Managed Unit

You can remove existing membership rules from a Managed Unit via the Membership
Rules settings of the Active Roles Console.

To remove a membership rule from a Managed Unit

1.

In the Active Roles Console, on the Console tree, navigate to Configuration >
Managed Units.

Under Managed Units, locate the Managed Unit you want to modify, right-click it,
and click Properties.

On the Membership Rules tab, select the membership rule you want to remove,
then click Remove.

Including a member to a Managed Unit

You can add members to a Managed Unit by configuring one or more membership rules in
the Active Roles Console.

To include a member to a Managed Unit

1.

In the Active Roles Console, on the Console tree, navigate to Configuration >
Managed Units.

Under Managed Units, locate the Managed Unit you want to modify, right-click it,
and click Properties.

On the Membership Rules tab, click Add. This displays the Membership Rule
Type dialog.

In the Membership Rule Type dialog, click Include Explicitly, then click OK. The
Select Objects dialog appears.

Use the Select Objects dialog to locate and select the object (or objects) you want
to explicitly include in the Managed Unit.

For instructions on how to configure a membership rule, see Adding membership
rules to a Managed Unit.

To close the Properties dialog, click OK.

Excluding a member from a Managed Unit

You can exclude specific members from a Managed Unit with the Active Roles Console.
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To exclude a member to a Managed Unit

1.

In the Active Roles Console, on the Console tree, navigate to Configuration >
Managed Units.

Under Managed Units, locate the Managed Unit you want to modify, right-click it,
and click Properties.

On the Membership Rules tab, click Add. This displays the Membership Rule
Type dialog.

In the Membership Rule Type dialog, click Exclude Explicitly, and then click OK.
The Select Objects dialog appears.

Use the Select Objects dialog to locate and select the object (or objects) you want
to explicitly exclude in the Managed Unit.

For instructions on how to configure a membership rule, see Adding membership
rules to a Managed Unit.

To close the Properties dialog, click OK.

Adding group members to a Managed Unit

You can add group members to a Managed Unit with the Active Roles Console.

To add group members to a Managed Unit

1.

In the Active Roles Console, on the Console tree, navigate to Configuration >
Managed Units.

Under Managed Units, locate the Managed Unit you want to modify, right-click it,
and click Properties.

On the Membership Rules tab, click Add. This displays the Membership Rule
Type dialog.

In the Membership Rule Type dialog, click Include Group Members, and then
click OK. The Select Objects dialog appears.

Use the Select Objects dialog to locate and select the group (or groups) whose
members you want to be included in the Managed Unit.

For instructions on how to configure a membership rule, see Adding membership
rules to a Managed Unit.

To close the Properties dialog, click OK.
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Removing group members from a Managed
Unit

You can remove group members from Managed Units by changing their membership rule
settings in the Active Roles Console.

To remove group members from a Managed Unit

1.

In the Active Roles Console, on the Console tree, navigate to Configuration >
Managed Units.

Under Managed Units, locate the Managed Unit you want to modify, right-click it,
and click Properties.

On the Membership Rules tab, click Add. This displays the Membership Rule
Type dialog.

In the Membership Rule Type dialog, click Exclude Group Members, then click
OK. The Select Objects dialog appears.

Use the Select Objects dialog to locate and select the group (or groups) whose
members you want to be excluded from the Managed Unit.

For instructions on how to configure a membership rule, see Adding membership
rules to a Managed Unit.

To close the Properties dialog, click OK.

Copying a Managed Unit

With the Active Roles Console, you can create copies of Managed Units. This feature helps
you reuse existing Managed Units.

To copy a Managed Unit

1.

In the Active Roles Console, on the Console tree, navigate to Configuration >
Managed Units.

Under Managed Units, locate the Managed Unit you want to copy.

Right-click the Managed Unit, then click Copy. The Copy Object - Managed Unit
wizard starts.

On the first page of the wizard, do the following, then click Next:
a. Inthe Name box, enter a name for the Managed Unit.

b. (Optional) In the Description box, enter any information about the
Managed Unit.

On the second page of the wizard, you can add, remove, and modify the membership
rules that were copied from the original Managed Unit. Do the following:

@NE IDENTITY Active Roles 8.1.5 Administration Guide 51

by Quest Configuring rule-based administrative views



e To add a membership rule to the new Managed Unit, click Add.

e To remove a membership rule from the new Managed Unit, select the
membership rule from the list, and click Remove.

e To modify a membership rule for the new Managed Unit, select the
membership rule from the list, and click View /Edit.

For instructions on how to configure a membership rule, see Adding membership
rules to a Managed Unit.

6. Click Next.

7. On the next page of the wizard, do the following:
» Click Security to specify permission settings on the Managed Unit.
» Click Policy to specify policy settings on the Managed Unit.

For instructions on how to specify security and policy settings, see Modifying
permission settings on a Managed Unit and Modifying policy settings on a
Managed Unit.

8. Click Next, then lick Finish.

NOTE: The membership rules, permission settings, and policy settings are copied
from the original Managed Unit and can be modified in the Copy Object - Managed
Unit wizard.

Exporting and importing a Managed Unit

With the Active Roles Console, you can export Managed Units to an .xml file and then
import them from that file to populate another instance of Active Roles. The export and
import operations provide a way to move Managed Units from a test environment to a
production environment.

To export Managed Units, select them, right-click the selection, and select All Tasks >
Export. In the Export Objects dialog, specify the file where you want to save the data,
and click Save.

To import Managed Units, right-click the container where you want to place the Managed
Units, then click Import. In the Import Directory Objects dialog, select the file to which
the Managed Units were exported, and click Open.

NOTE: When you export and then import a Managed Unit, only membership rules are
transferred along with other properties of the Managed Unit. The permission and policy
settings of the Managed Unit are not exported. You need to reconfigure them manually
after you import the Managed Unit.

Renaming a Managed Unit

You can rename a Managed Unit with the Rename setting of the Active Roles Console.
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To rename a Managed Unit

1. Inthe Active Roles Console, on the Console tree, navigate to Configuration >
Managed Units.

2. Under Managed Units, locate the Managed Unit you want to rename, right-click it,
and click Rename.

3. Enter a new name, then press Enter.

NOTE: Renaming a Managed Unit does not affect the membership rules, permission
settings, or policy settings associated with the Managed Unit.

Deleting a Managed Unit

You can delete existing Managed Units with the Active Roles Console.

To delete a Managed Unit

1. Inthe Active Roles Console, on the Console tree, navigate to Configuration >
Managed Units.

2. Under Managed Units, locate the Managed Unit you want to delete, right-click it,
and click Delete.

NOTE: When you delete a Managed Unit, its members are not deleted. However, the
permission settings and the policy settings that were specified via the Managed Unit are
no longer in effect after the Managed Unit has been deleted.

Scenario: Implementing role-based
administration across multiple OUs

This scenario involves the creation of an administrative view named Sales in an
organization with an OU-based structure of Active Directory.

Suppose an organization has offices in USA and Canada. The rule for including a user in an
OU is the geographical location of the user. Therefore, all users who work in USA reside in
the USA OU, and those working in Canada reside in the Canada OU.

The offices in USA and Canada each have Marketing, Development, and Sales departments.
By creating a Sales MU, it is possible to manage users from the Sales departments in USA
and Canada collectively, without changing the actual OU-based structure.

When delegating control of an MU, all users that belong to the MU inherit security settings
defined at the level of the Managed Unit. Thus, applying an Access Template to a Managed
Unit specifies the security settings for each user in the MU.

To implement this scenario, perform the following steps:
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Create the sales MU.
Add users from the Sales department in USA and Canada to the Sales MU.

Prepare the Sales Access Template.

DR W N -

Apply the sales Access Template to the sales MU, and designate an appropriate
group as a Trustee.

As a result, the members of the group gain control of user accounts that belong to the Sales
MU. The scope of control is defined by the permissions in the Sales Access Template.

The following sections elaborate on the steps to implement this scenario.

Creating the Managed Unit

The first step is to create the Sales Managed Unit. For information on how to create a
Managed Unit, see Creating a Managed Unit.

Adding users to the Managed Unit

When the Sales Managed Unit is prepared, add users from the Sales departments across
the company.

Suppose that all users from the Sales departments (in both USA and Canada) have the
Description property set to Sales.

Create a membership rule of the Include by Query type with the following parameters:

e From the Find list, select Users.

e Inthe Description box, type Sales.

As a result, all users with the description Sales will be included in the Managed Unit.

For more information on how to create membership rules, see Adding membership rules to
a Managed Unit.

Preparing the Access Template

To define which rights the Trustee will get for the Sales Managed Unit, create a Sales
Access Template, and add permissions to this Access Template.

For more information on how to create an Access Template, see Creating an Access
Template.
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Applying the Access Template

To apply the Sales Access Template to the Sales Managed Unit, right-click the Sales
Managed Unit and click Delegate Control. Then, click Add and follow the instructions in
the Delegation of Control wizard.

On the Users or Groups page of the wizard, add the user or group to be designated
as a Trustee.

On the Access Templates page of the wizard, select the Sales Access Template
you prepared.

For more information on how to apply an Access Template to a Managed Unit, see Applying
Access Templates.
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Configuring role-based
administration

To provide additional flexibility beyond the system-provided Active Directory Users and
Computers tool in delegating administrative responsibilities, Active Roles supports:

e Consolidating permissions into customizable administrative roles, known as
Access Templates.

Access Templates are collections of permissions representing administrative roles.
Permissions are used to allow or deny certain administrative operations to a user or
group. You can create an Access Template that incorporates all permissions required
to perform a particular administrative role.

e Claims-based authorization rules (known as "Access Rules") to allow or deny access
to Active Directory objects.

Access rules improve access control management for Active Directory administration.
With access rules, Active Roles adds more flexibility and precision in delegating
control of Active Directory objects, such as users, computers or groups, through the
use of claims (the Active Directory user and computer properties) in the Active Roles
authorization model.

TIP: For more information on these role-based administration features, see Access
Templates and Access Rules in the Active Roles Feature Guide.

Access Template management tasks

This section guides you through the Active Roles Console to manage Access Templates.

Using predefined Access Templates

Active Roles offers an extensive suite of preconfigured Access Templates that represent
typical administrative roles, enabling the correct level of administrative authority to be
delegated quickly and consistently.
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The predefined Access Templates are located in containers under Configuration > Access
Templates in the Active Roles Console. You can display a list of Access Templates in the
details pane by expanding Configuration > Access Templates, then selecting one of
these containers in the Console tree:

e Active Directory

e AD LDS (ADAM)

e Azure

e Builtin

e Computer Resources

e Configuration

e Exchange

e Skype for Business Server
e Starling

e User Interfaces

e User Self-management

For more information on predefined Access Templates and their recommended use, see the
Active Roles Built-in Access Templates Reference Guide.

Creating an Access Template

You can create a new Access Template for role-based delegation with the Active
Roles Console.

NOTE: Creating and managing Access Templates is done with the Add Permission
Entries Wizard. For the detailed description of the wizard, see Add Permission Entries
Wizard in the Active Roles Feature Guide.

To create an Access Template

1. Inthe Console tree, under Configuration > Access Templates, locate and select
the folder in which you want to add the Access Template.

NOTE: Consider the following when creating an Access Template:

e You can create a new folder by right-clicking Access Templates and
selecting New > New Access Template Container. Similarly, you can
create a sub-folder in a folder by right-clicking the folder, and selecting New
> Access Template Container.

e One Identity recommends storing custom Access Templates in a
separate container.

2. To start the New Object - Access Template wizard, right-click the folder, and
select New > Access Template.
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. On the first page of the wizard, do the following, then click Next:
a. Inthe Name box, enter a name for the Access Template.

b. (Optional) In the Description box, type any information about the
Access Template.

. On the second page of the wizard, configure the list of permission entries,
then click Next.

. Click Finish to create the Access Template that includes the permission entries you
have specified.

To add a permission entry to an Access Template

In the Active Roles Console, select the Access Template you want to modify.

. To start the Add Permission Entries Wizard, on the page that displays a list of
permission entries included in the Access Template, click Add.

. On the first page of the wizard, select one of these options:

» All object classes: The rights defined by this permission entry apply to
objects of any class.

e Only the following classes: The rights defined by this permission entry
apply to objects of specific classes. Select object classes from the list. If the list
does not include the object class you want, select Show all possible classes.

. Click Next.

. On the second page of the wizard, select one of these options:

» Full control access: The rights to create or delete child objects, read and
write properties, examine child objects and the object itself, add and remove
the object from the directory, and read or write with any extended right. This
option does not have any configuration parameters.

e Object access: The rights to exercise certain generic permissions and
extended rights on the objects. Select permissions and extended rights from
the list to configure this option as appropriate.

e Object property access: The rights to read or write certain properties of the
object. Select check boxes to configure this option as appropriate: Read
properties, Write properties. On the next page of the wizard, you can select
the properties you want to be controlled by this permission entry.

» Creation/Deletion of child objects: The rights to create or delete child
objects of the object. Select check boxes to configure this option as
appropriate: Create child objects, Delete child objects, Move objects
into this container. On the next page of the wizard, you can specify the class
or classes of child object you want to be controlled by this permission entry.

If you want the Access Template to deny the rights defined by this permission entry,
select the Deny permission check box. Otherwise, leave the check box cleared.

7. Do the following, depending on the option you selected and configured in Step 4:
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* Full control access or Object access: Click Finish to add the permission
entry to the Access Template.

» Object property access or Creation/Deletion of child objects: Click
Next to continue configuring the option.

8. Continue configuring the option you selected in Step 4. then, to add the permission
entry to the Access Template, click Finish:

» If you selected Object property access, select the properties to be controlled
by this permission entry. You have two options: All properties and The
following properties. With the second option, you must select properties
from the list. If the list does not include the property you want, select Show all
possible properties.

o If you selected Creation/Deletion of child objects, specify the class or
classes of child object to be controlled by this permission entry. You have two
options: Child objects of any class and Child objects of the following
classes. With the second option, you must select one or more object classes
from the list. If the list does not include the object class you want, select Show
all possible classes.

To view or modify a permission entry in an Access Template

In the Active Roles Console, select the Access Template you want to modify.

2. On the page that displays a list of permission entries included in the Access Template,
select the permission entry you want to view or modify. Then, to display the Modify
Permission Entry dialog, click View/Edit.

3. Examine the Apply Onto tab in the Modify Permission Entry dialog. On this tab,
you can view or modify the same settings as on the first page of the Add
Permission Entries Wizard.

4. Examine the Permissions tab in the Modify Permission Entry dialog. This tab
provides the same options as the second page of the Add Permission Entries
Wizard. The options are read-only, so you cannot change the option that was
selected upon creation of the permission entry. However, you can manage the
configuration of the option:

» Object access: Select generic permissions or extended rights you want to add
to the Access Template.

» Object property access: Select or clear these check boxes: Read
properties, Write properties.

» Creation/Deletion of child objects: Select or clear these check boxes:
Create child objects, Delete child objects, Move objects into this
container.

5. (Optional) If you want the Access Template to deny the rights defined by this
permission entry, select the Deny permission check box on the Permissions tab.
Otherwise, leave the check box cleared.

6. If Object property access is selected on the Permissions tab, use the Object
Properties tab in the Modify Permission Entry dialog to view or modify the
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settings that determine which properties are controlled by this permission entry.

7. If Creation/Deletion of child objects is selected on the Permissions tab, use
the Object Classes tab in the Modify Permission Entry dialog to view or modify
the settings that determine which classes of child object are controlled by this
permission entry.

To delete a permission entry from an Access Template

In the Active Roles Console, select the Access Template you want to modify.

2. On the page that displays a list of permission entries included in the Access Template,
select the permission entry you want to delete, and click Remove.

3. To confirm deleting the permission entry, click Yes.

Applying Access Templates

You can apply ATs to an AD object with the Delegation of Control Wizard. To start the
wizard, navigate to either:

e The AT you want to apply on an AD object. When you start the Delegation of
Control Wizard this way, you can select the securable AD objects for which
the access is granted, and the trustees who receive the access to those
securable objects.

For the steps of this procedure, see Applying an Access Template directly.

e The securable AD object (container, Managed Unit or leaf object) whose access and
administration permissions you want to configure. When you start the Delegation of
Control Wizard this way, you can select the trustees who receive the access to the
securable object and the ATs defining the permissions of the trustees to the
securable object.

For the steps of this procedure, see Applying Access Templates on a securable object.

e The trustee for which you want to assign permissions. When you start the
Delegation of Control Wizard this way, you can select the securable AD object to
which the trustee will receive access and the ATs defining the permissions of the
trustee to the securable object.

For the steps of this procedure, see Applying Access Templates on a user or group.

NOTE: ATs support propagating their permission settings for the child objects of the
securable objects too.

TIP: For more technical details about how Active Roles applies permissions with
Access Templates, see Applying permissions with Access Template in the Active Roles
Feature Guide.
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Applying an Access Template directly

You can configure permissions for a trustee to a securable Active Directory (AD) object via
an Access Template (AT) by selecting the AT directly in the Active Roles Console.

To apply an Access Template on a trustee or trustees

1. Inthe Active Roles Console, in the Active Directory (AD) tree, navigate to
Configuration > Access Templates.

2. Right-click the AT you want to assign to a trustee (or trustees), then click Links.

TIP: For more information on the ATs, see the Description of the AT or the Active
Roles Built-in Access Templates Reference Guide document.

3. Inthe Links dialog, to start the Delegation of Control Wizard, click Add. Click
Next on the Welcome page, when it appears.

4. In the Objects step, specify the securable objects that you want to add to the
scope of the AT.

» To specify a new securable object or objects, click Add. Then, in the Select
Objects window, locate and select the securable objects you want to add to
the scope of the AT, and click Add.

Once you finalized the list, to close the Select Objects window and apply your
selection, click OK.

TIP: If no securable objects appear in the window, use the Click here to
display objects link.
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Figure 8: Delegation of Control Wizard - Select objects window when
specifying securable objects
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Figure 9: Delegation of Control Wizard - Selecting securable objects
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e To remove securable objects added earlier to the scope of the AT, select them
in the Objects step, and click Remove.

To continue, click Next.

5. Inthe Users or Groups step, specify the trustee(s) for which you want to grant the
permissions of the AT.

e To specify a new trustee or new trustees, click Add. Then, in the Select
Objects window, locate and select the users or groups you want to add to the
scope of the AT, and click Add. Once you finalized the list, to close the Select
Objects window and apply your selection, click OK.

TIP: If no users or groups appear in the window, use the Click here to
display objects link.
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Figure 10: Delegation of Control Wizard - Select Objects window
when specifying trustees
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Figure 11: Delegation of Control Wizard - Selecting trustees
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e To remove existing trustees added earlier to the scope of the AT, select them in
the Users or Groups step, and click Remove.

To continue, click Next.

6. In the Inheritance Options step, specify with the Apply permissions onto
setting the scope of securable objects to which Active Roles applies the
permissions of the AT:

e This directory object: Trustees receive the AT permissions only to the
selected securable object.

e Child objects of this directory object: Trustees receive the AT
permissions to the children of the securable object. To limit the granted

permissions only to the direct children of the object, select Immediate child
objects only as well.
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Figure 12: Delegation of Control Wizard- Inheritance Options
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To continue, click Next.

7. Inthe Permissions Propagation step, to synchronize the configured permission
settings to the native Active Directory (AD) access controls, select Propagate
permissions to Active Directory.
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Figure 13: Delegation of Control Wizard — Permissions propagation
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Permissions propagation is an advanced option. It does not affect Active Roles operations,
and is only intended to provision other applications with native permissions to Active Directory.

This option generates native Active Directory permission entries based on permissions
specified with Active Roles.
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Selecting this setting will modify the authorization information of the AD objects with
the permission settings defined in Active Roles, providing more flexibility for users
and groups that use native AD management tools besides Active Roles.

IMPORTANT: Selecting this setting will result in trustees keeping their configured
permissions outside of the Active Roles environment, with the potential risk of
bypassing policies configured and enforced with Active Roles.

Therefore, select this option only if the selected trustees have the required security
clearance and/or meet all security guidelines in effect within your organization.

TIP: Once Propagate permissions to Active Directory is selected and
configured, you can change this setting at any time with the Active Roles
Security > Sync to AD setting, or with the Advanced Details > Sync to AD
setting. For more information, see Synchronizing permissions to Active Directory.

To continue, click Next.

8. To complete the wizard, click Finish.

Applying Access Templates on a securable object

You can configure permissions for a trustee (or trustees) to a securable Active Directory
(AD) object via Access Templates (ATs) by selecting the securable object in the Active
Roles Console.
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To configure permissions with an Access Template from a securable object

1. Inthe Active Roles Console, in the Active Directory (AD) tree, navigate to the
securable object for which you want to configure an AT.

2. Toopen the Delegation of Control Wizard from the securable object:

o If the securable object is a container or Managed Unit, right-click the object,
then click Delegate Control > Add.

o If the securable object is a leaf object, right-click the object and click
Properties. Then, in the Properties window, click Administration >
Security > Add.

When the Welcome screen of the Delegation of Control Wizard appears, click Next.

3. Inthe Users or Groups step, specify the trustee(s) for which you want to grant the
permissions of the AT.

e To specify a new trustee or new trustees, click Add. Then, in the Select
Objects window, locate and select the users or groups you want to add to the
scope of the AT, and click Add. Once you finalized the list, to close the Select
Objects window and apply your selection, click OK.

TIP: If no users or groups appear in the window, use the Click here to
display objects link.
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Figure 14: Delegation of Control Wizard - Select Objects window
when specifying trustees
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Figure 15: Delegation of Control Wizard - Selecting trustees
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e To remove existing trustees added earlier to the scope of the AT, select them in
the Users or Groups step, and click Remove.

To continue, click Next.

4. Inthe Access Templates step, specify the ATs you want to assign to the selected
trustees for the configured securable object. Expand the containers of the ATs, then
select the AT or ATs you want to apply.
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Figure 16: Delegation of Control Wizard - Selecting Access Templates
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To continue, click Next.

5. In the Inheritance Options step, specify with the Apply permissions onto
setting the scope of securable objects to which Active Roles applies the
permissions of the AT:

e This directory object: Trustees receive the AT permissions only to the
selected securable object.

» Child objects of this directory object: Trustees receive the AT
permissions to the children of the securable object. To limit the granted
permissions only to the direct children of the object, select Immediate child
objects only as well.
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Figure 17: Delegation of Control Wizard- Inheritance Options
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To continue, click Next.

6. Inthe Permissions Propagation step, to synchronize the configured permission
settings to the native Active Directory (AD) access controls, select Propagate
permissions to Active Directory.
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Figure 18: Delegation of Control Wizard — Permissions propagation
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Permissions propagation is an advanced option. It does not affect Active Roles operations,
and is only intended to provision other applications with native permissions to Active Directory.

This option generates native Active Directory permission entries based on permissions
specified with Active Roles.
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Selecting this setting will modify the authorization information of the AD objects with
the permission settings defined in Active Roles, providing more flexibility for users
and groups that use native AD management tools besides Active Roles.

IMPORTANT: Selecting this setting will result in trustees keeping their configured
permissions outside of the Active Roles environment, with the potential risk of
bypassing policies configured and enforced with Active Roles.

Therefore, select this option only if the selected trustees have the required security
clearance and/or meet all security guidelines in effect within your organization.

TIP: Once Propagate permissions to Active Directory is selected and
configured, you can change this setting at any time with the Active Roles
Security > Sync to AD setting, or with the Advanced Details > Sync to AD
setting. For more information, see Synchronizing permissions to Active Directory.

To continue, click Next.

7. To complete the wizard, click Finish.

Applying Access Templates on a user or group

You can configure permissions for a trustee (typically a user or group) to a securable Active
Directory (AD) object via Access Templates (ATs) by selecting the trustee in the Active
Roles Console.
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To configure permissions with an Access Template from a trustee

1. Inthe Active Roles Console, in the Active Directory (AD) tree, navigate to the trustee
AD object (such as a user or group) for which you want to configure access with an AT
or ATs to a securable object.

2. Toopen the Delegation of Control Wizard, right-click the trustee, then click
Delegated Rights > Add.

When the Welcome screen appears, click Next.

3. In the Objects step, specify the securable objects that you want to add to the
scope of the AT.

e To specify a new securable object or objects, click Add. Then, in the Select
Objects window, locate and select the securable objects you want to add to
the scope of the AT, and click Add.

Once you finalized the list, to close the Select Objects window and apply your
selection, click OK.

TIP: If no securable objects appear in the window, use the Click here to
display objects link.
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Figure 19: Delegation of Control Wizard - Select objects window

when specifying securable objects
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Figure 20: Delegation of Control Wizard - Selecting securable objects
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e To remove securable objects added earlier to the scope of the AT, select them
in the Objects step, and click Remove.

To continue, click Next.

4. Inthe Access Templates step, specify the ATs you want to assign to the selected
trustees for the configured securable object. Expand the containers of the ATs, then
select the AT or ATs you want to apply.
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Figure 21: Delegation of Control Wizard - Selecting Access Templates
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To continue, click Next.

5. In the Inheritance Options step, specify with the Apply permissions onto
setting the scope of securable objects to which Active Roles applies the
permissions of the AT:

e This directory object: Trustees receive the AT permissions only to the
selected securable object.

» Child objects of this directory object: Trustees receive the AT
permissions to the children of the securable object. To limit the granted
permissions only to the direct children of the object, select Immediate child
objects only as well.
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Figure 22: Delegation of Control Wizard- Inheritance Options

Delegation of Control Wizard 7 X

Inheritance Options
You can specify whether you want child objects to inherit the permission settings Q
from the selected Access Templates.

Directory object selected:
| roles1.net/Examplec| |

Apply permissions onto;
This directory object

Child objects of this directory object
[ ] immediate child objects only

< Back Cancel Help

To continue, click Next.

6. Inthe Permissions Propagation step, to synchronize the configured permission
settings to the native Active Directory (AD) access controls, select Propagate
permissions to Active Directory.
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Figure 23: Delegation of Control Wizard — Permissions propagation
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Permissions propagation is an advanced option. It does not affect Active Roles operations,
and is only intended to provision other applications with native permissions to Active Directory.

This option generates native Active Directory permission entries based on permissions
specified with Active Roles.
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Selecting this setting will modify the authorization information of the AD objects with
the permission settings defined in Active Roles, providing more flexibility for users
and groups that use native AD management tools besides Active Roles.

IMPORTANT: Selecting this setting will result in trustees keeping their configured
permissions outside of the Active Roles environment, with the potential risk of
bypassing policies configured and enforced with Active Roles.

Therefore, select this option only if the selected trustees have the required security
clearance and/or meet all security guidelines in effect within your organization.

TIP: Once Propagate permissions to Active Directory is selected and
configured, you can change this setting at any time with the Active Roles
Security > Sync to AD setting, or with the Advanced Details > Sync to AD
setting. For more information, see Synchronizing permissions to Active Directory.

To continue, click Next.

7. To complete the wizard, click Finish.

Managing Access Template links

When you apply an Access Template (as described in Applying Access Templates), Active
Roles creates an Access Template link that stores information about:
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e The Access Template used for giving the permissions.

e The directory object on which the Access Template is applied.

e The user or group (Trustee) to whom the permissions are assigned.

If needed, you can modify the link via the Active Roles Console.

TIP: For more information about Access Template links, see Access Template link
management in the Active Roles Feature Guide.

To view or modify Access Template links in which a given Access
Template occurs

1. Right-click the Access Template, and click Links.

2. Inthe Links dialog, do the following:

To create a new link, click Add and follow the steps in the Delegation of
Control Wizard to apply an Access Template. For more information, see
Applying Access Templates.

To delete a link, select it from the list and click Remove.

To view or modify the inheritance and synchronization settings for a link, select
the link and click View /Edit.

To change the synchronization setting for a link, select the link and click Sync
to AD or Desync to AD.

To remove or restore the effect of a link, select the link and click Disable or
Enable, respectively.

To view or modify Access Template links on a given object

1. Open the Active Roles Security dialog for the object with one of the
following methods:

Right-click the object, and click Delegate Control.

Right-click the object, and click Properties. Then, on the Administration tab
in the Properties dialog, click Security.

2. Inthe Active Roles Security dialog, do the following:

To create a new link, click Add and follow the steps in the Delegation of
Control Wizard to specify permission settings on the object by using an
Access Template. For more information, see Applying Access Templates.

To delete a link, select it from the list and click Remove.

To view or modify the inheritance and synchronization settings for a link, select
the link and click View/Edit.

To change the synchronization setting for a link, select the link and click Sync
to AD or Desync to AD.

To remove or restore the effect of a link, select the link and click Disable or
Enable, respectively.
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To view or modify Access Template links for a given user or group

1. Right-click the user or group, and click Delegated Rights.
2. Inthe Delegated Rights dialog, do the following:

e To create a new link, click Add and follow the steps in the Delegation of
Control Wizard to specify permissions for the user or group by using an
Access Template. For more information, see Applying Access Templates.

e To delete a link, select it from the list and click Remove.

e To view or modify the inheritance and synchronization settings for a link, select
the link and click View/Edit.

e To change the synchronization setting for a link, select the link and click Sync
to AD or Desync to AD.

* To remove or restore the effect of a link, select the link and click Disable or
Enable, respectively.

NOTE: Consider the following when managing Access Template links:

e By default, the Active Roles Security dialog for an object lists all the links that
determine the permission settings on the object, regardless of whether a link was
created on the object itself or on a container or Managed Unit that holds the object.
To change the display of the list, clear the Show inherited check box.

e Inthe Active Roles Security dialog, only direct links can be removed, that s, a
link can be removed if the link was created on the object itself (not inherited from a
container or Managed Unit). Only direct links are displayed when you clear the
Show inherited check box, so you can delete them by clicking Remove.

e Inthe Active Roles Security dialog, the Remove button is available only on
direct links. When you need to delete links, it is advisable to manage this by using
the Links command on the Access Template or by using the Delegated Rights
command on the Trustee (user or group).

Alternatively, you can delete a link by using the View/Edit option. Select the link
and click View /Edit. Then, click Properties next to the Access Template

box. After that, on the Administration tab, click Links. Finally, delete the link
from the Links dialog.

» Inthe Active Roles Security dialog, the Sync to AD button is available only on
direct links. When you need to change synchronization status of a link, it is
advisable to manage this by using the Links command on the Access Template or
by using the Delegated Rights command on the Trustee (user or group).

Alternatively, you can change the synchronization status of a link by using
the View/Edit option. Select the link and click View/Edit. Then, on the

Synchronization tab, select or clear Propagate permissions to Active

Directory.

» Clicking View/Edit displays the Properties dialog for the selected link. This dialog
can be considered as a focal point for administration of all elements of the link.
Thus, from the Properties dialog, you can access the properties of the directory
object, Access Template and Trustee that are covered by the link, view or modify
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the settings found on the Inheritance Options and Permissions Propagation
pages in the Delegation of Control Wizard, and enable or disable the link.

e You can also manage Access Template links on the Links or Active Roles
Security tab in the Advanced Details Pane, which allows you to perform the
same tasks as the Links or Active Roles Security dialog, respectively. Right-click
a link or a blank area on the tab, and use command on the shortcut menu. The
Links tab is displayed when you select an Access Template. Otherwise, the Active
Roles Security tab is displayed. To display the Advanced Details Pane, check
Advanced Details Pane on the View menu. For more information, see Advanced
pane in the Active Roles Feature Guide.

Synchronizing permissions to Active
Directory

Active Roles provides the option to keep Active Directory native security updated with
selected permission settings that are specified by using Access Templates. This option,
referred to as "permission propagation”, is intended to provision users and applications
with native permissions to Active Directory. The normal operation of Active Roles does not
rely on this option.

You can set the permissions propagation option as follows:

e When applying an Access Template, select the Propagate permissions to Active
Directory check box in the Delegation of Control Wizard. For more information,
see Applying Access Templates.

 When managing Access Template links, use the Sync to AD button in the dialog that
displays a list of links. For more information, see Managing Access Template links.

As an example, you can use the following instructions to set the permissions propagation
option on the permission settings that are defined by applying a certain Access Template to
an Organizational Unit (OU):

To synchronize permission settings on an OU

Right-click the OU and click Delegate Control.

2. Inthe Active Roles Security dialog, select the Access Template link that
determines the permission settings you want to synchronize to Active Directory, then
click Sync to AD.

3. Click OK to close the Active Roles Security dialog.
NOTE: Consider the following when configuring permission propagation:

e When synchronizing permissions to Active Directory, Active Roles creates
permission entries in Active Directory so that the Trustee has the same rights in
Active Directory as it has in the Active Roles environment as per the Access
Template links you have synchronized.
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e You can stop synchronization of permissions at any time by clicking Desync to AD.
If you do so, Active Roles deletes all permission entries in Active Directory that
were created as a result of synchronization.

» Inthe Active Roles Security dialog, the Sync to AD button is only available on
direct links. When you need to synchronize links, it is advisable to manage them
using the Links command on the Access Template.

e You can also manage the permissions propagation option on the Links or Active
Roles Security tab in the Advanced Details Pane, which allows you to perform
the same tasks as the Links or Active Roles Security dialog, respectively. Right-
click the link on which you want to set the permissions propagation option, and
click Sync to AD to start synchronization or Desync to AD to stop
synchronization. The Links tab is displayed when you select an Access Template.
Otherwise, the Active Roles Security tab is displayed. To display the Advanced
Details Pane, check Advanced Details Pane on the View menu. For more
information, see Advanced pane in the Active Roles Feature Guide.

Adding, modifying, or removing Access
Template permissions

Even after creating a new Access Template, you can:

e Add additional permissions to it.
« Modify any of its permissions.

« Remove any of its permissions.

To change the configured permissions of an existing Access Template, use the Active
Roles Console.

Adding permissions to an Access Template

You can add permission entries to an Access Template via the Active Roles Console.

To add a permission entry to an Access Template

1. Inthe Console tree, under Configuration > Access Templates, locate and select
the folder that contains the Access Template you want to modify.

In the details pane, right-click the Access Template, and click Properties.

3. On the Permissions tab, click Add, and then use the Add Permission Entries
Wizard to configure a permission entry.

For detailed instructions on how to add a permission entry to an Access Template,
see Creating an Access Template.

| NOTE: Consider the following when working with an Access Template:
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e The Permissions tab lists the permission entries that are configured in the Access
Template. You can use the Permissions tab to add, modify, or delete permission
entries from the Access Template.

e Once you apply an Access Template in Active Roles to specify directory
permissions, any changes to the list of permission entries in the Access Template
will result in the directory permissions changing accordingly.

e Active Roles includes a suite of predefined Access Templates. The list of permission
entries in a predefined Access Template cannot be modified. If you need to add,
modify, or delete permission entries from a predefined Access Template, create a
copy of that Access Template, then make changes to the copy. Another option is to
create an Access Template and nest the predefined Access Template into the newly
created Access Template. For instructions, see Creating an Access Template,
Copying an Access Template, and Managing nested Access Templates.

Modifying permissions in an Access Template

You can modify the permissions of an Access Template with the Modify Permission Entry
dialog of the Active Roles Console.

To modify a permission entry in an Access Template

1. Inthe Console tree, under Configuration > Access Templates, locate and select
the folder that contains the Access Template you want to modify.

In the details pane, right-click the Access Template, and click Properties.

3. Onthe Permissions tab, select the permission entry you want to modify, click
View/Edit, then use the tabs in the Modify Permission Entry dialog to make
changes to the permission entry.

For detailed instructions on how to view or modify a permission entry in an Access
Template, see Creating an Access Template.

NOTE: Consider the following when modifying the permissions of an Access Template:

e The Permissions tab lists the permission entries that are configured in the Access
Template. You can use the Permissions tab to add, modify, or delete permission
entries from the Access Template.

e The options on the Permissions tab in the Modify Permission Entry dialog are
read-only. If you need to choose a different option for the permission entry, delete
the permission entry, then add a new permission entry with the option you need.
For more information, see Adding permissions to an Access Template.

e Once you apply an Access Template in Active Roles to specify directory
permissions, any changes to the list of permission entries in the Access Template
will result in the directory permissions changing accordingly.

» Active Roles includes a suite of predefined Access Templates. The list of permission
entries in a predefined Access Template cannot be modified. If you need to add,
modify, or delete permission entries from a predefined Access Template, create a
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copy of that Access Template, then make changes to the copy. Another option is to
create an Access Template and nest the predefined Access Template into the newly
created Access Template. For instructions, see Creating an Access Template,
Copying an Access Template, and Managing nested Access Templates.

Removing permissions from an Access Template

You can remove permissions from an Access Template by deleting the related permission
entry in the Active Roles Console.

To delete a permission entry from an Access Template

1. Inthe Console tree, under Configuration > Access Templates, locate and select
the folder that contains the Access Template you want to modify.

In the details pane, right-click the Access Template, and click Properties.

3. Onthe Permissions tab, select the permission entry you want to delete, click
Remove, then click Yes to confirm the deletion.

NOTE: Consider the following when working with an Access Template:

e The Permissions tab lists the permission entries that are configured in the Access
Template. You can use the Permissions tab to add, modify, or delete permission
entries from the Access Template.

e Once you apply an Access Template in Active Roles to specify directory
permissions, any changes to the list of permission entries in the Access Template
will result in the directory permissions changing accordingly.

e Active Roles includes a suite of predefined Access Templates. The list of permission
entries in a predefined Access Template cannot be modified. If you need to add,
modify, or delete permission entries from a predefined Access Template, create a
copy of that Access Template, then make changes to the copy. Another option is to
create an Access Template and nest the predefined Access Template into the newly
created Access Template. For instructions, see Creating an Access Template,
Copying an Access Template, and Managing nested Access Templates.

Managing nested Access Templates

You can define permissions in an Access Template (AT) by including (nesting) other ATs.
This reduces the work required if you need to create a new AT that is similar to an existing
one. Instead of modifying an existing Template to add new permissions, you can nest it
into a new AT.

To manage nested ATs, use the Properties > Nesting settings of the Active Roles
Console.
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To configure an Access Template to include another Access Template

1.

In the Console tree, under Configuration > Access Templates, locate and select
the folder that contains the Access Template you want to configure.

In the details pane, right-click the Access Template, and click Properties.

3. Onthe Nesting tab, click Add, then select the Access Template you want to be

included in the Access Template you are configuring.

NOTE: Consider the following when nesting Access Templates:

Configuring an Access Template to include another Access Template is called
"nesting". The Nesting tab provides a list of Access Templates that are nested into
the Access Template. You can add Access Templates to the list or remove Access
Templates from the list.

Nesting an Access Template into a target Access Template causes the list of
permission entries in the target Access Template to be extended with the
permission entries of the nested Access Template. Thus, if Access Template A is
nested into Access Template B, all the permission entries found in Access Template
A are added to the list of permission entries in Access Template B.

You can view a consolidated list of permission entries for the Access Template: On
the Nesting tab, click All Permissions. The list includes both the permission
entries that are configured in the Access Template and the permission entries
found in each Access Template that is nested into the Access Template. Note that
the Permissions tab in the Properties dialog box lists only those permission
entries that are configured in the Access Template. The permission entries that are
inherited from other Access Templates by reason of nesting are not listed on the
Permissions tab.

You can view the Access Templates into which the selected Access Template is
nested: On the Nesting tab, click Nested In. Double-clicking items in the Nested
In list opens the Properties dialog for each of the Access Templates that the
selected Access Template is nested into.

Nesting allows you to reuse the existing predefined or custom Access Templates.
For example, if you need to add permission entries to the predefined Helpdesk
Access Template, then you can create a new Access Template, nest the Helpdesk
Access Template into the newly-created Access Template, and add permission
entries to the new Access Template as needed.

Copying an Access Template

With the Active Roles Console, you can create copies of Access Templates. This feature
helps you reuse existing Access Templates. For example, if you need to modify a
predefined Access Template, you can create a copy of that Access Template, then modify
the copy as needed.
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To copy an Access Template

1. Inthe Console tree, under Configuration > Access Templates, locate and select
the folder that contains the Access Template you want to copy.

2. To start the Copy Object - Access Template wizard, in the details pane, right-click
the Access Template, then click Copy.

3. On the first page of the wizard, do the following, then click Next:
a. Inthe Name box, enter a name for the new Access Template.

b. (Optional) In the Description box, enter any information about the new
Access Template.

4. On the second page of the wizard, you can add, modify, and delete the permission
entries that were copied from the original Access Template. Do the following, then
click Next:

e To add a permission entry to the new Access Template, click Add.

e To modify a permission entry for the new Access Template, select the entry
from the list, and click View/ Edit.

» To delete a permission entry from the new Access Template, select the entry
from the list, and click Remove.

For more information on how to add or modify a permission entry, see Creating an
Access Template.

5. To create the copy of the Access Template, click Finish.

Exporting and importing Access Templates

With the Active Roles Console, you can export Access Templates to an XML file and then
import them from that file to populate another instance of Active Roles. The export and
import operations provide a way to move Access Templates from a test environment to a
production environment, and vice versa.

NOTE: When you export and then import an Access Template, only permission entries are
transferred. The Access Template links are not exported, and therefore you need to recon-
figure them manually after you imported the Access Template.

To export Access Templates, select them, right-click the selection, and select All Tasks >
Export. In the Export Objects dialog, specify the file where you want to save the data,
and click Save.

To import Access Templates, right-click the container where you want to place the Access
Templates, and then click Import. In the Import Directory Objects dialog, select the file
to which the Access Templates were exported, and click Open.
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Renaming an Access Template

You can rename an existing Access Template with the Rename setting of the Active
Roles Console.

To rename an Access Template

1. Inthe Console tree, under Configuration > Access Templates, locate and select
the folder that contains the Access Template you want to rename.

2. Inthe details pane, right-click the Access Template, and click Rename.

3. Type a new name, then press Enter.
NOTE: Consider the following when renaming an Access Template:

e Renaming an Access Template does not affect its links. This is because Access
Templates are referenced by immutable identifier rather than by name.

e If an Access Template is applied within Active Roles to determine permission
settings in the directory, renaming the Access Template does not cause any
changes to the permission settings in the directory. When applying an Access
Template, Active Roles refers to the Access Template by an internal identifier
rather than by the name of the Access Template.

e Active Roles includes a suite of predefined Access Templates. The name of a
predefined Access Template cannot be modified. If you need an Access Template
with a different name to have the same permission entries as a predefined Access
Template, create a copy of the predefined Access Template, and then make
changes to the copy. Another option is to create an Access Template and nest the
predefined Access Template into the newly- created Access Template. For more
information, see Creating an Access Template, Copying an Access Template, and
Managing nested Access Templates.

Deleting an Access Template

You can delete existing Access Templates in the Active Roles Console.

Prerequisites

To delete an Access Template, you must remove all existing references to it. To do so:

e Delete the links to the Access Template. For more information, see Managing Access
Template links.

e Remove the Access Template from all Access Templates in which the Access
Template is nested. For more information, see Managing nested Access Templates.
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To delete an Access Template

1. Inthe Console tree, under Configuration > Access Templates, locate and select
the folder that contains the Access Template you want to delete.

2. Inthe details pane, right-click the Access Template, then click Delete.
NOTE: Consider the following when deleting an Access Template:

e Once an Access Template is applied (linked) within Active Roles to determine
permission settings in the directory, the Access Template cannot be deleted. You
can view the links in which the Access Template participates by right-clicking the
Access Template, and clicking Links. If you need to delete the Access Template,
first remove all items from the Links list. For instructions, see Managing Access
Template links.

e An Access Template cannot be deleted if it is nested into another Access Template.
To view the Access Templates into which the selected Access Template is nested,
on the Nesting tab, click Nested In. Then, double-click an item in the Nested In
list to open a dialog where you can remove the Access Template from nesting. For
instructions, see Managing nested Access Templates.

» Active Roles includes a suite of predefined Access Templates and a number of built-
in Access Templates. Neither predefined Access Templates nor built-in Access
Templates can be deleted. For more information on the built-in Access Template,
see Active Roles Built-in Access Templates Reference Guide.

Access Rule management tasks

This section guides you through the Active RolesConsole to manage Windows claims-based
Access Rules.

Prerequisites for using Access Rules

Before you can use Access Rules, the following conditions must be fulfilled:

e Claim support must be enabled in your Active Directory domain. For details, review
the topic Enabling claim support.

e For Access Rules to use device claims, Group Policy setting Computer
Configuration > Policies > Administrative Templates > System >
Kerberos > Support Compound Authentication with the Always option must
be enabled on the client computers, in addition to the Kerberos client support
for claims, compound authentication and Kerberos armoring setting (see
Client computer).

e The Active Roles Administration Service must be installed on a computer running
Windows Server 2016 or a later version of the Windows Server operating system.
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e The Active Roles Administration Service that performs authorization using Access
Rules must be installed in the Active Directory forest where the user account of the
authorizing user is defined and in which the claim types used by the Access Rules are
created. Active Roles does not support the use of Access Rules for cross-forest
authorization.

e Group Policy setting Computer Configuration > Policies > Administrative
Templates > System > Kerberos > Kerberos client support for claims,
compound authentication and Kerberos armoring must be enabled on the
computer running the Administration Service.

e The Administration Service must be configured to support Kerberos authentication.

Configuring the Administration Service to support
Kerberos authentication

Access Rules require the Active Roles Administration Service to support Kerberos
authentication. This is because Windows claims are delivered inside Kerberos tickets. To
enable Kerberos authentication, the Service Principal Name (SPN) of the Active Roles
Administration Service must be added to the service account (domain user account under
which the Administration Service runs). For example, suppose that:

e arsrv.domain.com is the FQDN of the computer running the Administration Service.

e arsrv is the name of the computer running the Administration Service.
SPNs must be added to the service account:
e aradminsvc/arsrv.domain.com
e aradminsvc/arsrv
You can add the SPNs to the service account by using the Setspn command line tool:
1. setspn -s aradminsvc/<FQDN> <ServiceAccountName>
For example, setspn -s aradminsvc/arsrv.domain.com domain\arsvcacct
2. setspn -s aradminsvc/<name> <ServiceAccountName>

For example, setspn -s aradminsvc/arsrv domain\arsvcacct

Enabling claim support

Claims-based authorization requires:

e A domain controller (or controllers) running a version of Windows Server supported
by Active Roles, with claim support enabled. For the list of supported operating
system, see System Requirements in the Active Roles Release Notes.

e (Optional) If you need to use device claims, then a domain-joined client computer (or
computers) running a supported version of the Windows operating system.
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Domain controller requirements for claims-based
authorization

The claims-based authorization mechanism has the following requirements on the domain
controller (DC) side:

o Extensions to Active Directory, such as claim type objects intended to store the claim
configuration data. By adding a Windows Server domain controller (DC), you extend
the Active Directory schema to provide the object classes and attributes required to
support claims-based authorization.

e Enhancements in the Kerberos Key Distribution Center (KDC) and Security Accounts
Manager (SAM) that enable DCs running Windows Server to recognize claim types,
retrieve claim information, and transport claims within Kerberos tickets.

A Windows Server DC that supports claim issuance understands claim types
published in Active Directory. Claim types define the claim source attributes. When
servicing an authentication request, the domain controller reads the source attribute
from the claim type and retrieves the attribute data for the authenticating user.
Then, the retrieved attribute data is included in the Kerberos ticket and returned to
the requestor.

o If the DC does not support claim issuance by default, you must enable it via Group
Policy. The Group Policy setting that serves this purpose is located in Computer
Configuration > Policies > Administrative Templates > System > KDC >
KDC support for claims, compound authentication and Kerberos
armoring. Enable this policy setting in a Group Policy Object applied to the
Domain Controllers Organizational Unit (for example, in the Default Domain
Controllers Policy object), and confirm that this policy setting has the
Supported option selected.

NOTE: Claims-based authorization does not impose domain or forest functional require-
ments. If your Active Directory domain has a sufficient number of Windows Server DCs to
service authentication requests that include claim information, then you can make use of
Windows claims.

Client computer

The claims-based authorization mechanism has the following requirements on the client
computer side:

e Domain-joined client computers running supported Windows operating systems
are required for claims-based authorization when using device claims. For the list
of supported operating system, see System Requirements in the Active Roles
Release Notes.

NOTE: This requirement does not apply to authorization scenarios that employ user
claims only.
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o If the client computer does not request user or device claims upon user
authentication, you must enable claim support on the client computer via Group
Policy. The Group Policy setting that serves this purpose is located in Computer
Configuration > Policies > Administrative Templates > System > Kerberos >
Kerberos client support for claims, compound authentication and Kerberos
armoring. Enable this policy setting in a Group Policy Object applied to the
Organizational Unit that holds the computer accounts of client computers.

Managing Windows claims

Claims are statements about an authenticated user or device, issued by an Active Directory
domain controller running Windows Server 2016 or later. Claims can contain information
about the user or device retrieved from Active Directory.

You can manage claims in Active Roles under the Active Directory > Claim Types
container of the Active Roles Console tree.

NOTE: For more information about Windows claims and claims-based Access Rules, see
Management of Windows claims in the Active Roles Feature Guide.

Managing claim types

Claim types must be created in Active Directory to enable domain controllers (DCs) to issue
claims to users or computers. Claims issued by the DC are sourced from attributes of user
or computer accounts stored in Active Directory. Claim types specify the attributes from
which the claims are sourced, and contain metadata required for using claims.

New claim types are created in the Claim Types container under the Active Directory
node located in the Active Roles Console tree. If you have domains from multiple forests
registered with Active Roles, then the Console displays an individual Claim Types
container for each forest that has DCs running a Windows Server operating system
supported by (see System Requirements in the Release Notes for more information). To
identify the forest of a given Claim Types container, the container name includes the
name (or a part of the name) of the forest root domain.

To create a new claim type

Right-click the Claim Types container, and select New > Claim Type.

2. On the Source Attribute page, select the desired source attribute for claims
of this type.

3. Review the auto-generated display name and description, and change them if
needed.

4. Under Claims of this type can be issued for the following classes, select:
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e The User check box to enable issuance of this claim type to users.
 The Computers check box to enable issuance of this claim type to computers.

5. Select the Set ID to a semantically identical claim type in a trusted forest
check box if the claim type must match an existing claim type in a different forest.
Type the claim identifier. Clear this check box to generate the claim identifier
automatically.

6. Select the Protect from accidental deletion check box to ensure an administrator
cannot accidentally delete the claim type. Clear the check box to remove accidental
deletion protection.

7. Click Next to proceed to the Suggested Values page.
8. Click the option you want for suggested values. Create suggested values as needed.
9. Click Finish.

To modify an existing claim type

Right-click the claim type you want to modify and then click Properties.

2. Onthe Source Attribute page, view or change the source attribute, the display
name, description, user or computer claim issuance options, and the option to
protect the claim type from accidental deletion.

3. Click the Suggested Values tab to view or change suggested values.

4. Click OK to save the modified claim type.

To delete a claim type

1. Right-click the claim type, then click Delete.

2. Confirm the claim type deletion.

If you encounter a message stating that you do not have permission to delete the claim
type, then modify the claim type and clear the Protect from accidental deletion
check box. If this check box is cleared, verify that you have sufficient rights to delete
claim type objects.

Enabling and disabling claim types

Windows claim types have two states: disabled and enabled. Disabled claim types are valid
claim types, but are unavailable for use in production. Claims of disabled claim types are
not issued by domain controllers and disabled claim types are filtered from view in the
access rule condition builder. A claim type becomes available for production use once you
enable it. Active Roles creates enabled claim types, and allows you to disable and enable
claim types as needed.

To disable an enabled claim type

1. Inthe Active Roles Console, navigate to the enabled claim type you want to disable.

2. Right-click the claim type object and click Disable.
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To enable a disabled claim type

1. Inthe Active Roles Console, navigate to the disabled claim type you want to enable.

2. Right-click the claim type object and click Enable.

Managing and applying Access Rules

Access Rules are used in Active Roles to specify conditions for authorizing user access to
securable objects (target objects) that involve user groups, user claims, device groups,
device claims, and target object properties. When you apply an Access Template, you can
specify an Access Rule to determine the conditions that must be satisfied for the
permissions resulting from the Access Template to take effect.

Access Rules are held in the Access Rules container under the Configuration node in the
Console tree.

Creating or modifying an Access Rule

You can create a new Access Rule in the Configuration > Access Rules container, or
modify an existing Access Rule in that container.

To create a new Access Rule
1. Right-click the Access Rules container, and select New > Access Rule.
2. Onthe General page, type a name and description for the new Access Rule.
3. Click Next to proceed to the Conditions page.

4. Configure a conditional expression, then click Finish.

To modify an existing Access Rule

1. Right-click the Access Rule you want to modify, then click Properties.
2. Onthe General page, view or change the name and description of the Access Rule.

3. On the Conditions page, view or change the conditional expression.

Configuring a conditional expression for an
Access Rule

The Conditions page provides an editor for configuring a conditional expression. When you
configure an expression, you need to add at least one condition. Initially, you add a
condition to the default condition group. You can create additional condition groups to
group a set of conditions and nest the grouped conditions within other condition groups.
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A condition group contains one or more conditions connected by the same logical operator.
By grouping conditions, you specify that those conditions should be evaluated as a single
unit. The effect is the same as if you put parentheses around an expression in a
mathematical equation or logic statement.

To add a condition to a condition group

e Click the name of the condition group and then click Insert condition.
OR

e Click the plus sign (+) next to the name of the condition group.

You can remove a condition, if needed, by clicking the Delete condition button labeled X
on the right side of the list item representing the condition in the condition builder.

To add a condition group into another condition group

e Click the name of the condition group, point to Insert condition group, and then
click an option to specify the logical operator:

e« AND group: The condition group evaluates to TRUE if all conditions in the
group are TRUE.

e OR group: The condition group evaluates to TRUE if any condition in the
group is TRUE.

By default, AND is the logical operator between the conditions in a condition group. Itis
possible to change the logical operator by converting the condition group to a different
group type: Click the name of the group, point to Convert condition group to, and then
click the option appropriate to the desired logical operator.

You can remove an entire condition group, if needed, by clicking the name of the group and
then clicking Delete condition group.

Once you have added a condition to a condition group, you can use the following steps to
configure the condition.

To configure a condition

1. Click Configure condition to evaluate, and then choose from the following options
to specify what you want the condition to evaluate:

e Click Device claim to evaluate a computer claim, or groups the computer
account is a member of. Then, in the claim type list, select the desired claim
type, or click Group if you want the condition to evaluate the group
membership of the computer account.

e Click Target object property to evaluate a certain property of the object to
which the authorizing user requests access. Then, in the property list, select
the desired property.

e Click User claim to evaluate a user claim, or groups the user accountis a
member of. Then, in the claim type list, select the desired claim type, or click
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Group if you want the condition to evaluate the group membership of the user
account.

2. Click in the middle field of the condition line to choose the comparison
operator you want.

3. Click Define value to compare to, and then choose from the following options to
specify the desired comparison value:

e Click Device claim to perform comparison with a computer claim. Then, in the
claim type list, select the desired claim type.

e Click Target object property to perform comparison with the value of a
certain property of the object to which the authorizing user requests access.
Then, in the property list, select the desired property.

e Click User claim to perform comparison with a user claim. Then, in the claim
type list, select the desired claim type.

e Click Value to perform comparison with a particular text string, integer,
Boolean value, or a list of groups. Then, supply the desired value. The value
you can supply depends upon the type of data the condition is intended to
evaluate. For example, when configuring a condition to evaluate group
memberships, you have to supply a list of groups as a comparison value. If the
claim type you have selected to evaluate provides a list of suggested values,
then you can only select a comparison value from that list.

When you configure a condition, consider the following:

e Only single-value claim types and object properties are supported. The multi-value
claim types and object properties are filtered out from the lists provided by the
condition builder.

e To perform comparison, a valid condition requires that values on either side of the
comparison operator be of the same or compatible data type. Therefore, when you
supply a comparison value, the condition builder restricts you to the options that
match the data type of the claim or property you choose to evaluate. If you choose to
evaluate a string-value, integer-value, or Boolean claim type or object property, then
the comparison value must be a string, integer, or Boolean value, respectively.

» If you choose to evaluate the group membership of a user or device, the comparison
value must be a list of groups. Other options are unavailable in this case.

Applying an Access Rule to Access Template links

You must apply Access Rules to Access Template links. A single Access Rule or no Access
Rule can be applied to a given link. By default, no Access Rule is applied, which configures
an unconditional link. By applying an Access Rule, you create a conditional link that has an
effect only if the Access Rule’s conditional expression evaluates to True during the
permission check.
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To apply an Access Rule

1. In alist of Access Template links, double-click the Access Template link to which you
want to apply the Access Rule.

You can display a list of Access Template links in a number of ways:

e Right-click a container, then click Delegate Control. This displays a list of all
Access Template links applied to that container or inherited from a higher-
level container.

e Right-click a user or group, then click Delegated Rights. This displays a list of
all Access Template links applied to that user or group or inherited from
another security group.

e Right-click an Access Template, then click Links. This displays a list of all
Access Template links referring to that Access Template.

2. In Properties, click Access Rule.

3. Click Change, then select the Access Rule you want to apply.
From the Access Rule tab, you can also perform the following tasks:

e Access Rule: This field identifies the Access Rule that is currently applied to the
Access Template link. If no Access Rule is applied, this field is empty; otherwise, the
field displays the name of the Access Rule along with the path to the Access Rule
object in the Configuration > Access Rules container.

e Properties: Click this button to view or change the Access Rule properties, including
the conditional expression of the Access Rule.

e Clear: Click this button if you want to remove the Access Rule from the Access
Template link.

To see if a given link has an Access Rule applied to it, refer to the Access Rule field in the
list of Access Template links.

Deploying an Access Rule

This section demonstrates how to implement a security scenario where each delegated
administrator is restricted to managing users from a single department. The scenario is
implemented by using an Access Rule that enables a delegated administrator to access only
those objects whose Department property is identical to the Department claim of that
delegated administrator.

Prerequisites of deploying an Access Rule

To deploy a new Access Rule, you and your organization must meet the following
conditions:
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e Your organization must have an Active Directory domain, with at least one Domain
Controller (DC) running a Windows Server version supported by Active Roles. For
the supported operating systems, see System Requirements in the Active Roles
Release Notes.

e The Active Roles Administration Database and Active Roles Console of the latest
version of the product must be installed on a member server in your Active Directory
domain. The member server must also run a Windows server version supported by
Active Roles.

e Your Active Directory domain is registered with Active Roles as a managed domain.

Enabling claim support

To deploy the Access Rule, configure a Group Policy to enable domain controllers (DCs) to
issue claims.

To create a Group Policy for claim support

1. On a DCrunning a supported version of Windows Server, open the Group Policy
Management console.

To open the Console, press Win+R. Then, in the Run dialog, type gpmc.msc,
and click OK.

In the Console tree, select the Domain Controllers OU under your domain.
In the details pane, right-click Default Domain Controllers Policy, then click Edit.

4. Perform the following steps in the Group Policy Management Editor console
that appears:

a. Inthe Console tree, select Computer Configuration > Policies >
Administrative Templates > System > KDC.

b. Inthe details pane, double-click KDC support for claims, compound
authentication and Kerberos armoring.

c. Inthe KDC support for claims, compound authentication and Kerberos
armoring dialog, click Enabled and select Supported from the Options
drop-down list. When finished, click OK to close the dialog.

5. Close the Group Policy Management Editor.
6. Close Group Policy Management.
7. Open the Windows command prompt and enter the following command:

gpupdate /force

Once you are ready, configure the Group Policy to enable the Active Roles Administration
Database to retrieve claims for clients by using Kerberos protocol transition.
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To configure the Group Policy to retrieve claims

1. Onthe server running the Active Roles Administration Service, open the Local
Group Policy Editor console.

2. To open the Console, press Win+R. Then, in the Run dialog, type gpmc.msc,
and click OK.

3. Inthe Console tree, select Computer Configuration > Policies >
Administrative Templates > System > Kerberos.

4. In the details pane, double-click Kerberos client support for claims, compound
authentication and Kerberos armoring.

5. Inthe Kerberos client support for claims, compound authentication and
Kerberos armoring dialog, click Enabled, then click OK.

6. Restart the computer to apply the new setting to the Active Roles
Administration Service.

NOTE: Make sure to restart the computer. Restarting only the Active Roles Admin-
istration Service is not sufficient.

Once you are ready, to enable Kerberos authentication, add the Service Principal Names
(SPNs) of the Active Roles Administration Service to the service account.

To add SPNs to the service account and enable Kerberos authentication

1. Open the Windows command prompt.
2. Enter the following commands:
» setspn -s aradminsvc/<FQDN> <service-account-name>

+ setspn -s aradminsvc/<name> <service-account-name>
In the above commands:

e <FQDN> is the fully qualified domain name of the computer running the Active Roles
Administration Service (for example, arsrv.domain.com).

e <name> is the name of the computer (for example, arsrv).

e <service-account-name> is the name of the service account (that is the domain user
account running the Active Roles Administration Service), for example
domain\arsvcacct.

Creating a claim type

Create a claim type object for your Domain Controller (DC) to issue user claims sourced
from the Department attribute. Log in as an Active Roles administrator and perform the
following steps in the Active Roles Console.

NOTE: If using a default Active Roles configuration, you must log in with a domain user
account that is a member of the Administrators local group of the member server running
the Active Roles Administration Service.
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To create a claim type

1. Inthe Console tree, expand the Active Directory node, right-click the Claim
Types container, and select New > Claim Type.

2. Onthe Source Attribute page, scroll down the list of attributes, and click
Department.

3. Click Next, then click Finish.

Creating the Access Rule

Use the Active Roles Console to create an Access Rule object with a conditional expression
that evaluates to True if the Department claim of the authorizing user evaluates exactly to
the Department property of the target object.

To create a new Access Rule

1. Inthe Console tree, expand the Configuration node, right-click the Access Rules
container, and select New > Access Rule.

2. Onthe General page, type Department Admins in the Name field, then click Next.
3. On the Conditions page, configure the conditional expression:

a. Click the AND group item, then click Insert condition.

b. Click Configure condition to evaluate, then click User claim.

c. Onthe Select Claim Type page that appears, click Department in the list of
claim types, then click OK.

d. Verify that the comparison operator reads equals (this is the default setting).
e. Click Define value to compare to, then click Target object property.

f. On the Select Target Object Property page that appears, select the
Department property, then click OK.

4. Click Finish.

Applying the Access Rule

To apply the Access Rule you created in the Creating the Access Rule step, you first need to
delegate control by using an Access Template, then attach the Access Rule to the Access
Template link. Create a security group to hold your delegated administrators, and perform
the following steps in the Active Roles Console:

To apply an Access Rule to a security group

1. Inthe Console tree, under the Active Directory node, right-click the name of your
domain, then click Delegate Control.
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2. To start the Delegation of Control Wizard, on the Active Roles Security page
that appears, click Add.

3. Follow the wizard pages:

a. Onthe Users or Groups page, click Add, and select the security group that
holds your delegated administrators. Click Next.

b. Onthe Access Templates page, expand the Active Directory node, and
select the OUs - Read All Properties and Users - Modify All Properties
check boxes. Click Next.

c. On the remaining pages, click Next to accept the default settings.
d. On the completion page, click Finish.

You will apply the Access Rule to the Users - Modify All Properties Access
Template link. The OUs - Read All Properties Access Template enables the
delegated administrators to browse the domain for user objects.

4. To close the Active Roles Security, click OK. This will create the Access
Template links.

5. To open the Active Roles Security page claim, right-click the name of your Active
Directory domain and click Active Roles Security.

6. On the Active Roles Security page, select the Users - Modify All Properties
Access Template link, then click View/ Edit.

7. Onthe Access Rule tab in dialog that appears, click Change, and select the
Department Admins Access Rule. To close the Select an Access Rule page, click
OK, then close the dialog by clicking OK again.

8. To close the Active Roles Security page, click OK.

After you completed these steps, Active Roles allows a delegated administrator to make
changes to only those user accounts that have the same department setting as the account
of the delegated administrator.
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Rule-based autoprovisioning and
deprovisioning

Active Directory (AD) supports delegating control with fine granularity. However, simply
restricting control, access and permissions may not always be a sufficient or effective way
of managing the resources of an organization.

Many directory administration processes (such as creating or disabling user accounts,
enforcing user name conventions, resetting passwords, and so on) are based on predefined
workflows that often share the same procedures. In practice, this means that
administrators have to repeatedly perform configuration tasks with similar steps.

To make the management of such administrative tasks easier, Active Roles provides a
policy-based administration solution to automate and speed up repeat procedures when
administering on-premises, hybrid and Azure cloud-only objects. This approach is
represented with Policy Objects, available in the Configuration > Policies >
Administration node of the Active Roles Console.

NOTE: Policy Object settings specific to Azure cloud-only objects (such as cloud-only
Azure users, guest users, or contacts) are available only if your Active Roles deployment
is licensed for managing cloud-only Azure objects. Contact One Identity support for more
information.

Also, Policy Objects specific to Azure cloud-only objects will work correctly only if an
Azure tenant is already configured in the AD of the organization, and Active Roles is
already set as a consented Azure application for that Azure tenant. For more information
on these settings, see Configuring a new Azure tenant and consenting Active Roles as an
Azure application.

Summary of Policy Objects

Each configured Policy Object contains one or more policies, defining either the behavior of
the Active Roles system, or the actions that Active Roles performs when certain directory
objects are created, modified, or deleted. This way, Active Roles can automate the
administrative workflow within the organization.

Policy Objects specify what AD objects to change, how, when, whenever they are created,
modified, or deleted. You can also configure policies to have Active Roles accept certain
data changes only if they conform to the formatting requirements specified by the policy.
This helps maintain control over the data stored in AD, and also keeps network objects in a
consistent state with each defined policy.
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To offer additional flexibility for configuring policies, Active Roles Policy Objects can also
run customizable scripts before or after running a task.

Example: Use case for setting up a policy

A typical use case for an Active Roles policy is to automate the administration of a
new employee. When creating a user account for a new employee, you can create a
policy that makes Active Roles automatically perform all of the following steps:

1. Retrieve information from the HR database of the organization.

2. Use the retrieved information as the default data for filling user account
properties, such as name, contact information, and so on.

3. Create a home folder and home share for the new user account.
4. Add the user account to all relevant groups within the organization.

Create an Exchange mailbox for the user account, and add the mailbox to the
relevant distribution lists.

With one or more properly configured Policy Objects, this entire procedure can be
performed either automatically, or with minimal manual administrator work. Without
policies, it would require time-consuming manual administrative actions each time a
new user is administered.

NOTE: Active Roles does not automatically check for changes in directory objects, contain-
ers or groups specified for provisioning in the configured Policy Objects. This means that

if any changes are made in any directory resources in use in a policy, you must update

the impacted policies manually. For example, if a directory group used by a Group
Membership AutoProvisioning Policy Group is deleted, the Policy Group must be updated
manually to reflect the changes.

Advantages of using Policy Objects

Configuring Policy Objects has the following advantages:

e They reduce the workload and the time needed to perform common administration
duties by automating tasks, combining multiple tasks into a single workflow, or even
eliminating certain tasks altogether.

e They offer automated (or largely simplified) workflows for provisioning,
reprovisioning and deprovisioning directory objects in the organization.

e They improve network security.
e They ensure the consistency of the managed AD objects across the organization.

e They minimize administration errors.
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Types of Policy Objects

To help you configure, organize and apply Policy Objects, they are in two main categories in
the Active Roles Console:

e Provisioning Policy Objects: Use provisioning Policy Objects to specify provisioning
rules, such as:
e Populating and validating directory data.
e Creating account resources (such as home folders and mailboxes).
e Administering access to resources within the organization.

e Deprovisioning Policy Objects: Use deprovisioning Policy Objects to specify rules
upon requests to deprovision a selected user or group. Deprovisioning rules
may include:

e Removing user accounts or email addresses.
e Revoking group and distribution list memberships.

» Disabling security permissions and application access rights.

Both categories can contain multiple Policy Objects.

Built-in Policy Objects

To help you get started with configuring policy-based administration in your organization,
Active Roles includes a set of built-in Policy Objects that offer provisioning and depro-
visioning rules to the most typical administrative use cases. To find the built-in Policy
Objects, navigate to the following node of the Active Roles Console:

Configuration > Policies > Administration > Builtin

To help you configure Script Execution policies, Active Roles also ships with several built-in
Script Modules that you can use to set up your own Script Execution policies. Find these
built-in Script Modules in the following node of the Active Roles Console:

Configuration > Script Modules > Builtin

Provisioning Policy Objects

To configure provisioning policies for user name and email generation, group memberships,
property generation or script running, use the policies available via the Provisioning
Policy Objects option.

NOTE: Policy Object settings specific to Azure cloud-only objects (such as cloud-only
Azure users, guest users, or contacts) are available only if your Active Roles deployment
is licensed for managing cloud-only Azure objects. Contact One Identity support for more
information.

Also, Policy Objects specific to Azure cloud-only objects will work correctly only if an
Azure tenant is already configured in the AD of the organization, and Active Roles is
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already set as a consented Azure application for that Azure tenant. For more information
on these settings, see Configuring a new Azure tenant and consenting Active Roles as an
Azure application.

Table 2: Provisioning Policy Objects

Policy Description

User Logon Name  Generates a user login name (pre-Windows 2000) for a newly-
Generation created user account. Use this policy to:

e Add a uniqueness number to the generated logon name.
e Apply multiple rules to generate a logon name.

« Allow a logon name to be specified manually when creating a
new user.

TIP: Combine these options to ensure the uniqueness of the user
logon name (pre-Windows 2000), which is a schema requirement
in Active Directory (AD).

For more information on how to set up this policy, see Configuring a
User Logon Name Generation policy.

E-mail Alias Sets up the appropriate email aliases for newly-created user
Generation accounts. Use this policy to generate aliases based on:

» Pre-selected user properties, such as the first and last names.

» A custom selection of properties, not limited to user properties.

TIP: Use this policy to make each alias unique by adding a unique-
ness number to the alias.

For more information on how to set up this policy, see Configuring an
E-mail Alias Generation policy.

Exchange Mailbox Creates user mailboxes in the appropriate mailbox stores or
AutoProvisioning databases. Use this policy to:

e Specify the mailbox stores or databases in which mailboxes
can be created.

» Apply a rule to distribute mailboxes among multiple stores or
databases.

TIP: Configure this policy to distribute mailboxes either with the
round-robin method, or by selecting a store or database with the
least number of mailboxes.

For more information on how to set up this policy, see Configuring an
Exchange Mailbox AutoProvisioning policy.

Group Ensures that directory objects (such as users) are assigned to (or
Membership unassigned from) the appropriate group(s) if the specified policy
AutoProvisioning criteria are met.
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Policy

Description

Home Folder
AutoProvisioning

Property
Generation and
Validation

TIP: Use this policy to have Active Roles automatically add or
remove objects (such as users or guest users) to or from certain
groups if the configured group membership rules are met.

NOTE: Consider the following when configuring a Group Member-
ship AutoProvisioning Policy:

e In case of cloud-only Azure objects, you can use the Group
Membership Autoprovisioning policy to automatically assign
(or unassign) Azure users and Azure guest users to (or from)
the specified 0365 group(s) in the same Azure tenant.

e Active Roles does not automatically check for changes in
directory objects, containers or groups specified for
provisioning in the configured Policy Objects. This means
that if any changes are made in any directory resources in
use in a policy, you must update the impacted policies
manually. For example, if a directory group used by a Group
Membership AutoProvisioning Policy Group is deleted, the
Policy Group must be updated manually to reflect the

changes.

For more information on how to set up this policy, see Configuring a
Group Membership AutoProvisioning policy.

Performs provisioning actions to assign home folders and home
shares to user accounts. Use this policy to:

» Create home folders for newly-created user accounts.

e Rename home folders upon renaming user accounts.

TIP: Use this policy to specify the server on which to create home
folders and shares, determine their naming conventions, and
configure their access rights as well.

For more information on how to set up this policy, seeConfiguring a
Home Folder AutoProvisioning policy.

Generates and validates directory data, such as user properties. Use
this policy to:

e Populate a directory with the default data that the organization
requires.

» Validate the existing data upon checking directory updates.

TIP: Consider the following when planning to configure a Property
Generation and Validation policy:

e To help you get started with configuring policy-based admin-
istration in your organization, Active Roles includes a set of
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Policy

Description

Script Execution

Microsoft 365 and

built-in Policy Objects that offer provisioning and depro-
visioning rules to the most typical administrative use cases.
To find the built-in Policy Objects, navigate to the following
node of the Active Roles Console:

Configuration > Policies > Administration > Builtin

o If the directory of your organization contains cloud-only
Azure objects (Azure users, guest users or contacts), then
use the built-in Azure CloudOnly Policy - Default Rules
to Generate Properties Policy Object to provision their
default properties and accepted values.

For more information on how to set up this policy, see Configuring a
Property Generation and Validation policy.

Runs the specified PowerShell (or other custom) script on request to
perform certain operations, such as creating a user account or
updating its properties. Use this policy to:

» Trigger additional actions to perform directory object
provisioning.

e Regulate object data format and requirements.

e Further automate administrative tasks.

When linking a custom script to an administrative operation via a
Script Execution policy, the script will receive control in Active
Roles either when the operation is requested or when it is completed.

TIP: Consider the following when planning to use custom scripts for
your provisioning policies:

e To help you configure Script Execution policies, Active Roles
also ships with several built-in Script Modules that you can
use to set up your own Script Execution policies. Find these
built-in Script Modules in the following node of the Active
Roles Console:

Configuration > Script Modules > Builtin

o If the directory of your organization contains any cloud-only
Azure users, then use the built-in Generate User
Password - Azure only script module to set up a password
generation policy for cloud-only Azure users that meets the
password strength criteria of both your organization and

Microsoft Azure Active Directory (Azure AD).

For more information on how to set up a Script Execution policy, see
Configuring a Script Execution policy.

Enables configuring multiple assignments to Azure objects. Use this
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Policy

Description

Azure Tenant
Selection

AutoProvisioning
in SaasS products

policy to:

» Validate the selected Azure tenants for Azure users, guest
users, 0365 groups, Azure security groups, and contacts.

e Select 0365 Licenses for Azure users and guest users.
e Select 0365 Roles for Azure users and guest users.

e Preprovision OneDrive for Azure users.

For more information on how to set up this policy, see Configuring an
0365 and Azure Tenant Selection policy.

Automates user and group provisioning in the selected SaaS
products using Starling Connect connectors.

You can specify the Starling Connect connectors to be validated for
the users or groups for which the policy is then applied. For more
information on how to set up this policy, see Create Provisioning
policy for Starling Connect.

Deprovisioning Policy Objects

Deprovisioning Policy Objects allows configuration and application of the following policies.

Table 3: Deprovisioning Policy Objects

Policy

Description

User Account
Deprovisioning

When deprovisioning a user, this policy modifies the user account so
that the user cannot log on. You can configure this policy to:

» Disable the user account.
» Set the user’s password to a random value.
e Set the user’s logon names to random values.

» Rename the user account.

You can also select account properties and configure this policy to
update them when processing a deprovisioning request.

Group When deprovisioning a user, this policy removes the user account from
Membership groups. You can configure this policy to remove the account from
Removal security groups, mail-enabled groups, or both. In this policy, both
distribution groups and mail-enabled security groups are collectively
referred to as mail-enabled groups.
You can also select the groups from which you do not want this policy
@NE IDENTITY Active Roles 8.1.5 Administration Guide 108

by Quest

Rule-based autoprovisioning and deprovisioning



Policy

Description

User Account
Relocation

Exchange
Mailbox
Deprovisioning

Home Folder
Deprovisioning

User Account
Permanent
Deletion

Group Object
Deprovisioning

to remove the user account, or configure the policy not to remove the
user account from any security groups or mail-enabled groups.

When deprovisioning a user, this policy moves the user account to a
different location. You can select the Organizational Unit to which you
want the policy to move the account. You can also configure the policy
not to move the user accounts upon user deprovisioning.

When deprovisioning a user, this policy makes changes needed to
deprovision Microsoft Exchange resources for that user. You can
configure this policy to:

» Hide the mailbox from the global address list (GAL).

» Prevent non-delivery reports (NDR) from being sent.

» Grant the user’s manager full access to the user’s mailbox.

» Grant selected users or groups full access to the user’s mailbox.
» Disallow forwarding messages to alternate recipients.

* Forward all incoming messages to the user’'s manager.

When deprovisioning a user, this policy makes changes needed to
prevent the user from accessing his or her home folder. You can
configure this policy to:

» Remove the user’s permissions on the home folder.

* Grant the user’s manager read-only access to the user’s home
folder.

* Grant selected users or groups read-only access to the user’s
home folder.

» Make a selected user or group the owner of the user’s home
folder.

* Delete the home folder when the user account is deleted.

When deprovisioning a user, this policy schedules the user account for
deletion. You can specify the number of days (retention period) before
the account is deleted. Another option is to delete the deprovisioned
user accounts immediately to Active Directory Recycle Bin. It is also
possible to configure this policy so that the deprovisioned user
accounts are not deleted automatically.

When deprovisioning a group, this policy makes changes to the group
object in Active Directory in order to prevent the use of the group. You
can configure this policy to:

* Hide the group from the Global Address List (GAL).
¢ Change the group type from Security to Distribution.
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Policy Description

¢ Rename the group.
« Remove members from the group.

¢ Change or clear any other properties of the group object.

Group Object When deprovisioning a group, this policy moves the group object to a

Relocation different container in Active Directory. You can select the
Organizational Unit to which you want the policy to move the group
object.

Group Object When deprovisioning a group, this policy schedules the group object

Permanent for deletion in Active Directory. You can specify the number of days

Deletion (retention period) before the group is deleted. Another option is to

delete the deprovisioned groups immediately to Active Directory
Recycle Bin. It is also possible to configure this policy so that the
deprovisioned groups are not deleted automatically.

Notification In the course of a deprovisioning operation, this policy sends a

Distribution notification message to the email recipients you specify. You can
customize both the message subject and message body.

Report Upon completion of a deprovisioning operation, this policy sends a

Distribution report to the email recipients you specify. The report includes a list of

actions taken during the deprovisioning operation and the details of
the deprovisioning activity. You can customize the subject of the email
message containing the report.

You can also configure this policy to send the report only if any errors
occurred in the course of a deprovisioning operation.

Script Execution Inthe course of a deprovisioning operation, this policy runs the script
you specify. By using a script, you can implement custom
deprovisioning actions.

Office 365 When deprovisioning an Azure AD user, this policy automates
Licenses retention of all or selected Microsoft 365 licenses assigned to the Azure
Retention AD user after the Azure AD user is deprovisioned successfully.

How Policy Objects work

A Policy Object is a collection of administrative policies that specifies the business rules to
be enforced. A Policy Object includes stored policy procedures and specifications of events
that activate each procedure.

A Policy Object associates specific events with its policy procedures, which can be built-in
procedures or custom scripts. This provides an easy way to define policy constraints,
implement sophisticated validation criteria, synchronize different data sources, and
perform a number of administrative tasks as a single batch.

Active Roles enforces business rules by linking Policy Objects to:
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e Administrative views (Active Roles Managed Units)
e Active Directory containers (Organizational Units)

» Individual (leaf) directory objects, such as user or group objects

By choosing where to link a Policy Object, you determine the policy scope. For example, if
you link a Policy Object to a container, all objects in the container and its sub-containers
are normally subject to the Policy Object.

You can link different Policy Objects to different containers to establish container-specific
policies. You may need to do so if each Organizational Unit uses a dedicated Exchange
Server to store mailboxes or file server to store home folders.

You can also link a Policy Object to a leaf object, such as a user object. As an example,
consider a policy that prohibits changes to group memberships when copying a certain
user object.

Policy Objects define the behavior of the system when directory objects are created,
modified, moved, or deleted within the policy scope. Policies are enforced regardless of
administrative rights of a user performing a management task. It is important to
understand that even those who have administrator rights to Active Roles itself are forced
to abide by administrative policies once they are enforced.

Policy Object management tasks

This section guides you through the Active Roles Console to manage Policy Objects.

Creating a Policy Object

The Active Roles Console provides separate wizards for creating Policy Objects both for
provisioning and deprovisioning.

To create a Policy Object

1. Inthe Console tree, under Configuration > Policies > Administration, locate
and select the folder in which you want to add the Policy Object.

You can create a new folder by right-clicking Administration and selecting New >
Container. Similarly, you can create a sub-folder in a folder by right-clicking the
folder and selecting New > Container.

2. Right-click the folder, point to New, then click Provisioning Policy or
Deprovisioning Policy.

3. Onthe Welcome page of the wizard, click Next.

4. Onthe Name and Description page, do the following:
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a. Inthe Name box, enter a name for the Policy Object.
b. (Optional) Under Description, enter any information about the Policy Object.
Click Next.

5. On the Policy to Configure page, select a policy type, and click Next to configure
policy settings.

Figure 24: Provisioning policies

Policy to Configure . ]
Select a policy you want to configure and indude in this Provisioning Policy Object. -~

Select a policy to configure:

£2-| User Logon Name Generation
(13 E-mail Alias Generation
--£#4 Exchange Mailbox AutoProvisioning
-- Group Membership AutoProvisioning
-2 Home Folder AutoProvisioning
g5 Property Generation and Validation
--[E5 Script Execution
B 0365 and Azure Tenant selectn]

-2 Autoprovisioning in Saa$ products

Active Roles Community
Read a brief description of the policy you have selected:

This policy enables the administrator to specify the Azure tenant in which the Hybrid
objects can be created.

6. On the Enforce Policy page, you can specify the objects to which this Policy
Object will be applied. To locate and select the objects you want, Click Add and use
Select Objects.

7. Click Next, then click Finish.
NOTE: Consider the following when creating Policy Objects:

e For information about available policy types, see Provisioning Policy Objects and
Deprovisioning Policy Objects.

» For information on how to configure policies, see Policy configuration tasks.

e To add more policies to the new Policy Object, display the Properties dialog, and
click Add on the Policies tab.
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Adding policies to a Policy Object

You can add policies to Policy Objects with the Active Roles Console.

To add a policy to a Policy Object

1. Inthe Console tree, under Configuration > Policies > Administration, locate
and select the folder that contains the Policy Object you want to modify.

2. Inthe details pane, right-click the Policy Object, and then click Properties.

3. On the Policies tab, click Add to start a wizard that helps you configure a policy.
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Figure 25: Policy Objects Management
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4. On the Welcome page of the wizard, click Next.
5. On the Policy to Configure page, select the type of the policy you want to add.

6. Configure policy settings. For instructions, see Policy configuration tasks.

NOTE: Consider the following when adding policies to Policy Objects:

e The Policies tab lists the policies that are configured in the Policy Object. You can

use the Policies tab to add, modify, or delete policies from the Policy Object.

e Active Roles processes policies in the order they are listed on the Policies tab. To
change the order, select a policy and click # or # to move the policy up or down in
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the list.

e Once a Policy Object is applied within Active Roles to determine policy settings in
the directory, any changes to the list of policies in the Policy Object causes the
policy settings in the directory to change accordingly.

Modifying policies in a Policy Object

You can modifies policies in Policy Objects with the Active Roles Console.

To view or modify a policy in a Policy Object
1. Inthe Console tree, under Configuration > Policies > Administration, locate
and select the folder that contains the Policy Object you want to examine.
2. Inthe details pane, right-click the Policy Object, then click Properties.

3. On the Policies tab, select the policy you want to view or modify, and click
View/Edit.
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Figure 26: Policy Objects Management
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4. Use the tabs in the Policy Properties dialog to view or modify policy settings.

The tabs in the Policy Properties dialog provide the same options as the wizard for
configuring the policy. For information about the options specific to each type of
policy, see Policy configuration tasks.

NOTE: Consider the following when modifying policies in a Policy Object:

e The Policies tab lists the policies that are configured in the Policy Object. You can
use the Policies tab to add, modify, or delete policies from the Policy Object.

e Active Roles processes policies in the order they are listed on the Policies tab. To

@NE IDENTITY Active Roles 8.1.5 Administration Guide 116

Quest Rule-based autoprovisioning and deprovisioning



change the order, select a policy and click # or # to move the policy up or down in
the list.

Removing policies from a Policy Object

You can remove policies from Policy Objects with the Active Roles Console.

To delete a policy from a Policy Object

1. Inthe Console tree, under Configuration > Policies > Administration, locate
and select the folder that contains the Policy Object you want to modify.

2. Inthe details pane, right-click the Policy Object, then click Properties.

3. On the Policies tab, select the policy you want to delete, click Remove, then click
Yes to confirm the deletion.
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Figure 27: Policy Objects Management
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NOTE: Consider the following when removing policies for a Policy Object:

e The Policies tab lists the policies that are configured in the Policy Object. You can

use the Policies tab to add, modify, or delete policies from the Policy Object.

e Once a Policy Object is applied within Active Roles to determine policy settings in
the directory, any changes to the list of policies in the Policy Object causes the
policy settings in the directory to change accordingly.
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Blocking all policies in a Policy Object

For troubleshooting purposes, you can stop enforcing policies without actually
deleting them.

To block all policies in a Policy Object

1. Inthe Console tree, under Configuration > Policies > Administration, locate
and select the folder that contains the Policy Object you want to examine.

2. Inthe details pane, right-click the Policy Object, then click Properties.

3. Onthe Policies tab, select the Disable all policies included in this Policy
Object check box and click Apply.
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Figure 28: Policy Objects Management
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4. Click OK.

Applying Policy Objects

Implementing a policy to enforce business rules is a two-phase process where configuring
the policy within a Policy Object is only the first step. When you create a new policy, you
select a policy type from the available options and then define the options that make up the
policy. The second step is to use the Active Roles Console to enforce the policy on the
desired areas of the directory.
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Active Roles allows policies to be enforced on any directory object, that is an administrative
view (Managed Unit), a directory folder (container), or an individual (leaf) object. Policies
are enforced by applying (linking) a Policy Object that holds the policies.

When you apply a Policy Object to a Managed Unit or directory folder, the policies control
the objects in that Unit or folder as well as the Unit or folder itself. When you apply a Policy
Object to a leaf object, such as a user or group, the policies only control that object. For
example, applying a Policy Object to a group does not affect the members of the group.

The objects that are subject to a given Policy Object, that is, the objects under control of
the policies defined in that Policy Object, are collectively referred to as policy scope. For
example, if you apply a Policy Object to a Managed Unit, the policy scope is composed of
the objects within the Managed Unit.

Thus, the policy scope normally includes all objects that reside in a container or Managed
Unit to which the Policy Object is applied. However, sometimes you may need to exclude
individual objects or sub-containers from the policy scope, thereby preventing certain
objects from being affected by policies.

Active Roles gives you the option to selectively exclude objects or entire containers from
the policy scope. You can block policy inheritance on individual objects or containers,
refining the policy scope. For more information on how to block policy inheritance, see
Managing policy scope.

To apply a Policy Object

1. Inthe Console tree, under Configuration > Policies > Administration, locate
and select the folder that contains the Policy Object you want to apply.

2. Inthe details pane, right-click the Policy Object, then click Policy Scope.
3. Inthe Active Roles Policy Scope dialog, click Add.

4. Use the Select Objects dialog to locate and select the container, Managed Unit, or a
leaf object on which you want to specify policy settings by using the Policy Object.

5. Click OK to close the Active Roles Policy Scope dialog.

To specify policy settings on an object by using a Policy Object
1. Open the Active Roles Policy dialog for the object in one of the following ways:
e Right-click the object, and click Enforce Policy.

e Right-click the object, and click Properties. Then, on the Administration tab
in the Properties dialog, click Policy.

2. Inthe Active Roles Policy dialog, click Add.
3. Use the Select Policy Objects dialog to locate and select the Policy Object to apply.

4. To select a Policy Object, click the check box next to the name of the Policy Object.
You can select multiple Policy Objects.

5. Click OK to close the Active Roles Policy dialog.

TIP: To apply a Policy Object, you can also use the Active Roles Policy Scope or Active
Roles Policy tab in the advanced details pane. To do so, right-click a blank area on the
tab, and then click Add. To display the advanced details pane, check Advanced Details
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Pane on the View menu. For more information, see Advanced pane in the Active Roles
Feature Guide.

To view or modify inheritance options for a Policy Object on a container or
Managed Unit

1. Open the Active Roles Policy Scope dialog for the Policy Object: Right-click the
Policy Object, then click Policy Scope.

2. Inthe Active Roles Policy Scope dialog, select the container or Managed Unit to
which the Policy Object is applied and on which you want to examine inheritance
options, then click View/Edit.

3. Onthe General tab, view or modify the selection of these options, which specifies
the scope where the Policy Object determines policy settings:

e This directory object: The scope includes the container or Managed Unit you
have selected (this option does not cause the scope to include any child objects
or members of the container or Managed Unit).

e Child objects of this directory object: The scope includes all the child
objects (or members, as applied to a Managed Unit) in the entire hierarchy
under the container or Managed Unit you have selected.

« Immediate child objects only: The scope includes only the child objects (or
members, as applied to a Managed Unit) of which the container or Managed
Unit that you have selected is the direct ancestor.

Adding Managed Units or containers to policy
scope

You can add administrative views (Managed Units) and directory folders (containers) to the
policy scope of a given Policy Object in one of following ways:

e Right-click the Policy Object and click Policy Scope. Then, in the Active Roles
Policy Scope window, click Add.

e Ensure that Advanced Details Pane is checked on the View menu. Then, select the
Policy Object. On the Active Roles Policy Scope tab in the details pane, right-click
a blank area and click Add.

In both cases, clicking Add displays the Select Objects window where you can

select containers and Managed Units. To build a list of containers from which to

select, click Browse and select Active Directory or a container in the hierarchy
under Active Directory.
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Figure 29: Policy Objects
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To build a list of Managed Units, click Browse and select Managed Units or a container in
the hierarchy under Managed Units.
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Figure 30: Managed Units
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In the Select Objects window, select containers or Managed Units from the list and click
Add to build the resultant list of items. When finished, click OK.

Adding Policy Objects to policy list for directory
object

For a given directory object (container, user, group, and so on), a list of Policy Objects that
affect the directory object is referred to as policy list. If the directory object is in the policy
scope of a given Policy Object, the Policy Object is included in the policy list for that
directory object.

The steps to add a Policy Object to the policy list for a directory object depend on whether it
is a container or leaf object:
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e Right-click a Managed Unit or container and click Enforce Policy. Then, in the
Active Roles Policy window, click Add.

e Right-click a leaf object (user, group, or the like), click Properties, go to the
Administration tab, and click Policy. Then, in the Active Roles Policy
window, click Add.

If you use the advanced details pane (Advanced Details Pane is checked on the View
menu), you can do this as follows, regardless of the type of the directory object:

e Select the directory object, go to the Active Roles Policy tab in the details pane,
right-click a blank area on the tab, and then click Add.

In all these cases, clicking Add displays the Select Policy Objects window where you can
select Policy Objects to add. Select the Policy Objects, then click OK.

Figure 31: Policy Objects
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Managing policy scope

When applying a Policy Object to a directory object, Active Roles creates a Policy Object
link. Thus, policies are put in force by linking Policy Objects to directory objects: Managed
Units, directory folders (containers), or individual (leaf) objects.

Each Policy Object link includes the following information:

e The Policy Object that defines the policies.
e The Directory object that is the target of the link.

e An Include or Exclude flag that specifies whether the directory object is included or
excluded from the policy scope.

You can display a list of Policy Object links starting from one of the following points:

e Policy Object: Right-click a Policy Object and click Policy Scope.
This displays the links in which the Policy Object occurs.

» Directory object: First, open a window that lists the Policy Objects that affect this
directory object:

e For a container object or Managed Unit, right-click the object or Unit and click
Enforce Policy.

e For a leaf object, right-click the object, click Properties, go to the
Administration tab, and click Policy.

Next, in the window that opens, click Advanced.

This displays the links in which the directory object occurs as the target object.

Another way to see a list of Policy Object links is the use of the Advanced Details Pane.
Ensure that Advanced Details Pane is checked on the View menu, and then do one of
the following:

e Select a Policy Object.
The Active Roles Policy Scope tab lists the links in which the Policy Object occurs.

e Select a directory object (Managed Unit, container, or leaf object), right-click a blank
area on the Active Roles Policy tab, and click Advanced View.

This displays the links in which the directory object occurs as the target object.

When you display a list of Policy Object links for a directory object, the list appears in a
separate window. Each entry in the list includes the following information:

e Policy Object: Name of the Policy Object.

» Directory Object: Canonical name of the object to which the Policy Object is linked,
that is, the target object of the link.

e Include/Exclude: Flag that determines the behavior of the link:

e Include Explicitly means the link puts the target object within the policy
scope, that is, the policies defined in the Policy Object control the target object.
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» Exclude Explicitly means the link puts the target object out of the policy
scope, that is, the policies defined in the Policy Object do not control the
target object.

The Exclude flag takes precedence over the Include flag. If there are two links with the
same Policy Object, one of which is flagged Include while another one is flagged Exclude,
the object is effectively excluded from the policy scope of the Policy Object.

The list of Policy Object links displays the links of these categories:

e Direct links: Policy Object is applied (linked) directly to the object you have
selected.

e Inherited links: Policy Object is applied (linked) to a container in the hierarchy of
containers above the object you have selected, or to a Managed Unit to which the
selected object belongs.

The links inherited from parent objects can be filtered out of the list. To do this, clear the
Show inherited check box.

To manage links, you can use the buttons beneath the list:

e Add: Displays the dialog where you can select Policy Objects, creating the links to
the Policy Objects you select.

« Remove: Deletes the selected entries from the list of links. Available for
direct links only.

e View/Edit: Displays the dialog to view or modify link properties, such as whether
the link affects the child objects of the link target object. Available for only those links
that are flagged Include.

e Exclude: Shows up for links flagged Include. Available on direct links only. Changes
the flag to Exclude.

e Include: Shows up for links flagged Exclude. Available on direct links only. Changes
the flag to Include.

TIP: The Remove button is only available on direct links. When you need to delete links,
it is advisable to manage them using the Policy Scope command on the Policy Object.

To simplify the management of policy effect on directory objects, the Active Roles
Console allows you to manage policy scope without directly managing links to Policy
Objects. For a directory object, you can view and modify its policy list, that is a list of
Policy Objects that control (affect) the directory object, instead of having to sort through
direct and inherited links.

Given a directory object, you can display its policy list as follows:
e For a container or a Managed Unit, right-click it and click Enforce Policy.

e For a leaf object (user, group, or suchlike), right-click it, click Properties, go to the
Administration tab, and click Policy.

Each entry in the policy list includes the following information:

e Policy Object: The name of the Policy Object. The Policy Object controls this
directory object due to a direct link or inherited links.
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» Block Inheritance: Indicates whether policy effect is blocked on this directory
object. If the Blocked check box is selected, the Policy Object link flagged Exclude
is created for this directory object.

You can manage the policy list using the buttons beneath the list:

e Add: Displays the dialog where you can select Policy Objects, putting the directory
object under the control of the Policy Objects you select.

« Remove: If you select a Policy Object from the policy list and click Remove, the
direct link of the Policy Object to this object is deleted.

If the Policy Object is in the list due to an inherited link, the Remove button is
unavailable. Moreover, if there are both the direct link and an inherited link to the
Policy Object, clicking Remove deletes the direct link. However, it does not remove
the Policy Object from the policy list. In this case, the Policy Object remains in the list
because the policies are still applied due to inheritance.

If you need to remove the directory object from the policy scope of a given Policy
Object, select the Blocked check box in the Block Inheritance column. This adds
the Policy Object link flagged Exclude for the directory object.

» View/Edit: Displays the Properties dialog for the Policy Object you select from the
list. You can use the Properties dialog to manage policies in the Policy Object and
gain access to the list of all links where this Policy Object occurs.

e Advanced: Opens the window with the list of Policy Object links for this directory
object, discussed earlier in this section.

You can also access the policy list from the advanced details pane. The list is displayed on
the Active Roles Policy tab when you select a directory object.

On the Active Roles Policy tab, you can perform the same management tasks as in the
Active Roles Policy window: Right-click a list entry or a blank area and use commands on
the shortcut menu. The commands act in the same way as the buttons in the Active Roles
Policy window.

Given a Policy Object, you can also manage its policy scope by using a list of directory
objects to which the Policy Object is applied (linked). The list can be displayed in a separate
window or on a tab in the Advanced Details Pane:

e To display the list in a window, right-click the Policy Object and click Policy Scope.

e To display the list on a tab, ensure that Advanced Details Pane is checked on the
View menu and select the Policy Object.

The list displays all links of the Policy Object. Each entry in the list includes the following
information:

« Name: Canonical name of the directory object to which the Policy Object is linked,
that is, the target object of the link.

e Include/Exclude: Flag that determines the behavior of the link:

e Include Explicitly means the link puts the target object within the policy
scope, that is, the policies defined in the Policy Object control the target object.
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» Exclude Explicitly means the link puts the target object out of the policy
scope, that is, the policies defined in the Policy Object do not control the
target object.

The Exclude flag takes precedence over the Include flag. If there are two links
with the same target object, one of which is flagged Include while another one is
flagged Exclude, the target object is effectively excluded from the policy scope of
the Policy Object.

To manage the list in the Active Roles Policy Scope window, you can use the buttons
beneath the list: Add, Remove, View/Edit, Include, or Exclude. The buttons perform
basically the same functions as those described earlier in this section. To manage the
list in the Active Roles Policy Scope tab, you can use the command on the shortcut
menu: Right-click a link or a blank area to access the menu. The menu includes the
following commands:

e Add: Appears when you right-click a blank area. Performs the same action as
the Add button. Opens the Select Objects dialog where you can select
containers or Managed Units to which you want to link the Policy Object (see
Applying Policy Objects).

e Delete: Appears when you right-click a link. Performs the same action as the
Remove button. Deletes the link you select from the list.

e Exclude: Appears when you right-click a link flagged Include. Performs the same
action as the Exclude button. Changes the flag on the link you select.

e Include: Appears when you right-click a link flagged Exclude. Performs the same
action as the Include button. Changes the flag on the link you select.

o Refresh: Updates the list with the current information.

Managing Policy Object links

When you apply a Policy Object (see Applying Policy Objects), Active Roles creates an
object, referred to as a Policy Object link, that stores information about the Policy Object
and about the directory object on which the Policy Object is applied. Basically, the
management of policy settings in Active Roles comes to the management of Policy Objects
and Policy Object links. This topic provides some instructions you can use to view or modify
Policy Object links.

To view or modify Policy Object links in which a given Policy Object occurs
1. Right-click the Policy Object, and click Policy Scope.
2. Inthe Active Roles Policy Scope dialog, do the following:

e To create a new link, click Add, and then use the Select Objects dialog to
locate and select the object to which you want to link the Policy Object.

» To delete a link, select it from the list and click Remove.
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e To view or modify the properties of a link, such as the inheritance options,
select the link from the list and click View/Edit. For information about
inheritance options, see Applying Policy Objects.

e To specify whether a link removes or puts the effect of the Policy Object on the
object to which the Policy Object is linked, select the link and click Exclude or
Include, respectively.

To view or modify a list of the Policy Objects on a given object

1. Open the Active Roles Policy dialog for the object in one of the following ways:
» Right-click the object, and click Enforce Policy.

» Right-click the object, and click Properties. Then, on the Administration tab
in the Properties dialog, click Policy.

The Active Roles Policy dialog for a given object lists all the Policy Objects that
determine the policy settings on that object. Use the following instructions to modify
the list, if necessary.

2. Inthe Active Roles Policy dialog, do the following:

» To define additional policy settings on the object, click Add, and then select
one or more Policy Objects that determine the policy settings.

» To remove the effect of a certain Policy Object on the object you are
administering, select the Blocked check box next to the name of the Policy
Object. Clear the check box if you want the Policy Object to have an effect on
the object.

e To delete a Policy Object link on the object, select the Policy Object and click
Remove. (This operation can be performed if the Policy Object is linked to the
object itself rather than to a container or Managed Unit that holds the object).

e To view or modify policies in a Policy Object, select the Policy Object and click
View/Edit. For more information, see Modifying policies in a Policy Object.

e To display a list of the Policy Object links that determine the policy settings on
the object, click Advanced. Use the following instructions to administer the
list, if necessary.

To view or modify Policy Object links that determine the policy settings on a
given object

1. Inthe Active Roles Policy dialog, click Advanced.
2. Inthe Active Roles Policy - Advanced View dialog, do the following:
e To create a new link, click Add, and then select the Policy Object you want.

e To delete a link, select it from the list and click Remove. (This operation can be
performed if the Policy Object is linked to the object itself rather than to a
container or Managed Unit that holds the object.)

e To view or modify the properties of a link, such as the inheritance options,
select the link from the list and click View / Edit.
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» To specify whether a link removes or puts the effect of the Policy Object on the
object you are administering, select the link and click Exclude or Include,
respectively.

NOTE: Consider the following when managing Policy Object links:

e By default, the Active Roles Policy - Advanced View dialog for an object lists all
the links that determine the policy settings on the object, regardless of whether a
link was created on the object itself or on a container or Managed Unit that holds
the object. To change the display of the list, clear the Show inherited check box.

« Clicking View/Edit in the Active Roles Policy - Advanced View or Active
Roles Policy Scope dialog displays the Properties dialog for the selected link.
From the Properties dialog, you can access the properties of both the directory
object and Policy Object that are covered by the link, and view or modify the
inheritance options for the link. For more information, see Applying Policy Objects.

e You can also manage Policy Object links on the Active Roles Policy Scope or
Active Roles Policy tab in the Advanced Details Pane, which allows you to
perform the same tasks as the Active Roles Policy Scope or Active Roles
Policy dialog, respectively. Right-click a link or a blank area on the tab, and use
command on the shortcut menu. The Active Roles Policy Scope tab is displayed
when you select a Policy Object. Otherwise, the Active Roles Policy tab is
displayed. To display the Advanced Details Pane, check Advanced Details
Pane on the View menu (see Advanced pane in the Active Roles Feature Guide).

Excluding an object from a policy scope

The objects on which a given Policy Object has effect are collectively referred to as the
policy scope of the Policy Object. When applying a Policy Object, you add objects to the
policy scope. To remove the effects of the Policy Object from specific objects, perform the
following steps.

To exclude an object from the policy scope of a Policy Object

1. Open the Active Roles Policy dialog for the object in one of the following ways:
» Right-click the object, and click Enforce Policy.

» Right-click the object, and click Properties. Then, on the Administration tab
in the Properties dialog, click Policy.

2. Inthe Active Roles Policy dialog, select the Blocked check box next to the name of
the Policy Object.

3. Click OK to close the Active Roles Policy dialog.

NOTE: Consider the following when excluding an object from the policy scope of a
Policy Object:

e You can restore the effect of the Policy Object on the object that was excluded from
the policy scope: In the Active Roles Policy dialog for that object, clear the
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Blocked check box next to the name of the Policy Object.

e Excluding an object from the policy scope creates a Policy Object link on that
object, the link being flagged Exclude Explicitly. Restoring the effect of the Policy
Object causes that link to be removed. For more information on how to manage
Policy Object links, see Managing Policy Object links.

Copying a Policy Object

With the Active Roles Console, you can create copies of Policy Objects. This feature helps
you reuse existing Policy Objects.

To copy a Policy Object

1. Inthe Console tree, under Configuration > Policies > Administration, locate
and select the folder that contains the Policy Object you want to copy.

2. To start the Copy Object - Policy Object Wizard, in the details pane, right-click
the Policy Object, then click Copy.

3. On the first page of the wizard, do the following:
a. Inthe Name box, enter a name for the new Policy Object.

b. (Optional) In the Description box, enter any information about the new
Policy Object.

Click Next.
4. To create the copy of the Policy Object, click Finish.

NOTE: The copy of a Policy Object contains the same policies as the original Policy Object.
You can view or modify policies by using the Properties dialog for the newly created
Policy Object. To have the console display the Properties dialog, select Display the
object properties when this wizard closes on the completion page of the Copy
Object - Policy Object Wizard. For more information on how to add, modify, and
remove policies from a Policy Object, see Adding policies to a Policy Object, Modifying
policies in a Policy Object, and Removing policies from a Policy Object.

Renaming a Policy Object

You can rename Policy Objects with the Active Roles Console.

To rename a Policy Object

1. Inthe Console tree, under Configuration > Policies > Administration, locate
and select the folder that contains the Policy Object you want to rename.

2. In the details pane, right-click the Policy Object, and click Rename.

Enter a new name, then press Enter.
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NOTE: If a Policy Object is applied within Active Roles to determine policy settings in the
directory, renaming the Policy Object does not cause any changes to the policy settings in
the directory. When applying a Policy Object, Active Roles refers to the Policy Object by
an internal identifier rather than by the name of the Policy Object.

Exporting and importing Policy Objects

With the Active Roles Console, you can export Policy Objects to an XML file and then import
them from that file to populate another instance of Active Roles. The export and import
operations provide a way to move Policy Objects from a test environment to a production
environment.

NOTE: When you export and then import Policy Objects, only policies are transferred. The
Policy Object links are not included in the export-import operation. You need to recon-
figure them manually after completing the operation.

To export Policy Objects, select them, right-click the selection, and select All Tasks >
Export. In the Export Objects dialog, specify the file where you want to save the data,
and click Save.

To import Policy Objects, right-click the container where you want to place the Policy
Objects, and then click Import. In the Import Directory Objects dialog, select the file to
which the Policy Objects were exported, and click Open.

Deleting a Policy Object

You can delete Policy Objects with the Active Roles Console.

To delete a Policy Object

1. Inthe Console tree, under Configuration > Policies > Administration, locate
and select the folder that contains the Policy Object you want to delete.

2. Inthe details pane, right-click the Policy Object, then click Delete.

NOTE: Once a Policy Object is applied within Active Roles to determine policy settings in
the directory, the Policy Object cannot be deleted. You can view a list of objects to which
the Policy Object is applied: right-click the Policy Object, and click Policy Scope. If you
need to delete the Policy Object, first remove all items from the list in the Active Roles
Policy Scope dialog.

Policy configuration tasks

This section discusses how to configure policies of the following types, grouped by Policy
Object category.
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Table 4: Policy Configuration Tasks

Policy Object category

Policy type

Provisioning Policy Object

Deprovisioning Policy Object

Property Generation and Validation
User Logon Name Generation
Group Membership AutoProvisioning
E-mail Alias Generation

Exchange Mailbox AutoProvisioning
Home Folder AutoProvisioning
Script Execution

Microsoft 365 and Azure Tenant Selection
AutoProvisioning in SaaS products
Office 365 Licenses Retention

User Account Deprovisioning
Group Membership Removal
Exchange Mailbox Deprovisioning
Home Folder Deprovisioning

User Account Relocation

User Account Permanent Deletion
Group Object Deprovisioning
Group Object Relocation

Group Object Permanent Deletion
Notification Distribution

Report Distribution

Script Execution

Property Generation and Validation

Property Generation and Validation policies help you automate the configuration of
directory object properties. Using this policy, you can:

» Automatically generate default property values for new directory objects (for
example, when creating new user accounts or groups).
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e Automatically check if the configured property values comply with the specified
corporate policy rules.

To set up a policy, you can specify conditions that the property values must meet, and can
also determine the default value for each property provisioned with the policy. For
example, you can configure a policy to enforce a certain type of telephone number
formatting in the contact information properties for your directory.

TIP: Consider the following when planning to configure a Property Generation and Valid-
ation policy:

e To help you get started with configuring policy-based administration in your organ-
ization, Active Roles includes a set of built-in Policy Objects that offer provisioning
and deprovisioning rules to the most typical administrative use cases. To find the
built-in Policy Objects, navigate to the following node of the Active Roles Console:

Configuration > Policies > Administration > Builtin

o If the directory of your organization contains cloud-only Azure objects (Azure
users, guest users or contacts), then use the built-in Azure CloudOnly Policy -
Default Rules to Generate Properties Policy Object to provision their default
properties and accepted values.

NOTE: Policy Object settings specific to Azure cloud-only objects (such as cloud-only
Azure users, guest users, or contacts) are available only if your Active Roles deployment
is licensed for managing cloud-only Azure objects. Contact One Identity support for more
information.

Also, Policy Objects specific to Azure cloud-only objects will work correctly only if an
Azure tenant is already configured in the AD of the organization, and Active Roles is
already set as a consented Azure application for that Azure tenant. For more information
on these settings, see Configuring a new Azure tenant and consenting Active Roles as an
Azure application.

How the Property Generation and Validation
policy works

When creating or modifying an object, Active Roles checks whether the property values
satisfy the criteria defined in the policy. If they do not, Active Roles prevents you from
creating or modifying the object.

In the Object Creation Wizard and Properties dialogs, the properties that are controlled
by the policy are displayed as hyperlinks. If you have a policy configured to populate a
property with a certain value (generate the default value), the edit box for the property is
unavailable for editing, as shown in the following figure.
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Figure 32: Object creation
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You can click a hyperlink to display the policy details.

With a policy configured to define a set of acceptable values for a given property, the Active
Roles Console provides a drop-down list to select a value when modifying that property.
The user of the Active Roles Console can choose an acceptable value from the list instead of
having to type a value in the edit box. This feature is illustrated in the following figure,
where the Office box provides a list of acceptable values that are prescribed by policy.
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Figure 33: Acceptable values for a policy
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Configuring a Property Generation and
Validation policy

To configure a Property Generation and Validation policy via the Active Roles Console (also
known as the MMC interface), perform the following procedure.

To configure a Property Generation and Validation policy

1. Navigate to Configuration > Policies > Administration.

2. To open the New Provisioning Policy Object Wizard dialog, right-click in
the middle pane to open the context menu, and then select New >
Provisioning Policy.

# Active Roles [ART.roles1.net] Mame

v ﬁ Configuration =9 Builtin
|1 Access Rules
B Access Templates
&g Managed Units

W g Policies
v = Administratinn
E@ Built Delegate Control...
[z Workflor Enforce Policy...

[ Script Moduy Find...
g}ﬁ Server Confi

. . Import...
@ Active Directon, - Prar— -
. Roles Security for: Administration (Policy Ot

& AD LDS (ADAM, Check Policy... "“' )
ﬁ Applications Change History ] Act

Mew ¥ Provisicning Policy

All Tasks > Deprovisioning Policy

View 3 Container

Mew Window from Here

3. Onthe Name and Description page, provide a unique Name for the new Policy
Object. Optionally, also provide a Description. To continue, click Next.

4. On the Policy to Configure page, select Property Generation and Validation,
and then click Next.

5. On the Controlled Property page, click Select to open the Select Object Type
and Property dialog.

6. To select the object type and its object property you want the policy to control, use
the settings of the Select Object Type and Property dialog:

» Use the Object type drop-down menu to select the object type whose
property you want to provision.
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10.
11.

12.

13.

» Use either the Look for Property search box to manually search for the object
property you want to provision, or browse it in the Object Property list.

TIP: If you do not see the object type you need, expand the list by selecting
Show all possible object types.

NOTE: Policy Object settings specific to Azure cloud-only objects (such as
cloud-only Azure users, guest users, or contacts) are available only if your
Active Roles deployment is licensed for managing cloud-only Azure objects.
Contact One Identity support for more information.

Also, Policy Objects specific to Azure cloud-only objects will work correctly
only if an Azure tenant is already configured in the AD of the organization,
and Active Roles is already set as a consented Azure application for that
Azure tenant. For more information on these settings, see Configuring a new
Azure tenant and consenting Active Roles as an Azure application.

e Once you selected the object and property, click OK to continue.

On the Configure Policy Rule page, specify the condition(s) you want to configure
for the policy by selecting them in the Select conditions to configure policy rule
list. The selected conditions then appear in the Edit policy rule text box.

(Optional) If the selected condition supports editing, then click the underlined part of
the condition to open the Add Value dialog and edit its settings.

To specify additional configuration for the condition, enter a variable into the Value
field, then click OK to close the Add Value dialog.

Alternatively, click Configure Value, then click Add, and configure an entry
manually in the Add Entry dialog. For more information on manual configuration,
see Configuring entries. To close the Add Value dialog, click OK.

(Optional) If multiple conditions are selected, switch between the AND and OR logic
of the condition relations by clicking and or or.

After selecting and configuring the condition(s), click Next.

(Optional) On the Policy Description page, modify the default description of the
policy generated by the wizard. To do so, select Modify this policy description to
make the description editable. Modify the description, then click Next.

On the Enforce Policy page, specify the objects to which the configured Policy
Object will be applied. Click Add, and then use the Select Objects dialog to locate
and select the objects.

TIP: When provisioning cloud-only Azure users or guest users, you can either select
the respective object category (such as the Azure user or Azure guest user
node) in this step, or the Azure tenant that contains the Azure objects.

To complete creating the Policy Object, click Next, then Finish.

Entry type: Text

When you select Text under Entry type in the Add Entry window, the Entry properties
area displays the Text value box.

In the Text value box, type the text you want to include in the value, and then click OK.
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Entry type: <Object> Property

When you select <Object> Property under Entry type in the Add Entry window, the
Entry properties area looks as follows.

¥ ndd Entry 2 x|
Entry bype ————————————  Enkry properties
Al Text Configure value to include a selected property of the object being managed by this palicy,

Click Select to choose a property.
User Property A=A

|58 Parent QU Property Propetty:

F'arent Darmain Property Select... |
{ Fraask

This entry is bo include:

™ all characters of the property walue

% The first I G _IZ characters of the property value

[w If walue is shorter, add filing characters at the end of value

Filling charactes: I a0

Descripkion:
Adds a selected property of the object being managed by this policy

Cancel |

P

Using this entry type, you can configure a value based on a property of the object itself. To
choose a property, click Select.

If you want the entry to include the entire value of the property, click All characters of
the property value. Otherwise, click The first, and specify the number of characters to
include in the entry.

In the latter case, you can select the If value is shorter, add filling characters at the
end of value check box, and type a character in the Filling character box. This character
will fill the missing characters in the value of the object property if the value is shorter than
specified in the box next to the option The first.

When you are done configuring an entry, click OK to close the Add Entry window. The
entry is added to the Configure Value dialog.
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Entry type: Parent OU Property

When you select Parent OU Property under Entry type in the Add Entry window, the
Entry properties area looks as follows.

Figure 34: Add Entry: Parent OU Property
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Descripkion:
Adds a selected property of a parent OU of the object being managed by this policy

Using this entry type, you can configure a value based on a property of a parent
Organizational Unit (OU) of the object being managed by this policy. To choose an OU
property, click Select.

If you want the entry to include the entire value of the property, click All characters of
the property value. Otherwise, click The first, and specify the number of characters to
include in the entry.

In the latter case, you can select the If value is shorter, add filling characters at the
end of value check box, and type a character in the Filling character box. This character
will fill the missing characters in the value of the OU property if the value is shorter than
specified in the box next to the option The first.

You can also specify the level of the OU you want to the policy to use. To use the property of
the OU in which the object resides, click Immediate parent OU of the object being
managed by this policy. To use the property of a parent OU of a different level, click
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More distant parent OU and then, in the Level box, specify the level of the OU. Lower
level means greater distance from the managed object in the hierarchy of containers above
that object. OU level 1 is an immediate child OU of the domain.

When you are done configuring an entry, click OK to close the Add Entry window. The
entry is added to the Configure Value dialog.

Entry type: Parent Domain Property

When you select Parent Domain Property under Entry type in the Add Entry window,
the Entry properties area looks as follows.

Figure 35: Add Entry: Parent Domain Property
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Descripkiaon:
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Using this entry type, you can configure a value based on a property of the domain of the
object being managed by this policy. To choose a domain property, click Select.

If you want the entry to include the entire value of the property, click All characters of
the property value. Otherwise, click The first, and specify the number of characters to
include in the entry.

In the latter case, you can select the If value is shorter, add filling characters at the
end of value check box, and type a character in the Filling character box. This character
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will fill the missing characters in the value of the domain property if the value is shorter
than specified in the box next to the option The first.

When you are done configuring an entry, click OK to close the Add Entry window. The
entry is added to the Configure Value dialog.

Entry type: Mask

When you select Mask under Entry type in the Add Entry window, the Entry properties
area looks as follows.

Figure 36: Add Entry: Mask
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With this entry type, you can define which characters (letters, numerals) are acceptable in
the entry you add to the value of the controlled property.

If you want to allow the entry to include any series of characters, click Any characters or
no characters.

If you want to specify a maximum number of allowed characters the entry may include,
click At most the specified number of characters. In the Number of characters box,
specify the number of allowed characters. The entry may include any number of characters
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not exceeding the specified number. Under Allowed characters, select check boxes to
specify the allowed characters.

If you want to specify an exact number of allowed characters that the entry must include,
click Exactly the specified nhumber of characters. In the Number of characters box,
specify the number of allowed characters. The entry must include exactly the specified
number of characters. Under Allowed characters, select check boxes to specify the
allowed characters.

When you are done configuring an entry, click OK to close the Add Entry window. The
entry is added to the Configure Value dialog.

Configuring entries

Use the following step-by-step instructions to configure an entry in the Add Entry dialog.
The same instructions apply when you are making changes to an existing entry.

To configure a Text entry

1. Under Entry type, click Text.
Use a Text entry to add a text string to the value you are configuring.
In Text value, type the text string you want the value to include.

3. Click OK.

To configure an <Object> Property entry

1. Under Entry type, click <Object> Property.

Use an <Object> Property entry when configuring a value to include a certain
property (or a part of a property) of the object that is under the control of the policy.
In these instructions, <Object> stands for the type of object, such as User, Group,
or Computer.

2. Click Select, click the property to include in the value, and then click OK.

If you want the entry to include the entire value of the property, click All characters
of the property value. Otherwise, click The first, and specify the number of
characters to include in the entry.

4. If you selected The first, then, optionally, select If value is shorter, add filling
characters at the end of value, and enter a character in Filling character.

This character will fill the missing characters in the value of the property if the value
is shorter than specified in the box next to The first.

5. Click OK.

To configure a Parent OU Property entry

1. Under Entry type, click Parent OU Property.
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6.

Use a Parent OU Property entry when configuring a value to include a certain
property (or a part of a property) of an Organizational Unit (OU) in the hierarchy of
containers above the object being managed by the policy.

Click Select, click the property to include in the value, and then click OK.

If you want the entry to include the entire value of the property, click All characters
of the property value. Otherwise, click The first, and specify the number of
characters to include in the entry.

If you selected The first, then, optionally, select If value is shorter, add filling
characters at the end of value, and type a character in Filling character.

This character will fill the missing characters in the value of the property if the value
is shorter than specified in the box next to The first.

Choose one of these options:

e To use the property of the OU in which the object resides, click Immediate
parent OU of the object being managed by this policy.

e To use the property of a parent OU of a different level, click More distant
parent OU and then, in Level, specify the level of the OU.

Lower level means greater distance from the managed object in the hierarchy of
containers above that object. OU level 1 is an immediate child OU of the domain.

Click OK.

To configure a Parent Domain Property entry

1.

5.

Under Entry type, click Parent Domain Property.

Use a Parent Domain Property entry when configuring a value to include a
certain property (or a part of a property) of the domain of the object being
managed by the policy.

Click Select, click the property to include in the value, and then click OK.

If you want the entry to include the entire value of the property, click All characters
of the property value. Otherwise, click The first, and specify the number of
characters to include in the entry.

If you selected The first, then, optionally, select If value is shorter, add filling
characters at the end of value, and type a character in Filling character.

This character will fill the missing characters in the value of the property if the value
is shorter than specified in the box next to The first.

Click OK.

To configure a Mask entry

1.

Under Entry type, click Mask.

Use a Mask entry when configuring a value to include a syntax that determines how
many and what characters are allowed in the property controlled by the policy.

Select one of these options:
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e Any characters or no characters: Allows the entry to include any series of
characters.

» At most the specified number of characters: Specify the maximum
number of allowed characters the entry may include.

« Exactly the specified number of characters: Specify an exact number of
allowed characters that the entry must include.

3. If you selected At most the specified number of characters or Exactly the
specified number of characters, then in Number of characters, specify the
number of characters allowed in this entry.

If you selected At most the specified number of characters, the entry may
include any number of characters not exceeding the number specified.

If you selected Exactly the specified number of characters, the entry must
include exactly the specified number of characters.

e Under Allowed characters, select check boxes to specify what characters are
allowed in this entry.

4. Click OK.

To configure a Date and Time entry

1. Under Entry type, click Date and Time.

Use a Date and Time entry when configuring a value to include the date and time of
the operation performed by the policy (for example, the date and time when the user
was deprovisioned).

In the list under Date and time format, click the date or time format you want.
3. Click OK.

To configure an Initiator ID entry

1. Under Entry type, click Initiator ID.

Use an Initiator ID entry when configuring a value to include the ID of the Initiator,
that is, the user who initiated the operation performed by the policy (for example, the
ID of the user who initiated the deprovisioning operation). You can build the Initiator
ID based on a combination of properties of the Initiator.

2. Select one of these options:

» User logon name (pre-Windows 2000) of the Initiator, in the form
Domain\Name to set the Initiator ID to the pre-Windows 2000 user logon
name of the Initiator.

e User logon name of Initiator to set the Initiator ID to the user logon name
of the Initiator.

o Initiator ID built using a custom rule to compose the Initiator ID of other
properties specific to the Initiator.

3. If you selected Initiator ID built using a custom rule, click Configure, and use
the Configure Value dialog to set up the value to be used as the Initiator ID: Click
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Add and specify the entries for the value as appropriate.

You can configure entries of these categories: Text (any text string), Initiator
Property (a certain property of the Initiator user object), Parent OU Property
(a certain property of an Organizational Unit that holds the Initiator user object),
Parent Domain Property (a certain property of the domain of the Initiator
user object).

4. Click OK.

To configure a Uniqueness Number entry

1. Under Entry type, click Uniqueness Number.

Use a Uniqueness Number entry when configuring a value to include a number the
policy will increment in the event of a naming conflict. For example, in a policy that
generates a user logon name or email alias, you can add an entry of this category to
the generation rule in order to ensure the uniqueness of the name or alias generated
by the policy.

2. Click one of these options:

e Add always: The value includes this entry regardless of whether or not the
policy encounters a naming conflict when applying the generation rule.

e Add if the property value is in use: The policy adds this entry to the
value in the event of a naming conflict; otherwise the value does not
include this entry.

3. Specify how you want the entry to be formatted:

e To have the entry formatted as a variable-length string of digits, clear the
Fixed-length humber, with leading zeroes check box. In most cases, this
will result in a single-digit entry.

e To have the entry formatted as a fixed-length string of digits, select the Fixed-
length number, with leading zeroes check box, and then specify the
number of digits you want the string to include. This will result in an entry
prefixed with the appropriate number of zeroes, such as 001, 002, 003.

4. Click OK.
NOTE: Consider the following when configuring entries:

e You may need to configure an entry when configuring a policy such as Property
Generation and Validation, User Logon Name Generation, Group Membership
AutoProvisioning, E-mail Alias Generation, User Account Deprovisioning, or Group
Object Deprovisioning.

e The contents of the Entry Type list in the Add Entry dialog depend on the type of
the policy you are configuring.
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Scenario 1: Using mask to control phone
number format

This scenario describes how to configure a policy that forces the user phone number to
conform to the format (###) ###-##-#4#.

To implement this scenario, you must perform the following actions:

1. Create and configure a Policy Object that defines the appropriate policy.
2. Apply the Policy Object to a domain, OU, or Managed Unit.

As a result, when creating or modifying a user object in the container you selected in Step
2, Active Roles checks whether the phone number conforms to the stated format. If not,
the policy disallows the creation or modification of the user object.

The following two sections elaborate on the steps to implement this scenario.

Creating and configuring the Policy Object

You can create and configure the Policy Object you need by using the New
Provisioning Policy Object Wizard. For more information about the wizard, see
Creating a Policy Object.

To configure the policy, click Property Generation and Validation on the Policy to
Configure page of the wizard. Then, click Next.

On the Controlled Property page, click Select. Then, in the Select Object Type and
Property dialog, select User from the Object type list, and click Telephone number in
the Object property list, as shown in the following figure.
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Figure 37: Select Object type and property
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Click OK, then click Next.

On the Configure Policy Rule page, in the upper box, select the following check boxes:

e 'Telephone Number’ must be specified: This makes the phone number a
required property, that is, requires that a phone number be specified in every
user account.

e 'Telephone Number’ must be <value>: This allows you configure a mask for the
telephone number by adding the appropriate entry to the value for this condition.

At this stage, the Configure Policy Rules page looks like the following figure.
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Figure 38: Configure policy rules
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The next phase is to configure the value.

Click <click to add value>. In the Add Value dialog, click Configure. In the Configure
Value dialog, click Add. In the Add Entry window, under Entry type, click Mask.

Now you can use the Entry properties area in the Add Entry window to
configure a mask.

The format consists of four groups of numerals divided by certain characters: spaces,

hyphens, and brackets. First, configure a mask that requires the first three characters to
be numerals:

» Select Exactly the specified number of characters.
e Inthe Number of characters box, enter 3.

e Under Allowed characters, select the Numerals check box.

The Add Entry window should look as shown in the following figure.

@NE IDENTITY Active Roles 8.1.5 Administration Guide

Quest 150

Rule-based autoprovisioning and deprovisioning



Figure 39: Add entry
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Click OK to close the Add Entry window. Then, click OK to close the Configure Value
dialog. As a result, the Add Value dialog looks as shown in the following figure.

Figure 40: Add value dialog
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Taking into consideration the mask you have configured, you can guess that the mask for
the phone number format you need is as follows:

({3 required [0-9]}) {3 required [0-9]}-{2 required [0-9]}-{2 required [0-9]}

Type this mask in the ‘Telephone Number’ must be box in the Add Value dialog. Pay
attention to the round brackets enclosing the first three characters, a space character
following the group in the round brackets, and two hyphen characters that separate the
groups of characters.

Click OK to close the Add Value dialog. Click Next and follow the instructions in the wizard
to create the Policy Object.

Applying the Policy Object

You can apply the Policy Object by using the Enforce Policy page in the New
Provisioning Policy Object Wizard, or you can complete the wizard and then use the
Enforce Policy command on the domain, OU, or Managed Unit where you want to apply
the policy.

For more information on how to apply a Policy Object, see Applying Policy Objects and
Managing policy scope.

Scenario 2: Using regular expressions to control
phone number format

This scenario describes how to configure a policy that forces the user phone number to
conform to the following format:

e The first character must be “+".
e The second character(s) must be the country code.
(Thisis 1 in the US and Canada, and 61 in Australia for example.)
e Use spaces (instead of dashes or braces) to separate area code.
e Use spaces (instead of dashes) to separate the phone number.

e Optionally, use a lowercase “x"” to indicate an extension.

The following table provides some examples to clarify how the phone number should look in
accordance with these formatting requirements.

Table 5: Phone nhumber format

Correct Incorrect Comment

+1 949 754 949-754-8515 The incorrect entry does not begin with + and country

8515 code, and uses dashes instead of space.

+44 1628 +44 1628 The incorrect entry uses the upper-case X.

606699 x1199 606699
X1199
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To implement this scenario, you must perform the following actions:

1. Configure the Policy Object that defines the appropriate policy.
2. Apply the Policy Object to a domain, OU, or Managed Unit.

As a result, when creating or modifying a user object in the container you selected in Step
2, Active Roles checks whether the phone number conforms to the stated format. If not,
the policy disallows the creation or modification of the user object.

Configuring the Policy Object

You can configure the Policy Object you need by modifying the Policy Object that
implements Scenario 1: Using mask to control phone number format.

Display the Properties dialog for that Policy Object and go to the Policies tab. Then,
select the policy from the list, and click View/Edit to display the Property Generation
and Validation Policy Properties dialog.

The Policy Rule tab in the Property Generation and Validation Policy Properties
dialog looks similar to the Configure Policy Rule page in the wizard you used to configure
the policy. You can use that tab to modify the policy rules.

First, modify the rule to remove the mask entry. On the Policy Rule tab, in the upper box,
clear the ‘Telephone Number’ must be <value> check box.

Next, choose to configure a rule based on regular expressions. On the Policy Rule tab,
in the upper box, select the ‘Telephone Number’ must match regular expression
<value> check box. To access this check box, you need to scroll down the list of
check boxes.

Finally, specify the regular expressions that define the policy in question. The regular
expressions you need are as follows:

M+([0-9]+ )+[0-9]+%
M+([0-9]+ )+x[0-9]+%

The following table briefly describes the elements that are used in the two above syntax.
For more information about regular expressions, see Using regular expressions.

Table 6: Regular expressions

This Indicates

Element

A The beginning of the input string to validate.

\+ The escape sequence to represent the plus character (+).

([0-9]+ )+ Concatenation of one or more substrings, with each substring consisting of
one or more digit characters followed by a space character.

[0-9]+ One or more digit characters.

x[0-9]+ A lowercase "x" followed by one or more digit characters.

$ The end of the input string to validate.
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Thus, the policy must be configured to only allow the telephone numbers that
match "\+([0-9]+ )+[0-9]+% (telephone numbers without extensions) or ~\+([0-9]+
)+x[0-9]+$ (telephone numbers that include extensions). Proceed with configuring
the policy as follows:

1. On the Policy Rule tab, in the lower box, click the link labeled <click to
add value>.

In the Add Value dialog, enter "\+([0-9]+ )+[©-9]+$, and click OK.
On the Policy Rule tab, in the lower box, click <click to add value>.
In the Add Value dialog, enter "\+([0-9]+ )+x[0-9]+$, and click OK.

Click OK to close the Property Generation and Validation Policy
Properties dialog.

i > W N

Applying the Policy Object

You can apply the Policy Object without closing its Properties dialog. Go to the Scope tab
and do the following:

1. Onthe Scope tab, click the Scope button to display the Active Roles Policy Scope
window for the Policy Object you are managing.

2. Click Add and select the domain, OU, or Managed Unit where you want to apply
the policy to.

You can also use the Remove button to remove items where you want the policy to
no longer be applied.

3. Click OK to close the Active Roles Policy Scope window.

4. Click OK to close the Properties dialog for the Policy Object.

For more information on how to apply a Policy Object, see Applying Policy Objects and
Managing policy scope.

User Logon Name Generation

Policies in this category are intended to automate the assignment of the pre-Windows 2000
user logon name when creating or modifying a user account, with flexible options to ensure
uniqueness of the policy-generated name.

The ability to generate a unique name is essential. If Active Roles attempts to assign a
policy-generated name when there is an existing user account with the same pre-
Windows 2000 user logon name, a naming conflict will occur. Active Directory does not
support multiple accounts with the same pre-Windows 2000 user logon name. A policy
can be configured to generate a series of names in order to prevent naming conflicts with
existing accounts.

When configuring a policy of this category, you can define multiple rules so that the policy
applies them successively, attempting to generate a unique name in the event of a naming
conflict. You can also configure a rule to include an incremental numeric value to ensure
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uniqueness of the policy-generated name. You also have the option to allow policy-
generated names to be modified by operators who create or update user accounts.

How the User Logon Name Generation policy
works

When creating a user account, Active Roles relies on this policy to assign a certain pre-
Windows 2000 user logon name to the user account. The policy generates the name based
on properties of the user account being created. A policy may include one or more rules
that construct the name value as a concatenation of entries that are similar to those you
encounter when using a Property Generation and Validation policy.

A special entry—uniqueness number—is provided to help make the policy-generated name
unique. A uniqueness number entry represents a numeric value the policy will increment in
the event of a naming conflict. For example, a policy may provide the option to change the
new name from JSmith to J1Smith if there is an existing user account with the pre-
Windows 2000 user logon name set to 3Smith. If the name J1Smith is also in use, the new
name can be changed to 32Smith, and so on.

The policy configuration provides the option to allow or disallow manual edits of policy-
generated names. Permission to modify a policy-generated name can be restricted to the
case where the name is in use by another account.

Some specific features of the policy behavior are as follows:

e With a single rule that does not use a uniqueness number, Active Roles simply
attempts to assign the generated name to the user account. The operation may fail if
the generated name is not unique, that is, the same pre-Windows 2000 user logon
name is already assigned to a different user account. If the policy allows manual edits
of policy-generated names, the name can be corrected by the operator who creates
the user account.

e With multiple rules or with a rule that uses a uniqueness number, Active Roles adds a
button at the client side, next to the User logon name (pre-Windows 2000) field
on the user creation and modification forms.

e To generate a name, the client user (operator) must click that button, which is also
the case where the generated name is in use. Clicking the Generate button applies a
subsequent rule or increases the uniqueness number by one, thereby allowing the
name to be made unique.

e The policy defines a list of characters that are unacceptable in pre-Windows 2000
user logon names. The following characters are not allowed: " / \ [ 1 : ; |
=, + ¥ ? <>

e The policy causes Active Roles to deny processing of operation requests that assign
the empty value to the pre-Windows 2000 user logon name.

» When checking user accounts for policy compliance, Active Roles detects, and reports
of, the pre-Windows 2000 user logon names that are set up not as prescribed by the
user logon name generation policy.
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Configuring a User Logon Name Generation policy

You can configure a new User Logon Name Generation policy with the New Provisioning
Policy Object Wizard of the Active Roles Console.

To configure a User Logon Name Generation policy

1. On the Policy to Configure page, select User Logon Name Generation, then
click Next.

Figure 41: New Provisioning Policy Object Wizard
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2. Onthe User Logon Name (pre-Windows 2000) Generation Rules page, you
can set up a list of generation rules. Each entry in the list includes the following
information:
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e Priority: The policy applies generation rules in the order of their priority, as
they stand in the list: first read, first applied.

e Rule: Syntax that defines the rule.

 Uniqueness Number: Displays Yes or No, indicating whether the rule
includes a uniqueness number entry.

You can use these buttons manage the list of rules:

e Add: Opens the Configure Value dialog, discussed in Configuring a Property
Generation and Validation policy. Use that dialog to configure a value for the
‘Logon Name (pre-Windows 2000)’ must be condition, in the same way
as you do when configuring a Property Generation and Validation policy. For
more information, see Configuring a logon name generation rule.

e Remove: Deletes the rules you select from the list.

e View/Edit: Opens the Configure Value dialog for the rule you select from
the list. Modify the selected rule by managing the list of entries in that dialog.

e Up and Down: Change the order of rules in the list. Click Up or Down to move
a selected rule higher or lower in the list to give the rule a higher or lower
priority, respectively.

e Advanced: Set certain options that apply to all rules in the list, such as the
maximum length of the generated name, whether to format the name as the
uppercase or lowercase string, the scope where you want the generated
name to be unique, and the characters to be excluded from the generated
names. Complete the Advanced dialog by using the procedure outlined later
in this topic.

e If you want the logon name to be allowed for manual edit, select the
Allow manual edits of pre-Windows 2000 logon name check box.
Then, do one of the following:

e Click Always to authorize the operator who creates or updates the
user account to modify the pre-Windows 2000 logon name.

* Click Only if a unique name cannot be generated by
this policy to allow manual changes only in the situation
where a policy-generated name is already assigned to a
different user account.

3. Click Next.

4. On the Enforce Policy page, specify the objects to which this Policy Object will be
applied. To do so, click Add, and use the Select Objects dialog to locate and select
the objects you want.

5. Click Next, then click Finish.

To complete the Configure Value dialog

1. Click Add.

2. Configure an entry to include in the value. For more information, see
Configuring entries.
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3. In the Configure Value dialog, add more entries, delete or edit existing ones,
then click OK.

To complete the Advanced dialog

1. In Maximum length, in characters, set the maximum length of the
generated name.

2. Optionally, select Adjust the case of characters to configure case formatting:
e Click All UPPERCASE to format the name as the uppercase string.
e Click All lowercase to format the name as the lowercase string.
3. Specify the scope in which you want the generated name to be unique:
e Click Domain to make the name unique within the domain.
e Click Forest to make the name unique within the forest.

e Click All managed domains to make the name unique across all
managed domains.

4. (Optional) In the Restricted characters area, specify the characters you want the
policy to remove from the generated name.

The policy always removes the following characters: " @ * + | = \ : ; ?
[ 1., <>/

To specify additional characters, type them one by one, without any separator
character, in the provided text box.

Configuring a logon name generation rule

To configure a generation rule, click Add beneath the Generation rules list. This displays
the Configure Value dialog, prompting you to set up a value for the ‘Logon Name’ must
be condition.

To start configuring a value, click Add in the Configure Value dialog. This displays the
Add Entry window.

A value is a concatenation of one or more entries. In the Add Entry window, you can select
the type of the entry to add, then configure the entry. The following table summarizes the
available types of entries.

Table 7: Types of entries

Type of Description
entry
Text Adds a text string to the value.

Uniqueness  Adds a numeric value the policy will increment in the event of a naming
Number conflict.

User Adds a selected property (or a part of a property) of the user account to

Property which the policy will assign the logon name.
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Type of Description

entry

Parent OU Adds a selected property (or a part of a property) of an Organizational Unit

Property in the hierarchy of containers above the user account to which the policy
will assign the logon name.

Parent Adds a selected property (or a part of a property) of the domain of the

Domain user account to which the policy will assign the logon name.

Property

Instructions on how to configure an entry depend on the type of the entry. You can use the
instructions outlined in Configuring a Property Generation and Validation policy to configure
an entry of any of these types:

» Text: See Entry type: Text.
» User Property: See Entry type: <Object> Property.
 Parent OU Property: See Entry type: Parent OU Property.

» Parent Domain Property: Refer to the Entry type: Parent Domain Property.

The following subsection elaborates on the Uniqueness Number entry.

Entry type: Uniqueness Number

When you select Uniqueness Number under Entry type in the Add Entry window, the
Entry properties area looks as follows.
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Figure 42: Entry Type: Uniqueness Number
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Using this entry type, you can add an entry that represents a number the policy will
increment in the event of a naming conflict.

First, you need to choose when you want the policy to employ this entry. You have the
following options:

e Add always: The value includes this entry regardless of whether or not the policy
encounters a naming conflict when applying the generation rule.

e Add if the property value is in use: The policy adds this entry to the value in the
event of a naming conflict; otherwise the value does not include this entry.

Next, you can specify how you want the entry to be formatted:

e To have the entry formatted as a variable-length string of digits, clear the Fixed-
length number, with leading zeroes check box. In most cases, this will resultin a
single-digit entry.

* To have the entry formatted as a fixed-length string of digits, select the Fixed-
length number, with leading zeroes check box, and then specify the number of
digits you want the string to include. This will result in an entry prefixed with the
appropriate number of zeroes, such as 001, 002, 003, and so on.
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When you are done configuring an entry, click OK to close the Add Entry window. The
entry is added to the Configure Value dialog.

Scenario 1: Using uniqueness nhumber

The policy described in this scenario generates the pre-Windows 2000 user logon name in
accordance with this rule: the first character of the user first name, optionally followed by a
uniqueness number, followed by the user last name. The length of the policy-generated
name is at most eight characters. If the name is longer, trailing characters are truncated as
needed. Examples of names generated by this policy are as follows:

e JSmitson
e J1Smitso
e J2Smitso

The policy generates the name J1Smitso for the user John Smitson if the name JSmitson
is in use. If both JSmitson and J1Smitso are in use, the policy generates the name
J2Smitso, and so on.

To implement this scenario, you must perform the following actions:

1. Create and configure the Policy Object that defines the appropriate policy.
2. Apply the Policy Object to a domain, OU, or Managed Unit.

As a result, when assigning a pre-Windows 2000 user logon name to a user account in the
container you selected in Step 2, the Active Roles user interfaces provide a Generate
button to create a name in accordance with the policy rule. In the event of a naming
conflict, clicking Generate causes the policy to add a uniqueness number to the name.

The following two sections elaborate on the steps to implement this scenario.

Creating and configuring the Policy Object

You can create and configure the Policy Object you need by using the New Provisioning
Policy Object Wizard. For information about the wizard, see Creating a Policy Object.

To configure the policy, click User Logon Name Generation on the Select Policy Type
page of the wizard. Then, click Next.

On the User Logon Name (pre-Windows 2000) Generation Rules page, click Add.
Then, complete the Configure Value dialog as follows:

1. Click Add.

2. Configure the entry to include the first character of the user first name:
a. Under Entry type, click User Property.
b. Under Entry properties, click Select.
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e.

In the Select Object Property window, click First Name in the Object
property list, then click OK.

Under Entry properties, click The first, and make sure the box next to that
option reads 1.

Click OK.

3. Click Add.

4. Configure the entry to optionally include a uniqueness number:

a. Under Entry type, click Uniqueness Number.

b. Under Entry properties, click Add if the property value is in use,
and make sure the Fixed-length number, with leading zeroes check
box is cleared.

c. Click OK.

5. Click Add.

6. Configure the entry to include the user last name:

a.
b.

C.

d.

Under Entry type, click User Property.
Under Entry properties, click Select.

In the Select Object Property window, click Last Name in the Object
property list, then click OK.

Click OK.

After you complete these steps, the list of entries in the Configure Value dialog should
look like the following figure.
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Figure 43: Configure Value
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Click OK to close the Configure Value dialog.

You also need to set up the limitation on the length of the name. On the User Logon
Name (pre-Windows 2000) Generation Rules page, click Advanced. In the
Advanced dialog, in the Maximum length, in characters box, type 8, then click OK.

Click Next and follow the instructions in the wizard to create the Policy Object.

Applying the Policy Object

You can apply the Policy Object by using the Enforce Policy page in the New
Provisioning Policy Object Wizard, or you can complete the wizard and then use the
Enforce Policy command on the domain, OU, or Managed Unit where you want to apply
the policy.

For more information on how to apply a Policy Object, see Applying Policy Objects and
Managing policy scope.

Scenario 2: Using multiple rules

The policy described in this scenario uses multiple rules to generate the pre-Windows 2000
user logon name. The rules are as follows:
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1. The first character of the user first name, followed by the user last name.
2. The first two characters of the user first name, followed by the user last name.

3. The first three characters of the user first name, followed by the user last name.

The length of the policy-generated name is at most eight characters. If the name is longer,
trailing characters are truncated as needed.

Examples of nhames generated by this policy are as follows:

¢ JSmitson
¢ JoSmitso
e JohSmits

The policy generates the name JoSmitso for the user John Smitson if the name JSmitson is
in use. If both JSmitson and JoSmitso are in use, the policy generates the name JohSmits.

To implement this scenario, you must perform the following actions:

1. Configure the Policy Object that defines the appropriate policy.
2. Apply the Policy Object to a domain, OU, or Managed Unit.

As a result, when assigning a pre-Windows 2000 user logon name to a user account in the
container you selected in Step 2, the Active Roles user interfaces provide a Generate
button to create the name in accordance with the policy rules. In the event of a naming
conflict, clicking Generate causes the policy to apply a subsequent rule.

The following two sections elaborate on the steps to implement this scenario.

Configuring the Policy Object

You can configure the Policy Object you need by modifying the Policy Object that
implements the previous scenario; see Scenario 1: Using uniqueness number.

Display the Properties dialog for that Policy Object and go to Policies. Then, select the
policy from the list, and click View/Edit to display the User Logon Name Generation
Policy Properties dialog.

The Generation Rules tab in the User Logon Name Generation Policy Properties
dialog looks similar to the User Logon Name (pre-Windows 2000) Generation Rules
page in the wizard you used to configure the policy. You can use that tab to add or modify
policy rules.

First, modify the rule to remove the uniqueness number entry. On the Generation Rules
tab, select the rule and click View/Edit to display the Configure Value dialog. Then,
select the uniqueness number entry as shown in the following figure, and click Remove.
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Figure 44: Configure Value
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Click OK to close the Configure Value dialog.

Next, configure the additional policy rules as follows.

1. Onthe Generation Rules tab, click Add to display the Configure Value dialog.
2. Inthe Configure Value dialog, click Add to display the Add Entry window.
3. Configure the entry to include the first two character of the user first name:

a. Under Entry type, click User Property.

b. Under Entry properties, click Select.

c. Inthe Select Object Property window, click First Name in the Object
property list, and then click OK.

d. Under Entry properties, click The first, and enter 2 in the box next to
that option.

e. Click OK to close the Add Entry window.
4. Inthe Configure Value dialog, click Add to display the Add Entry window.
5. Configure the entry to include the user last name:

a. Under Entry type, click User Property.

b. Under Entry properties, click Select.
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c. Inthe Select Object Property window, click Last Name in the Object

property list, and then click OK.
d. Click OK to close the Add Entry window.
6. Click OK to close the Configure Value dialog.

7. Repeat Steps 1 through 6 with the following alteration:

In Step 3, sub-step d), enter 3 in the box next to the The first option.

After you complete these steps, the list of rules on the Generation Rules tab should look

as follows:

Figure 45: Generation rules

User Logon Mame Generation Policy Prnperties::

iseneral  @Eneration Rules

Set up a lisk of rules on how to generate user logon name {pre-\Windows

2000) upon user account creation.

iaeneration rules:

Priariky Fule Uni. .

1 el <givenMame =% <sn> Mo

2 el <givenMame =% <sn> Mo

3 “od=givenhame =% <sn= Mo
Add. .. REmoye WiewEdit. .. Advanced...

|
| 7

@ To ensure the uniqueness of the name, wou can configure mulkiple
tules or add unigueness number to a rule, Rules are applied in the
arder of their priority, IF the name generated by a rule is in use, the

policy applies the next rule from the lisk,

% Always

£ Only if & unigue mame cannot be generated by Ehis policy

Ik

Cancel

Help

Click OK to close the User Logon Name Generation Policy Properties dialog.
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Applying the Policy Object

You can apply the Policy Object without closing its Properties dialog. Go to the Scope tab
and do the following:

1. On the Scope tab, click the Scope button to display the Active Roles Policy Scope
window for the Policy Object you are managing.

2. Click Add and select the domain, OU, or Managed Unit where you want to apply
the policy to.

You can also use the Remove button to remove items where you want the policy to
no longer be applied.

3. Click OK to close the Active Roles Policy Scope window.
4. Click OK to close the Properties dialog for the Policy Object.

For more information on how to apply a Policy Object, see Applying Policy Objects and
Managing policy scope.

Group Membership AutoProvisioning

Group Membership AutoProvisioning policies help you automate adding or removing the
specified objects (such as user objects) to or from the specified groups.

In case of cloud-only Azure objects, you can use the Group Membership Autoprovisioning
policy to automatically assign (or unassign) Azure users and Azure guest users to (or from)
the specified 0365 group(s) in the same Azure tenant.

NOTE: Policy Object settings specific to Azure cloud-only objects (such as cloud-only
Azure users, guest users, or contacts) are available only if your Active Roles deployment
is licensed for managing cloud-only Azure objects. Contact One Identity support for more
information.

Also, Policy Objects specific to Azure cloud-only objects will work correctly only if an
Azure tenant is already configured in the AD of the organization, and Active Roles is
already set as a consented Azure application for that Azure tenant. For more information
on these settings, see Configuring a new Azure tenant and consenting Active Roles as an
Azure application.

To set up a policy, select the type of objects you want to provision, select the affected
group(s), and then configure the policy rules. Once set up, the policy adds (or removes)
directory objects to (or from) the selected groups depending on whether the provisioned
objects meet the specified rules.

To help you get started with configuring policy-based administration in your organization,
Active Roles includes a set of built-in Policy Objects that offer provisioning and depro-
visioning rules to the most typical administrative use cases. To find the built-in Policy
Objects, navigate to the following node of the Active Roles Console:

Configuration > Policies > Administration > Builtin
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NOTE: Active Roles does not automatically check for changes in directory objects, contain-
ers or groups specified for provisioning in the configured Policy Objects. This means that

if any changes are made in any directory resources in use in a policy, you must update

the impacted policies manually. For example, if a directory group used by a Group
Membership AutoProvisioning Policy Group is deleted, the Policy Group must be updated
manually to reflect the changes.

How the Group Membership AutoProvisioning
policy works

A Group Membership AutoProvisioning policy performs provisioning tasks such as adding or
removing users from groups. A policy can be configured to define a list of groups and
conditions so that a user account is automatically added to, or removed from, those groups
depending on whether the properties of the user account meet the policy conditions.

Active Roles automatically checks users against conditions, and adds or removes users
from specified groups based on the check results. Although the capabilities of this policy are
similar to those provided by Dynamic Groups, a Group Membership AutoProvisioning policy
gives the administrator extra flexibility and control over group memberships.

Whereas the Dynamic Groups feature delivers a rules-based mechanism for managing a
group membership list as a whole, a Group Membership AutoProvisioning policy allows the
administrator to define membership rules on a per-user basis. This policy automates the
process of adding particular users to particular groups without affecting the other members
of those groups.

Configuring a Group Membership
AutoProvisioning policy

To configure a Group Membership AutoProvisioning policy via the Active Roles Console
(also known as the MMC interface), perform the following procedure.

To configure a Group Membership AutoProvisioning policy

Navigate to Configuration > Policies > Administration.

2. To open the New Provisioning Policy Object Wizard dialog, right-click in
the middle pane to open the context menu, and then select New >
Provisioning Policy.
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3. Onthe Name and Description page, provide a uniqgue Name for the new Policy
Object. Optionally, also provide a Description. To continue, click Next.

4. On the Policy to Configure page, select Group Membership AutoProvisioning,
and then click Next.

5. Onthe Object Type Selection page, to specify the type of object you want the
policy to add or remove from groups, click Select, then click OK.

TIP: If you do not see the object type you need, expand the list by selecting Show
all possible object types.

6. On the Policy Conditions page, set up conditions that specify how the policy adds or
removes the selected object types to or from groups. To create a new condition with
the Set Up Condition dialog, click Add.

7. To select the object property on which you want to set up the condition, click
Property to open the Object property page.

8. Select the property you want the condition to check, then click OK.

TIP: If you do not see the object type you need, expand the list by selecting Show
all possible object types.

9. In Operation, click the operation type you want to assign to the condition.

10. To specify additional configuration for the condition, enter a variable into the Value
field, then click OK to close the Add Value dialog.

Alternatively, click Configure Value, then click Add, and configure an entry
manually in the Add Entry dialog. For more information on manual configuration,
see Configuring entries. To close the Add Value dialog, click OK.
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11. (Optional) To modify or remove an existing condition, click View/Edit or Remove
on the Policy Conditions page, respectively.

12. Click Next on the Policy Conditions page to continue onto the Policy Action page.

13. On the Policy Action page, specify whether you want the policy to add or remove
objects if the configured conditions are met.

» Select Add object to groups if object satisfies policy conditions if you
want Active Roles to add the object to the specified group(s) if the configured
conditions are met.

» Select Remove object from groups if object satisfies policy conditions
if you want Active Roles to remove the object from the specified group(s) if the
configured conditions are met.

Click Next to continue.

14. On the Group Selection page, specify the group(s) you want the policy to add the
objects to (or remove from, depending on your choice on the Policy Action page).
Click Add to open the Select Objects dialog, and then use either the Look in:
drop-down or click Browse to specify the group(s). Once you are ready, click Next
to continue.

NOTE: Consider the following limitations when configuring a Group Membership
Autoprovisioning policy for cloud-only Azure objects:

e When provisioning cloud-only Azure users or Azure guest users, you must
specify an 0365 Group (or 0365 Groups) in this step. To do so, click Browse
to open the Browse for Container dialog, and then navigate to the
following node for the list of 0365 Groups in the organization:

Azure > <azure-tenant-name> > Office 365 Groups

e The Group Membership AutoProvisioning policy can only add or remove
cloud-only Azure users and guest users to or from 0365 Groups that are
located in the same Azure tenant as the Azure users and guest users.
Selecting 0365 Groups located in another Azure tenant causes the
configured Policy Object to not work properly.

15. On the Enforce Policy page, specify the objects to which the configured Policy
Object will be applied. Click Add, and then use the Select Objects dialog to locate
and select the objects.

TIP: When provisioning cloud-only Azure users or guest users, you can either select
the respective object category (such as the Azure user or Azure guest user
node) in this step, or the Azure tenant that contains the Azure objects.

16. Click Next, and then click Finish to create the new policy.

Scenario: Adding users to a specified group

The policy described in this scenario automatically adds user accounts to the specified
groups depending on the Department property of user accounts. If the Department
property of a user account is set to Sales, the policy adds the account to the Sales group.

To implement this scenario, you must perform the following actions:

@NE IDENTITY Active Roles 8.1.5 Administration Guide 170

by Quest Rule-based autoprovisioning and deprovisioning



1. Create and configure a Policy Object that defines the appropriate policy.
2. Apply the Policy Object to a domain, OU, or Managed Unit.

As a result, when a user account in the container you selected has the Department
property set to Sales, Active Roles automatically adds that account in the Sales group.

Configuring the Group Membership AutoProvisioning
Policy Object

You can create and configure the Policy Object you need by using the New Provisioning
Policy Object Wizard. For information about the wizard, see Creating a Policy Object.

To configure the policy, click Group Memberships AutoProvisioning on the Select
Policy Type page of the wizard. Then, click Next.

On the Object Type Selection page, click Next to accept the default setting for the object
type (User).

On the Policy Conditions page, click Add to display the Set Up Condition dialog.
Configure the condition as follows:

1. Click the Property button; then, select the Department property and click OK.
2. Inthe Value box, type Sales.

After you complete these steps, the Set Up Condition dialog must look as follows.

Figure 46: Set Up Condition
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Configured condition:
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Click OK to close the Set Up Condition dialog.
On the Policy Conditions page, click Next.

On the Policy Action page, click Add object to groups if object satisfies policy
conditions, then click Next.
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On the Group Selection page, click Add and use the Select Objects dialog to locate the
Sales group. After you add the Sales group to the list on the Group Selection page, click
Next and follow the instructions in the wizard to create the Policy Object.

Applying the Policy Object

You can apply the Policy Object by using the Enforce Policy page in the New
Provisioning Policy Object Wizard, or you can complete the wizard and then use the
Enforce Policy command on the domain, OU, or Managed Unit where you want to apply
the policy.

For more information on how to apply a Policy Object, see Applying Policy Objects and
Managing policy scope.

Exchange Mailbox AutoProvisioning

Policies in this category are intended to automate the selection of a mailbox store or
database when designating a user as mailbox-enabled or creating a mailbox on Microsoft
Exchange Server.

You can specify Exchange Servers and mailbox stores or databases where mailbox
creation is allowed, and specify rules to distribute mailboxes among multiple stores. For
example, you can configure a policy to automatically choose a store that holds the least
number of mailboxes.

How the Exchange Mailbox AutoProvisioning
policy works

When making a user mailbox-enabled or creating a mailbox, Active Roles relies on this
policy to select the mailbox store or database. The policy defines a single store, or a set of
stores, in which creation of mailboxes is allowed. Some specific features of the policy
behavior are as follows:

» If the policy specifies a single store, mailboxes are created in that store. A different
store cannot be selected by the operator who creates or updates the user account.

» If the policy specifies multiple stores, the store is selected either automatically (by
Active Roles) or manually (by the operator who creates or updates the user account),
depending on policy options.

In case of multiple stores, the policy provides these options to govern the selection
of a store:

e Manually: Allows the operator to select a store from the list defined by the policy.

e By using the round-robin method: Redirects mailbox creation requests
sequentially across the stores, selecting the first store for the first request, the
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second store for the second request and so on. After the last store is reached, the
next request is passed to the first store in the sequence.

e Containing the least number of mailboxes: Forwards mailbox creation requests
to the store that holds the least amount of mailboxes.

Configuring an Exchange Mailbox
AutoProvisioning policy

You can configure a new Exchange Mailbox AutoProvisioning policy with the Active
Roles Console.

To configure an Exchange Mailbox AutoProvisioning Policy

1. On the Policy to Configure page, select Exchange Mailbox AutoProvisioning,
then click Next.
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Figure 47: Allowed mailbox stores
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2. Under Select allowed mailbox stores, select servers and stores to be allowed for
mailbox creation, then click Next.

In case of multiple stores, from the Pick a store list, select one of following options:
* Manually
e By using the round-robin method
» Containing the least number of mailboxes

For information about the methods of picking a store in case of multiple stores, see
How the Exchange Mailbox AutoProvisioning policy works.

3. On the Enforce Policy page, you can specify objects to which this Policy Object is to
be applied:

e Click Add, and use the Select Objects dialog to locate and select the
objects you want.

4, Click Next, then click Finish.
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Scenario: Mailbox store load balancing

The policy described in this scenario allows multiple stores to be used for mailbox
creation, and forces Active Roles to automatically select the store that holds the least
amount of mailboxes.

To implement this scenario, you must perform the following actions:

1. Create and configure a Policy Object that defines the appropriate policy.
2. Apply the Policy Object to a domain, OU, or Managed Unit.

As a result, when creating a mailbox for a user account that resides in the container you
selected in Step 2, Active Roles chooses the least loaded store among those where mailbox
creation is allowed.

Creating and configuring the Exchange Mailbox
AutoProvisioning Policy Object

You can create and configure the Policy Object you need by using the New Provisioning
Policy Object Wizard. For information about the wizard, see Creating a Policy Object.

To configure the policy, click Exchange Mailbox AutoProvisioning on the Select Policy
Type page of the wizard. Then, click Next.

On the Allowed Mailbox Stores page, select the stores in which you want mailbox
creation to be allowed. Then, under Pick a store, click Containing the least number
of mailboxes.
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Figure 48: Allowed mailbox stores
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Click Next, and follow the instructions in the wizard to create the Policy Object.

Applying the Policy Object

You can apply the Policy Object by using the Enforce Policy page in the New
Provisioning Policy Object Wizard, or you can complete the wizard and then use the
Enforce Policy command on the domain, OU, or Managed Unit where you want to apply
the policy.

For more information on how to apply a Policy Object, see Applying Policy Objects and
Managing policy scope.
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Default creation options for Exchange mailboxes

In the wizard for creating user accounts, whether in the Active Roles Console or Web
Interface, the Create an Exchange mailbox option is selected by default, causing the
user mailbox to be created upon creation of a user account. This behavior can be
changed by applying an appropriately crafted policy of the Exchange Mailbox
AutoProvisioning category.

A policy can be configured so that the Create an Exchange mailbox option is not
selected by default but the administrator who uses the wizard to create a user account can
select that option if necessary. It is also possible to configure a policy that forces the
Create an Exchange mailbox option to be selected.

To set default creation options for Exchange mailboxes

1. Create a Policy Object containing an Exchange Mailbox AutoProvisioning policy.
2. Open the Properties dialog for the Policy Object you created.

3. On the Policies tab in the Properties dialog, double-click the Exchange Mailbox
AutoProvisioning policy entry.

4. On the Mailbox Creation tab in the Exchange Mailbox AutoProvisioning Policy
Properties dialog, set policy options as appropriate for your situation:

* Create the user mailbox by default: Determines whether the Create an
Exchange mailbox option is selected by default in the wizard for creating user
accounts. If you want user mailboxes not to be created by default, clear this
policy option.

» Enforce creation of the mailbox: Causes the Create anExchange
mailbox option to be selected and unavailable so that the administrator who
creates a user account cannot clear that option.

5. Click OK to close the dialogs you opened.

6. Apply the Policy Object to the scope (domains, containers, or Managed Units) where
you want this policy to be in effect.

AutoProvisioning in SaaS products

Policies of this category are intended to automate the provisioning of users and groups in
the selected Saa$S products using Starling Connectors.

You can specify the Starling Connect connectors to be validated for the users or groups for
which the policy is applied.
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How the AutoProvisioning in SaaS products
policy works

Active Roles relies on this policy during user creation to provision the users for connected
systems based on the registered Starling Connectors that are selected based on the
configured policy.

Creating a provisioning policy for Starling Connect

You can create a new provisioning policy for Starling Connect in the Active Roles Console by
configuring a new Policy Object based on the Autoprovisioning in SaaS products policy.

To create a Policy Object for Starling Connect

1. Inthe Console tree, under Configuration > Policies > Administration, locate
and select the folder in which you want to add the Policy Object.

You can create a new folder as follows: Right-click Administration and select New
> Container. Similarly, you can create a sub-folder in a folder: Right-click the folder
and select New > Container.

Right-click the folder, point to New, then click Provisioning Policy.
3. Onthe Welcome page of the wizard, click Next.
4. On the Name and Description page, do the following, then click Next:
a. Inthe Name box, enter a name for the Policy Object.
b. (Optional) Under Description, enter any information about the Policy Object.

5. On the Policy to Configure page, select Autoprovisioning in SaaS products,
and click Next to configure policy settings.

6. Onthe Object Type Selection page, click Select.

a. Onthe Select Object Type, from the Object types list, select User or
Group, and click OK.

b. Click Next.

c. On the Policy Conditions page, from the Starling Connect Connectors list,
select the connectors to be provisioned for the user or group as part of the
policy. Click Next.

7. On the Enforce Policy page, you can specify the containers on which this Policy
Object is to be applied:

a. Click Add, and use the Select Objects to locate and select the objects
you want.

b. Click Next.
8. Click Finish.

@NE IDENTITY Active Roles 8.1.5 Administration Guide 178

by Quest Rule-based autoprovisioning and deprovisioning



IMPORTANT: Consider the following when configuring a Policy Object for Starling
Connect:

e You must apply the Starling Connect policy on the container for any SaaS opera-
tions to take place.

e SaaS operations for each connector may vary from each other. Each connector may
have a set of mandatory attributes to perform any operation.

e The operation will fail if any of the mandatory attributes are missing in the
particular request. The notification will report the information of all the mandatory
attributes missing in that event which caused the failure. If this happens, you you
must create the corresponding virtual attributes, customize the Web Interface to
enter the value for the virtual attribute during the specified operation. Using this
approach, the attribute value is passed as a part of the request.

OneDrive Provisioning

Policies of this category are intended to provision access to OneDrive for Azure AD users.
Provisioning of OneDrive is controlled or restricted by creating a new provisioning policy
and applying the policy to the Organizational Unit.

How the OneDrive Provisioning policy works

Active Roles relies on this policy during user creation to provision Azure AD users for
OneDrive access.

Creating a provisioning policy for OneDrive

Provisioning access to OneDrive for Azure AD users is controlled or restricted by creating a
new provisioning policy and applying the policy to the Organizational Unit.

To create and apply the new policy

1. From the Active Roles Console, create a Policy Object. For more information on how
to create a Policy Object, see Creating a Policy Object.

2. In Active Roles Console, on the Policy to Configure page, select OneDrive
Provisioning.

3. In the New Provisioning Policy Object Wizard > OneDrive folder
Management page, enter the SharePoint Admin URL and the storage size,
and click Next.

| NOTE: Consider the following when creating and applying a new policy:
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» If the policy conditions are not met, for example by specifying an incorrect
SharePoint Admin URL or a storage size that is not within the acceptable
range, an error will appear.

e The policy accepts a minimum storage size of 1 GB and a maximum of 10 TB.

4. Inthe Enforce Policy page, select the Organizational Unit (OU) on which the policy
must be applied.

5. Click Next.
6. Click Finish.

Home Folder AutoProvisioning

Policies in this category are intended to automate the creation or renaming of user home
folders and home shares upon user accounts creation or renaming through Active Roles.

You can specify a server on which to create home folders and home shares, define how
to set permissions for new home folders and shares, specify haming conventions for
new home folders and home shares, and limit the number of concurrent connections to
home shares.

For example, using this type of policy, a corporate rule can be defined so that every time
Active Roles creates a user account, it also creates a folder on a network file share, and
assigns it as the user’s home folder.

How the Home Folder AutoProvisioning policy
works

When running a Home Folder AutoProvisioning policy, Active Roles performs various
actions depending on whether a user is created, copied, or renamed.

Creating home folders and shares when creating user
accounts

When Active Roles creates a user account (whether from scratch or by copying an existing

account), the policy can cause Active Roles to create a home folder and, optionally, a home
share for the account using the path specified in the policy. The name of the home share is
composed of the user name, and the prefix and suffix specified in the policy.

The policy provides the option to enable creation of home folders with paths and names
that differ from the path and name prescribed by the policy. For example, a Property
Generation and Validation policy can be configured to generate the Home Drive and
Home Directory properties on user accounts. When making changes to those
properties, Active Roles verifies that the specified home folder exists, and creates the
home folder if necessary.
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A special policy is implemented in Active Roles that restricts the folders on the network file
shares in which home folders can be created. The Policy Object containing that policy is
located in the Configuration/Policies/Administration/Builtin container. The name of
the Policy Object is Built-in Policy - Home Folder Location Restriction. You can
access it by using the Active Roles Console. The policy settings include a list of the folders
on the network file shares in which creation of home folders is allowed. For instructions on
how to view or modify that list, see Configuring the Home Folder Location Restriction policy.

Renaming home folders when renaming user accounts

When Active Roles modifies the user logon name (pre-Windows 2000) of a user account,
the policy can rename the home folder and, optionally, re-create the home share for that
user account. The name of the new home share is set up in accordance with the naming
convention specified in the policy.

The policy renames the existing home folder based on the new user logon name (pre-
Windows 2000). However, if the home folder is in use, Active Roles cannot rename the
folder. In this case, Active Roles creates a new home folder with the new name and does
not affect the existing home folder.

Option to prevent operation on file server

By default, Active Roles attempts to create or rename a (non-local) home folder on the file
server when the Home Directory property is set or modified on a user account in Active
Directory. If creation or renaming of the home folder fails (for example, because the file
server is inaccessible), then the creation or modification of the user account fails, as well.
To prevent such an error condition, a Home Folder AutoProvisioning policy can be
configured so that Active Roles applies the changes to the Home Drive and Home
Directory properties in Active Directory without attempting an operation on the file server.
This policy option enables the use of a tool other than Active Roles for creating home
folders on the file server.

Active Roles comes with a preconfigured Policy Object that allows the creation or renaming
of home folders when setting home folder properties on user accounts in Active Directory.
The Policy Object is located in the Configuration/Policies/Administration/Builtin
container in Active Roles Console tree. The name of the Policy Object is Built-in Policy -
Default Rules to Provision Home Folders. If you want to prevent Active Roles from
attempting to create or rename home folders, you can modify the policy in the built-in
Policy Object or configure and apply another Home Folder AutoProvisioning policy with the
respective option turned off.

Configuring a Home Folder AutoProvisioning
policy

You can create a new Home Folder AutoProvisioning policy with the Active Roles Console.
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To configure a Home Folder AutoProvisioning policy

1. On the Policy to Configure page, select Home Folder AutoProvisioning, then
click Next.

Figure 49: Home folder management
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2. Onthe Home Folder Management page, do the following:
e From the Connect list, select the drive letter to which you want the policy to
map the home folder.

e Inthe To box, specify a network path to the home folder. The path must
include a common share at one level above the home folders. For example, if
you want to create home folders on the share Home of the server Ant, use the

following path:

\\Ant\Home\%username%
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NOTE: Paths containing just the server and username, like
\\SERVER\%username% are not valid.

* To have the policy verify that the home folder path and name on user accounts
are set in compliance with this policy, select Enforce this home folder
setting in Active Directory.

When this check box is cleared, the policy allows home folder paths and names
that differ from the path and name prescribed by the policy.

e To have Active Roles automatically set the home folder properties in accord
with this policy upon user account creation in Active Directory, select Apply
this home folder setting when user account is created.

e To have Active Roles automatically set the home folder properties in accord
with this policy upon user account renaming in Active Directory, select Apply
this home folder setting when user account is renamed.

e To have Active Roles attempt creation or renaming of a (non-local) home folder
on the file server when home folder properties are set or changed on a user
account in Active Directory, select Create or rename home folder on file
server as needed.

If you want to configure the policy so that it not only sets home folder
properties on user accounts in Active Directory but also creates or renames
home folders and home shares in accord with the policy settings, you must
keep the Create or rename home folder on file server as needed
check box selected (this is the default setting). If the check box is cleared,
then the policy can only set or verify home folder properties on user
accounts in Active Directory.

e Specify how you want the policy to configure permission settings on home
folders. You can choose from the following options:

» Copy user permissions on home folder from parent folder: Upon
creation or renaming of a home folder for a user account, ensures that
the user account has the same rights on the home folder as on the folder
in which the home folder resides.

e Set user as home folder owner: Upon creation or renaming of a
home folder for a user account, ensures that the user account is set as
the owner of the home folder.

o Set user permissions on home folder: Upon creation or renaming of
a home folder for a user account, ensures that the user account has the
specified access rights on the home folder (such as Change Access or
Full Access).

Click Next.

3. Onthe Home Share Management page, specify settings for user home shares. Do
the following:

« Select Create home share when home folder is created or renamed for
the policy to create or rename the home share when creating or renaming the
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home folder.

e (Optional) In Share name prefix and Share name suffix, type a prefix and
suffix for the name of the home share.

e (Optional) In Description, type a comment to add to the home share.

e If you want to limit the number of users that can connect to the share at a time,
click Allow this number of users and specify the maximum number of users
in the box next to that option. Otherwise, click Maximum allowed.

Click Next.

4. On the Enforce Policy page, you can specify objects to which this Policy Object is to
be applied:

e Click Add, and use the Select Objects dialog to locate and select the
objects you want.

5. Click Next, then click Finish.

Connect <Drive Letter> to <Network Path>

Upon creation or renaming of a user account, the policy can configure the user account in
Active Directory to connect the home folder to the specified network path. From the
Connect list, select the drive letter to which you want the policy to map the home folder. In
the To box, specify a network path to the home folder. Ensure that the path meets the
following requirements:

e Avalid network path must begin with the UNC name of a network file share, such as
\\Server\Share\, and should normally include the %ousername®bo notation. For
example, with the Connect: Z: To: \\Server\Share\%username®o option, the
policy can configure a user account in Active Directory so that the Home Drive
property of the user account is set to Z: and the Home Directory property of the
user account is set to \\Server\Share\LogonName where LogonName stands for the
pre-Windows 2000 logon name of the user account.

e The path must include a common share at one level above the home folders. For
example, if you type \\Comp\Home\%username%, the policy creates home folders on
the share Home on the server Comp, with the name of the folder being the
same as the user logon name (pre-Windows 2000). The path
\\Comp\%username%% is invalid.

e The folder on the network file share in which you want the policy to create home
folders must be listed in the Home Folder Location Restriction policy. For instructions
on how to view or modify the list see Configuring the Home Folder Location
Restriction policy.

» If you want the policy to create home shares (see Set user permissions on home
folder), you should not specify an administrative share, such as C$, as the common
share in the To box. Otherwise, the policy may be unable to create home shares
when creating home folders. Thus, if you specify \\Comp\C$\%username¥%, the policy
can successfully create home folders in the folder C:\ on the computer Comp, but it
may fail to create home shares.
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Enforce this home folder setting in Active Directory

Use this option to have Active Roles verify whether the Home Drive and Home Directory
properties on user accounts in Active Directory are in compliance with the Connect:
<drive letter> To: <network path> setting specified by this policy.

For example, with the Connect: Z: To: \\Server\Share\%username%bo policy setting,
this option causes a policy violation condition in Active Roles upon an attempt to modify a
user account so that the Home Drive property is assigned a drive letter other than Z: or
the Home Directory property is assigned a network path other than
\\Server\Share\LogonName where LogonName stands for the pre-Windows 2000 logon
name of the user account.

When this option is turned off, the policy allows a home folder path and name that differs
from the path and name prescribed by this policy. A Property Generation and Validation
policy can be configured to generate the Home Drive and Home Directory properties on
user accounts, or those properties can be specified manually. In either case, Active Roles
updates the user account so that the folder with the specified path and name is set as the
user home folder. If necessary, Active Roles creates the folder.

When this option is turned on, the policy behaves as follows:

e It ensures that the path and name of the home folder is in compliance the policy
settings. If a different path or name is specified upon creation or modification of a
user account, the policy does not allow the changes to the home folder path and
name to be committed to the directory.

» The Check Policy command causes the policy to verify the existing home folder
settings. The policy check results inform about policy violations, if any, and provide
the ability to fix the home folder path and name settings on user accounts so as to
bring them into compliance with the policy settings.

By selecting the Enforce this home folder setting in Active Directory check box, you
ensure that the home folders on user accounts are set in compliance with this policy.

By clearing the check box, you get the option of applying a Property Generation and
Validation policy in order to generate and validate the Home Drive and Home Directory
properties, and thus have Active Roles create and assign home folders in accordance
with the flexible, highly customizable rules provided by a Property Generation and
Validation policy.

IMPORTANT: When setting the Home Drive and Home Directory properties, Active
Roles does not create the home folder if the network path of the folder to hold the home
folder is not listed in the Home Folder Location Restriction policy. The policy defines a list
of the folders on network file shares in which creation of home folders is allowed, and
prevents Active Roles from creating home folders in other network locations. For instruc-
tions on how to view or modify the policy settings, see Configuring the Home Folder
Location Restriction policy.
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Apply this home folder setting when user account is
created

Upon creation of a user account, this option causes Active Roles to configure the user
account in Active Directory in accord with the Connect: <drive letter> To: <network
path> setting specified by this policy.

For example, with the Connect: Z: To: \\Server\Share\%username%bo policy setting,
selecting this check box ensures that a newly created user account has the Home Drive
property set to z: and the Home Directory property set to \\Server\Share\LogonName
where LogonName stands for the pre-Windows 2000 logon name of the user account.

Apply this home folder setting when user account is
renamed

Upon renaming a user account, this option causes Active Roles to configure the user
account in Active Directory in accord with the Connect: <drive letter> To: <network
path> setting specified by this policy.

For example, with the Connect: Z: To: \\Server\Share\%username%bo policy setting,
renaming a user account causes the policy to set the Home Directory property to
\\Server\Share\NewLogonName where NewLogonName stands for the pre-Windows 2000
logon name that is assigned to the user account by the rename operation.

Create or rename home folder on file server as needed

When selected, this option directs Active Roles to attempt the creation or renaming of a
(non-local) home folder on the file server when the Home Directory property is set or
modified on a user account in Active Directory. The renaming of the home folder is
attempted if the Home Directory property value contains the %ousername®bo notation
and the changes to the user account include modification of the pre-Windows 2000 logon
name of the user account. In other cases, the creation of a new home folder is attempted.

For example, with the Connect: Z: To: \\Server\Share\%username%bo policy setting,
selecting this check box together with the option to apply the policy setting upon creation of
a user account causes Active Roles to attempt the creation of the home folder for the user
account. Active Roles attempts to create the holder with the following network path:
\\Server\Share\LogonName, where LogonName stands for the pre-Windows 2000
logon name of the user account.

Another example is setting the Home Drive and Home Directory properties on an
existing user account in Active Directory: With this check box selected, Active Roles
attempts to create the folder specified by the network path that is assigned to the Home
Directory property.

If creation or renaming of the home folder fails on the file server, then the creation or
modification of the user account fails as well. To prevent such an error condition, you could
clear this check box.
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The result is that Active Roles applies the changes to the Home Drive and Home
Directory properties in Active Directory without attempting an operation on the file server,
which allows the use of a different tool for creating home folders on the file server.

Copy user permissions on home folder from parent folder

Upon creation or renaming of a home folder for a particular user account, this option
ensures that the user account has the same rights on the home folder as it has on the folder
in which the home folder resides.

Set user as home folder owner

Upon creation or renaming of a home folder for a particular user account, this option
ensures that the user account is set as the owner of the home folder.

An owner of a folder is authorized to make any changes to permission settings on the
folder. For example, an owner can authorize other persons to access the folder.

Set user permissions on home folder

Upon creation or renaming of a home folder for a particular user account, this option
ensures that the user account has the specified access rights on the home folder.

With the Grant Full Access setting, the user account is authorized to perform any
operation on the folder and its contents except for making changes to permission settings.
With the Grant Change Access setting, the user account is authorized to view and modify
the contents of the folder.

When finished, click Next to display the Home Share Management page. This page lets
you configure policy options for creating home shares.
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Figure 50: Home share management
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To have the policy create home shares, select the Create home share when home
folder is created or renamed check box.

When you configure the policy to create home shares, you can specify the prefix and suffix
for the home share names.

Specifying a prefix and suffix allows you to establish a naming convention for home shares.
Suppose you want home shares to be displayed at the top of the list of shares. To do so,
you can use an underscore as the prefix.

You may also assign a suffix to distinguish home shares created by the policy. For example,
to distinguish the home shares of users from the Sales department, you could use the
suffix _s. Then, when you create a user account with the pre-Windows 2000 logon name set
to JohnB, the policy will map the user’s home folder to the selected drive and specify
\\Server\_JohnB_s as the path to the home folder. The policy will also create the share _
JohnB_s that points to the folder \\Server\Home\JohnB.
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Optionally, in the Description box, you can type a comment about the home share. The
users will see it when viewing share properties.

You can also limit the number of users that can connect to the share at one time. Click
Maximum allowed or Allow this number of users. With the latter option, specify a
number in the box next to the option.

Using the built-in policy for home folder
provisioning

If you want to configure Active Roles so that setting or changing home folder related
properties on any user account in any managed domain does not result in an attempt to
create or rename a folder on a file server, then you can use the Active Roles Console to
modify the built-in Policy Object:

1. Inthe Console tree, select Configuration > Policies > Administration > Builtin.

2. Inthe Details pane, double-click Built-in Policy - Default Rules to Provision
Home Folders.

3. On the Policies tab, select the policy from the list and then click View/ Edit.

4. On the Home Folder tab, clear the Create or rename home folder on file
server as needed check box.

5. Click OK to close the dialogs you opened.

If you have any other Policy Objects containing policies of the Home Folder
AutoProvisioning category, then you need to configure them as appropriate: Select or clear
the Create or rename home folder on file server as needed check box in each of
those policies depending on whether or not Active Roles should attempt creation or
renaming of home folders for user accounts that fall within the scope of the respective
Policy Object.

Another scenario may require Active Roles to create or rename home folders for user
accounts that are outside a certain scope (such as a certain domain, Organizational Unit, or
Managed Unit), whereas creation or renaming of home folders should not be attempted on
user accounts that fall within that particular scope. In this scenario, ensure that the Create
or rename home folder on file server as needed option is selected in the built-in
Policy Object. Then, create and configure a Policy Object containing a policy of the Home
Folder AutoProvisioning category with the Create or rename home folder on file
server as needed option cleared, and apply that Policy Object to the scope in question.

Configuring the Home Folder Location
Restriction policy

When creating home folders, Active Roles operates in the security context of the service
account under which the Administration Service is running, so the service account must
have sufficient rights to create home folders. Normally, the service account has

@NE IDENTITY Active Roles 8.1.5 Administration Guide 186

by Quest Rule-based autoprovisioning and deprovisioning



administrative rights on an entire file server, which enables Active Roles to create home
folders in any folder on any network file share that exists on that server. The Home Folder
Location Restriction is used to restrict to a certain list the network file shares and folders in
which Active Roles is authorized to create home folders.

The Home Folder Location Restriction policy determines the folders on the network file
shares in which Active Roles is allowed to create home folders, and prevents Active Roles
from creating home folders in other locations. The restrictions imposed by this policy do not
apply if the home folder creation operation is performed by an Active Roles Admin role
holder (normally, these are the users that have membership in the Administrators local
group on the computer running the Active Roles Administration Service). Thus, when an
Active Roles Admin role holder creates a user account, and a certain policy is in effect to
facilitate home folder provisioning, the home folder is created regardless of the Home
Folder Location Restriction policy settings.

By default, no network file shares and folders are listed in the policy. This means that Active
Roles cannot create a home folder unless the user management operation that involves
creation of the home folder is performed by the Active Roles Admin role holder. In order to
allow delegated administrators to create home folders, you have to configure the policy so
that it lists the folders on the network file shares in which creation of home folders is
allowed. You can do this by using the Active Roles Console as follows.

To configure the Home Folder Location Restriction policy

1. Inthe Console tree, expand Configuration > Policies > Administration, and
select Builtin under Administration.

2. Inthe Details pane, double-click Built-in Policy - Home Folder Location
Restriction.

3. On the Policies tab, double-click the list item under Policy Description.

4. On the Allowed Locations tab, view or modify the list of folders on the network file
shares where creation of home folders is allowed.

When adding a folder to the list, specify the UNC name of the folder. If you specify
the name in the form \\ <Server>\<Share>, home folders can be created in any
folder on the network file share specified. If you specify the name in the form
\\<Server>\<Share>\<PathtoFolder>, home folders can be created in any
sub-folder of the folder.

Scenario: Creating and assighing home folders

In this scenario, you configure a policy to create home folders when creating user accounts.
The policy assigns home folders to newly created accounts and grants the users change
access to their home folders.

To implement this scenario, you must perform the following actions:

1. Verify that the network file share on which you want the policy to create home folders
is listed in the Home Folder Location Restriction policy.
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2. Create and configure a Policy Object that defines the appropriate policy.
3. Apply the Policy Object to a domain, OU, or Managed Unit.

As a result, when creating a user account in the container you selected in Step 3, Active
Roles creates the user home folder and assigns that folder to the user account.

The following sub-sections elaborate on the steps to implement this scenario.

Verifying the Home Folder Location Restriction policy

The network file share to hold home folders must be listed in the Home Folder
Location Restriction policy. Use the Configuring the Home Folder Location Restriction
policy instructions to verify that the policy allows creation of home folders on the
network file share.

Creating and Configuring the Policy Object

You can create and configure the Policy Object you need by using the New Provisioning
Policy Object Wizard. For information about the wizard, see Creating a Policy Object.

To configure the policy, click Home Folder AutoProvisioning on the Policy to
Configure page of the wizard. Then, click Next.

On the Home Folder Management page, set up the following options:

e In the Connect box, select the drive letter to assign to the home folder (for
example, Z:).

e Inthe To box, enter the path in the following format:
\\server\share\%username%

In the above format, \\server\share is a valid UNC path to a network file share. For
example, if you have a network file share set up on the comp server, with the share
name set to home, specify the following path:

\\comp\home\%username’.

» Select the Apply this home folder setting when user account is created
check box.

As a result, the Home Folder Management page should look like the following figure.
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Figure 51: Policy Object: Home folder management
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Click Next and follow the steps in the wizard to create the Policy Object.

Applying the Policy Object

You can apply the Policy Object by using the Enforce Policy page in the New
Provisioning Policy Object Wizard, or you can complete the wizard and then use the
Enforce Policy command on the domain, OU, or Managed Unit where you want to apply
the policy.

For more information on how to apply a Policy Object, see Applying Policy Objects and
Managing policy scope.
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Script Execution

Script execution policies help you run supplementary PowerShell (or other) script
modules in Active Roles during or after performing certain administrative operations.
When linking a custom script to an administrative operation via a Script Execution
policy, the script will receive control in Active Roles either when the operation is
requested or when it is completed.

Use Script Execution policies to set up custom scripts (residing in Script Modules in the
Active Roles Console) to:

e Trigger additional actions when performing directory object provisioning.

e Regulate object data format and requirements (such as for generating user
passwords).

e Further automate administrative tasks.

Example use case for a Script Execution policy

Consider a scenario where employees of an organization are frequently transferred
among its office branches temporarily due to various projects.

To administer such temporary assignments quickly and efficiently, write and apply a
custom script that automatically reassigns the employee's user account from the OU
of their original office to the OU of their new office, whenever their City or Office
Location attributes are updated in Active Roles.

For more information on how to set up a Script Execution policy, see Configuring a Script
Execution policy.

TIP: Consider the following when planning to use custom scripts for your provi-
sioning policies:

e To help you configure Script Execution policies, Active Roles also ships with several
built-in Script Modules that you can use to set up your own Script Execution
policies. Find these built-in Script Modules in the following node of the Active

Roles Console:
Configuration > Script Modules > Builtin

» If the directory of your organization contains any cloud-only Azure users, then use
the built-in Generate User Password - Azure only script module to set up a
password generation policy for cloud-only Azure users that meets the password
strength criteria of both your organization and Microsoft Azure Active Directory
(Azure AD).

NOTE: Policy Object settings specific to Azure cloud-only objects (such as cloud-only
Azure users, guest users, or contacts) are available only if your Active Roles deployment
is licensed for managing cloud-only Azure objects. Contact One Identity support for more
information.
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Also, Policy Objects specific to Azure cloud-only objects will work correctly only if an
Azure tenant is already configured in the AD of the organization, and Active Roles is
already set as a consented Azure application for that Azure tenant. For more information
on these settings, see Configuring a new Azure tenant and consenting Active Roles as an
Azure application.

How the Script Execution policy works

Active Roles executes the script module specified in the policy when the operation is
requested or after the operation is completed. The script module is stored in the Active
Roles configuration database.

Configuring a Script Execution policy

When configuring a Script Execution policy, you can prepare a script module beforehand.
Alternatively, you can create an empty script module when configuring a policy, and later
you can edit the module and add a script to be used by the policy.

To configure a Script Execution policy

1. Onthe Policy to Configure page, select Script Execution, then click Next.
2. On the Script Module page, do one of the following:

e To use an existing script module, click Select a script module, and select the
script module in the box beneath this option.

» To create new script module, click Create a new script module, and click
Next. Then, specify a name for the script module, and click Next. Then, select
the event handlers you want the script module to include.

3. Click Next.
4. On the Policy Parameters page, do the following:

a. (Optional) If necessary, from the Function to declare parameters list,
choose the function that defines the parameters specific to this policy.

The list contains the names of all script functions found in the selected Script
Module. The policy has the parameters that are defined by the function
specified in the Function to declare parameters box. Normally, this is a
function named onlInit.

b. Under Parameter values, view or change the values of the policy
parameters. To change the value of a parameter, select the name of the
parameter and click Edit.

Clicking Edit displays a page where you can add, remove, or select a value or
values for the selected parameter. For each parameter, the function that is
used to declare parameters defines the name of the parameter and other
characteristics, such as a description, a list of possible values, the default
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value, and whether a value is required. If a list of possible values is defined,
then you can only select values from that list.

5. On the Enforce Policy page, you can specify objects to which this Policy Object will
be applied. To do so, click Add, and use the Select Objects dialog to locate and
select the objects you want.

6. Click Next, then click Finish.

To create a script module

1. Inthe Console tree, under Configuration > Script Modules, locate and select the
folder in which you want to add the script module.

To create a new folder, right-click Script Modules and select New > Scripts
Container. Similarly, you can create a sub-folder in a folder by right-clicking the
folder and selecting New > Scripts Container.

Right-click the folder and select New > Script Module.
Specify the name and language of the module to create. Then, click Next.

4. In Select a script module type, click the type of the module to create.
Then, click Next.

5. If you selected the Policy script type for the module, select the event handlers you
want the module to include, then click Next.

6. Click Finish.

To edit a script module

In the Console tree, expand Configuration > Script Modules.

2. Under Script Modules, click the folder that contains the script module you
want to edit.

3. Inthe details pane, right-click the script module, then click Edit Script.
Use the details pane to make changes to the script.
5. Right-click the script module in the Console tree, and do one of the following:
e To commit the changes you have made, click Save Script on Server.

e To quit the script editor without saving your changes, click Discard Changes.

To import a script module

1. Inthe Console tree, under Configuration > Script Modules, locate and select the
folder in which you want to add the script module.

To create a new folder, right-click Script Modules and select New > Scripts
Container. Similarly, you can create a sub-folder in a folder by right-clicking the
folder and selecting New > Scripts Container.

2. Right-click the folder, and click Import.

3. Locate and select the file containing the script to import, and click Open.
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To export a script module

In the Console tree, expand Configuration > Script Modules.

2. Under Script Modules, select the folder that contains the script module you
want to export.

3. Inthe details pane, right-click the script module, and select All Tasks > Export.

4. Specify the file to which you want to save the script, then click Save.

Importing a script

To import a script file, in the Console tree, right-click Script Modules, and click Import.
This displays the Import Script dialog where you can select and open a script file.

Creating a script

To create a new script module, in the Console tree, right-click Script Modules and select
New > Script Module. This opens the New Object - Script Module Wizard.

TIP: It is advisable to store custom script modules in a separate container. You can create
a container as follows: Right-click Script Modules in the Console tree, and select New >
Scripts Container. After you have created a container, you can have the wizard add a
script module to that container rather than directly to Script Modules: right-click the
container in the console tree and select New > Script Module.

The first page of the wizard looks as shown in the following figure.
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Figure 52: Script module: Creating a script
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Type a name and description for the new script module, and select script language. Then
click Next. The next page looks as shown in the following figure.
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Figure 53: Script Module: Policy script
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On this page, select a type of the script module. Select Policy script to create a script that
will be used as part of the Policy Object. The other options are:

e Scheduled Task script: Script that you can schedule to run on the
Administration Service.

e Library script: Script to be used by other script modules. You can collect commonly
used functions into a standalone script module and include it in other modules
requiring those functions. This allows you to re-use some pieces of existing scripts,
thus reducing development effort and time.

Select Policy script and click Next. This displays the page with a list of event handler
functions shown in the following figure.
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Figure 54: Script Module: Event handler functions

Event handler functions:
| _Event Handler Name Description -
T onPreCreate In & scrpt policy applied to a container, recei...
™ onPostCreate In & script policy applied to a container, recei...
™ onPreDelete Receives control upon a request to delete a..
™ onPostDelete Heceives control after a request to delete an...
™ on PreModify Receives control upon a request to start cha...
™ on PostModify Receives control after a request to change o... __
I onPreMove In a script policy applied to a container, this f ...
™ onPostMove In @ script policy applied to a container, this f...
™ onPreRename Receives control upon a request to start ren...
™ onPostRename Receives control after a request to rename a...
™ onPreGet Receives control upon a request to retrieve ..
[T onPostGet Heceives control after a request to retrieve o
[ AnPreSearrh Rersives rartmil 1innn & remuiest tn etart & 25 ;I
<Back [ Ned> 3]  Canced | Hep |

On this page, select functions to be used in the script, and click Next. Then, click Finish to
create the script module.

For instructions and guidelines on how to develop policy scripts, refer to the Active Roles
Software Development Kit (SDK).

In the Active Roles Console, you can view and modify scripts, both imported and
newly created.

Editing a script

To edit a script, select it in the Console tree under Configuration/Script Modules. You
can view and modify the script in the details pane. To start editing the script, right-click the
script module and click Edit Script. Then, click Yes to confirm the operation. You can
make changes to the script in the details pane.

When you are editing the script, a red asterisk is displayed next to the name of the script
module in the Console tree. This indicates the changes you are making to the script are not
saved. You can undo your changes or save them:
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e To undo changes, press CTRL+Z. (The redo function is also available: press CTRL+Y.)

e To undo all unsaved changes, right-click the script module and click Discard
Changes. (This operation is irreversible: if you perform this command, your changes
to the script are lost.)

e To save the changes, right-click the script module and click Save Script on Server.

When the script module is ready, you can proceed to configuring a script policy that will use
the prepared script module.

Active Roles allows you to attach a debugger to the Administration Service’s script host for
a given policy script or scheduled task script. When the script is being executed by the
specified Administration Service, the debugger may help you identify and isolate problems,
if any, with the policy or task based on that script.

To enable debugging of a script in the Active Roles Console, display the Properties dialog
for the script module containing the script, go to the Debugging tab, and select the
Enable debugging check box. From the Debug on server list, select the Administration
Service where you want the debugger to run.

Scenario: Restricting group scope

This scenario describes how to configure a policy that prevents creation of universal
groups. With this policy, the Active Roles Console orWeb Interface does not allow an
administrator to create a new universal group or convert an existing group to a
universal group.

To implement this scenario, you must perform the following actions:

1. Prepare the script that implements this scenario.
2. Create and configure the Policy Object to run that script.
3. Apply the Policy Object to a domain, OU, or Managed Unit.

As a result, the Active Roles Console or Web Interface cannot be used to set the universal
group scope option when creating a new group or changing an existing group in the
container you selected in Step 3. For example, if you choose the Universal option under
Group scope and then click Next in the New Object - Group Wizard, the Active Roles
Console presents you with an error message stating that creation of universal groups is
not allowed.

The following sections elaborate on the steps to implement this scenario.

Preparing the script module

The script used in this scenario is installed with the Active Roles SDK. By default, the path
and name of the script file is as follows:

%ProgramFiles%\One Identity\Active Roles\Active
Roles\SDK\Samples\RestrictGroupScope\RestrictGroupScope.psl
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The script receives control upon a request to check the property values submitted to the
Administration Service, and analyzes the value of the groupType attribute to determine if
the universal group scope option is attempted. If the script detects that the assumed
groupType value would cause a group to be configured as a universal group, it raises a
policy violation event in the Administration Service. As a result, the application that
initiated the request (such as the Active Roles Console or Web Interface) displays an error
message provided by the script.

To import the script, right-click the Script Modules container in the Active Roles Console,
and click Import. Then, select and open the RestrictGroupScope.ps1 file.

Creating and configuring the Policy Object

You can create and configure the Policy Object you need by using the New Provisioning
Policy Object Wizard. For information about the wizard, see Creating a Policy Object.

To configure the policy, click Script Execution on the Policy to Configure page of the
wizard. Then, click Next.

On the Script Module page, click Select a script module, and select
RestrictGroupScope from the list of script modules, as shown in the following figure.
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Figure 55: Script Module: Creating/configuring Policy Object

New Provisioning Policy Object Wizard ed 4

Script Module

Select an existing script module or create a new one. The palicy will execute the
script contained in that script module.

The policy runs the script found in the selected script module.

™ Create a new script module
¥ Select 3 script module:

= Script Modules
(- Builtin
- RestrictiGroupScope
Script description:
=]
=

= Badk Cancel Help

Click Next and follow the instructions in the wizard to create the Policy Object.

Applying the Policy Object

You can apply the Policy Object by using the Enforce Policy page in the New
Provisioning Policy Object Wizard, or you can complete the wizard and then use the
Enforce Policy command on the domain, OU, or Managed Unit where you want to apply
the policy.

For more information on how to apply a Policy Object, see Applying Policy Objects and
Managing policy scope.
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Microsoft 365 and Azure Tenant Selection

Microsoft 365 and Azure Tenant Selection policies help you manage Azure tenant selection,
Microsoft 365 (M365) license and role selection, and OneDrive provisioning for hybrid Azure
users in the Azure tenant.

How the Microsoft 365 and Azure Tenant
Selection policy works

The provisioning policy 0365 and Azure Tenant Selection is a unified policy for Azure Office
365 management for users, controlled or restricted by creating a new provisioning policy
and applying the policy to the Organizational Unit. This policy is used for tenant selection,
Office 365 license selection, and Office 365 roles selection, and OneDrive provisioning
forAzure AD users.

This policy is also used for tenant selection for Groups and contacts.

Configuring an 0365 and Azure Tenant
Selection policy

You can configure an 0365 and Azure Tenant Selection policy in the Active Roles Console
(also known as the MMC Interface) to:

» Validate the selected Azure tenants for Azure users, guest users, 0365 groups, Azure
security groups, and contacts.

e Select 0365 Licenses for Azure users and guest users.
e Select 0365 Roles for Azure users and guest users.

e Preprovision OneDrive for Azure users.

Prerequisites

Consider the following before configuring an 0365 and Azure Tenant Selection policy:

e The OneDrive settings of this policy are applicable to hybrid Azure users only, and will
work only if you have already enabled OneDrive for your Azure tenant in the Azure
AD Configuration > Modify (Tenant details) window of the Active Roles Config-
uration Center. For more information on enabling OneDrive for Azure users in an
Azure tenant, see Enabling OneDrive in an Azure tenant.

e To configure an 0365 and Azure Tenant Selection policy, your Organizational
Unit (OU) must already have the Azure - Default Rules to Generate Properties
built-in policy configured. For more information on configuring the policy, see
Configuring the Azure - Default Rules to Generate Properties policy.
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To configure an 0365 and Azure Tenant Selection policy

1. Navigate to Configuration > Policies > Administration.

2. To open the New Provisioning Policy Object Wizard dialog, right-click in
the middle pane to open the context menu, and then select New >
Provisioning Policy.

# Active Roles [ART.roles1.net] Mame

v ﬁ Configuration =9 Builtin
|1 Access Rules
B Access Templates
&g Managed Units

W g Policies
v = Administratinn
Eg] Built Delegate Control...
[z Workflor Enforce Policy...

[ Script Moduy Find...
@ Server Confi

. . Import...
@ Active Directon, - Prar— -
. Roles Security for: Administration (Policy Ot

& AD LDS (ADAM, Check Policy... "“' )
ﬁ Applications Change History ] Act

Mew » Provisicning Policy

All Tasks > Deprovisioning Policy

View 3 Container

Mew Window from Here

3. Onthe Name and Description page, provide a unique Name for the new Policy
Object. Optionally, also provide a Description. To continue, click Next.

4. On the Policy to Configure page, select 0365 and Azure Tenant Selection, and
click Next.
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Mew Provisioning Policy Object Wizard

Policy to Configure
Select a policy you want to configure and incude in this Pravisioning Palicy Object.

Select a policy to configure:

Active Roles Community

Read a brief description of the policy you have selected:

This paolicy enables the administrator to specify the Azure tenant in which the Hyhbrid
ohjects can be created.

< Back |I Mext = || Cancel | | Help

5. Onthe Object Type Selection page, to specify the type of object you want the
policy to provision, click Select, then click OK.

TIP: If you do not see the object type you need, expand the list by selecting Show
all possible object types.

NOTE: If you want to assign and validate Office 365 licenses and roles, or provision
OneDrive storage as part of the configured policy, select the User (user) object
type in this step. Office 365 license and role validation, and OneDrive provisioning
are not applicable to Azure Groups and Azure Contacts.

6. On the Policy Conditions page, select your Azure tenant for which you want to set
up the policy. To continue, click Next.
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Mew Provisioning Pelicy Object Wizard

Policy Conditions
Configure the policy to select the Azure 0365 tenant assigned to the hybrid object

Select the Azure 0365 Tenant for Policy validation

= 1=

- activerolestest, onmicrosoft, com

<Back || mewt> | | cancel | | Hep

7. (Optional) On the next Policy Conditions page, select the licenses to validate and
assign to new Azure users in the Azure tenant. To continue, click Next.

NOTE: If OneDrive storage is planned to be provisioned in the selected Azure
tenant for Azure users, make sure that you select the SharePoint Online license
in this step. Otherwise, the configured OneDrive storage cannot be provisioned for
Azure users created later. For more information, see Creating a new cloud-only
Azure user in the Active Roles Web Interface User Guide.

8. (Optional) On the next Policy Conditions page, select the Office 365 roles to
validate and assign to new Azure users in the Azure tenant. To continue, click Next.

9. (Optional) To configure OneDrive storage for the Azure users of the Azure tenant,
configure the following attributes on the OneDrive Folder Management page:
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Mew Provisioning Policy Object Wizard

OneDrive Folder Management
IUpon creation or renaming of user accounts, the policy manages user Onelrive
folders as you spedify in this step,

Mote : If the below fields are left empty, the OneDrive folder will not be provisioned.

Sharepoint Admin Url : https: ffactiverolestest-admin. sharepoint. com/

Size(in GE) : 4

Before provisioning OneDrive for users:

» SharePoint Online license must be assigned to users to provision
Onelrive for the users.

« SharePoint Online Management Shell must be installed.

< Back |I Mext = || Cancel || Help

e SharePoint Admin URL: Specify the URL of the SharePoint administration
site of your Azure tenant. The URL has the following syntax: <azure-tenant-
name>-admin.sharepoint.com

e Size (in GB): Specify the default OneDrive storage size allocated for each
Azure user in the Azure tenant.

If you do not need to provision OneDrive storage for users in the Azure tenant, leave
the settings empty and click Next.

NOTE: If the wizard shows an error when clicking Next after configuring the
OneDrive settings:
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10.

11.

e Check that the specified SharePoint Admin URL is correct.

e Make sure that the specified OneDrive storage size is correct (that is, it is
within the range of the individual cloud storage allowed for users in your
organization).

On the Enforce Policy page, select the Organizational Unit (OU) for which the policy
will be applied. To do so, click Add to open the Select Objects window, then select
the OU from the list. To continue, click OK then Next.

To complete the wizard, click Finish.

Applying a new policy

To manage Office 365 user licenses

1.

From the Web Interface, assign, or modify the Office 365 license for an Azure
AD User.

The Policy is triggered for any Azure AD user in the Organization Unit for which the
0365 and Azure Tenant selection policy is applied.

If the policy conditions are not satisfied while assigning or modifying Azure AD User
licenses, the following policy violation error is displayed:

Provisioning policy failure. The 'O365 and Azure Tenant Selection' policy encountered
an error. Exception in Azure Tenant Management Policy violation: The Azure user
License(s) 0365_BUSINESS_ESSENTIALS-PROJECTWORKMANAGEMENT, cannot be
assigned. The policy prescribes that this Azure User requires only the specified
license in the Policy Object to be assigned.

To check if there are any policy violations, right-click and click Check Policy.
For a container object, this displays the Check Policy dialog.

Review the options in the Check Policy dialog and click OK.

The Policy Check Results window is displayed.

IMPORTANT: Office 365 user license management now allows Administrator to
select a subset of the licenses selected in policy during user creation or
modification.

Office 365 user roles management through provisioning policy

From the Web Interface, assign or modify the Office 365 roles for an Azure AD User.

While creating an Azure AD user from the Active Roles Web Interface, if the policy
conditions are not satisfied while assigning Azure AD User roles, the following policy
violation error is displayed:

Provisioning policy failure. The 0365 and Azure Tenant Selection policy encountered an
error. Exception in Azure Tenant Management Policy violation: The Azure user Role(s)
cannot be assigned. The policy prescribes that this Azure User requires only the specified
role in the Policy Object to be assigned.
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Figure 56: OneDrive folder management wizard

OneDrive Folder Management
Upon creation or renaming of user accounts, the policy manages user OneDrive v
folders as you spedfy in this step.

Note : If the below fields are left empty, the OneDrive folder will not be provisioned.

Sharepoint Admin Url : ||

Size(in GB) :

Before provisioning OneDrive for users:

» SharePoint Online license must be assigned to users to provision
OneDrive for the users.

« SharePoint Online Management Shell must be installed.

Provisioning OneDrive for Azure AD users
1. From the Web Interface, create an Azure AD User, and assign a valid SharePoint
Online license.

2. After the user is created, the OneDrive provisioning process is performed in the
background and after some time the process is completed.

NOTE: Consider the following when provisioning OneDrive:

e If the SharePoint Admin URL is incorrect then the OneDrive provisioning is
not successful.

e For an existing Azure AD user, during modification of user properties:
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» If OneDrive is not provisioned, then OneDrive provisioning is triggered.

» If OneDrive is provisioned, and any changes are made to the OneDrive
provisioning policy, then the policy changes are applied on the user.

3. To check the provisioning result, open Azure Properties window for the user from the
Web Interface, navigate to the OneDrive tab.

On successful provisioning of the user, the OneDrive URL, the used storage size, and
the total storage size are displayed.

NOTE: The storage size indicated in the policy gets synchronized to the Azure AD
user's OneDrive.

E-mail Alias Generation

Policies in this category are intended to automate the assignment of the email alias when
designating a user as mailbox-enabled on Microsoft Exchange Server. By default, Microsoft
Exchange Server provides for the following recipient email address format: <email-
alias>@<domain-name>

You can use predefined rules to generate email aliases, or configure custom rules. For
example, you can configure a policy to compose the email alias of the first initial followed
by the last name of the user. Custom rules provide for the addition of an incremental
numeric value to ensure uniqueness of the alias. You can also specify whether the alias can
be modified by the operator who creates or updates the user account.

How the E-Mail Alias Generation policy works

When making a user mailbox-enabled, Active Roles relies on this policy to assign a certain
email alias to the user account. The policy generates the alias based on user properties,
such as the pre-Windows 2000 user logon name, first name, initials, and last name. A
custom rule can be configured to use other properties.

A custom rule can also be configured to add so-called uniqueness number. A uniqueness
number is a numeric value the policy includes into the alias, incrementing that value in the
event of an alias naming conflict. For example, the policy can automatically change the
generated alias from John.Smith to John1.Smith if a mailbox with the alias John.Smith
already exists. If the alias John1.Smith is also in use, the new alias will be changed to
John2.Smith, and so on.

The policy configuration provides the option to allow or disallow manual edits of policy-
generated aliases. Permission to modify a policy-generated alias can be restricted to the
case where the alias is in use by another mailbox.

Some specific features of the policy behavior are as follows:

e With a rule that does not use a uniqueness number, Active Roles simply attempts to
assign the generated alias to the user account. The operation may fail if the
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generated alias is not unique, that is, the alias is already assigned to a different user
account. If the policy allows manual edits of policy-generated aliases, the alias can be
corrected by the operator who creates the user account.

e With a custom rule that uses a uniqueness number, Active Roles adds a button at the
client side, next to the Alias field on the user creation and modification forms.

To generate an alias, the client user (operator) must click that button, which also
applies if the generated alias is in use. Clicking Generate increases the uniqueness
number by one, thereby allowing the alias to be made unique.

e With a custom rule configured to include user properties that are normally not
displayed on the user creation forms, an extra page is added to the New Object -
User Wizard in the Active Roles Console, making it possible to specify the user
properties required to generate the alias.

e The policy defines a list of characters that are unacceptable in e-mail aliases. Space
characters and the following characters are not accepted:

@*+|=\;:?[1,<>/

e The policy denies processing of operation requests that assign the empty value to the
e-mail alias.

» When checking user accounts for Active Roles policy compliance, Active Roles
detects, and reports on, the aliases that are not set up as prescribed by the alias
generation policy.

Configuring an E-mail Alias Generation policy

You can configure a new E-mail Alias Generation policy with the Active Roles Console.
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To configure an E-mail Alias Generation policy

1. Onthe Policy to Configure page, select E-mail Alias Generation, and click Next.

Mew Provisioning Policy Dbject Wizard ed 4

E-mail Alias Generation Rule

Configure policy ko automatically sek up e-mail alias for newly created user
accounts,

Set e-mail alias to:

" User logon name {pre-Wwindows Z000)

™ First nitial Followed by last name (example: I5mith)

™ First name Followed by last initial (example: Johns)

™ First name followed by last name (example: John3mith)

& Cther combination of user properties:

iZlick Comfigure ta seb up alias gemeratian rule, Configure... |

[T allow manual edits of e-mail alias

0 nlways

£ Ol if & unigue alias cannet be generated by this palicy

< Back Cancel Help

2. Onthe E-mail Alias Generation Rule page, do the following:

» Select one of the preconfigured generation rules, or create a custom alias-
generation rule. To create a custom rule, click Other combination of user
properties, click Configure, and complete the Configure Value dialog as
described later in the procedure.

e If you want the email alias to be allowed for manual edit, select Allow manual
edits of e-mail alias. Then, do one the following:

e Click Always to authorize the operator who creates or updates the user
account to modify the email alias.

» Click Only if a unique alias cannot be generated by this policy to
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allow manual changes only in the situation where a policy-generated
alias is already assigned to a different user account.

Click Next.

3. On the Enforce Policy page, you can specify objects to which this Policy Object is to
be applied:

e Click Add, and use the Select Objects dialog to locate and select the
objects you want.

4. Click Next, then click Finish.

To complete the Configure Value dialog

1. Click Add.

2. Configure an entry to include in the value. For more information, see
Configuring entries.

3. In the Configure Value dialog, add more entries, delete or edit existing ones,
and click OK.

Configuring a custom generation rule

To configure a custom rule, click Other combination of user properties, then click
Configure. This displays the Configure Value dialog, as described in Configuring a
Property Generation and Validation policy. You can use that dialog to set up a value for the
*Alias’ must be condition, the same way you configure a Property Generation and
Validation policy.

To start configuring a value, click Add in the Configure Value dialog. This displays the
Add Entry window.

A value is a concatenation of one or more entries. In the Add Entry window, you can select
the type of the entry to add, and then configure the entry. The following table summarizes
the available types of entries.

Table 8: Available entries

Type of Description
entry
Text Adds a text string to the value.

Uniqueness  Adds a numeric value the policy will increment in the event of an alias
Number naming conflict.

User Adds a selected property (or a part of a property) of the user account to
Property which the policy will assign the alias.

Parent OU Adds a selected property (or a part of a property) of an Organizational Unit
Property in the hierarchy of containers above the user account to which the policy

will assign the alias.
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Type of Description

entry

Parent Adds a selected property (or a part of a property) of the domain of the
Domain user account to which the policy will assign the alias.

Property

Instructions on how to configure an entry depend on the type of the entry. For more
information on how to configure each entry type, see the following resources:

» Text: See Entry type: Text.

e Uniqueness Number: See Entry type: Uniqueness Number.
e User Property: See Entry type: <Object> Property.
 Parent OU Property: See Entry type: Parent OU Property.

 Parent Domain Property: See Entry type: Parent Domain Property.

When you are done configuring a value, click OK to close the Configure Value dialog. This
will add the value to the policy rule. If necessary, you can modify the value by clicking
Configure, then managing the list of entries in the Configure Value dialog.

When you are done configuring the policy rule, click Next on the E-mail Alias Generation
Rule page and follow the instructions in the wizard to create the Policy Object.

Scenario: Generating e-mail alias based on user
names

The policy described in this scenario generates the e-mail alias in accordance with this
rule: user first name, optionally followed by a three-digit uniqueness number, followed
by a period, followed by the user last nhame. Examples of aliases generated by this rule
are as follows:

e John.Smith
e John001.Smith
e John002.Smith

The policy generates the alias John001.Smith for the user John Smith if the alias
John.Smith is in use. If both John.Smith and John001.Smith are in use, the policy
generates the alias John002.Smith, and so on.

To implement this scenario, you must perform the following actions:

1. Create and configure the Policy Object that defines the appropriate policy.
2. Apply the Policy Object to a domain, OU, or Managed Unit.

As a result, when assigning an email alias to a user account in the container you selected in
Step 2, the Active Roles user interfaces provide a Generate button to create the alias in
accordance with the policy rule. In the event of an alias naming conflict, clicking Generate
causes the policy to add a uniqueness number to the alias.
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The following two sections elaborate on the steps to implement this scenario.

Creating and configuring the Policy Object

You can create and configure the Policy Object you need by using the New Provisioning
Policy Object Wizard. For information about the wizard, see Creating a Policy Object.

To configure the policy, click E-mail Alias Generation on the Select Policy Type page of
the wizard. Then, click Next.

On the E-mail Alias Generation Rule page, click Other combination of user
properties, and then click Configure.

Complete the Configure Value dialog as follows:
1. Click Add.
2. Configure the entry to include the user first name:
a. Under Entry type, click User Property.
b. Under Entry properties, click Select.

c. Inthe Select Object Property window, click First Name in the Object
property list, and then click OK.

d. Click OK.
3. Click Add.
4. Configure the entry to optionally include a uniqueness number:
a. Under Entry type, click Uniqueness Number.
b. Under Entry properties, set the entry options:
e Click Add if the property value is in use.
» Select the Fixed-length number, with leading zeroes check box.
e Inthe box next to Length of the number, in digits, type 3.
c. Click OK.
5. Click Add.
6. Configure the entry to include the period character:
a. In Text value under Entry properties, type the period character.
b. Click OK.
7. Click Add.
8. Configure the entry to include the user last name:
a. Under Entry type, click User Property.
b. Under Entry properties, click Select.

c. Inthe Select Object Property window, click Last Name in the Object
property list, and then click OK.

d. Click OK.
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After you complete these steps, the list of entries in the Configure Value dialog
must look like the following figure.

¥/ Configure Yalue ed |

‘Alias’ musk be:

'Firsk Mame [giventlame), Fallowed by

3-digit uniqueness number - add if the property value is in use, Followed by

"', Followed by REmOVE

'Lask Mame {sn)’
Edit...

Configured walue;

%o <givenhlame ={@counter{optional, 3k % <sn >

Cancel

== Ll

9. Click OK to close the Configure Value dialog. Then, click Next and follow the
instructions in the wizard to create the Policy Object.

Applying the Policy Object

You can apply the Policy Object by using the Enforce Policy page in the New
Provisioning Policy Object Wizard, or you can complete the wizard and then use the
Enforce Policy command on the domain, OU, or Managed Unit where you want to apply
the policy.

For more information on how to apply a Policy Object, see Applying Policy Objects and
Managing policy scope.

User Account Deprovisioning

Policies in this category are intended to automate the following deprovisioning-related
tasks on user accounts:

e Disable the user account.
e Set the user password to a random value.

e Set the user’s logon names to random values.
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e Rename the user account.

» Modify other properties of the user account.

When configuring a policy of this category, you specify how you want Active Roles to modify
the user’s account in Active Directory upon a request to deprovision a user so that once the
deprovision operation is completed, the deprovisioned user cannot log on to the network.

You may also configure a policy to update any user properties, such as those that regulate
users’ membership in Active Roles Managed Units. In this way, the policy can automate the
addition or removal of deprovisioned users from Managed Units.

How the User Account Deprovisioning policy
works

When processing a request to deprovision a user, Active Roles uses this policy to modify
the user’s account so that once the user has been deprovisioned, they cannot log on to
the network.

A policy can also be configured to update user accounts. Depending on the policy
configuration, each policy-based update results in the following:

e Certain portions of account information are removed from the directory by resetting
specified properties to empty values.

e Certain properties of user accounts are set to new, non-empty values.
A policy can be configured so that new property values include:

e Properties of the user account being deprovisioned, retrieved from the directory prior
to starting the process of the user deprovisioning.

e Properties of the user who originated the deprovisioning request.

e Date and time when the user was deprovisioned.

Thus, when deprovisioning a user, Active Roles modifies the user’s account in Active
Directory as determined by the User Account Deprovisioning policy that is in effect.

Configuring a User Account Deprovisioning policy

To configure a User Account Deprovisioning policy

1. On the Policy to Configure page, select User Account Deprovisioning, and then
click Next.
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Figure 57: User Account Deprovisioning
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2. Onthe Option to Prevent Logon page, select the options you want the policy to
apply when deprovisioning a user account. You can select any combination of these
options:

» Disable the user account

» Set the user’'s password to a random value

o Set the user logon name to a random value

o Set the user logon name (pre-Windows 2000) to a random value
« Rename the user account to

3. Ifyou selected Rename the user account to, click Configure, and then complete
the Configure Value dialog by using the procedure outlined later in this topic, in
order to specify how you want the policy to update the user name when
deprovisioning a user account.

4. Click Next.
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On the Properties to Be Updated page, specify how you want the policy to update
user properties when deprovisioning a user account:

e Click Add, and then complete the Select Object Property dialog by using the
procedure outlined later in this topic, in order to add property update rules.

e Use View/Edit to modify existing rules.

» Use Remove to delete existing rules.

6. Click Next.
7. On the Enforce Policy page, you can specify objects to which this Policy Object is to

8.

be applied:

e Click Add, and use the Select Objects dialog to locate and select the
objects you want.

Click Next, and then click Finish.

To complete the Configure Value dialog

1. Click Add.

Configure an entry to include in the value. For more information, see
Configuring entries.

In the Configure Value dialog, add more entries, delete or edit existing ones, and
then click OK.

To complete Select Object Property dialog

1.

2.

From the Object property list, select an object property, and then click OK. The
Add Value dialog appears.

If you select multiple properties, the Add Value dialog is not displayed. The
properties you have selected are added to the list on the Properties to Be Updated
page, with the update rule configured to clear those properties, that is, to assign
them the “empty” value.

In the Add Value dialog, do one of the following:

e Select Clear value if you want the update rule to assign the empty value to
the property.

e Select Configure value if you want the update rule to assign a certain, non-
empty value to the property. Then, click Configure and complete the
Configure Value dialog by using the instructions given earlier in this topic.

Configuring a property update rule

To configure a property update rule for the user name, click Configure. This shows the
Configure Value dialog, as described in Configuring a Property Generation and Validation
policy. You can use that dialog to set up a value for the ‘name” must be condition, in the
same way as you do when configuring a Property Generation and Validation policy.

To start configuring a value, click Add in the Configure Value dialog. This displays the
Add Entry window.
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A value is a concatenation of one or more entries. In the Add Entry window, you can select
the type of the entry to add, and then configure the entry. The following table summarizes
the available types of entries.

Table 9: Types of entries: Configuring a property update rule

Type of Description

entry
Text Adds a text string to the value.
User Adds a selected property (or a part of a property) of the user account being

Property  deprovisioned.

Parent OU Adds a selected property (or a part of a property) of an Organizational Unit in
Property  the hierarchy of containers above the user account being deprovisioned.

Parent Adds a selected property (or a part of a property) of the domain of the user
Domain account being deprovisioned.
Property

Dateand Adds the date and time when the account was deprovisioned.
Time

Initiator Adds a string that identifies the Initiator, that is, the user who originated the
ID deprovisioning request. This entry is composed of Initiator-related
properties, retrieved from the directory.

Instructions on how to configure an entry depend on the type of the entry. For more
information on how to configure each entry type, see the following resources:

» Text: See Entry type: Text.
» User Property: See Entry type: <Object> Property.
« Parent OU Property: See Entry type: Parent OU Property.

* Parent Domain Property: See Entry type: Parent Domain Property.

The following subsections elaborate on the Date and Time and Initiator ID entries.

Entry type: Date and Time

When you select Date and Time under Entry type in the Add Entry window, the Entry
properties area looks as follows.
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Figure 58: Entry type: Date and Time
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Descripkion:
Adds the date and time when the user was deprovisioned

Using this entry type, you can add an entry that represents the date and time when the
user account was deprovisioned.

In the list under Date and time format, click the date or time format you want. Then,
click OK to close the Add Entry window.

Entry type: Initiator ID

When you select Initiator ID under Entry type in the Add Entry window, the Entry
properties area looks as follows.
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Figure 59: Entry type: Initiator ID
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With this entry type, you can add a string that identifies the Initiator, that is, the user who
originated the deprovisioning request. The policy generates the Initiator ID based on
certain properties of the Initiator’s account, such as the user logon name. A custom rule
can be configured to use other properties.

You can choose a pre-configured rule or configure a custom rule to generate the Initiator
ID. The pre-configured rules allow you to set the Initiator ID to one of the following:

e The pre-Windows 2000 user logon name of the Initiator, in the form
DomainName\UserName.

e The user logon name of the Initiator.

A custom rule allows you to compose the Initiator ID of other Initiator-related properties.

Configuring a custom rule to build the Initiator ID

To configure a custom rule for Initiator ID, click the lowermost option under Entry
properties, then click Configure. This displays the Configure Value dialog, described in
Configuring a Property Generation and Validation policy. You can use that dialog to set up a
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value for the ‘Initiator ID’" must be condition, in the same way as you do when
configuring a Property Generation and Validation policy.

To start configuring a value, click Add in the Configure Value dialog. This displays the
Add Entry window.

A value is a concatenation of one or more entries. In the Add Entry window, you can select
the type of the entry to add, and then configure the entry. The following table summarizes
the available types of entries.

Table 10: Available entries for Configuring a custom rule to build the Initiator ID

Type of Description

entry

Text Adds a text string to the value.

Initiator Adds a selected property (or a part of a property) of the Initiator’s user
Property account.

Parent OU Adds a selected property (or a part of a property) of an Organizational Unit
Property in the hierarchy of containers above the Initiator’s user account.

Parent Adds a selected property (or a part of a property) of the domain of the
Domain Initiator’s user account.

Property

Instructions on how to configure an entry depend on the type of the entry. For more
information on how to configure each entry type, see the following resources:

e Text: See Entry type: Text.

« Initiator Property: See Entry type: <Object> Property.

« Parent OU Property: See Entry type: Parent OU Property.
 Parent Domain Property: See Entry type: Parent Domain Property.

When you are done configuring a value for the ‘Initiator ID" must be condition, click OK
to close the Configure Value dialog. This will add the value to the Initiator ID entry
properties. If necessary, you can modify the value by clicking the Configure button in the
Add Entry window and then managing the list of entries in the Configure Value dialog.

When you are done configuring the Initiator ID entry, click OK to close the Add
Entry window. The entry is added to the Configure Value dialog for the ‘'name’ must
be condition.

When you are done configuring a value for the ‘name’ must be condition, click OK to close
the Configure Value dialog. This will add the rule to the Options to Prevent Logon
page of the wizard. If necessary, you can modify the rule by clicking Configure on that
page and then managing the list of entries in the Configure Value dialog.

Once you have completed the Options to Prevent Logon page, click Next to display the
Properties to Be Updated page.
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Figure 60: Properties to Be Updated
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On this page, you can set up a list of user properties you want the policy to update. Each
entry in the list includes the following information:

* Property: When deprovisioning a user, Active Roles will update this property of the
user’s account.

 LDAP Display Name: Uniquely identifies the property to be updated.

» Value to Assign: After the deprovisioning operation is completed, the property has
the value defined by this syntax.

You can use these buttons to manage the list on this page:

e Add: Allows you to select a property and configure an update rule for that
property. A property update rule specifies how to generate the new value to assign
to the property.

« Remove: If you want the policy to no longer update a given property, select the
property from the list and click Remove.
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e View/Edit: Allows you to modify the update rule for the property you select
from the list.

Clicking Add displays the Select Object Property dialog where you can choose user
properties you want to the policy to update. To choose a property, select the check box
next to the property name, and then click OK.

You can select multiple check boxes. If you do so, the properties you have selected are
added to the list on the wizard page, with the update rule configured to clear those
properties, that is, to assign them the empty value.

If you select a single property in the Select Object Property dialog, you are presented
with the Add Value dialog so you can proceed to configuring a property update rule.

Figure 61: Add Value
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You can select one of these update options:

e Clear value: Causes the policy to assign the empty value to the property.

e Configure value: Allows you to configure a value for the ‘property’ must
be condition.

With the second option, you must configure a value the policy will assign to the property
upon the user deprovisioning. You can configure a value in the same way as you do when
configuring a property update rule for the user name: Click Configure and follow the
instructions provided in Configuring a property update rule.

When you are done configuring a value, click OK to close the Add Value dialog. The
property name along with the property update rule is added to the wizard page. If
necessary, you can modify the update rule by clicking View /Edit beneath the list of
properties. This displays a dialog, similar to the Add Value dialog, allowing you to choose a
different update option or set up a different value for the *‘property’ must be condition.
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Once you have set up the list on the wizard page, click Next and follow the instructions in
the wizard to create the Policy Object.

Scenario 1: Disabling and renaming the user
account upon deprovisioning

The policy described in this scenario performs the following functions during the user
deprovisioning process:

» Disable the user account.

e Append this suffix to the user name: - Deprovisioned, followed by the date that the
user account was deprovisioned.

For example, the policy changes the user name John Smith to John Smith -
Deprovisioned 12/11/2010.

To implement this scenario, you must perform the following actions:

1. Create and configure the Policy Object that defines the appropriate policy.
2. Apply the Policy Object to a domain, OU, or Managed Unit.

As a result, when deprovisioning a user account in the container you selected in Step 2,
Active Roles disables and renames the user account as prescribed by this policy.

The following two sections elaborate on the steps to implement this scenario.

Creating and configuring the Policy Object

You can create and configure the Policy Object you need by using the New
Deprovisioning Policy Object Wizard. For information about the wizard, see Creating a
Policy Object.

To configure the policy, click User Account Deprovisioning on the Select Policy Type
page of the wizard. Then, click Next.

On the Options to Prevent Logon page, select these check boxes:

e Disable the user account

 Rename the user account to

Then, click Configure, and use the following instructions to complete the Configure
Value dialog.

1. Click Add.

2. Inthe Add Entry window, click User Property under Entry type, and configure the
entry as follows:

a. Click Select and choose the Name property.

b. Click All characters of the property value.
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c. Click OK.
3. Click Add.

4. In the Add Entry window, click Text under Entry type, and configure the
entry as follows:

a. Inthe Text value box, type - Deprovisioned.
b. Click OK.
5. Click Add.

In the Add Entry window, click Date and Time under Entry type, and configure
the entry as follows:

a. From the list under Date and time format, select the format m/d/yyyy.
b. Click OK.

After you complete these steps, the list of entries in the Configure Value dialog should
look like the following figure.

Figure 62: Configure Value
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Click OK to close the Configure Value dialog. Then, click Next and follow the instructions
in the wizard to create the Policy Object.
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Applying the Policy Object

You can apply the Policy Object by using the Enforce Policy page in the New
Provisioning Policy Object Wizard, or you can complete the wizard and then use the
Enforce Policy command on the domain, OU, or Managed Unit where you want to apply
the policy.

For more information on how to apply a Policy Object, see Applying Policy Objects and
Managing policy scope.

Scenario 2: Managed Unit for deprovisioned
user accounts

This scenario describes how to configure a Managed Unit and a User Account
Deprovisioning policy so that the Managed Unit includes all the deprovisioned user
accounts. The policy sets the Notes property to Deprovisioned upon the user
deprovisioning, whereas the Managed Unit is configured to include user accounts that have
the Notes property set to Deprovisioned.

To implement this scenario, you must perform the following actions:

1. Create and configure the Managed Unit.
2. Configure the Policy Object that defines the appropriate policy.
3. Apply the Policy Object to a domain, OU, or Managed Unit.

As a result, after deprovisioning a user account in the container you selected in Step 3,
Active Roles automatically adds that account to the Managed Unit you created in Step 1.

The following sections elaborate on the steps to implement this scenario.

Creating and configuring the Managed Unit

You can create and configure the Managed Unit by using the Active Roles Console.

To create and configure the Managed Unit for deprovisioned users

1. Inthe Console tree, under Configuration, right-click Managed Units, and select
New > Managed Unit.

2. In Name, enter a name for the Managed Unit. For example, enter
Deprovisioned Users.

3. Click Next.

4. Configure the membership rule to have the Managed Unit include the
deprovisioned user accounts from all domains that are registered with Active Roles
(managed domains):
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a. Onthe wizard page, click Add.

. In the Membership Rule Type dialog, click Include by Query, and
then click OK.

c. Use the Create Membership Rule window to set up the rule:
e In Find, click Users.
» Click Browse and select Active Directory.
e Click Advanced.
e Click Field, then click Notes.
» In Condition, click Is (exactly).
e In Value, enter Deprovisioned.

At this point, the window must look like the following figure.

Figure 63: Find Groups
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e Click Add.

e Click Add Rule.
5. On the wizard page, click Add.
6. Inthe Membership Rule Type dialog, click Retain Deprovisioned, then click OK.
7. Click Next, click Next, and then click Finish.

Configuring the Policy Object

You can configure the Policy Object you need by modifying the Policy Object that
implements the scenario described in Scenario 1: Disabling and renaming the user account
upon deprovisioning.
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Display the Properties dialog for that Policy Object and go to the Policies tab. Then,
select the policy from the list, and click View /Edit to display the Group Object
Deprovisioning Policy Properties dialog. Click Change Properties.

The Change Properties tab looks similar to the page of the same name in the wizard
you used to create the Policy Object. You can use that tab to add the update rule for the
Notes property:

1. Click Add to display the Select Object Property dialog.
2. Select the check box next to the Notes property, and then click OK.

3. Inthe Add Value dialog, type Deprovisioned in the *‘Notes’ must be box, and
then click OK.

Click OK to close the Group Object Deprovisioning Policy Properties dialog.

Applying the Policy Object

You can apply the Policy Object without closing its Properties dialog. Go to the Scope tab
and do the following:

1. On the Scope tab, click the Scope button to display the Active Roles Policy Scope
window for the Policy Object you are managing.

2. Click Add and select the domain, OU, or Managed Unit where you want to apply
the policy to.

You can also use the Remove button to remove items where you want the policy to
no longer be applied.

3. Click OK to close the Active Roles Policy Scope window.
4. Click OK to close the Properties dialog for the Policy Object.

For more information on how to apply a Policy Object, see Applying Policy Objects and
Managing policy scope.

Office 365 Licenses Retention

This policy is intended to automate retention of all or selected Microsoft 365 licenses
assigned to an Azure AD user after the Azure AD user is deprovisioned successfully.

How the Microsoft 365 Licenses Retention
policy works

When processing a request to deprovision an Azure AD user, Active Roles uses this policy to
determine if the licenses assigned to the Azure AD user must be retained.
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When an Azure AD User is deprovisioned, this policy ensures that the administrator-
assigned Microsoft 365 licenses are retained based on the policy configuration.

You can configure the Office 365 Licenses Retention policy to specify how you want
Active Roles to modify the Azure AD user’s licenses in Azure AD upon a request to
deprovision the Azure AD user.

When an Azure user is deprovisioned from the Active Roles Console, Web Interface, or
Management Shell, the Microsoft 365 licenses that were assigned to the user during user
provisioning are retained based on the Office 365 Licenses Retention policy
configuration. As per the policy set, all the licenses or only selected licenses are retained
upon the user deprovision.

The changes that take effect after deprovisioning the user are reflected in the Azure portal
and the Azure Properties > Licenses tab of the Azure AD user in the Web Interface.

Active Roles Console enables you to create a new Deprovisioning Policy Object or add to the
existing Built-in Policy — User Default Deprovisioning policy. For instructions on how
to create a Deprovisioning Policy Object, see Creating a Policy Object. The Office 365
Licenses Retention policy from the User Deprovisioning Policies must be selected to
enable retention of the required Microsoft 365 licenses upon Azure AD user deprovisioning.

NOTE: The Office 365 Licenses Retention policy is enabled only if Azure AD is
configured.

Configuring a Microsoft 365 license retention
policy

You can configure a new Microsoft 365 license retention policy with the Office 365
License Retention policy type in the Active Roles Console.

To configure an Microsoft 365 license retention policy

1. On the Policy to Configure page, select Office 365 License Retention,
then click Next.
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Figure 64: Office 365 Licenses Retention page
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2. On the Office 365 Licenses Retention page, select the options you want the policy
to apply when deprovisioning the Azure AD user.

« Select the tenant from which the licenses have to be retained for the user from
the drop-down list.

e Select the check box corresponding to Retain all the licenses option to

enable the deprovisioned Azure AD user to retain all the Microsoft 365 licenses
after successful deprovisioning.

e Select the check boxes corresponding to the specific Microsoft 365 subscription
plans and licenses that the deprovisioned Azure AD must retain after successful
deprovisioning.

3. Click Next.

The Enforce Policy page is displayed, which enables you to specify objects to which
this Policy Object is to be applied.

4. Click Add, and use the Select Objects dialog to locate and select the objects on
which you want to enforce the policy.

5. Click Next, then click Finish.

NOTE: Consider the following when configuring an Microsoft 365 licenses retention
policy:

o After performing an Undo Provisioning operation on the deprovisioned Azure AD
user, the original licenses assignment made to the user at the time of user
provisioning is restored to the user.

e In Active Roles with Office365 Licenses Rention policy applied, when a

deprovisioned Azure AD user tries to set licenses, a policy violation error is
displayed.
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e For more information on deprovisioning Policy Objects and creating new
deprovisioning policies see Deprovisioning Policy Objects and Creating a
Policy Object.

Report on deprovisioning results

The Deprovisioning Results window displays the deprovision operation results pertaining
to the Office 365 Licenses Retention policy. The results display a report of the success or
failure of the policy.

Table 11: Office 365 License Retention policy

Report item (success) Report item
(failure)
In accordance with the policy, the Azure AD user's Office 365 Not applicable

licenses are retained.

Azure User Office 365 licenses are retained. Not applicable

Group Membership Removal

Policies in this category are intended to automate the removal of deprovisioned user
accounts from groups. A policy can be configured to remove user accounts from all groups
with optional exceptions. Individual policy rules can be applied to security groups and to
mail-enabled groups of both the security and distribution type.

How the Group Membership Removal policy works

When processing a request to deprovision a user, Active Roles uses this policy to determine
what changes are to be made to group memberships of the user account. By removing the
account from security groups, the policy revokes user access to resources. By removing the
account from mail-enabled groups, the policy prevents erroneous situations where email is
sent to the deprovisioned mailbox.

IMPORTANT: The deprovisioned users are automatically removed from all Dynamic
Groups, regardless of the Group Membership Removal policy settings.

A Group Membership Removal policy includes separate rules for security groups and for
mail-enabled groups. For each category of groups, a rule can instruct Active Roles to
perform one of the actions that are summarized in the following table.
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Table 12: Group Membership Removal policy includes separate rules

Category Action Result

Security Do not The deprovisioned user remains in all security groups it was

groups remove from a member of as of the time of deprovisioning, except for the
groups. Dynamic Groups.

Remove from The deprovisioned user is removed from all security groups.

all groups.
Remove from The deprovisioned user is not removed from the specified
all groups security groups, with the exception of Dynamic Groups. The
except for user is removed from all the other security groups.
the specified
ones.
Mail- Do not The deprovisioned user is not removed from distribution
enabled remove from groups or mail-enabled security groups, except for the
groups groups. Dynamic Groups.
Remove from The deprovisioned user is removed from all distribution
all groups. groups and from all mail-enabled security groups.
Remove from The deprovisioned user is not removed from the specified
all groups distribution or mail-enabled security groups, with the
except for exception of Dynamic Groups. The user is removed from all
the specified the other distribution and mail-enabled security groups.
ones.

In the event of a conflict in policy implementation, the remove action takes precedence. For
example, with a rule configured to remove the user account from all security groups, the
user account is removed from all security groups even if there is another rule according to
which Active Roles does not remove the user account from mail-enabled security groups.

Another conflict may occur in the situation where a policy of this category attempts to
remove a deprovisioned user from a group that is configured as an Active Roles Dynamic
Group (for more information, see Dynamic groups). The Dynamic Group policy detects the
removal, and might add the deprovisioned user back to the Dynamic Group. To avoid this,
Active Roles does not allow Dynamic Groups to hold deprovisioned users. Once a user is
deprovisioned, the user account is removed from all Dynamic Groups.

Configuring a Group Membership Removal policy

You can configure a new Group Membership Removal policy with the Active Roles Console.
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To configure a Group Membership Removal policy

1. On the Policy to Configure page, select Group Membership Removal,
then click Next.

Figure 65: Removal from Security Groups

Mew Deprovisioning Policy Object Wizard

Removal from Security Groups

You can specify hiow wou want the policy to remove deprovisioned users from
securiby groups,

once a user is deprovisioned, the selected options are applied to the usetr's account,
i Do nok remove from security groups

& Remove From all security groups, with optional exceptions

|_ Keep the user account in these security groups:

Mame | In Folder |
Gdd... Remowe Properties
< Back Cancel Help

2. Onthe Removal from Security Groups page, do one of the following:

e Click Do not remove from security groups for the policy not to make
changes to security group memberships of the user account.

» Click Remove from all security groups, with optional exceptions for the
policy to remove the user account from all security groups.

3. Ifyou selected Remove from all security groups, with optional exceptions,
specify whether you want the policy not to remove the user account from certain
security groups. Do one of the following:

» Select the Keep the user account in these security groups check box and
set up the list of security groups from which you want the policy not to remove
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the user account.

» If you want the policy to remove the user account from all security groups,
leave the check box cleared.

4. Click Next.
5. Onthe Removal from Mail-enabled Groups page, do one of the following:

e Click Do not remove from mail-enabled groups for the policy not to make
changes to mail-enabled group memberships of the user account.

» Click Remove from all mail-enabled groups, with optional exceptions
for the policy to remove the user account from all mail-enabled groups.

Figure 66: Removal from Mail-enabled Groups

Mew Deprovisioning Policy Object Wizard i ilil

Removal from Mail-enabled Groups

You can specify hiow wou want the policy to remove the deprovisioned users
From both diskribukion groups and mail-enabled security groups.,

once a user is deprovisioned, the selected options are applied to the user's account, This
policy affects both diskribution and mail-enabled security groups, collectively referred to as
mail-enabled groups.

" Do not remave From mail-enabled groups

& Remave From all mail-enabled groups, with optional exceptions

™ Keep the user account in these mai-enabled groups:

Mame | In Folder |

&dd, ., Remaye Broperties

< Back Cancel Help

6. If you selected Remove from all mail-enabled groups, with optional
exceptions, specify whether you want the policy not to remove the user account
from certain mail-enabled groups. Do one of the following:
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» Select the Keep the user account in these mail-enabled groups check
box and set up the list of mail-enabled groups from which you want the policy
not to remove the user account.

e If you want the policy to remove the user account from all mail-enabled
groups, leave the check box cleared.

7. Click Next.
8. On the Enforce Policy page, you can specify objects to which this Policy Object is to
be applied:

e Click Add, and use the Select Objects dialog to locate and select the
objects you want.

9. Click Next, then click Finish.

Scenario: Removing deprovisioned users from
all groups

The policy described in this scenario, removes the deprovisioned users from all groups,
both security and distribution.

To implement this scenario, you must perform the following actions:

1. Create and configure the Policy Object that defines the appropriate policy.
2. Apply the Policy Object to a domain, OU, or Managed Unit.

As a result, when deprovisioning a user account, Active Roles removes the user account
from all groups.

Creating and configuring the Group Membership Removal
Policy Object
You can create and configure the Policy Object you need by using the New

Deprovisioning Policy Object Wizard. For information about the wizard, see Creating a
Policy Object.

To configure the policy, click Group Membership Removal on the Select Policy Type
page of the wizard. Then, click Next and follow these steps:

1. Onthe Removal from Security Groups page:
a. Click Remove from all security groups, with optional exceptions.

b. Verify that the Keep the user account in these security groups check box
is cleared.

c. Click Next.

2. Onthe Removal from Mail-enabled Groups page:
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a. Click Remove from all mail-enabled groups, with optional exceptions.

b. Verify that the Keep the user account in these mail-enabled groups
check box is cleared.

c. Click Next.

3. Click Next and follow the instructions in the wizard to create the Policy Object.

Applying the Policy Object

You can apply the Policy Object by using the Enforce Policy page in the New
Provisioning Policy Object Wizard, or you can complete the wizard and then use the
Enforce Policy command on the domain, OU, or Managed Unit where you want to apply
the policy.

For more information on how to apply a Policy Object, see Applying Policy Objects and
Managing policy scope.

Exchange Mailbox Deprovisioning

Policies of this category are intended to automate the following tasks on deprovisioning
Microsoft Exchange resources for deprovisioned users:

e Hide deprovisioned users from address lists.

e Prevent non-delivery reports from being sent.

» Grant designated persons full access to deprovisioned mailboxes.
e Redirect email addressed to deprovisioned users.

e Force the mailbox of the deprovisioned user to send automatic replies.

When configuring a policy of this category, you specify how you want Active Roles to modify
the user’s account and mailbox upon a request to deprovision a user. The purpose is to
reduce the volume of email sent to the mailbox of the deprovisioned user, and to authorize
designated persons to monitor such email.

How the Exchange Mailbox Deprovisioning
policy works

When processing a request to deprovision a user, Active Roles uses this policy to determine
the Exchange mailbox deprovisioning options, and then updates the user account and
mailbox accordingly.

The available mailbox-deprovisioning options are summarized in the following table. For
each option, the table outlines the policy effect on a user mailbox.
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Table 13: Policy effect on a user’s mailbox

Option

Policy effect

Hide the mailbox
from the Global
Address List (GAL),
to prevent access to
the mailbox

Prevent non-delivery
reports (NDR) from
being sent

Grant the user’s
manager full access
to the mailbox

Grant the selected
users or groups full
access to the mailbox

Disallow forwarding
messages to
alternate recipients

Forward all incoming
messages to the
user’'s manager

Leave copies in the
mailbox

Don’t change the
mailbox autoreply
settings

Auto-reply with the
following messages
(once for each
sender)

(GNE IDENTITY

by Quest

Prevents the deprovisioned user from appearing in your
Exchange organization’s address lists. If you select this option,
the deprovisioned user is hidden from all address lists.

This option renders the mailbox inaccessible. You cannot log
on to Exchange Server as the mailbox user or otherwise access
the hidden mailbox.

Prevents non-delivery reports from being generated when
emails are sent to the deprovisioned mailbox. (Non-delivery
report is a notice that a message was not delivered to the
recipient.)

Provides the person designated as the deprovisioned user’s
manager with full access to the mailbox of that user. The
manager is determined based on the Manager attribute of the
deprovisioned user account in Active Directory.

Provides the specified users or groups with full access to the
deprovisioned user mailbox.

Email addressed to the deprovisioned user is not forwarded to
an alternate recipient.

E-mail addressed to the deprovisioned user is forwarded to the
user’s manager. The manager is determined based on the
Manager attribute of the deprovisioned user account in Active
Directory.

Email addressed to the deprovisioned user is delivered to both
the mailbox of the user’'s manager and the mailbox of the
deprovisioned user. If you do not select this option, such email
is only delivered to the manager’s mailbox.

Active Roles makes no changes to the Automatic Replies
configuration of the mailbox. Thus, if the mailbox is configured
to send automatic replies, deprovisioning the mailbox user
does not cause the mailbox to stop sending automatic replies.

Active Roles configures the mailbox to send the Automatic
Replies messages specified by the policy. This option provides
for the following policy settings:

e The Automatic Replies message that is sent to senders
within the organization.

e Whether to send an Automatic Replies message to
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Option Policy effect

senders outside of the organization (external senders).

e Whether to send an Automatic Replies message to all
external senders or only to the user’s contacts.

e The Automatic Replies message that is sent to external
senders.

Configuring an Exchange Mailbox Deprovisioning
policy

You can configure a new Exchange Mailbox Deprovisioning policy with the Active
Roles Console.

To configure an Exchange Mailbox Deprovisioning policy

1. On the Policy to Configure page, select Exchange Mailbox Deprovisioning,
then click Next.
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Figure 67: Options to Deprovision Mailbox

MNew Deprovisioning Policy Object Wizard 7| x|

Options to Deprovision Mailbox
You can select policy options to deprovision Microsoft Exchange resources For
the deprovisioned users,

Onece a user is deprovisioned, the selected options are applied to the user's mailbo:,

[v Hide the mailbo:: From the global address lisk (GALY, to prevent access ko the mailbosx
v Prevent non-delivery reports {MDR) From being sent

[ Grant the user's manager full access ko the mailbox

™ Grant the selected users or groups Full access ko the mailbos

I Select,, |

[ Maodify configuration of the e-mail Forwarding

" Disallow forwarding messages b alternate recipients
€ Forward &l incaming messages to the user's manager

™| Leave copies i bhe mailbax

% Back Cancel Help

2. Onthe Options to Deprovision Mailbox page, select the options you want the
policy to apply when deprovisioning a user account. You can select any combination
of these options to deprovision Microsoft Exchange resources for the deprovisioned
user account:

 Hide the mailbox from the Global Address List (GAL), to prevent
access to the mailbox

* Prevent non-delivery reports (NDR) from being sent

+ Grant the user’'s manager full access to the mailbox

+ Grant the selected users or groups full access to the mailbox
* Modify configuration of the e-mail forwarding

3. Ifyou selected the Grant the selected users or groups full access to the
mailbox check box, click Select to specify the users or groups you want.
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4. If you selected the Modify configuration of the e-mail forwarding check box, do
one of the following:

e Click Disallow forwarding messages to alternate recipients to
specify that the email messages sent to the deprovisioned user are not to
be forwarded.

» Click Forward all incoming messages to the user’s manager to specify
that the email messages sent to the deprovisioned user are to be forwarded to
the manager of that user. Then, select or clear the Leave copies in the
mailbox check box to specify whether you want the messages to be delivered
to both the user’s mailbox and the manager’s mailbox or only to the
manager’s mailbox.

5. Click Next.
6. On the Automatic Replies page, choose from the following options:
 Don't change the mailbox autoreply settings

+ Automatically reply with the following messages (once for each
sender)

7. If you selected the Automatically reply with the following messages (once for
each sender) option, do the following:

» Inthe Inside organization box, specify the autoreply message to be sent to
senders within the user’s organization.

» If you want the mailbox to send an autoreply message to external senders,
select the Auto-reply to people outside organization check box, and
specify the message in the area beneath that check box.

» Select the User's contacts only or Anyone outside organization option
depending on whether you want the mailbox to auto-reply only to external
senders that are in the user’s Contacts folder or to all external senders,
respectively.

8. Click Next.
9. On the Enforce Policy page, you can specify objects to which this Policy Object is to
be applied:

e Click Add, and use the Select Objects dialog to locate and select the
objects you want.

10. Click Next, then click Finish.

Scenario: Hide mailbox and forward email to
manager

The policy described in this scenario performs the following functions during the user
deprovisioning process:
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» Hides the deprovisioned user from the Exchange organization’s address lists.

e Configures email forwarding so that email messages addressed to the deprovisioned
user are sent to the user’s manager, without delivering them to the user mailbox.

To implement this scenario, you must perform the following actions:

1. Create and configure the Policy Object that defines the appropriate policy.
2. Apply the Policy Object to a domain, OU, or Managed Unit.

As a result, when deprovisioning a user account in the selected container, Active Roles
hides the deprovisioned user from the Exchange address lists and configures the
forwarding address for that user as prescribed by this policy.

Creating and configuring the Exchange Mailbox
Deprovisioning Policy Object

You can create and configure the Policy Object you need by using the New
Deprovisioning Policy Object wizard. For information about the wizard, see Creating a
Policy Object.

To configure the policy, click Exchange Mailbox Deprovisioning on the Select Policy
Type page of the wizard. Then, click Next.

On the Options to Deprovision Mailbox page, select these check boxes:

* Hide the mailbox from the global address list (GAL), to prevent access to
the mailbox

« Modify configuration of the email forwarding

Make sure that no other check boxes on the page are selected. Then, click Forward all
incoming messages to the user’'s manager and clear the Leave copies in the
mailbox check box.

When you are done, click Next and follow the instructions in the wizard to create the
Policy Object.

Applying the Policy Object

You can apply the Policy Object by using the Enforce Policy page in the New
Provisioning Policy Object Wizard, or you can complete the wizard and then use the
Enforce Policy command on the domain, OU, or Managed Unit where you want to apply
the policy.

For more information on how to apply a Policy Object, see Applying Policy Objects and
Managing policy scope.
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Home Folder Deprovisioning

Policies in this category are intended to automate the following tasks on deprovisioning
home folders for deprovisioned users:

e Revoke access to home folders from deprovisioned user accounts.
e Grant designated persons read access to deprovisioned home folders.
e Change ownership on deprovisioned home folders.

e Delete deprovisioned home folders.

When configuring a policy in this category, you specify how you want Active Roles to modify
security on the user’s home folder upon a request to deprovision a user, and whether you
want Active Roles to delete home folders upon user account deletion. The purpose is to
prevent deprovisioned users from accessing their home folders, and to authorize
designated persons to access deprovisioned home folders.

How the Home Folder Deprovisioning policy works

When processing a request to deprovision a user, Active Roles uses this policy to determine
the home folder deprovisioning options, and then updates the configuration of the user’s
home folder accordingly.

The available home folder deprovisioning options are summarized in the following table.
For each option, the table outlines the policy effect on the user’s home folder.

Table 14: Policy effect on the user’'s home folder

Option Policy effect

Remove the Modifies the home folder security so that the deprovisioned user cannot
user’s access his or her home folder.

permissions

on the home

folder
Grant the Makes it possible for the person designated as the deprovisioned user’s
user’s manager to view and retrieve data from the home folder of that user. The

manager read manager is determined based on the Manager attribute of the
access tothe  deprovisioned user account in Active Directory.
home folder

Grant selected Makes it possible for the specified users or groups to view and retrieve
users or data from the deprovisioned user’s home folder.

groups read

access to the

home folder
Make the Designates the specified user or group as the owner of the deprovisioned
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Option Policy effect

selected user user’s home folder. The owner is authorized to control how permissions
or group the are set on the folder, and can grant permissions to others.

owner of the

home folder

Delete the Upon the deletion of a user account, analyzes whether the user’s home
home folder folder is empty, and then deletes or retains the home folder, depending
when the user on the policy configuration. A policy can be configured to only delete
accountis empty folders. Another option is to delete both empty and non-empty
deleted folders.

Configuring a Home Folder Deprovisioning policy

You can configure a Home Folder Deprovisioning policy with the Active Roles Console.

To configure a Home Folder Deprovisioning policy

1. Onthe Policy to Configure page, select Home Folder Deprovisioning, and then
click Next.
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Figure 68: Options to Deprovision Home Folder

Mew Deprovisioning Policy Object Wizard

Options to Deprovision Home Folder

You can select policy options ko deprovision home Folders of the deprovisioned
users,

Qnce a user is deprovisioned, the selected options are applied to the user's home Folder,
¥ Remove the user's permissions on the home Folder
V¥ Grant the user's manager read-only access to the home Folder

[ Grant these users or groups read-only access to the home Folder:

I Select, .

¥ Make this user or group the owner of the home Folder:

BUILTIM Administr atars Select. ..

¥ Delete the home folder when the user account is deleted:

I.ﬁ.lwa';.-'s j

< Back Cancel Help

2. Onthe Options to Deprovision Home Folder page, select the options you want
the policy to apply when deprovisioning a user account. You can select any
combination of these options to deprovision the home folder for the deprovisioned
user account:

« Remove the user’'s permissions on the home folder

+ Grant the user’'s manager read-only access to the home folder

+ Grant these users or groups read-only access to the home folder
 Make this user or group the owner of the home folder

» Delete the home folder when the user account is deleted

3. Ifyou selected the Grant these users or groups read-only access to the home
folder check box, click Select and use the Select Objects dialog to specify the
users or groups you want.

4. If you selected the Make this user or group the owner of the home folder
check box, click Select and use the Select Objects dialog to specify the user or
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group you want.

5. If you selected the Delete the home folder when the user account is deleted
check box, select one of these options:

e Always to have the policy delete the home folder regardless of whether the
folder contains any files or sub-folders.

« If home folder is empty to prevent the home folder from being deleted if it
contains any files or sub-folders.

6. Click Next.

7. On the Enforce Policy page, you can specify objects to which this Policy Object must

be applied. To do so, click Add, and use the Select Objects dialog to locate and
select the objects you want.

8. Click Next, then click Finish.

Scenario: Removing access to home folder

The policy described in this scenario performs the following functions during the user
deprovisioning process:

e Removes all permissions the user had to his or her home folder.

e Designates the Administrators group as the owner of deprovisioned home folders.
To implement this scenario, you must perform the following actions:

1. Create and configure the Policy Object that defines the appropriate policy.
2. Apply the Policy Object to a domain, OU, or Managed Unit.

As a result, when deprovisioning a user account in the container you selected in Step 2,
Active Roles modifies the security on the user’s home folder as prescribed by this policy.

The following two sections elaborate on the steps to implement this scenario.

Creating and configuring the Policy Object

You can create and configure the Policy Object you need by using the New

Deprovisioning Policy Object Wizard. For information about the wizard, see Creating a

Policy Object.

To configure the policy, click Home Folder Deprovisioning on the Select Policy Type
page of the wizard. Then, click Next.

On the Options to Deprovision Home Folder page, select both the Remove the user’s

permissions on the home folder and Grant the user’'s manager read-only access
to the home folder check boxes.

Make sure that no other check boxes on the page are selected. Then, click Next and follow

the instructions in the wizard to create the Policy Object.
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Applying the Policy Object

You can apply the Policy Object by using the Enforce Policy page in the New
Provisioning Policy Object Wizard, or you can complete the wizard and then use the
Enforce Policy command on the domain, OU, or Managed Unit where you want to apply
the policy.

For more information on how to apply a Policy Object, see Applying Policy Objects and
Managing policy scope.

User Account Relocation

Policies in this category automate the movement of deprovisioned user accounts to
specified Organizational Units. This removes such accounts from the control of
administrators who are responsible for management of the Organizational Units in which
those accounts originally reside. A policy in this category can also be configured not to
move deprovisioned user accounts.

How the User Account Relocation policy works

When processing a request to deprovision a user, Active Roles uses this policy to determine
whether to move the deprovisioned user account to a different Organizational Unit.

A policy configured to move user accounts also specifies the destination Organizational Unit
to which Active Roles moves deprovisioned user accounts.

A policy can be configured not to move user accounts. When applied at a certain level of the
directory hierarchy, such a policy overrides any other policy of this category applied at a
higher level of the directory hierarchy.

Let us consider an example to clarify this behavior. Suppose you configure a policy to move
accounts and apply that policy to a certain parent container. In general, the policy is passed
down from parent to child containers, thatis, the policy applies to all child containers
beneath the parent container, causing Active Roles to move deprovisioned user accounts
from each container. However, if you configure a different policy not to move accounts and
apply that new policy to a child container, the child container policy overrides the policy
inherited from the parent container. Active Roles does not move deprovisioned user
accounts from that child container or any container beneath that child container.

Configuring a User Account Relocation policy

You can configure a new User Account Relocation policy for deprovisioned user accounts
with the New Deprovisioning Policy Object Wizard of the Active Roles Console.
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To configure a User Account Relocation policy

1. On the Policy to Configure page, select User Account Relocation, then
click Next.

Figure 69: Target container

MNew Deprovisioning Policy Object Wizard 7| x|

Target Container

You can choose whether you wank the policy ko move deprovisioned objects, and
specify the destination conkainer,

Cnce an object is deprovisioned, the selected options are applied to that object,
% Do not move the object

™ Move the object to this container:

Select,, |

= Back Cancel Help

2. Onthe Target Container page, do one of the following, then click Next:

e Click Do not move the object if you want the policy to keep deprovisioned
user accounts in their original locations.

e Click Move the object to this container if you want the policy to move
deprovisioned user accounts to a certain container. Then, click Select, and
select the container you want.

3. On the Enforce Policy page, you can specify objects to which this Policy Object will
be applied. To do so, click Add, and use the Select Objects dialog to locate and

@NE IDENTITY Active Roles 8.1.5 Administration Guide

Ouest 249
ues Rule-based autoprovisioning and deprovisioning



select the objects you want.
4. Click Next, and then click Finish.

Scenario: Organizational Unit for deprovisioned
user accounts

This scenario describes how to configure a policy so that a certain Organizational Unit
contains all the deprovisioned user accounts.

To implement this scenario, you must perform the following actions:

1. Create and configure the Policy Object that defines the appropriate policy.
2. Apply the Policy Object to a domain, OU, or Managed Unit.

As a result, after deprovisioning a user account in the container you selected in Step 2,
Active Roles automatically moves that account to the Organizational Unit determined by
the policy configuration. The following two sections elaborate on the steps to implement
this scenario.

Creating and configuring the Policy Object

You can create and configure the Policy Object you need by using the New Deprovisioning
Policy Object wizard. For information about the wizard, see Creating a Policy Object.

To configure the policy, click User Account Permanent Deletion on the Select Policy
Type page of the wizard. Then, click Next.

On the Deletion Options page, click Delete the object after retention period. Then,
in the box beneath that option, type 9e.

When you are done, click Next and follow the instructions in the wizard to create the
Policy Object.

Applying the Policy Object

You can apply the Policy Object by using the Enforce Policy page in the New
Provisioning Policy Object Wizard, or you can complete the wizard and then use the
Enforce Policy command on the domain, OU, or Managed Unit where you want to apply
the policy.

For more information on how to apply a Policy Object, see Applying Policy Objects and
Managing policy scope.
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User Account Permanent Deletion

Policies in this category are intended to automate the deletion of deprovisioned user
accounts. Deprovisioned user accounts are retained for a specified amount of time before
they are permanently deleted. A policy in this category can also be configured not to delete
deprovisioned accounts.

How the User Account Permanent Deletion
policy works

When processing a request to deprovision a user, Active Roles uses this policy to determine
whether to schedule the deprovisioned user account for deletion. When scheduled for
deletion, a user account is permanently deleted after a certain time period, referred to as a
retention period.

A policy configured to delete user accounts specifies the number of days to retain
deprovisioned user accounts. With such a policy, Active Roles permanently deletes a user
account after the specified number of days has passed since the user was deprovisioned.

A policy can be configured not to delete user accounts. When applied at a certain level of
the directory hierarchy, such a policy overrides any other policy of this category applied at
a higher level of the directory hierarchy.

Let us consider an example to clarify this behavior. Suppose you configure a policy to
delete accounts and apply that policy to a certain container. In general, the policy is passed
down from parent to child containers, that is, the policy applies to all child containers
beneath the parent container, causing Active Roles to delete deprovisioned user accounts
in each container. However, if you configure a different policy not to delete accounts and
apply that new policy to a child container, the child container policy overrides the policy
inherited from the parent container. Active Roles does not delete deprovisioned user
accounts in that child container or any container beneath that child container.

One more option of this policy is intended for domains where Active Directory Recycle Bin is
enabled. The policy can be configured so that once a user account is deprovisioned, the
account is moved to Recycle Bin (which effectively means that the account will be deleted
immediately, without any retention period). Moving deprovisioned user accounts to the
Recycle Bin may be required for security reasons, as an extra security precaution. The
Active Directory Recycle Bin ensures that the account can be restored, if necessary, without
any loss of data. Active Roles provides the ability to un-delete and then un-deprovision user
accounts that were deprovisioned to the Recycle Bin.

Configuring a User Account Permanent Deletion
policy

You can configure a new User Account Permanent Deletion policy with the New
Deprovisioning Policy Object Wizard of the Active Roles Console.
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To configure a User Account Permanent Deletion policy

1. On the Policy to Configure page, select User Account Permanent Deletion,
then click Next.

Figure 70: Deletion options

MNew Deprovisioning Policy Object Wizard 7| x|
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You can choose whether you want the policy bo delete deprovisioned objects,
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This option has am effect only if &chive Directory Recyele Bin s enabled in
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2. Onthe Deletion Options page, do one the following, then click Next:

e Click Do not automatically delete the object if you want the policy not to
delete deprovisioned user accounts.

e Click Delete the object after retention period if you want the policy to
schedule deprovisioned user accounts for deletion. Then, in Retention period

(days), specify the number of days to retain the deprovisioned user account
before it is deleted.
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» Click Delete the object to Active Directory Recycle Bin immediately if
you want the policy to move deprovisioned user accounts to Recycle Bin.

NOTE: If you select this option, apply the policy to domains that have Active
Directory Recycle Bin enabled, or the policy will have no effect.

With this option, once a user account is deprovisioned, the policy causes
Active Roles to delete the user account immediately. In a domain where
Active Directory Recycle Bin is enabled, this deletion means that the account
is marked as deleted and moved to a specified container from which it can be
restored later if necessary without any data loss.

Click Next.

3. On the Enforce Policy window, you can specify objects to which this Policy Object is
to be applied:

e Click Add, and use the Select Objects dialog to locate and select the
objects you want.

4. Click Next, then click Finish.

Scenario: Deleting deprovisioned user accounts

This scenario describes how to configure a policy so that Active Roles permanently deletes
deprovisioned user accounts after the 90-day retention period.

To implement this scenario, you must perform the following actions:

1. Create and configure the Policy Object that defines the appropriate policy.
2. Apply the Policy Object to a domain, OU, or Managed Unit.

As a result, after deprovisioning a user account in the container you selected in Step 2,
Active Roles retains the deprovisioned account for 90 days and then it deletes that account.

Creating and configuring the Policy Object

You can create and configure the Policy Object you need by using the New
Deprovisioning Policy Object Wizard. For more information about the wizard, see
Creating a Policy Object.

To configure the policy, click User Account Permanent Deletion on the Select Policy
Type page of the wizard. Then, click Next.

On the Deletion Options page, click Delete the object after retention period. Then,
in the box beneath that option, type 90.

When you are done, click Next and follow the instructions in the wizard to create the
Policy Object.
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Applying the Policy Object

You can apply the Policy Object by using the Enforce Policy page in the New
Provisioning Policy Object Wizard, or you can complete the wizard and then use the
Enforce Policy command on the domain, OU, or Managed Unit where you want to apply
the policy.

For more information on how to apply a Policy Object, see Applying Policy Objects and
Managing policy scope.

Group Object Deprovisioning

Group object deprovisioning policy specifies the changes to make to the group object in
Active Directory in order to prevent the use of the group. It is intended to perform the
following tasks when deprovisioning a group:

e Hide the group from the Global Address List (GAL) to prevent access to the group
from Exchange Server client applications such as Microsoft Outlook.

e Change the type of the group from Security to Distribution to revoke access rights
from the group.

* Rename the group, to distinguish deprovisioned groups by name.

« Remove members from the group to revoke user access to resources controlled by
the group. This task has the option to specify the members that should not be
removed from the group.

In addition, the policy can be configured to change or clear any other properties of a group,
such as the pre-Windows 2000 name, e-mail addresses, or description.

How the Group Object Deprovisioning policy
works

When processing a request to deprovision a group, Active Roles uses this policy to modify
the group object in Active Directory, so that once the group has been deprovisioned, it
cannot be used.

A policy can also be configured to update individual properties of groups. Depending on the
policy configuration, each policy-based update results in the following:

e Certain portions of group information, such as information about group members, are
removed from the directory.

e Certain properties of groups are changed or cleared.

A policy can be configured so that new property values include:
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e Properties of the group being deprovisioned, retrieved from the directory prior to
starting the process of the group deprovisioning.

e Properties of the user who originated the deprovisioning request.

» Date and time when the group was deprovisioned.

Thus, when deprovisioning a group, Active Roles modifies the group object in Active
Directory as determined by the Group Object Deprovisioning policy that is in effect.

Configuring a Group Object Deprovisioning policy

You can configure a new Group Object Deprovisioning policy with the Active Roles Console.

To configure a Group Object Deprovisioning policy

1. On the Policy to Configure page, select Group Object Deprovisioning,
then click Next.
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Figure 71: Disable Group
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2. Onthe Disable Group page, select the options you want the policy to apply when

deprovisioning a group. You can select any combination of these options to prevent
the use of the group:

« Change the group type from Security to Distribution: Revokes
access rights from deprovisioned groups. This option is applicable only to
security groups.

+ Hide the group from the Global Address List (GAL): Prevents access to
deprovisioned groups from Exchange Server client applications. This option is
applicable to distribution groups or mail-enabled security groups.

« Rename the group to: Changes the name of the group.

3. If you selected Rename the group to, specify how you want the policy to update
the group name when deprovisioning a group. To do so, click Configure and
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complete the Configure Value dialog by using the procedure outlined later in this
topic. For more information, see Configuring a property update rule.

4. Click Next.

Figure 72: Remove members
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5. Onthe Remove Members page, do one of the following:

e Click Do not remove members from the group for the policy not to make
changes to the membership list of the group.

* Click Remove all members, with optional exceptions for the policy to
remove the members from the group.

6. If you selected Remove all members, with optional exceptions, specify
whether you want the policy not to remove certain objects from deprovisioned
groups. Do the following:
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» Select the Keep these objects in the group check box and set up the list of
the objects you want the policy not to remove from deprovisioned groups.

» Leave the check box cleared if you want the policy to remove all members from
deprovisioned groups.

7. Click Next.

Figure 73: Change Properties
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8. On this page, you can set up a list of group properties you want the policy to update.
Each entry in the list includes the following information:

* Property: When deprovisioning a group, Active Roles will update this property
of the group object in Active Directory.

 LDAP Display Name: Uniquely identifies the property to be updated.
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» Value to Assign: After the deprovisioning operation is completed, the
property has the value defined by the rule specified.

Specify how you want the policy to update properties of the group object when
deprovisioning a group:

e Click Add, then add property rules by completing the Select Object
Property dialog.

e Use View/Edit to modify existing rules.

» Use Remove to delete existing rules.

9. Click Next.
10. On the Enforce Policy page, you can specify objects to which this Policy Object is to
be applied:

e Click Add, and use the Select Objects dialog to locate and select the
objects you want.

11. Click Next, then click Finish.

To complete the Configure Value dialog

1. Click Add.

2. Configure an entry to include in the value. For more information, see
Configuring entries.

3. In the Configure Value dialog, add more entries, delete or edit existing ones,
then click OK.

To complete the Select Object Property dialog

1. From the Object property list, select an object property, then click OK. The Add
Value dialog appears.

If you select multiple properties, the Add Value dialog is not displayed. The
properties you have selected are added to the list on the Change Properties page,
with the update rule configured to clear those properties, that is, to assign them the
empty value.
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Figure 74: Add value
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2. Inthe Add Value dialog, do one of the following:
e Select Clear value if you want the update rule to assign the empty value to
the property.

» Select Configure value if you want the update rule to assign a certain, non-
empty value to the property. Then, click Configure and complete the
Configure Value dialog.

3. When you are done configuring a value, click OK to close the Add Value dialog. The
property name along with the property update rule is added to the wizard page. If
necessary, you can modify the update rule by clicking View/Edit beneath the list of
properties. This displays a dialog, similar to the Add Value dialog, allowing you to
choose a different update option or set up a different value for the ‘property’ must
be condition.

Scenario 1: Disabling and renaming the group
upon deprovisioning

The policy described in this scenario performs the following functions during the group
deprovisioning process:

e When deprovisioning a security group, change the type of the group to Distribution.

e When deprovisioning a distribution group, remove the group from the Global
Address List.

e Append this suffix to the group name: - Deprovisioned, followed by the date when
the group was deprovisioned.
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For example, the policy changes the group name of Partner Marketing to Partner
Marketing - Deprovisioned 12/11/2013.

To implement this scenario, you must perform the following actions:

1. Create and configure the Policy Object that defines the appropriate policy.
2. Apply the Policy Object to a domain, OU, or Managed Unit.

As a result, when deprovisioning a group, Active Roles disables and renames the group as
prescribed by this policy.

Configuring the Group Object Deprovisioning Policy
Object

You can create and configure the Policy Object you need by using the New
Deprovisioning Policy Object Wizard. For information about the wizard, see Creating a
Policy Object.

To configure the policy, click Group Object Deprovisioning on the Select Policy Type
page of the wizard. Then, click Next.

On the Disable Group page, select these check boxes:

+ Change the group type from Security to Distribution
* Hide the group from the Global Address List (GAL)

« Rename the group to

Then, if empty, enter the following name under Rename the group to:
%<name> - Deprovisioned {@date(M/d/yyyy)}

Click Next and follow the instructions in the wizard to create the Policy Object.

Applying the Policy Object

You can apply the Policy Object by using the Enforce Policy page in the New
Provisioning Policy Object Wizard, or you can complete the wizard and then use the
Enforce Policy command on the domain, OU, or Managed Unit where you want to apply
the policy.

For more information on how to apply a Policy Object, see Applying Policy Objects and
Managing policy scope.

Scenario 2: Managed Unit for deprovisioned
groups

This scenario describes how to configure a Managed Unit and a Group Object
Deprovisioning policy so that the Managed Unit includes all deprovisioned groups. The
policy sets the Notes property to Deprovisioned upon the deprovisioning of a group,
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whereas the Managed Unit is configured to include the groups that have the Notes
property set to Deprovisioned.

To implement this scenario, you must perform the following actions:

1. Create and configure the Managed Unit.
2. Configure the Policy Object that defines the appropriate policy.
3. Apply the Policy Object to a domain, OU, or Managed Unit.

As a result, after deprovisioning a group, Active Roles automatically adds that group to the
Managed Unit you created.

Creating and configuring the Managed Unit for the Group
Object Deprovisioning policy

You can create and configure the Managed Unit by using the Active Roles Console:

1. Inthe Console tree, under Configuration, right-click Managed Units, and select
New > Managed Unit.

2. In Name, type a name for the Managed Unit. For example, you might type
Deprovisioned Users.

3. Click Next.

4. Configure the membership rule to have the Managed Unit include the
deprovisioned user accounts from all domains that are registered with Active Roles
(managed domains):

a. On the wizard page, click Add.

b. In the Membership Rule Type dialog, click Include by Query, and
then click OK.

c. Use the Create Membership Rule window to set up the rule:
e In Find, click Users.
e Click Browse and select Active Directory.
e Navigate to Advanced.
e Click Field, and then click Notes.
« In Condition, click Is (exactly).
e In Value, type Deprovisioned.

At this stage, the window should look as follows.
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Figure 75: Find Groups
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e Click Add.
e Click Add Rule.
5. On the wizard page, click Add.

6. In the Membership Rule Type dialog, click Retain Deprovisioned, and then
click OK.

7. Click Next, click Next, and then click Finish.

Configuring the Policy Object for Group Object
Deprovisioning
You can configure the Policy Object you need by modifying the Policy Object that

implements the previous scenario. See Scenario 1: Disabling and renaming the group upon
deprovisioning.

Display the Properties dialog for that Policy Object and navigate to Policies. Then, select
the policy from the list, and click View/Edit to display the Group Object Deprovisioning
Policy Properties dialog. Navigate to Change Properties.

The Change Properties tab looks similar to the page of the same name in the wizard
you used to create the Policy Object. You can use that tab to add the update rule for the
Notes property:

1. Click Add to display the Select Object Property dialog.
2. Select the check box next to the Notes property, and then click OK.
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3. In the Add Value dialog, type Deprovisioned in the *Notes’ must be box, and
then click OK.

Click OK to close the Group Object Deprovisioning Policy Properties dialog.

Applying the Policy Object

You can apply the Policy Object by using the Enforce Policy page in the New
Provisioning Policy Object Wizard, or you can complete the wizard and then use the
Enforce Policy command on the domain, OU, or Managed Unit where you want to apply
the policy.

For more information on how to apply a Policy Object, see Applying Policy Objects and
Managing policy scope.

Group Object Relocation

Policies in this category are intended to automate the movement of deprovisioned group
objects to specified Organizational Units. This removes such groups from the control of
administrators that are responsible for management of the Organizational Units in which
those groups originally reside. A policy in this category can also be configured not to move
deprovisioned group objects.

How the Group Object Relocation policy works

When processing a request to deprovision a group, Active Roles uses this policy to
determine whether to move the deprovisioned group object to a different
Organizational Unit.

A policy configured to move group objects also specifies the destination Organizational Unit
to which Active Roles moves deprovisioned group objects.

A policy can be configured not to move group objects. When applied at a certain level of the
directory hierarchy, such a policy overrides any other policy of this category applied at a
higher level of the directory hierarchy.

Configuring a Group Object Relocation policy

You can configure a new Group Object Relocation Policy with the Active Roles Console.
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To configure a Group Object Relocation policy

1. On the Policy to Configure page, select Group Object Relocation, then
click Next.

Figure 76: Target container
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2. Onthe Target Container page, do one of the following, then click Next:

e Click Do not move the object if you want the policy to keep deprovisioned
group objects in their original locations.

e Click Move the object to this container if you want the policy to move
deprovisioned group objects to a certain container. Then, click Select, and
select the container you want.
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3. On the Enforce Policy page, you can specify objects to which this Policy Object is to
be applied:

e Click Add, and use the Select Objects dialog to locate and select the
objects you want.

4. Click Next, then click Finish.

Scenario: Organizational Unit for deprovisioned
groups

This scenario describes how to configure a policy so that a certain Organizational Unit
contains all the deprovisioned groups.

To implement this scenario, you must perform the following actions:

1. Create and configure the Policy Object that defines the appropriate policy.
2. Apply the Policy Object to a domain, OU, or Managed Unit.

As a result, after deprovisioning a group in the container you selected in Step 2, Active
Roles automatically moves that group to the Organizational Unit determined by the policy
configuration.

Configuring the Group Object Relocation Policy Object

You can create and configure the Policy Object you need by using the New
Deprovisioning Policy Object Wizard. For information about the wizard, see Creating a
Policy Object.

To configure the policy, click Group Object Relocation on the Select Policy Type page
of the wizard. Then, click Next.

On the Target Container page, click Move the object to this container. Then, click
Select to display the Browse for Container dialog. Locate and select the Organizational
Unit to which you want the policy to move deprovisioned groups, and then click OK.

When you are done, click Next and follow the instructions in the wizard to create the
Policy Object.

Applying the Policy Object

You can apply the Policy Object by using the Enforce Policy page in the New
Provisioning Policy Object Wizard, or you can complete the wizard and then use the
Enforce Policy command on the domain, OU, or Managed Unit where you want to apply
the policy.

For more information on how to apply a Policy Object, see Applying Policy Objects and
Managing policy scope.
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Group Object Permanent Deletion

Policies in this category are intended to automate the deletion of deprovisioned groups.
Deprovisioned group objects are retained for a specified amount of time before they are
permanently deleted. A policy in this category can also be configured not to delete
deprovisioned group objects.

How the Group Object Permanent Deletion
policy works

When processing a request to deprovision a group, Active Roles uses this policy to
determine whether to schedule the deprovisioned group object for deletion. When
scheduled for deletion, a group object is permanently deleted after a certain time period,
referred to as a retention period.

A policy configured to delete groups specifies the number of days to retain deprovisioned
group objects. With such a policy, Active Roles permanently deletes a group after the
specified number of days has passed since the group was deprovisioned.

A policy can be configured not to delete groups. When applied at a certain level of the
directory hierarchy, such a policy overrides any other policy of this category applied at a
higher level of the directory hierarchy.

One more option of this policy is intended for domains where Active Directory Recycle Bin is
enabled. The policy can be configured so that once a group is deprovisioned, the group
object is moved to the Recycle Bin (which effectively means that the group will be deleted
immediately, without any retention period). Moving deprovisioned group objects to the
Recycle Bin may be required for security reasons, as an extra security precaution. The
Active Directory Recycle Bin ensures that the group object can be restored, if necessary,
without any loss of data. Active Roles provides the ability to un-delete and then un-
deprovision groups that were deprovisioned to the Recycle Bin.

Configuring a Group Object Permanent Deletion
policy

You can configure a new Group Object Permanent Deletion Policy with the Active
Roles Console.

To configure a Group Object Permanent Deletion policy

1. On the Policy to Configure page, select Group Object Permanent Deletion and
click Next.
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Figure 77: Deletion Options
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2. Onthe Deletion Options page, do one the following:

e Click Do not automatically delete the object if you want the policy not to
delete deprovisioned groups.

e Click Delete the object after retention period if you want the policy to
schedule deprovisioned groups for deletion. Then, in Retention period
(days), specify the number of days to retain the deprovisioned group before it
is deleted.

* Click Delete the object to Active Directory Recycle Bin immediately if
you want the policy to move deprovisioned group objects to Recycle Bin.

NOTE: If you select the third option, apply this policy to domains that have
Active Directory Recycle Bin enabled, or the policy will have no effect.
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With this option, once a group is deprovisioned, Active Roles deletes the
deprovisioned group immediately. In a domain where Active Directory
Recycle Bin is enabled, this means that the group object will be marked as
deleted and moved to a certain container from which it can be restored later
without data loss.

Click Next.

3. On the Enforce Policy window, you can specify objects to which this Policy Object is
to be applied:

e Click Add, and use the Select Objects dialog to locate and select the
objects you want.

4. Click Next, then click Finish.

Scenario: Deleting deprovisioned groups

This scenario describes how to configure a policy so that Active Roles permanently deletes
deprovisioned groups after the 90-day retention period.

To implement this scenario, you must perform the following actions:

1. Create and configure the Policy Object that defines the appropriate policy.
2. Apply the Policy Object to a domain, OU, or Managed Unit.

As a result, after deprovisioning a group, Active Roles retains the deprovisioned group
object for 90 days and then it deletes that object.

Creating and configuring the Policy Object

You can create and configure the Policy Object you need by using the New
Deprovisioning Policy Object Wizard. For more information about the wizard, see
Creating a Policy Object.

To configure the policy, click User Account Permanent Deletion on the Select Policy
Type page of the wizard. Then, click Next.

On the Deletion Options page, click Delete the object after retention period. Then,
in the box beneath that option, type 9e.

When you are done, click Next and follow the instructions in the wizard to create the
Policy Object.

Applying the Policy Object

You can apply the Policy Object by using the Enforce Policy page in the New
Provisioning Policy Object Wizard, or you can complete the wizard and then use the
Enforce Policy command on the domain, OU, or Managed Unit where you want to apply
the policy.
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For more information on how to apply a Policy Object, see Applying Policy Objects and
Managing policy scope.

Notification Distribution

Policies in this category are intended to automatically generate and send e-mail
notifications upon deprovisioning requests. The primary purpose of such a policy is to notify
designated persons about a request to deprovision a given object so as to take additional
deprovisioning-related actions on that object, if necessary. When configuring a policy in
this category, you can specify a list of notification recipients, and customize the subject and
body of the notification message.

How the Notification Distribution policy works

When processing a deprovisioning request, Active Roles uses this policy to determine
whether anyone must be notified of the deprovisioning operation that is requested. Then, it
generates a notification message and sends it to the recipients, if any specified in the policy
configuration.

When a deprovisioning operation is requested, Active Roles issues a notification message
regardless of operation results. Hence, a notification message cannot be considered as an
indication of success or failure of the operation. Rather, it only indicates that deprovisioning
has been requested. If you need to inform anybody of deprovisioning results, you should
use a policy of the Report Distribution category.

Notification performs on a per-object basis: Each notification message contains information
about a request to deprovision one object. When deprovisioning multiple objects, Active
Roles sends multiple notification messages, one message per object.

Active Roles sends notification messages via an SMTP server. The policy configuration
specifies the outbound SMTP server by using Active Roles email settings that include the
name of the SMTP server and information required to connect to the SMTP server.

Configuring email settings

When you click Settings, the Console displays the Properties dialog for the selected email
configuration, with the Mail Setup tab that looks like the following figure.
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Figure 78: Mail Setup
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On this tab, you can configure the following email settings:

e Outgoing mail server (SMTP): Specify the fully qualified address of the SMTP
server to use, such as smtp.mycompany . com.

e Port number: Specify the port number to connect to on the SMTP server. Normally,
the SMTP server has this port number set to 25.

« This server requires an encrypted connection (SSL): Select this check box if
the SMTP server requires that its clients use Secure Sockets Layer (SSL) when
posting messages over the network.
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» This server requires authentication: Select this check box if the SMTP server is
configured to use Basic Authentication or Integrated Windows Authentication. Then,
type the user name and password in the boxes beneath this option. By default, the
Outgoing mail server (SMTP) list includes a single entry. You can add more
entries to the list using the Active Roles Console. In the Console tree, expand
Configuration/Server Configuration, right-click Mail Configuration, select
New > Mail Configuration, and then follow the instructions in the wizard. passes
these credentials to the SMTP server when establishing a connection.

» Log on using Secure Password Authentication (SPA): Select this check box if
the SMTP server is configured to use Integrated Windows Authentication, in order not
to transmit the actual user password across the network.

 Sender email address: The default email address of the message sender. A valid
email address must be specified. Normally, this is the email address of the service
account used by the Administration Service.

e Name (used in the From field): Specify the default name of the message sender,
to be displayed in the From field of messages sent by using this email configuration.

When you are done configuring the email server-related settings, click OK to close the
Properties dialog box the email configuration. Then, click Next and follow the instructions
in the wizard to create the Policy Object.

Configuring a Notification Distribution policy

You can configure a new Notification Distribution policy with the Active Roles Console.

To configure a Notification Distribution policy

1. On the Policy to Configure page, select Notification Distribution Policy, then
click Next.

2. On the Notification Recipients and Message page, do the following, then
click Next:

e Click the button next to Notification recipients, and select one or more email
recipients.

» In Message Subject, type the subject of the message that the specified
recipients will receive upon a request to perform a deprovisioning operation.

e Under Message Body, type any information regarding the deprovisioning
operation.

Macros have the same syntax and semantics as values for policy conditions in
Property Generation and Validation policies: An attribute’s LDAP display name
enclosed in angle brackets (<>) and prefixed with the percent character (%)
represents the value of that attribute. For example, before sending a message, Active
Roles replaces % <name> with the name of the object to deprovision.
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3. On the Outgoing Mail Server page, select the email configuration you want the
policy to use. In the Outgoing mail server (SMTP) list, click the appropriate
mail settings.

NOTE: By default, the Outgoing mail server (SMTP) list includes a single entry.
You can add more entries to the list using the Active Roles Console. In the Console
tree, expand Configuration > Configuration, right-click Mail Configuration,
select New > Mail Configuration, then follow the instructions in the wizard.

4. If you want to view or modify the selected mail settings, click Settings, and use the
Mail Setup tab. For more information, see Configuring email settings.

5. Click Next.

6. On the Enforce Policy page, you can specify objects to which this Policy Object is to
be applied:

e Click Add, and use the Select Objects dialog to locate and select the
objects you want.

7. Click Next, then click Finish.

NOTE: Each email configuration specifies an SMTP server and provides information
required to connect to that server. You can view and modify configuration parameters by
clicking Settings.

Scenario: Sending deprovisioning notification

This scenario describes how to configure a policy so that the administrator is notified of
deprovisioning objects in any domain registered with Active Roles (managed domain).

To implement this scenario, you must perform the following actions:

1. Create the appropriate e-mail configuration.

2. Create, configure, and apply the Policy Object that defines the appropriate policy.

As a result, upon a request to deprovision an object such as a user or group in any
managed domain, the administrator receives an e-mail message informing of the
deprovisioning request. The message includes the name of the object to deprovision.

The following two sections elaborate on the steps to implement this scenario.

Creating the email configuration

This scenario assumes that your SMTP server:

e Runs on the server smtp.mycompany.com.
e Uses the default port number (25).
» Allows anonymous access.

* Allows non-encrypted connections.
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Additionally, the service account of the Administration Service is assumed to have a
mailbox with the email address of ARSService@mycompany.com.

Create the email configuration by using the Active Roles Console:

1. Inthe Console tree, expand Configuration > Server Configuration, right-click
Mail Configuration, and then select New > Mail Configuration to start the New
Mail Configuration Wizard.

Click Next.

In Name, type Deprovisioning Notification Distribution.
Click Next.

In Outgoing mail server (SMTP), type smtp.mycompany.com.

o Uk LN

In Sender e-mail address, type the email address of the service account:
ARSService@mycompany.com.

In Name (used in the From field), type Active Roles.
8. Click Next, then click Finish.

Creating, configuring, and applying the Policy Object

You can create, configure, and apply the Policy Object you need by using the New
Deprovisioning Policy Object Wizard. For information about the wizard, see Creating a
Policy Object.

To configure the policy, click Notification Distribution on the Select Policy Type page
of the wizard. Then, click Next.

On the Notification Recipients and Message page, click the button next to the
Notification recipients box to display the Deprovisioning Notification Recipients
dialog. In that dialog, type the administrator’s email address, such as
administrator@mydomain.com, then click OK.

Then, customize the message subject and the message body as necessary. For example,
you might enter the following subject and body:

« Message subject
Deprovisioning of %<objectClass> ’%<name>’ Requested
e Message body

Deprovisioning of %<objectClass> ’%<name>’ is in progress. Please take any
additional deprovisioning actions, if necessary, to complete the
deprovisioning of that %<objectClass>.

This notification was generated automatically by Active Roles according to
corporate deprovisioning rules.

Click Next to display the Outgoing Mail Server page.

From the list in the Outgoing mail server (SMTP) box, select Deprovisioning
Notification Distribution, which is the email configuration you created earlier. Then,
click Next to display the Enforce Policy page.

Add the Active Directory folder to the list on the Enforce Policy page:
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1. Click Add to display the Select Objects window.

2. In the Select Objects window, click Browse to display the Browse for
Container dialog.

3. Inthe Browse for Container dialog, click Active Directory, then click OK.
4. From the upper list in the Select Objects window, select Active Directory.
5. Click Add, then click OK to close the Select Objects window.

Click Next, then click Finish to close the wizard.

You can also use the Enforce Policy command on the Active Directory folder in the
Console tree to apply the policy to that folder. For more information on how to apply a
Policy Object, see Applying Policy Objects and Managing policy scope.

Report Distribution

Policies in this category are intended to automatically send a report on deprovisioning
results upon completion of a deprovisioning operation. The primary purpose of such a
policy is to inform designated persons about problems, if any encountered, when
processing deprovisioning requests. These reports are discussed later in this chapter. For
more information, see Report on deprovisioning results.

Reports are delivered via email. When configuring a Report Distribution policy, you can set
up a list of report recipients, customize the subject of report messages, and specify
whether to send a report if no errors occurred.

How the Report Distribution policy works

Upon completion of a deprovisioning operation, Active Roles uses this policy to determine if
the report on deprovisioning results must be sent. Then, Active Roles generates the report
message and sends it to the recipients specified in the policy configuration. The report
includes a list of actions taken during the deprovisioning operation. For each action, the
report informs of whether the action is completed successfully, and provides information
about the action results.

With the Report Distribution policy configured not to send reports if no errors occurred,
Active Roles examines the deprovisioning results for errors. If there are no errors, the
report is not sent.

Active Roles generates deprovisioning reports on a per-object basis: Each report
message contains information on the deprovisioning of one object. When deprovisioning
multiple objects, Active Roles sends multiple report messages, one message per
deprovisioned object.

Active Roles sends report messages via an SMTP server. The policy configuration specifies
the outbound SMTP server by using Active Roles email settings that include the name of the
SMTP server and information required to connect to the SMTP server.
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Configuring a Report Distribution policy

You can configure a new Report Distribution policy via the Policy to Configure page of the
Active Roles Console.

To configure a Report Distribution policy

1. On the Policy to Configure page, select Report Distribution Policy, then
click Next.

2. Onthe Report Recipients and Message page, do the following, then click Next:

e Click the button next to Report recipients, then select one or more email
recipients.

» In Message Subject, type the subject of the message that the specified
recipients will receive upon completion of a deprovisioning operation.

Macros have the same syntax and semantics as values for policy conditions in
Property Generation and Validation policies: An attribute’s LDAP display name
enclosed in angle brackets (<>) and prefixed with the percent character (%)
represents the value of that attribute. For instance, before sending a message,
Active Roles replaces %<name> with the original name of the object that has
been deprovisioned.

NOTE: Active Roles retrieves the attribute value prior to starting the depro-
visioning operation so the value is current as of the time the deprovisioning
process begins. Even if you have a deprovisioning policy configured to update
a given attribute, the message reads the original rather than updated value
of that attribute.

» Select the Send out the report only if any errors occur check box if you
want the policy not to send the report if no errors occurred during the
deprovisioning operation. Clear the check box if you want the policy to send the
report regardless of whether or not any errors occurred.

3. On the Outgoing Mail Server page, select the email configuration you want the
policy to use. In the Outgoing mail server (SMTP) list, click the appropriate
mail settings.

This page is similar to the respective wizard page for Notification Distribution policies.
For more information, see Configuring a Notification Distribution policy). You can
select the email configuration you want the policy to use, and view or modify email
settings in the selected configuration.

First, from the Outgoing mail server (SMTP) list, select the email configuration
you want the policy to use.

NOTE: By default, the Outgoing mail server (SMTP) list includes a single
entry. You can add more entries to the list using the Active Roles Console. In the
Console tree, expand Configuration/Server Configuration, right-click Mail
Configuration, select New > Mail Configuration, then follow the instructions
in the wizard.
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4. If you want to view or modify the selected mail settings, click Settings, and use the
Mail Setup tab. For more information, see Configuring email settings.

5. Click Next.

6. On the Enforce Policy page, you can specify objects to which this Policy Object is to
be applied. To do so, click Add, then use the Select Objects dialog to locate and
select the objects you want.

7. Click Next, and then click Finish.

Scenario: Sending deprovisioning report

This scenario describes how to configure the following policy to monitor deprovisioning
operations in all domains registered with Active Roles (managed domains):

» When a deprovisioning operation is completed, verify if any errors occurred during
the operation.

» If any errors occurred, send the report on the deprovisioning results to the
administrator.

To implement this scenario, you must perform the following actions:

1. Create the appropriate email configuration.

2. Create, configure, and apply the Policy Object that defines the appropriate policy.

As a result, upon completion of a deprovisioning operation in any managed domain, the
administrator receives a report in the event of any error during that operation. The
message subject includes the name of the object that has been deprovisioned.

The following two sections elaborate on the steps to implement this scenario.

Creating the email configuration

You can use the instructions in see Scenario: Sending deprovisioning notification to create
the email configuration. When prompted to specify a name for the new configuration, type
Deprovisioning Report Distribution.

Creating, configuring, and applying the Policy Object

You can create, configure, and apply the Policy Object you need by using the New
Deprovisioning Policy Object Wizard. For information about the wizard, see Creating a
Policy Object.

To configure the policy, click Report Distribution on the Select Policy Type page of the
wizard. Then, click Next.

On the Report Recipients and Message page, click the button next to the Report
recipients box to display the Deprovisioning Report Recipients dialog. In that dialog,
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type the administrator’s email address, such as administrator@mydomain.com, and then
click OK.

Then, customize the message subject as necessary. For example, you might enter the
following subject: Deprovisioning of %<objectClass> ’%<name>’ Completed with Errors.
Verify that the Send out the report only if any errors occur check box is selected and
then click Next to display the Outgoing Mail Server page.

From the list in the Outgoing mail server (SMTP) box, select Deprovisioning Report
Distribution—the email configuration you have created in Step 1, and then click Next to
display the Enforce Policy page.

On the Enforce Policy page, click Add and select the Active Directory folder to add to
the list. Click Next, and then click Finish to close the wizard.

You can also use the Enforce Policy command on the Active Directory folder in the
Console tree to apply the policy to that folder. For more information on how to apply a
Policy Object, see Applying Policy Objects and Managing policy scope.

Deployment considerations

Active Roles enforces policies by applying Policy Objects to promote data integrity
throughout the directory. This is done by generating and validating the data entered into
the directory. Each Policy Object is basically a container that holds one or more policy
entries (also referred to as policies).

There are several types of policy entries that can be configured within a Policy Object. The
two major ones are Property Generation and Validation, and Script Execution. Property
Generation and Validation policy entries provide a point-and-click interface for creating
basic rules for attribute population. Script Execution policy entries enable the use of
scripting for a broad range of custom actions that could supplement, extend, or replace the
policy types included with Active Roles out of the box.

Just as with Group Policy Objects in Active Directory, the location that Active Roles’ Policy
Objects are linked to is critical:

e Any policies that are intended to affect the entire domain should be included into
a Policy Object linked at the domain level. If needed, filtering can be used to
exclude specific objects or containers (Organizational Units) from being processed
by these policies.

» If more than one object or containers needs to be excluded from the effect of a
domain-wide policy, it is best to include those objects or containers explicitly into a
Managed Unit and then apply policy filtering to that Managed Unit by using the Block
Inheritance option.

From here, the best way to apply policies is at the top level of the directory tree they will
affect. Usually, however policies are only needed to affect certain Organizational Units
within the tree. In this case, a Managed Unit is the most effective way to apply the policies.
Include the desired Organizational Units explicitly into a Managed Unit, and then link the
Policy Object to that Managed Unit.

A policy consists of three major components. These are:
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» A policy entry that defines the policy
e A Policy Object containing that policy entry
» A Policy Object link that determines where the policy is applied in the directory

Typically, a single Policy Object includes all the entries for a specific set of policies. It is not
efficient to create one entry per Policy Object since this defeats the purpose of having
separation between the Policy Object and policy entries.

A policy cannot be filtered for specific sets of administrators. Once applied to a given object
or container, a policy will be in effect for every administrator under every condition. This is
unless a Script Execution policy is included as a policy entry that utilizes the
IEDSEffectivePolicyRequest interface to override the policies determined by other policy
entries. This interface is documented in Active Roles SDK.

Script Execution polices are policy entries that utilize scripts written in a scripting language
such as Microsoft Windows PowerShell or VBScript. Policy scripts use event handles that
are initiated before or after every action that can happen in the directory. See the following
table for a list of these handlers.

Table 15: Event handlers

Name Description

onPreCreate In a script policy applied to a container; receives control upon
a request to create an object in that container. This enables a
script to perform custom actions prior to creating an object.

onPostCreate In a script policy applied to a container; receives control after
a request to create an object in that container is completed.
This enables a script to perform custom actions further to
creating an object.

onPreDelete Receives control upon a request to delete an object. Enables a
script to perform custom actions prior to deleting an object.

onPostDelete Receives control after a request to delete an object is
completed. Enables a script to perform custom actions further
to deleting an object.

onPreModify Receives control upon a request to start changing object
properties. Enables a script to perform custom actions prior to
applying changes to an object.

onPostModify Receives control after a request to change object properties is
completed. Enables a script to perform custom action further
to changing an object's property values.

onPreMove In a script policy applied to a container, this function receives
control upon a request to start moving an object from that
container. This enables a script to perform custom actions
prior to moving an object.

onPostMove In a script policy applied to a container, this function receives
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Name

Description

onPreRename
onPostRename
onPreGet
onPostGet

onPreSearch

onPreDeprovision
onDeprovision
onPostDeprovision
onPreUnDeprovision
onUnDeprovision
onPostUnDeprovision

onPreUnDelete
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control after a request to move an object to that container is
completed. This enables a script to perform custom actions
further to moving an object.

Receives control upon a request to start renaming an object.
Enables a script to perform custom actions prior to renaming
an object.

Receives control after a request to rename an object is
completed. Enables a script to perform custom actions further
to renaming an object.

Receives control upon a request to retrieve object properties.
Enables a script to perform custom actions prior to starting
the retrieval of an object's property values.

Receives control after a request to retrieve object properties
is completed. Enables a script to perform custom actions
following the retrieval of an object's property values.

Receives control upon a request to start a search. Enables a
script to perform custom actions prior to starting a search.

Receives control upon a request to run the Deprovision
operation. Enables a script to perform custom actions prior to
starting the operation.

Receives control in the course of processing a request to run
the Deprovision operation. Enables the use of a script for
customizing the behavior of the operation.

Receives control after a request to run the Deprovision
operation is completed. Enables a script to perform custom
actions following the operation.

Receives control upon a request to run the Undo
Deprovisioning operation. Enables a script to perform custom
actions prior to starting the operation.

Receives control in the course of processing a request to run
the Undo Deprovisioning operation. Enables the use of a script
for customizing the behavior of the operation.

Receives control after a request to run the Undo
Deprovisioning operation is completed. Enables a script to
perform custom actions following the operation.

Receives control upon a request to run the Undelete
operation. Enables a script to perform custom actions prior to
starting the operation.
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Name Description

onPostUnDelete Receives control after a request to run the Undelete operation
is completed. Enables a script to perform custom actions
following the operation.

onCheckPropertyValues  Receives control upon a request to verify and validate the
changes that are going to be made to an object. Enables a
script to perform custom actions further to normal validity
checks on an object.

onGetEffectivePolicy Receives control upon a request to retrieve the policy settings
that are in effect on a particular object (such as policy
constraints on property values). Enables a script to perform
custom actions further to retrieval of policy settings.

onInit Receives control when the Administration Service retrieves
the definition of the script parameters, enabling the script to
manifest the name and other characteristics of each
parameter.

onFilter Boolean-valued function that is evaluated during execution of
the onPreSearch event handler, allowing search results to be
filtered based on properties of objects returned by the search.

Basically, when an action happens, Active Roles looks to see if there are any Policy Objects
applied that hold Script Execution policies. If so, the policy script is checked to see if it has
an event handler for the specific action being performed. The object being acted upon is
passed into the event handler for further actions. These event handlers are normally run in
the security context of the service account, so even if a user does not have rights to
perform the actions outlined in the policy script, it will still run correctly. If any errors occur
during the execution of a policy script, the errors can be found in the Active Roles event log
for post-action handlers and are displayed to the client for pre-action handlers.

Policy scripts are typically written in a scripting language such as Windows PowerShell
or VBScript.

It is also important to note that policy scripts can pick up and take action upon directory
changes made natively, as well. To turn on this behavior, you should choose the option that
directs in the policy script to handle directory changes reported by the directory
synchronization function (select the Handle changes from DirSync control check box
on the Script Module tab in the Properties dialog for the policy entry), and use the
IEDSRequestParameters interface in a post-action event handler.

Checking for policy compliance

Checking for policy compliance provides information on directory data that is out of
compliance with the policies, such as user or group naming conventions, defined with
Active Roles. If you define some policies when data has already been entered, you can
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check the data, and modify it accordingly, in order to ensure that the data meets the policy
requirements.

Although business rules and policies normally cannot be bypassed once they have been
configured, there are situations where the actual directory data may violate some of the
prescribed policies or business rules. For example, when applying a new policy, Active
Roles does not automatically verify the existing directory data in order to determine
whether that data conforms to the new policy. Another example is a process that
automatically creates new objects, such as user or group objects, by directly accessing
Active Directory without the use of Active Roles.

The Active Roles Report Pack includes a number of reports that help detect policy violations
in directory data by collecting and analyzing information on the state of directory objects as
against the prescribed policies. However, as retrieving such information may take much
time and effort, the reports on policy compliance sometimes do not allow policy-related
issues to be resolved in a timely fashion.

In order to address this problem, Active Roles makes it possible to quickly build and
examine policy check results on individual objects or entire containers. The policy check
results provide a list of directory objects violating policies, and describe the detected
violations. From the policy check results, you can make appropriate changes to objects
or policies:

» Modify object properties in conformity with policies.
e Prevent individual objects from being affected by particular policies.
» Modify Policy Objects as needed.

e Perform an administrative task—for example, disable or move user objects that
violate policies.

In addition, you can save policy check results to a file, print them out, or send them to an
email recipient.

To check an object for policy compliance

1. Right-click the object, and click Check Policy.

2. Ifthe object is a container or Managed Unit, select the appropriate combination of
these check boxes to specify the scope of the operation:

e This directory object: The scope includes the container or Managed Unit you
have selected (this option does not cause the scope to include any child objects
or members of the container or Managed Unit).

e Child objects of this directory object: The scope includes all the child
objects (or members, as applied to a Managed Unit) in the entire hierarchy
under the container or Managed Unit you have selected.

« Immediate child objects only: The scope includes only the child objects (or
members, as applied to a Managed Unit) of which the container or Managed
Unit that you have selected is the direct ancestor.

Click OK.
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The progress and results of the policy check operation are displayed in the Policy
Check Results window. The left pane of the window lists the objects for which a
policy violation has been detected.

3. Click an object in the left pane of the Policy Check Results window.

When you click an object in the left pane, the right pane describes the policy
violation in detail. By default, the right pane in the Policy Check Results window
only displays basic options. You can display more choices by clicking the Details
column heading.

4. Use hypertext links in the right pane to perform the following tasks:

e Modify the property value violating the policy. To do so, click the edit link next
to the Property value label.

e Remove the object from the policy scope: Click the block policy inheritance
link next to the Policy Object label. If you do so, the policy no longer controls
the object.

» Modify the policy by clicking the properties link next to the Policy Object
label. This displays the Properties dialog for the Policy Object. For instructions
on how to add, modify, or remove policies in the Properties dialog, see Adding
policies to a Policy Object, Modifying policies in a Policy Object, and Removing
policies from a Policy Object.

e View or modify the properties of the object that violates the policy. To do so,
click Properties in the upper-right corner of the right pane.

e View or modify the properties of the object to which the Policy Object is applied
(linked). To do so, click the properties link next to the Applied to label.

NOTE: The Check Policy command on a Policy Object performs a check on all the
objects found in the policy scope of the Policy Object. Use the Check Policy command on
a Policy Object to find all objects that are not in compliance with the policies defined by
that Policy Object.

To see how checking for policy compliance works in the Active Roles Console

1. Create and configure a Policy Object with the property validation and generation
policy for the Department property of user objects, specifying the policy rule as
follows: Value must be specified and must be Sales or Production.

2. Apply (link) that Policy Object to an Organizational Unit that already holds some user
objects with no department specified.

3. Right-click the Organizational Unit and click Check Policy. In the Check Policy
dialog, click OK.

Once you have performed these steps, the Policy Check Results window is
displayed. Its left pane lists objects violating the policy.

4. Wait while the list in the left pane is being populated. Then, select a user object
from the list.

The right pane, next to the Violation label, displays the prompt You must specify
a value for the property ‘department’.
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5. Intheright pane, click the edit link next to the Property value label.

6. Inthe Properties dialog, select one of the acceptable values (Production or Sales)
from the Department combo-box.

Deprovisioning users or groups

The Active Roles user interfaces, both Active Roles Console and Web Interface, provide the
Deprovision command on user and group objects. This command originates a request to
deprovision the selected objects. When processing the request, Active Roles performs all
operations prescribed by the deprovisioning policies.

Default deprovisioning options

Active Roles ships with two built-in Policy Objects that specify the operations to
perform when deprovisioning a user or group. You can find those Policy Objects in the
Active Roles Console by selecting the Configuration > Policies > Administration >
Builtin container.

The Built-in Policy - User Default Deprovisioning Policy Object determines the
default effect of the Deprovision command on user accounts; the Built-in Policy -
Group Default Deprovisioning Policy Object determines the default effect of that
command on groups. Both objects are applied to the Active Directory container, taking
effect in all domains that are registered with Active Roles.

The following tables summarize the default deprovisioning policy options. If you do not add,
remove, or change deprovisioning policies, Active Roles operates in accordance with these
options when carrying out the Deprovision command on a user or group.

The following table summarizes the default deprovisioning policy options for users, defined
by the Built-in Policy - User Default Deprovisioning Policy Object.

Table 16: Policy options for users: Built-in Policy - User Default Deprovisioning

Policy Options

User Account » Disable the user account.

Deprovisioning * Set the user password to a random value.

e Change the user name to include the suffix deprovisioned
followed by the date when the user was deprovisioned.

» Fill in the user description to state that this user account is
deprovisioned.

» Clear certain properties of the user account, such as city,
company, and postal address.

@NE IDENTITY Active Roles 8.1.5 Administration Guide Ja4

by Quest Rule-based autoprovisioning and deprovisioning



Policy

Options

Group
Membership
Removal

Exchange Mailbox
Deprovisioning

Home Folder
Deprovisioning

User Account
Relocation

User Account
Permanent
Deletion

Remove the user account from all security groups.

Remove the user account from all distribution groups.
Hide the user mailbox from Exchange address lists, thus
preventing access to the mailbox.

Revoke access to the user home folder from the user account.
Give the user’s manager read access to the user home folder.

Designate Administrators as the home folder owner.

Do not move the user account from the Organizational Unit in
which the account was located at the time of deprovisioning.

Do not delete the user account.

The following table summarizes the default deprovisioning policy options for groups,
defined by the Built-in Policy - Group Default Deprovisioning Policy Object.

Table 17: Policy options for groups: Built-in Policy - User Default Deprovisioning

Policy

Options

Group Object
Deprovisioning

Group Object
Relocation

Group Object
Permanent
Deletion

Change the group type from Security to Distribution.
Hide the group from the Global Address List (GAL).

Change the group name to include the suffix “deprovisioned”
followed by the date when the group was deprovisioned.

Remove all members from the group.

Fill in the group description to state that this group is
deprovisioned.

Do not move the group from the Organizational Unit in which
the group was located at the time of deprovisioning.

Do not delete the group.

Delegating the Deprovision task

Deprovisioning is, by default, a right of Active Roles Admin, the administrative account
specified during Active Roles installation, but the task of deprovisioning can be delegated to
any group or user. A dedicated Access Template is provided for this purpose so that you can
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delegate the use of the Deprovision command without delegating the create or delete
operation.

To delegate the task of deprovisioning users or groups in a certain container, such as an
Organizational Unit or a Managed Unit, apply the Access Template as follows.

To delegate the Deprovision task

1. Inthe Active Roles Console, right-click the container and click Delegate Control to
display the Active Roles Security window.

2. Inthe Active Roles Security window, click Add to start the Delegation of Control
Wizard. Click Next.

3. Onthe Users or Groups page, click Add, and then select the users or groups to
which you want to delegate the deprovision task. Click Next.

4. On the Access Templates page, expand the Active Directory folder, then do the
following:

» To delegate the task of deprovisioning users, select the check box next to
Users - Perform Deprovision Tasks.

e To delegate the task of deprovisioning groups, select the check box next to
Groups - Perform Deprovision Tasks.

5. Click Next and follow the instructions in the wizard, accepting the default settings.

After you complete these steps, the users and groups you selected in Step 3 are authorized
to deprovision users or groups in the container you selected in Step 1, as well as in any
sub-container of that container.

Using the Deprovision command

The Deprovision command is available in both the Active Roles Console and Web
Interface. By using the Deprovision command, you start the deprovisioning operation on
the objects you have selected.

The operation progress and results are displayed in the Deprovisioning Results window.
When the operation is completed, the window displays the operation summary, and allows
you to examine operation results in detail.

The left pane of the Deprovisioning Results window lists the objects that have been
deprovisioned. The right pane displays the operation status and error messages, if any.

To view operation results, select an object in the left pane. The right pane shows a report
on all actions taken during the deprovisioning of the selected object.

Report on deprovisioning results

For each deprovisioned object, the Deprovisioning Results window can be used to
examine the deprovision operation results on that object.
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The Active Roles Console or Web Interface opens the Deprovisioning Results window
when carrying out the Deprovision command. You can also open this window by using the
Deprovisioning Results command, which is available on deprovisioned objects.

The Deprovisioning Results window displays a report of the deprovisioning operation.
The report organizes operation results into sections named after policy categories, with
each section containing report items specific to a certain policy category. When you click
the heading at the top of the report, the report is fully expanded and all report items are
shown. Alternatively, you can expand and contract individual sections within the report by
clicking the heading for each section.

For certain items, the report provides the option to further expand the view and display
additional information. By clicking the List option, you can display a list of items, such as
user or group properties, involved in the operation. By clicking the Details option, you can
examine the operation result in more detail.

The Deprovisioning Results window also meets some common reporting requirements
including the ability to document all the operation results to a file for printing or viewing.
Using the shortcut menu, you can export the report to a file as either HTML or XML, print
the report, or send it out via email.

Report contents

The following tables list the possible report items, one table per report section. The items in
each section describe results of the actions that were taken in accordance with the
respective deprovisioning policy. Report items also inform about success or failure of each
action. In the event of a failure, the report item includes an error description.

Not all the listed items must necessarily be present in a report. An actual report only
includes the report items corresponding to the configured policy options. For example, if
the policy is not configured to disable user accounts, the report does not include the item
regarding disabling user accounts.

Report section: User Account Deprovisioning

Table 18: User Account Deprovisioning

Report item (Success) Report item (Failure)

The user account is disabled. Failed to disable the user account.

The user password is reset to a random value. Failed to reset the user password.

The user logon name is changed to a random Failed to change the user logon name.

value.

The user logon name (pre-Windows 2000) is Failed to change the user logon name

changed to a random value. (pre-Windows 2000).

The user name is changed. Failed to change the user name.
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Report item (Success) Report item (Failure)

Original name: <name>. Current name: <name>.
New name: <name>. Failed to set this name: <name>.
User properties are changed. List: Failed to change user properties. List:
e User properties, old and new property e User properties, error
values. description.

Report section: Group Membership Removal

Table 19: Group Membership Removal

Report item (Success) Report item (Failure)

In accordance with policy, the user is not removed from Not applicable
security groups, except for Dynamic Groups and
groups controlled by Group Family. Details:

e Security groups to which the user belongs.

The user is removed from all security groups. Details: Failed to remove the user from

some security groups. Details:
e Security groups from which the user is removed ¥ group

e Security groups from
which the user is
removed.

e Security groups from
which the user is not
removed due to an error.

In accordance with policy, the user is retained in some  Failed to remove the user from

security groups. Details: some security groups. Details:
e Security groups from which the user is removed. e Security groups from
which the user is

e Security groups from which the user is not
removed in accord with policy. removed.
e Security groups from

which the user is not

removed in accord with
policy.
e Security groups from

which the user is not
removed due to an error.

In accordance with policy, the user is not removed from Not applicable
distribution groups or mail-enabled security groups,

except for Dynamic Groups and groups controlled by

Group Family. Details:
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Report item (Success) Report item (Failure)

e Distribution groups and mail-enabled security
groups to which the user belongs.

The user is removed from all distribution groups and Failed to remove the user from
mail-enabled security groups. Details: some distribution groups or
mail-enabled security groups.
e Distribution groups and mail-enabled security Details: y group

groups from which the user is removed.

e Distribution groups and
mail-enabled security
groups from which the
user is removed.

» Distribution groups or
mail-enabled security
groups from which the
user is not removed due
to an error.

In accordance with policy, the user is retained in some  Failed to remove the user from

distribution groups or mail-enabled security groups. some distribution groups or
Details: mail-enabled security groups.
Details:

e Distribution groups and mail-enabled security

groups from which the user is removed. e Distribution groups and
mail-enabled security
groups from which the
user is removed.

e Distribution groups or mail-enabled security
groups from which the user is not removed in
accord with policy.

» Distribution groups or
mail-enabled security
groups from which the
user is not removed in
accord with policy.

e Distribution groups or
mail-enabled security
groups from which the
user is not removed due
to an error.

Report section: Exchange Mailbox Deprovisioning

Table 20: Exchange Mailbox Deprovisioning

Report item (Success) Report item (Failure)

Mailbox deprovisioning is skipped because the  Not applicable
user does not have an Exchange mailbox.

@NE IDENTITY Active Roles 8.1.5 Administration Guide J80

Quest Rule-based autoprovisioning and deprovisioning



Report item (Success)

Report item (Failure)

The user mailbox is removed (hidden) from the
Global Address List (GAL).

The user mailbox is configured to suppress
non-delivery reports (NDR).

The manager of the user is provided with full
access to the user mailbox.

Manager name: <name>

N/A

The required users and groups are provided
with full access to the user mailbox. List:

e Users and groups

Forwarding messages to alternate recipients is
disallowed on the user mailbox.

The user mailbox is configured to forward
incoming messages to the user’s manager.

The user mailbox is configured to forward
incoming messages to the user’s manager,
with the option to leave message copies in the
mailbox.

Failed to configure the user mailbox to forward
incoming messages to the user’s manager.
Reason: the user’s manager is not specified in
the directory.

Automatic replies turned on.

Failed to remove (hide) the user mailbox
from the Global Address List (GAL).

Failed to configure the user mailbox to
suppress non-delivery reports (NDR).

Failed to provide the manager of the
user with access to the user mailbox.

Manager name: <name>

Failed to provide the user’s manager
with access to the user mailbox.
Reason: The user’s manager is not
specified in the directory.

Failed to provide the required users or
groups with access to the user mailbox.
List:

e Users and groups

Failed to disallow forwarding messages
to alternate recipients on the user
mailbox.

Failed to configure the user mailbox to
forward incoming messages to the
user’'s manager.

Failed to configure the user mailbox to
forward incoming messages to the
user’'s manager.

Not applicable

Failed to turn on automatic replies.

Report section: Home Folder Deprovisioning

Table 21: Home Folder Deprovisioning

Report item (Success)

Report item (Failure)

Home folder deprovisioning is N/A
skipped because the user does not

have a home folder.
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Report item (Success)

Report item (Failure)

The user’s rights on the home
folder are removed.

The manager of the user is
provided with read-only access to
the user home folder.

Manager name: <name>.

Not applicable

In accordance with the policy, the
user home folder will be deleted
when the user account is deleted.

Home folder name: <name>.

The required users and groups are
provided with read-only access to
the user home folder. List:

e Users and groups

The new owner is assigned to the
user home folder.

Owner name: <name>.

Failed to remove the user’s rights on the home
folder.

Failed to provide the manager of the user with read-
only access to the user home folder.

Manager name: <name>.

Failed to provide the user’s manager with read-only
access to the user home folder. Reason: The user’s
manager is not specified in the directory.

Not applicable

Failed to provide the required users or groups with
read-only access to the user home folder. List:

e Users and groups

Failed to assign the new owner to the user home
folder.

Failed to set this owner name: <name>.

Report section: User Account Relocation

Table 22: User Account Relocation

Report item (Success)

Report item (Failure)

In accordance with the policy, the user account is not Not applicable
moved from its original location: <container-name>.

The user account is moved to new location. Failed to move the user

Original location: <container-name>.

New location: <container-name>.
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account to new location.

Original location:
<container-name>.

Failed to move to this
location: <container-name>.
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Report section: User Account Permanent Deletion

Table 23: User Account Permanent Deletion

Report Item (Success)

Report Item (Failure)

In accordance with the policy, the
user account is not scheduled for
deletion.

The user account is scheduled for
deletion.

Will be deleted on this date:
<date>.

The user account is deleted to
Active Directory Recycle Bin.

Not applicable

Failed to schedule the user account for deletion.

Failed to delete the user account to Active Directory
Recycle Bin. Verify that Active Directory Recycle Bin
is enabled.

Report section: Group Object Deprovisioning

Table 24: Group Object Deprovisioning

Report Item (Success)

Report Item (Failure)

The type of the group is changed from Security to

Distribution.

The type of the group cannot be changed from
Security to Distribution because this is not a security

group.

The group is removed (hidden) from the Global

Address List (GAL).

The group cannot be removed (hidden) from the
Global Address List (GAL) because this is not a mail-

enabled group.
The group name is changed.
Original name: <name>

New name: <name>

In accordance with policy, the members are not

removed from the group. Details:

e List of the members retained in the group.

The members are removed from the group. Details:

(GNE IDENTITY
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Failed to change the type of the
group from Security to
Distribution.

Not applicable

Failed to remove (hide) the group
from the Global Address List
(GAL).

Not applicable

Failed to change the group name.
Current name: <name>

Failed to set this name: <name>

Not applicable

Failed to remove some members
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Report Item (Success) Report Item (Failure)

e List of the members removed from the group. from the group. Details:

e List of the members
removed from the group.

o List of the members that
are not removed from the
group due to an error.

In accordance with policy, some members are Failed to remove some members
retained in the group. Details: from the group. Details:
 List of the members removed from the group.  List of the members

e List of the members retained in the group. removed from the group.

 List of the members
retained in the group in
accord with policy.

o List of the members that
are not removed from the
group due to an error.

Group properties are changed. List: Failed to change group

roperties. List:
e Property names, old and new property values. prop

e Property names, error
description.

Report section: Group Object Relocation

Table 25: Group Object Relocation

Report Item (Success) Report Item (Failure)

In accordance with policy, the group is not moved from Not applicable
its original location: name of container

The group is moved to new location. Failed to move the group to

Original location: <container-name>. new location.

Original location: <container-
name>.

New location: <container-name>.

Failed to move to this
location: <container-name>.

@NE IDENTITY Active Roles 8.1.5 Administration Guide S0

Quest Rule-based autoprovisioning and deprovisioning



Report section: Group Object Permanent Deletion

Table 26: Group Object Permanent Deletion

Report Item (Success) Report Item (Failure)

In accordance with policy, the Not applicable
group is not scheduled for
deletion.

The group is scheduled for Failed to schedule the group for deletion.
deletion.

Will be deleted on this date:
<date>.

The group is deleted to Active Failed to delete the group to Active Directory Recycle
Directory Recycle Bin. Bin. Verify that Active Directory Recycle Bin is enabled.

Report section: Notification Distribution

Table 27: Notification Distribution

Report Item (Success) Report Item (Failure)

Deprovisioning notification will be sent to Not applicable
the listed recipients (not sent so far). List:

e <name-of-recipients>

Deprovisioning notification was sent to the  Due to an error, deprovisioning notification
listed recipients. List: was not sent to the listed recipients. List:

e <name-of-recipients> e <name-of-recipients>

Report section: Report Distribution

Table 28: Report Distribution

Report Item (Success) Report Item (Failure)

Deprovisioning report will not be sent out Not applicable
since no errors occurred.

Deprovisioning report will be sent to the Not applicable
listed recipients (not sent so far). List:

e <name-of-recipients>

Deprovisioning report was sent to the listed Due to an error, deprovisioning report was

recipients. List: not sent to the listed recipients. List:
e <name-of-recipients> e <name-of-recipients>
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Restoring deprovisioned users or
groups

Active Roles provides the ability to restore deprovisioned objects, such as deprovisioned
users or groups. The purpose of this operation, referred to as the Undo Deprovisioning
operation, is to roll back the changes that were made to an object by the Deprovision
operation. When a deprovisioned object needs to be restored (for example, if a user
account has been deprovisioned by mistake), the Undo Deprovisioning operation allows the
object to be quickly returned to the state it was in before the changes were made.

The Undo Deprovisioning operation rolls back the changes that were made to the object in
accord with the standard Deprovisioning policies. For example, assume a User Account
Deprovisioning policy is configured so that a deprovisioned user account:

e Is disabled.

e Isrenamed.

e Has the Description changed.

e Has a number of properties cleared out.

e Has the password set to a random value.
In this case, the Undo Deprovisioning operation:

e Enables the user account.

e Sets the Description, Name, and other properties to the original values on the
user account.

e Can provide the option to reset the password so as to enable the user to log on.
Similar behavior is in effect for the other policies of the Deprovisioning category:

» If the Deprovision operation revokes user access to resources such as the home
folder or Exchange mailbox, then the Undo Deprovisioning operation attempts to
restore user access to the resources.

» If the Deprovision operation removes a user account from certain groups, the Undo
Deprovisioning operation can add the user account to those groups, restoring the
original group memberships of the user account.

To offer another example, suppose the deprovisioning policy is configured so that
Deprovision operation on a group:

* Removes all members from the group
 Renames the group

* Moves the group to a certain container

In this case, the Undo Deprovisioning operation:
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e Restores the original membership list of the group, as it was at the time of
deprovisioning

* Renames the group, restoring the original name of the group

e Moves the group to the container that held the group at the time of deprovisioning
Similar behavior is in effect for the other group deprovisioning policy options:

» If the Deprovision operation hides the group from the Global Address List (GAL),
Undo Deprovisioning restores the visibility of the group in the GAL.

» If the Deprovision operation changes the group type from Security to Distribution,
Undo Deprovisioning sets the group type back to Security.

» If the Deprovision operation changes any other properties of the group, Undo
Deprovisioning restores the original property values.

Both the Active Roles Console and Web Interface provide the Undo Deprovisioning
command on deprovisioned users or groups. When selected on a deprovisioned object, this
command originates a request to restore the object. Upon receipt of the request, Active
Roles performs all necessary actions to undo the results of deprovisioning on the object,
and provides a detailed report of the actions that were taken along with information about
success or failure of each action.

Policy options to undo user deprovisioning

The behavior of the Undo Deprovisioning operation is determined by a configurable policy
contained in a built-in Policy Object. This is the Policy Object named Built-in Policy -
Default Rules to Undo User Deprovisioning and located in the Builtin container under
Configuration/Policies/Administration. The Policy Object is applied to the Active
Directory folder, thus taking effect in all domains that are registered with Active Roles
(managed domains).

The option provided by this policy can be used to prevent restoration of group
memberships and resetting of the user password:

* Restore group memberships: When selected, causes the Undo Deprovisioning
operation on a deprovisioned user account to add the account to the distribution and
security groups from which the account was removed in accord with the Group
Membership Removal policy. If you do not want restored accounts to be
automatically added to groups, clear this option.

Note that regardless of whether this option is selected, once a deprovisioned user
account is restored, Active Roles automatically adds the account to the appropriate
Dynamic Groups and Group Families depending on properties of the account.

 Leave password unchanged: Causes the Undo Deprovisioning operation on a
deprovisioned user account to prevent resetting of the password for the restored
account. Select this option if you want the password to be reset by the HelpDesk or
by using a self-service password management solution after the account is restored.
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 Prompt to reset password: Causes the Undo Deprovisioning operation on a
deprovisioned user account to enable resetting of the password for the restored
account. If this option is selected, the Undo Deprovisioning command displays a
dialog in which the password can be reset.

To view or modify the policy options

1. Open the Active Roles Console.

2. Inthe Console tree, expand Configuration > Policies > Administration, and
select Builtin under Administration.

3. In the details pane, double-click Built-in Policy - Default Rules to Undo User
Deprovisioning.

4. On the Policies tab in the Properties dialog, click the policy in the list, and then
click View /Edit to access the policy options.

Since the built-in Policy Object is normally applied to the Active Directory node in the Active
Roles namespace, the policy options are in effect on any deprovisioned user account. If you
need different policy options for different domains or containers, create a copy of the built-

in Policy Object, and then configure and apply the copy as appropriate.

The Undo Deprovisioning operation is normally enabled in all domains that are registered
with Active Roles. It is possible to prohibit this operation in individual domains or
containers, or in all domains, by blocking or disabling the policy that governs the operation.
In case of disabling the built-in Policy Object, an enabled copy of that Policy Object can be
applied in order to allow the Undo Deprovisioning operation in individual domains or
containers.

Delegating the task to undo deprovisioning

Restoring deprovisioned users or groups is, by default, a right of Active Roles Admin, the
administrative account specified during Active Roles installation, but this task can be
delegated to any group or user. A dedicated Access Template is provided for this purpose
so you can delegate the use of the Undo Deprovisioning command without delegating
the create or delete operation.

To delegate the task of restoring deprovisioned users or groups held in a certain
container, such as an Organizational Unit or a Managed Unit, you should apply the Access
Template as follows.

To delegate the Undo Deprovisioning task

1. Inthe Active Roles Console, right-click the container and click Delegate Control to
display the Active Roles Security window.

2. Inthe Active Roles Security window, click Add to start the Delegation of Control
Wizard. Click Next.

3. Onthe Users or Groups page, click Add, and then select the users or groups to
which you want to delegate the task. Click Next.
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4. On the Access Templates page, expand the Active Directory folder and then do
the following:

a. To delegate the task of restoring deprovisioned users, select the check box
next to Users - Perform Undo Deprovision Tasks.

b. To delegate the task of restoring deprovisioned groups, select the check box
next to Groups - Perform Undo Deprovision Tasks.

5. Click Next and follow the instructions in the wizard, accepting the default settings.

After you complete these steps, the users and groups you selected in Step 3 are authorized
to restore deprovisioned users in the container you selected in Step 1, as well as in any
sub-container of that container.

Using the Undo Deprovisioning command

The Undo Deprovisioning command is available in both the Active Roles Console and
Web Interface to those who are authorized to restore deprovisioned users or groups. By
using this command, you start the Undo Deprovisioning operation on the objects you have
selected, causing Active Roles to undo the results of deprovisioning on those objects.

To restore a deprovisioned user account

1. Inthe Active Roles Console, right-click the user account, and then click Undo
Deprovisioning.

2. Inthe Password Options dialog, choose the options to apply to the password of the
restored account, and then click OK.

For information about each option, open the Password Options dialog, and
then press F1.

3. Wait while Active Roles restores the user account.

To restore a deprovisioned group
1. Inthe Active Roles Console, right-click the group, and then click Undo
Deprovisioning.
2. Wait while Active Roles restores the group.
The operation progress and results are displayed in the Results of Undo Deprovisioning
window, which is similar to the Deprovisioning Results window discussed earlier in this

chapter. When the operation is completed, the window displays the operation summary,
and allows you to examine operation results in detail.

Report on results of undo deprovisioning

For each of the restored objects, the Results of Undo Deprovisioning window can be
used to examine the restore operation results on that object. The Active Roles Console or
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Web Interface opens the Results of Undo Deprovisioning window when carrying out the
Undo Deprovisioning command.

The Results of Undo Deprovisioning window displays a report of the Undo
Deprovisioning operation, which is similar to a deprovisioning-related report discussed
earlier in this chapter. The report organizes operation results into sections, with each
section containing report items specific to a certain category of deprovisioning policy. The
report items within a particular section inform of the actions performed to roll back the
changes that were made by the deprovisioning policy of the respective category.

When you click the heading at the top of the report, the report is fully expanded and all
report items are shown. Alternatively, you can expand and contract individual sections
within the report by clicking the heading for each section.

For certain items, the report provides the option to further expand the view and display
additional information. By clicking the List option, you can display a list of items, such as
user or groups properties, involved in the operation. By clicking the Details option, you can
examine the operation result in more detail.

The Results of Undo Deprovisioning window also provides the ability to document all
the operation results to a file for printing or viewing. Using the shortcut menu, you can
export the report to a file as either HTML or XML, print the report, or send it out via email.

Report contents

The following tables list the possible report items, one table per report section. The items in
each section describe the results of the actions taken to undo the changes made by the
respective deprovisioning policy. Report items also inform about success or failure of each
action. In the event of a failure, the report item includes an error description.

Not all the listed items must necessarily be present in a report. An actual report only
includes the report items related to the deprovisioning policies that were in effect when the
user or group was deprovisioned.

Report section: Undo User Account Deprovisioning

Table 29: Undo User Account Deprovisioning

Report item (Success) Report item
(Failure)
The user account is enabled. Failed to enable the

user account.

The user password is reset to a known value with the following  Failed to reset the user

password options: <List of options> password.
The current user password is left unchanged. N/A
The user name is restored. Failed to restore the
user name.
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Report item (Success) Report item

(Failure)
Old name: <name> Current name: <name>
Restored name: <name> Failed to set this name:
<name>
User properties are restored. List: Failed to restore user

. properties. List:
e User properties, new property values

e User properties,
error description

Report section: Undo Group Membership Removal

Table 30: Undo Group Membership Removal

Report item (Success) Report item (Failure)

In accord with policy, the user’'s membership N/A
in security groups is not restored.

In accord with policy, the user’'s membership N/A
in distribution groups or mail-enabled
security groups is not restored.

The user’'s membership in security groups is  Failed to restore the user’'s membership in

restored. Details: some security groups. Details:
e Security groups to which the useris e Security groups to which the useris
added added

e Security groups to which the useris
not added due to an error

The user’'s membership in distribution Failed to restore the user’s membership in
groups and mail-enabled security groups is some distribution groups or mail-enabled
restored. Details: security groups. Details:
e Distribution and mail-enabled security e Distribution and mail-enabled
groups to which the user is added security groups to which the user is
added

» Distribution or mail-enabled security
groups to which the user is not
added due to an error

@NE IDENTITY Active Roles 8.1.5 Administration Guide 200

Quest Rule-based autoprovisioning and deprovisioning



Report section: Undo Exchange Mailbox Deprovisioning

Table 31: Undo Exchange Mailbox Deprovisioning

Report item (Success) Report item (Failure)

Restoration of the user mailbox is skipped because N/A
the user did not have an Exchange mailbox at the
time of deprovisioning.

The original state of the user mailbox is restored in Failed to restore the original state of
the Global Address List (GAL). the user mailbox in the Global
Address List (GAL).

The original settings for non-delivery reports Failed to restore the original settings
sending are restored on the user mailbox. for non-delivery reports sending on
the user mailbox.

The original configuration of the email forwarding  Failed to restore the original
is restored on the user mailbox. configuration of the email
forwarding on the user mailbox.

The original security settings are restored on the Failed to restore the original security
user mailbox. settings on the user mailbox.

Automatic replies turned off. Failed to turn off automatic replies.

Report section: Undo Home Folder Deprovisioning

Table 32: Undo Home Folder Deprovisioning

Report item (Success) Report item (Failure)

Restoration of the home folder is skipped because the  N/A
user did not have a home folder at the time of
deprovisioning.

The original security settings are restored on the user  Failed to restore the original
home folder. security settings on the user
home folder.

Report section: Undo User Account Relocation

Table 33: Undo User Account Relocation

Report item (Success) Report item (Failure)

No changes to undo. N/A

The user account is moved to its original  Failed to move the user account to its original
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Report item (Success)

Report item (Failure)

location.
Former location: <name of container>

Restored original location: <name of
container>

Report section: Undo User

location.
Current location: <name of container>

Failed to move to this location: <name of
container>

Account Permanent Deletion

Table 34: Undo User Account Permanent Deletion

Report Item (Success)

Report Item (Failure)

No changes to undo.

Scheduled deletion of the user account is
canceled.

Report section: Undo Grou

N/A

Failed to cancel scheduled deletion of the
user account.

The account is going to be deleted on this
date: <date>

p Object Deprovisioning

Table 35: Undo Group Object Deprovisioning

Report Item (Success)

Report Item (Failure)

The group is changed back to the
Security group type.

The group is restored in the Global
Address List (GAL).

The group name is restored.
Old name: <name>

Restored name: <name>

The membership list of the group is
restored. Details:

List of the members added to the
group

Group properties are restored. List:

e <Group properties, new
property values>

(GNE IDENTITY
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Failed to change the group back to the Security
group type.

Failed to restore the group in the Global Address
List (GAL).

Failed to restore the group name.
Current name: <name>

Failed to set this name: <name>

Failed to restore the membership list of the
group. Details:

List of the members added to the group

List of the members that are not added to the
group due to an error

Failed to restore group properties. List:

e <Group properties, error description>
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Report section: Undo Group Object Relocation

Table 36: Undo Group Object Relocation

Report Item (Success) Report Item (Failure)

No changes to undo. N/A

The group is moved to its original Failed to move the group to its original
location. location.

Former location: <name of container> Current location: <name of container>
Restored original location: <name of Failed to move to this location: <name of
container> container>

Report section: Undo Group Object Permanent Deletion

Table 37: Undo Group Object Permanent Deletion

Report Item (Success) Report Item (Failure)

No changes to undo. N/A

Scheduled deletion of the group is Failed to cancel scheduled deletion of the
canceled. group.

The group is going to be deleted on this date:
<date>

Container Deletion Prevention policy

A bulk deletion may occur in a situation where an administrator selects and deletes a
container object, such as an Organizational Unit, that has subordinate objects. Although
bulk deletions are rare, they are disruptive events you can guard against by leveraging a
new policy: Container Deletion Prevention.

One of the most common bulk deletions is a container deletion, which occurs when Active
Roles is used to delete a container object that holds other (subordinate) objects. By default,
a container deletion has the following characteristics:

e First, Active Roles builds a list of all the objects found in the container (subordinate
objects), and then starts deleting the listed objects one by one.

e Then, for every object in the list, Active Roles performs an access check to determine
if the user or process that requested the deletion has sufficient rights to delete the
object. If the access check allows the deletion, then the object is deleted; otherwise,
Active Roles does not delete the object, and proceeds to deletion of a subsequent
object in the list.
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» Finally, once all the subordinate objects are deleted, Active Roles deletes the
container itself. If any of the subordinate objects are not deleted, the container is not
deleted as well.

As a result of this behavior, an administrator who has full control over an Organizational
Unit in Active Roles can accidentally delete the entire Organizational Unit, with all its
contents, within a single operation. To prevent this, Active Roles provides for a certain
policy to deny deletion of non-empty containers.

The Container Deletion Prevention policy defines a configurable list of names of object
types as specified by the Active Directory schema (for example, the Organizational Unit
object type). When an Active Roles client requests the deletion of a particular container,
the Administration Service evaluates the request in order to determine whether the type of
the container is in the list defined by the policy. If the container type is in the list and the
container holds any objects, the Administration Service denies the request, preventing the
deletion of the container. In this case, the client prompts to delete all objects held in the
container before attempting to delete the container itself.

To configure a Container Deletion Prevention policy

In the Console tree, select Configuration > Policies > Administration > Builtin.

2. Inthe details pane, double-click Built-in Policy - Container Deletion
Prevention.

3. On the Policies tab, select the policy from the list and then click View/Edit.

4. Onthe Types of Containers tab, click Add and use the Select Object Type dialog
to select the type (or types) of container you want to protect, and then click OK.

For example, you can select the Organizational Unit object type to prevent deletion of
non-empty Organizational Units.

5. Click OK to close the dialogs you opened.

The built-in Policy Object you have configured using the above instructions prevents
deletion of non-empty containers in any managed domain.

You may not want Active Roles to prevent deletion of hon-empty containers that are
outside a certain scope (such as a certain domain, Organizational Unit, or Managed
Unit), whereas deletion should be prohibited on the non-empty containers that fall within
that particular scope. In this scenario, you need to create and configure a copy of the
built-in Policy Object and apply that copy to the scope in question. Then, block the effect
of the built-in Policy Object by selecting the Disable all policies included in this
Policy Object check box on the Policies tab in the dialog for managing properties of
the Policy Object.

If you only need to allow deletion of non-empty containers within a certain scope, then you
can simply block the effect of the built-in Policy Object on the object representing the scope
in question. Thus, if you want to allow deletion of Organizational Units that fall within a
certain Managed Unit, you can use the Enforce Policy command on that Managed Unit to
display the dialog for managing policy settings and then select the Blocked check box next
to the name of the built-in Policy Object.
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Protecting objects from accidental deletion

Another option to guard Organizational Units against accidental deletion is by using an
Active Roles feature that allows you to deny deletion of particular objects. When creating
an Organizational Unit by using Active Roles, you have the option to protect the newly
created Organizational Unit from deletion. You can also use Active Roles to enable this
protection on any existing Organizational Units or other objects in the managed Active
Directory domains and Active Directory Lightweight Directory Services (AD LDS) partitions.

On the pages for creating an Organizational Unit in the Active Roles Console or Web
Interface, you can select the Protect container from accidental deletion check box.
This option removes the Delete and Delete Subtree permissions on the Organizational Unit
and the Delete All Child Objects permission on the parent container of the Organizational
Unit. An Organizational Unit created with this option cannot be deleted, whether using
Active Roles or other tools for Active Directory administration, as the deletion-related
permissions are removed by applying the appropriate Access Templates in Active Roles and
replicating the resulting permission entries to Active Directory.

The option to protect existing Organizational Units or other objects from deletion is
available on the Object tab of the Properties page for an object in the Active Roles
Console or Web Interface. If you select the Protect object from accidental deletion
check box on that tab, Active Roles configures the permission entries on the object in the
same way as with the Protect container from accidental deletion option for an
Organizational Unit. When somebody attempts to delete a protected object, the operation
returns an error indicating that the object is protected or access is denied.

The option to protect an object from deletion adds the following Access Template links:

e On the object to protect, adds a link to the Objects - Deny Deletion Access
Template for the Everyone group.

e On the parent container of the object, adds a link to the Objects - Deny Deletion
of Child Objects Access Template for the Everyone group. (Active Roles does not
add this link if it detects that a link of the same configuration already exists.)

The links are configured to apply the Access Template permission entries not only in Active
Roles but also in Active Directory. This adds the following access control entries (ACEs) in
Active Directory:

» On the object to protect, adds explicit Deny ACEs for the Delete and Delete Subtree
permissions for the Everyone group.

e On the parent container of the object, adds an explicit Deny ACE for the Delete All
Child Objects permission for the Everyone group. (Active Roles does not add this ACE
if it detects that an ACE of the same configuration already exists.)

If you clear the Protect object from accidental deletion check box for a given object,
Active Roles the updates the object to remove the link to the Objects - Deny Deletion
Access Template in Active Roles along with the explicit Deny ACEs for the Delete and Delete
Subtree permissions for the Everyone group in Active Directory. As a result, the object is no
longer guarded against deletion. Note that clearing the check box for a particular object
removes the Access Template links and ACEs from only that object, leaving the Access
Template links and ACEs on the parent container intact. This is because the parent
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container may hold other objects that are protected from deletion. If the container does not
hold any protected objects, you could remove the link to the Objects - Deny Deletion of
Child Objects Access Template by using the Delegate Control command on that
container in the Active Roles Console, which will also delete the corresponding ACE in
Active Directory.

It is possible to configure Active Roles so that the Protect container from accidental
deletion check box will be selected by default on the pages for creating Organizational
Units in the Active Roles Console or Web Interface. To enable this behavior within a domain
or container, apply the Built-in Policy - Set Option to Protect OU from Deletion
Policy Object to that domain or container. This Policy Object ensures that Organizational
Units created by Active Roles are protected from deletion regardless of the method used to
create them. Thus, Organizational Units created using Active Roles script interfaces will
also be protected by default.

Picture management rules

You can use the Active Roles Console or Web Interface to add a picture for a user, group, or
contact object. An advantage of using pictures, such as the photographs or logos, is that a
picture makes it easier to recognize the user, group, or contact in e-mail clients and web
applications that can retrieve the picture from Active Directory. When you supply a picture
for a user, group or contact via Active Roles, the picture is saved in the thumbnailPhoto
attribute of that user, contact, or group in Active Directory.

Active Roles provides a policy to enforce the picture size limits, including maximum and
minimum dimensions and the option to resize the picture automatically. When you add a
picture to the user, group, or contact, Active Roles checks the dimensions of the picture,
and does not apply the picture in case of policy violation. If automatic picture resizing is
enabled, Active Roles reduces the dimensions of the picture as needed by downsampling
the original picture.

You can use the following policy options to configure the picture management rules:

« Controlled property and object type: Specifies the object class and the attribute
intended to store the picture. The policy fires upon a request to save a picture in the
specified attribute of an object of the specified object class. By default, the policy
controls the thumbnailPhoto attribute of the user, contact, or group object class. You
can choose a different attribute for each object class separately. For instance, you
can configure the policy to control the thumbnaillogo or jpegPhoto user attribute
while retaining control of the thumbnailPhoto attribute of groups and contacts.

e Maximum allowed size, in pixels: Specifies the maximum allowed dimensions of
the picture. If the width or height of a given picture is greater than specified by this
option, then the policy prevents the picture from being applied. The policy has the
option to resample pictures of large size. You can configure the policy so that Active
Roles automatically reduces the size of the original picture to meet the policy
requirements and then applies the resulting picture.
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e Minimum allowed size, in pixels: Specifies the minimum allowed dimensions of
the picture. If the width or height of a given picture is less than specified by this
option, then the policy prevents the picture from being applied.

 Enable automatic picture resizing: Causes Active Roles to resample the pictures
whose dimensions exceed the maximum allowed size. If you select this option, Active
Roles reduces the dimensions of the picture as appropriate and then applies the
resulting picture. Otherwise, Active Roles merely rejects the pictures that are too big.

To view or modify the policy options
Open the Active Roles Console.
In the Console tree, select Configuration > Policies > Administration > Builtin.

In the details pane, double-click Built-in Policy - Picture Management Rules.

D W N~

On the Policies tab in the Properties dialog that appears, click the policy in the list,
and then click View/ Edit.

5. Inthe Properties dialog that appears, do the following:

e On the Controlled Property tab, view or change the object class and attribute
to which the policy applies.

e On the Picture Sizing tab, view or change the policy settings that restrict the
size of the picture stored by the controlled property.

By default, the built-on Policy Object is applied to the Active Directory node in the Active
Roles namespace, so the policy options affect all users, groups and contacts in the
managed domains. If you need different policy options for different domains or containers,
create a copy of the built-in Policy Object, and then configure and apply the copy as
appropriate.

Policy extensions

In Active Roles, administrators can configure policies of the predefined types that are
installed with Active Roles. By default, the list of policy types in the Active Roles Console
contains only the predefined types, such as Home Folder AutoProvisioning or User
Account Deprovisioning. It is possible to extend the list by adding new types of policy.

Each policy type determines a certain policy action (for example, creating a home folder for
a user account) together with a collection of policy parameters to configure the policy
action (for example, parameters that specify the network location where to create home
folders). Active Roles provides the ability to implement and deploy custom types of policy.
It enables custom policy types to be created as necessary, and listed along with the
predefined policy types, allowing administrators to configure policies that perform custom
actions determined by those new types of policy.

Active Roles allows the creation of custom policies based on the Script Execution built-in
policy type. However, creating and configuring a script policy from scratch can be time-
consuming. Custom policy types provide a way to mitigate this overhead. Once a custom
policy type is deployed that points to a particular script, administrators can easily configure
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and apply policies of that type, having those policies perform the actions determined by the
script. The policy script also defines the policy parameters specific to the policy type.

Custom policy types provide an extensible mechanism for deploying custom policies. This
capability is implemented by using the Policy Type object class. Policy Type objects can be
created by using the Active Roles Console, with each object representing a certain type of
custom policy.

Design elements

The policy extensibility feature is designed around two interactions: policy type deployment
and policy type usage.

Policy type deployment

The deployment process involves: the development of a script that implements the policy
action and declares the policy parameters; the creation of a Script Module containing that
script; and the creation of a Policy Type object referring to that Script Module. To deploy a
policy type to a different environment, an administrator can export the policy type to an
export file in the source environment and then import the file in the destination
environment. Using export files makes it easy to distribute custom policy types.

Policy type usage

This is the process of configuring policies. It occurs when an administrator creates a new
Policy Object or adds policies to an existing Policy Object. For example, the wizard for
creating a Policy Object includes a page that prompts to select a policy. The page lists the
policy types defined in Active Roles, including the custom policy types. If a custom policy
type is selected, the wizard provides a page for configuring the policy parameters specific
to that policy type. Once the wizard is completed, the Policy Object contains a fully
functional policy of the selected custom type.

Active Roles provides a graphical user interface, complete with a programming
interface, for creating and managing custom policy types. Using those interfaces, Active
Roles policies can be extended to meet the needs of a particular environment. Active
Roles also has a deployment mechanism by which administrators put new types of
policy into operation.

Since policy extension involves two interactions, Active Roles provides solutions in both
areas. The Administration Service maintains policy type definitions, exposing policy
types to its clients such as the Active Roles Console or ADSI Provider. The Console
can be used to:

e Create a new custom policy type, either from scratch or by importing a policy type
that was exported from another environment.
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» Make changes to the definition of an existing custom policy type.

» Add a policy of a particular custom type to a Policy Object, making the necessary
changes to the policy parameters provided for by the policy type definition.

Normally, an Active Roles expert develops a custom policy type in a separate environment,
and then exports the policy type to an export file. An Active Roles administrator deploys the
policy type in the production environment by importing the export file. After that, the
Active Roles Console can be used to configure and apply policies of the new type.

Policy Type objects

The policy extensibility feature is built upon Policy Type objects, each of which represents a
single type of policy. Policy Type objects are used within both the policy type deployment
and policy type usage processes. The process of deploying a new policy type involves the
creation of a Policy Type object. During the process of adding a policy of a custom type, the
policy type definition is retrieved from the respective Policy Type object.

Each Policy Type object holds the following data to define a single policy type:

» Display name: Identifies the policy type represented by the Policy Type object. This
name is displayed on the wizard page where you select a policy to configure when
creating a new Policy Object or adding a policy to an existing Policy Object.

o Description: A text describing the policy type. This text is displayed when you select
the policy type in the wizard for creating a new Policy Object or in the wizard for
adding a policy to an existing Policy Object.

 Reference to Script Module: Identifies the script to run upon the execution of a
policy of this type. When adding a policy of a custom policy type, you effectively
create a policy that runs the script from the Script Module specified by the respective
Policy Type object.

» Policy Type category: Identifies the category of Policy Object to which a policy of
this type can be added. A policy type may have the category option set to either
Provisioning or Deprovisioning, allowing policies of that type to be added to either
provisioning or deprovisioning Policy Objects respectively.

e Function to declare parameters: Identifies the name of the script function that
declares the configurable parameters for the administration policy that is based on
this policy type. The function must exist in the Script Module selected for the policy
type. By default, it is assumed that the parameters are declared by the function
named onlnit.

» Policy Type icon: The image that appears next to the display name of the policy
type on the wizard page where you select a policy to configure, to help identify and
visually distinguish this policy type from the other policy types.

To create a custom policy type, you first need to create a Script Module that holds the policy
script. Then, you can create a Policy Type object referring to that Script Module. When you
import a policy type, Active Roles automatically creates both the Script Module and the
Policy Type object for that policy type. After the Policy Type object has been created, you
can add a policy of the new type to a Policy Object.
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Creating and managing custom policy types

In Active Roles, Policy Type objects provide the ability to store the definition of a custom
policy type in a single object. Policy Type objects can be exported and imported, which
makes it easy to distribute custom policies to other environments.

When creating a new Policy Object or adding a policy to an existing Policy Object, an
administrator is presented with a list of policy types derived from the Policy Type objects.
Selecting a custom policy type from the list causes Active Roles to create a policy based on
the settings found in the respective Policy Type object.

This section covers the following tasks specific to custom policy types:

e Creating a Policy Type object

e Changing an existing Policy Type object
e Using Policy Type containers

» Exporting policy types

e Importing policy types

e Configuring a policy of a custom type

» Deleting a Policy Type object

For more information about Policy Type objects, including instructions on scripting for
Policy Type objects, refer to the Active Roles SDK.

Creating a Policy Type object

Active Roles stores Policy Type objects in the Policy Types container. You can access that
container in the Active Roles Console by expanding the Configuration > Server
Configuration branch of the Console tree.

To create a new Policy Type object

1. Inthe Console tree, under Configuration/Server Configuration/Policy Types,
right-click the Policy Type container in which you want to create a new object, and
select New > Policy Type.

For example, if you want to create a new object in the root container, right-click
Policy Types.

2. Inthe New Object - Policy Type Wizard, type a name, a display name and,
optionally, a description for the new object.

The display name and description are displayed on the page for selecting a policy, in
the wizards that are used to configure Policy Objects.

3. Click Next.
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. Click Browse and select the Script Module containing the script that will be run by
the policies of this policy type.

The Script Module must exist under the Configuration/Script Modules container
and hold a policy script.

. Inthe Policy Type category area, do one of the following:

a. Click Provisioning if policies of this type are intended for Policy Objects of the
provisioning category.

b. Click Deprovisioning if policies of this type are intended for Policy Objects of
the deprovisioning category.

The policy types that have the Provisioning option selected appear on the page for
selecting a policy in the wizard that is used to create a provisioning Policy Object or to
add policies to an existing provisioning Policy Object. The policy types that have the
Deprovisioning option selected appear in the wizard for creating a deprovisioning
Policy Object or adding policies to such a Policy Object.

From the Function to declare parameters list, select the name of the script
function that defines the parameters specific to this type of administration policy.

The list contains the names of all the functions found in the script you selected in
Step 4. Every policy of this type will have the parameters that are specified by the
function you select from the Function to declare parameters list. Normally, this is
a function named onlInit.

. Click Policy Type Icon to verify the image that denotes this type of policy. To
choose a different image, click Change and open an icon file containing the
image you want.

This image appears next to the display name of the policy type on the wizard page for
selecting a policy to configure, to help identify and visually distinguish this policy type
from the other policy types.

The image is stored in the Policy Type object. In the dialog that appears when you
click Policy Type Icon, you can view the image that is currently used. To revert to
the default image, click Use Default Icon. If the button is unavailable, then the
default image is currently used.

. Click Next and follow the steps in the wizard to complete the creation of the new
Policy Type object.

Changing an existing Policy Type object

You can change an existing Policy Type object by changing the general properties, script,
category, oricon. The general properties include the name, display name, and description.
The Policy Type objects are located under Configuration/Server Configuration/Policy
Types in the Active Roles Console.

The following table summarizes the changes you can make to an existing Policy Type
object, assuming that you have found the object in the Active Roles Console.
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Table 38: Changing an existing Policy Type object

To change Do this

Commentary

Name of the Right-click the

object object and click
Rename.

Display Right-click the

name or object, click

description Properties and
make the necessary
changes on the
General tab.

Script Right-click the

Module object, click
Properties, click
the Script tab, click
Browse, and then
select the Script
Module you want.

Policy Type Right-click the

category object, click
Properties, click
the Script tab, and
then click either
Provisioning or
Deprovisioning.

Function to Right-click the

declare object, click

parameters  Properties, click
the Script tab, and
then choose the

(GNE IDENTITY
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The name is used to identify the object, and must be
uniqgue among the objects held in the same Policy
Type container.

Changing the display name or description also
changes the policy name or description on the page
for selecting a policy in the Policy Object
management wizards.

You can change the script in the Script Module that
is currently associated with the Policy Type object
instead of selecting a different Script Module. To
view or change the script, find and select the Script
Module in the Active Roles Console tree, under
Configuration/Script Modules.

Changing the script affects all the existing policies of
this policy type. If you add a policy to a Policy Object
and then change the script for the Policy Type object
based on which the policy was created, the policy
will run the changed script.

Changing this option changes the appearance of the
respective policy type in the Policy Object
management wizards. For example, once the option
has been changed from Provisioning to
Deprovisioning, the policy type is no longer
displayed in the wizard for configuring a
provisioning Policy Object; instead, it appears in the
wizard for configuring a deprovisioning Policy
Object.

However, changing the Policy Type category does
not affect the existing policies of this policy type. For
example, once a policy is added to a provisioning
Policy Object, the policy is retained in that Policy
Object after changing the Policy Type category from
Provisioning to Deprovisioning in the respective
Policy Type object.

Changing this setting changes the list of the policy
parameters specific to this policy type. The changes
do not affect the parameters of the existing policies
of this type. When you add a new policy based on
this policy type, the list of the policy parameters is
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To change Do this Commentary

appropriate built using the new function to declare parameters.
function from the

Function to

declare

parameters list.

Policy Type Right-click the Changing this setting changes the image that
icon object, click appears next to the display name of the policy type
Properties, click in the Policy Object management wizards, on the

the Script tab, click page that prompts you to select a policy to
Policy Type Icon, configure.

and then do one of

the following:

¢ Click Change
and open an
icon file
containing
the image you
want.

e Click Use
Default Icon
to revert to
the default
image.

Using Policy Type containers

You can use a Policy Type container to store related Policy Type objects and other Policy
Type containers.

Containers give you an additional way to categorize custom policy types, making it easier
to locate and select the policy to configure in the wizards for managing Policy Objects.
Thus, when you create a Policy Object, the wizard page that prompts you to select a policy
displays the custom policy types along with the containers that hold the respective Policy
Type objects.

To create a new Policy Type container

1. Inthe Console tree, under Configuration/Server Configuration/Policy Types,
right-click the Policy Type container in which you want to create a new container, and
select New > Policy Type Container.

For example, if you want to create a new container in the root container, right-click
Policy Types.
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2. Inthe New Object - Policy Type Container Wizard, type a name and, optionally,
a description for the new container.

The name and description are displayed on the page for selecting a policy, in the
wizards that are used to configure Policy Objects.

3. Click Next and follow the steps in the wizard to complete the creation of the
new container.

Exporting policy types

You can export Policy Type objects so that the definition of the policy types is stored in an
XML file that can be imported in a different Active Roles environment. Exporting and then
importing Policy Type objects make it easy to distribute custom policies to other
environments.

To export a Policy Type object or container

e Right-click the Policy Type object or container, click Export and specify a file to hold
the export data.

You can select multiple Policy Objects to export, or you can select a container to export all
Policy Type objects and containers held in that container. In either case, the Export
operation creates a single XML file that can later be imported to any container under the
Policy Types node.

Exporting Policy Type objects creates an XML file representing both the objects and the
Script Modules containing the policy scripts for each policy type being exported. During an
import, Active Roles creates the Policy Type objects and the Script Modules based on the
data found in the XML file. As a result of the import, the policy types are replicated to the
new environment and can be used the same way as in the environment from which they
were exported.

Importing policy types

You can import the exported Policy Type objects and containers, which will add them to a
Policy Type container and allow you to configure and use policies defined by those Policy
Type objects. All the data required to deploy the policy types is represented in an XML file.
To see an example of the XML document that represents a policy type, export a Policy Type
object and view the saved XML file.

To import the exported Policy Type objects and containers

1. Inthe Active Roles Console tree, under Configuration/Server
Configuration/Policy Types, right-click the Policy Type container in which you
want to import the Policy Type objects and containers.

2. Click Import Policy Types, and then open the export data file you want to import.
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This will create new Policy Type objects and containers in the selected container. In
addition, new Script Modules will be created in the Configuration/Script Modules
container and associated with the newly created Policy Type objects.

Configuring a policy of a custom type

Once a custom policy type has been deployed, an Active Roles administrator can add a
policy of that type to a Policy Object. This is accomplished by selecting the policy type in the
wizard that creates a new Policy Object or in the wizard that adds a policy to an existing
Policy Object.

Which wizards to use, depends upon the policy type category:

» For a policy type of the Provisioning category, a policy of that type can be added only
to a Provisioning Policy Object.

e For a policy type of the Deprovisioning category, a policy of that type can be added
only to a Deprovisioning Policy Object.

To configure a policy of a custom policy type

1. Follow the steps in the wizard for creating a new Policy Object or in the wizard for
adding a policy to an existing Policy Object.

For example, if the policy type is of the Provisioning category, you could use the New
Provisioning Policy Object Wizard opened by the New > Provisioning Policy
command on a container under Configuration/Policies/Administration in the
Active Roles Console.

2. Onthe Policy to Configure page in the wizard, click the type of the policy you want.

The Policy to Configure page lists the custom policy types together with the pre-
defined Active Roles policy types. Each custom policy type is identified by the display
name of the respective Policy Type object.

The custom policy types are organized in a tree-like structure that reflects the
existing hierarchy of the Policy Type containers. For example, if a Policy Type
container is created to hold a particular Policy Type object, the container also appears
on the wizard page, so you may need to expand the container to view or select the

policy type.

3. Onthe Policy Parameters page, set parameter values for the policy: Click the
name of a parameter in the list, and then click Edit.

Parameters control the behavior of the policy. When Active Roles executes the policy,
it passes the parameter values to the policy script. The actions performed by the
script, and the results of those actions, depend upon the parameter values.

Clicking Edit displays a page where you can add, remove or select a value or values
for the selected parameter. For each parameter, the policy script defines the name of
the parameter and other characteristics, such as a description, a list of acceptable
values, the default value, and whether a value is required. If a list of acceptable
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values is defined, then you can only select values from that list.

4. Follow the wizard pages to complete the wizard.

Deleting a Policy Type object

You can delete a Policy Type object when you no longer need to add policies of the type
represented by that object.

Before you delete a Policy Type object, consider the following:

* You can delete a Policy Type object only if no policies of the respective policy type
exist in any Policy Object. Examine each Policy Object and remove the policies of that
type, if any, from the Policy Object before deleting the Policy Type object.

e Deleting a Policy Type object permanently deletes it from the Active Roles database.
If you want to use this policy type again, you should export the Policy Type object to
an XML file before deleting the object.

» Deleting a Policy Type object does not delete the Script Module associated with that
object. This is because the Script Module may be used by other policies. If the Script
Module is no longer needed, it can be deleted separately.

To delete a Policy Type object
e Right-click the Policy Type object in the Active Roles Console and click Delete.
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Using rule-based and role-based
tools for granular administration

Although you can cover many administration scenarios with the exclusive use of either
rule-based Managed Units (MUs) or role-based Access Templates (ATs), combining MUs
and ATs in your administration workflow provides additional flexibility to achieve the
highest level of granularity.

This is useful if you want to ensure that certain management resources (for example,
departmental administrators or helpdesk agents) can access and administer only a specific
set of resources (for example, the resources of a specific department or geography, or
specific resource types within a department only).

The following example use cases demonstrate how to configure and delegate such high-
granularity permissions to:

¢ Deny access to certain Azure AD resources.

e Allow access to certain Azure AD resources only.

NOTE: Active Roles Console supports managing the following Azure AD resources with
Managed Units:

e Azure users

e Azure guest users

e Azure contacts (if the MU is configured with an Include Explicitly rule)

e Microsoft 365 (M365) groups

e Azure distribution groups (if the MU is configured with an Include Explicitly rule)

e Azure security groups

However, Managed Units do not support any Azure mailbox types and dynamic
distribution groups.
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CAUTION: Hazard of data loss!

The combined AT and MU configurations described in these example
scenarios are meant to delegate granular access for roles like
departmental administrators or helpdesk agents.

Do not delegate such granular permissions to:

 Administrators with an Active Roles Administration Service account.
e Super administrators.
+ Any other high-level administration personnel.

Otherwise, you can lose access to the Azure AD resources in the scope of
the configured granular access.

Example: Configuring high granularity
by hiding a specific Azure group

This scenario describes how to use the Managed Units (MUs) and Access Templates (ATs)
of the Active Roles Console together to configure Azure group administration permissions
with high granularity. In this example, the MUs and ATs are used to deny the read access
of a group of helpdesk users to a specific Azure Microsoft 365 (M365) group. You can
achieve this by:

1. Configuring an MU containing the M365 group that the helpdesk users should not
access. For more information on this procedure, see Configuring a Managed Unit to
hide specific Microsoft 365 groups.

2. Configuring an AT to deny access to that M365 group for the helpdesk users. For
more information on this procedure, see Configuring an Access Template to hide
Microsoft 365 Groups.

Prerequisites

To configure this example scenario, your organization must meet the following
requirements:

» To create MUs and ATs in the Active Roles Console, you must use an Active Roles
Administration Service account. For more information, see Configuring the
Administration Service account in the Active Roles Quick Start Guide.

» The organization must already have one or more Azure tenants configured and
consented for use with Active Roles. For more information, see Configuring a new
Azure tenant and consenting Active Roles as an Azure application.

e To ensure that the Helpdesk group receiving the granular read permission can still
read other Azure groups, they must have the built-in Azure Microsoft365 Groups
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- Read All Attribute AT (or a custom AT based on this built-in AT) applied to them,
with the affected Object being the Azure tenant of the managed Azure AD resources.
For more information on how to apply an AT, see Applying Access Templates.

e The users receiving the configured permissions must be on-premises or hybrid Active
Directory users. You cannot delegate the configured granular permission to cloud-
only Azure users.

Configuring a Managed Unit to hide specific
Microsoft 365 groups

To set up a highly-granular Microsoft 365 (M365) group access logic, first you must
configure a Managed Unit (MU) that will contain the M365 group that cannot be read by the
affected helpdesk users.

In this example, the MU is configured to explicitly include the Marketing M365 group of an
example Azure tenant. For more information on the available membership rule options for
MUs, see Creating a Managed Unit.

To configure a Managed Unit to hide a specific Microsoft 365 group

1. Inthe Active Roles Console, on the Console tree, navigate to Configuration >
Managed Units.

2. To create a new container for the configured MU, right-click on the Managed Units
node, then click New > Managed Unit Container.

Figure 79: Active Roles Console - Launching the Managed Unit
Container dialog

W Active Roles [ART.roles].net] Mame Type Descripti

e ﬁ Configuration E‘j Published Gr... Managed Unit Contains
| Access Rules

B Access Templates
w gl Managed Units

w |57 Builtin Delegate Control...
?:l Publis Enforce Policy...
v Ej Policies Find...
v =l Administ
& Builtir  MPort-
() Workflow Check Policy...
@l Script Madul Change History

@il Server Confic

v @ Active Directory New ¥ Managed Unit
w @ roles].net All Tasks 3 Managed Unit Container
@NE IDENTITY Active Roles 8.1.5 Administration Guide 210

by Quest Using rule-based and role-based tools for granular administration



3. Inthe Managed Unit Container dialog, specify a Name, and optionally, a
Description for the new MU container.

This example uses the following container settings:
e Name: Denied-Azure-Resources
e Description: Managed Units for the granular denial of Azure resources.
4. To create the new container, click Next then Finish.

5. To start configuring the new MU, right-click the newly-created Denied-Azure-
Resources container, then click New > Managed Unit.

6. Inthe New Object - Managed Unit dialog, specify a Name, and optionally, a
Description for the new MU.

This example uses the following MU settings:

¢ Name: Denied-M365-Groups

e Description: Managed Unit for the granular denial of M365 groups.
To continue, click Next.

7. To specify a new membership rule for the MU, in the Membership rule step,
click Add.

8. In the Membership Rule Type dialog, select the rule type used to populate the MU.
This example uses the Include Explicitly rule type. Select it, then click Next.
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Figure 80: New Managed Unit — Selecting the Include Explicitly
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9. Inthe Select Objects dialog, select the M365 group whose members you want to

add to the MU.

Figure 81: New Managed Unit - Adding an M365 Group to an MU
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In the Select Objects dialog, click Browse.

In the Browse for Container dialog, expand the Azure > <azure-tenant-
name> node (in this example, the Azure tenant is named
ARSExampleOrg.onmicrosoft.com).

c. Select the Microsoft 365 Groups node, and click OK. The M365 groups
existing in the Azure tenant will appear in the Select Objects dialog.

d. Inthe Select Objects dialog, select the M365 group you want to add to the
MU (in this example, the Marketing group).

e. To apply the selection, click Add and OK.

10. To finish creating the MU, click Next, then Next again in the Object Security /
Policy Object step, and finally Finish.

11. To verify that the MU is populated correctly, select the newly-created MU in the
Console Tree. The Marketing M365 group must appear in the Active Roles Console.

Configuring an Access Template to hide
Microsoft 365 Groups

Once you set up the Managed Unit (MU) as described in Configuring a Managed Unit to
hide specific Microsoft 365 groups, you must create an Access Template (AT) that denies
the read access of the affected helpdesk users to the Microsoft 365 (M365) group
included in that MU.

To create the AT, perform the following steps. For more information on creating ATs in
general, see Creating an Access Template.

To deny access to the Microsoft 365 group of a Managed Unit with an
Access Template

1. Inthe Active Roles Console, in the Active Directory (AD) tree, navigate to
Configuration > Access Templates.

2. Create a new container where you will store the AT. In this example, the container is
created in the Azure sub-container of the Access Templates node. Right-click
Access Templates > Azure, then click New > Access Template Container.
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Figure 82: Active Roles Console - Launching the Access Templates
Container dialog
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3. Inthe Access Templates Container dialog, specify a Name, and optionally, a
Description for the new AT container.

This example uses the following container settings:
¢ Name: Denied-Azure-Resources

e Description: Access Templates for the granular access of Azure
resources.

4. To create the new container, click Next then Finish.

5. To start configuring the new AT, right-click the Denied-Azure-Resources
container, then click New > Access Template.

6. Inthe New Object - Access Template dialog, specify a Name, and optionally, a
Description for the new AT.

This example uses the following AT settings:

¢ Name: DenyM365Groups

e Description: AT to deny access to the specified M365 groups.
To continue, click Next.

7. Inthe Access Template permission entries step, click Add. Then, in the Add
Permission Entries Wizard, select Only the following classes, and select EDS-
Azure-0365Group from the list. To continue, click Next.
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Figure 83: New Access Template - Selecting the M365 group object class
to deny general access to them
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8. Inthe Select permission category step, select Deny permission, then click
Finish. The permission then appears in the Access Template permission entries
step of the New Object - Access Template dialog.
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Figure 84: New Access Template - Verifying the deny permission
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9. To finish creating the AT, click Next, then Finish.

10. Assign the newly-created AT to the helpdesk users whose access you want to restrict.
To do so, check if the Advanced Details Pane option of the Active Roles Console is
selected. If not, open View, and select Advanced Details Pane.

11. To start the Delegation of Control Wizard, select the newly-created
DenyM365Groups AT, then right-click in the Advanced Details Pane, and click Add.

Figure 85: Active Roles Console - Launching the Delegation of Control
Wizard from the Advanced Details Pane
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12. In the Objects step of the wizard, click Add. Then, in the Select Objects

13.

(GNE IDENTITY

dialog, Browse for the Denied-Azure-Resources Managed Unit Container that
you created in Configuring a Managed Unit to hide specific Microsoft 365 groups.
To add the Denied-M365-Groups MU to the list of managed objects, click Add,
then click OK.

Figure 86: Delegation of Control Wizard - Selecting the Managed Unit as
an administered object

# Select Objects

Lockin: |5 Denied-Azure-Resources

? pod

W Browse...

Mame In Folder

5§ Denied-Azure-Resources Configuration/Managed Units

enied-M365-Groups Configuration/Managed Units/. ..

Denied-M365-Groups

Cancel

To continue, in the Objects step, click Next.

In the Users or Groups step, click Add, then select the users to which you want to
delegate the permission. In this example, the AT is delegated to the Helpdesk group
of an example Organizational Unit (OU). To add the group, click Add, then click OK.
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Figure 87: Delegation of Control Wizard - Selecting the Helpdesk
group as Trustee
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To continue, in the Users or Groups step, click Next.

14. In the Inheritance Options step, make sure that the This directory object
and Child objects of this directory object settings are selected. To
continue, click Next.

15. Inthe Permissions Propagation step, leave the Propagate permissions to
Active Directory setting in its default state. To continue, click Next.

16. To complete the wizard, click Finish.

Enabling or disabling the granular access to
Microsoft 365 Groups
Once you configured the Managed Unit (MU) of the Microsoft 365 (M365) group, and set up

the Access Template (AT) to deny access to that group, the Helpdesk group to which the
AT is assigned can no longer see the M365 group included in the MU. Instead:
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» If they expand the Microsoft 365 Groups node of the Azure tenant on the Active
Roles Web Interface, the M365 group included in the MU will not be visible to them.

o If they open the Azure Member Of page of any Azure user or Azure guest user who
are also members of the affected M365 group, the page will not list the M365 group
included in the MU among the group membership of the users.

This behavior is dynamic: adding additional M365 groups into the MU in the Active Roles
Console will result in those M365 groups also disappearing in the Active Roles Web
Interface for the affected helpdesk users once the changes of the Console are synchronized
to the Web Interface. Likewise, removing an M365 group from the MU will result in that
M365 group appearing again for the affected helpdesk users in the Web Interface.

You can easily enable or disable the configured granular access later for the affected
helpdesk users by enabling or disabling the AT.

To enable or disable the configured granular access to Microsoft 365 groups

1. In the Active Roles Console, on the Console Tree, navigate to Configuration >
Access Templates > Denied Azure Resources.

Select the DenyM365Groups AT.

In the Advanced Details Pane, right-click the configured link, and click Disable.

Figure 88: Active Roles Console - Disabling the configured Access
Template
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TIP: If the Advanced Details Pane does not appear for you, click View > Advanced
Details Pane.

Once the AT is disabled, the M365 group included in the associated Denied-M365-
Groups MU will appear in the Web Interface for the users to which the AT is assigned.

4. (Optional) To re-enable the AT, right-click the configured link again, and click
Enable.
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Example: Configuring high granularity
by hiding specific Azure users

This scenario describes how to use the Managed Units (MUs) and Access Templates (ATs)
of the Active Roles Console together to configure Azure user administration permissions
with high granularity. In this example, the MUs and ATs are used to deny the read access
of a group of helpdesk users to Azure users reporting to a specific manager. You can
achieve this by:

1. Configuring an MU containing all the Azure users that the helpdesk users should not
access. For more information on this procedure, see Configuring a Managed Unit to
hide specific Azure users.

2. Configuring an AT to deny access to those Azure users for the helpdesk users. For
more information on this procedure, see Configuring an Access Template to hide
Azure users.

Prerequisites

To configure this example scenario, your organization must meet the following
requirements:

e To create MUs and ATs in the Active Roles Console, you must use an Active Roles
Administration Service account. For more information, see Configuring the
Administration Service account in the Active Roles Quick Start Guide.

e The organization must already have one or more Azure tenants configured and
consented for use with Active Roles. For more information, see Configuring a new
Azure tenant and consenting Active Roles as an Azure application.

e To ensure that the Helpdesk group receiving the granular read permission can still
read other Azure users, the group must have the built-in Azure Cloud User - Read
All Attributes AT (or a custom AT based on this built-in AT) applied to them, with
the affected Object being the Azure tenant of the managed Azure AD resources. For
more information on how to apply an AT, see Applying Access Templates.

e The users receiving the configured permissions must be on-premises or hybrid Active
Directory users. You cannot delegate the configured granular permission to cloud-
only Azure users.

Configuring a Managed Unit to hide specific
Azure users

To set up a highly-granular Azure user access logic, first you must configure a Managed
Unit (MU) that will contain the Azure users that cannot be read by the affected
helpdesk users.
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In this example, the membership of the MU is configured via a query, specifying that only
Azure users reporting to a specific manager (in this example, Sam Smith) are included in
the MU. For more information on the available membership rule options for MUs, see
Creating a Managed Unit.

To configure a Managed Unit to hide specific Azure users

1.

2.

In the Active Roles Console, on the Console tree, navigate to Configuration >
Managed Units.

To create a new container for the configured MU, right-click on the Managed Units
node, then click New > Managed Unit Container.

Figure 89: Active Roles Console - Launching the Managed Unit
Container dialog
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In the Managed Unit Container dialog, specify a Name, and optionally, a
Description for the new MU container.

This example uses the following container settings:
¢ Name: Denied-Azure-Resources

e Description: Managed Units for the granular denial of Azure resources.

4. To create the new container, click Next then Finish.

5. To start configuring the new MU, right-click the newly-created Denied-Azure-

Resources container, then click New > Managed Unit.

In the New Object - Managed Unit dialog, specify a Name, and optionally, a
Description for the new MU.

This example uses the following MU settings:
e Name: Denied-Azure-Users
e Description: Managed Unit for the granular denial of Azure users.

To continue, click Next.
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7. To specify a new membership rule for the MU, in the Membership rule step,
click Add.

8. Inthe Membership Rule Type dialog, select the rule type used to populate the MU.
This example uses the Include by Query rule type. Select it, then click Next.

Figure 90: New Managed Unit — Selecting the Include by Query
membership rule type
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9. In the Create Membership Rule dialog, configure the query by which Active
Roles will dynamically populate the MU with Azure users. This example uses the
following settings:

e In the Find drop-down list, select Azure User.

e Under the Advanced tab, click Field, and select the
edsaAzureManager attribute.

TIP: If you cannot find the attribute in the list, select Show all possible
properties.

« In Condition, select Is (exactly).

e In Value, specify the manager Azure user (in this example, Sam Smith) by

clicking the J (Browse) button and selecting it from the Azure Users
container. Once selected, the distinguished name of the Azure user appears in
the Value text box.

@NE IDENTITY Active Roles 8.1.5 Administration Guide 331

by Quest Using rule-based and role-based tools for granular administration



Figure 91: New Managed Unit - Configuring the Include by Query
membership rule type
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10. To verify that the configured rule works properly, click Preview Rule. If Active Roles
asks if you want to add the current criteria to your search, click OK. Active Roles then
adds and immediately tests the membership rule for the MU, and the users reporting
to Sam Smith must appear in the list. If the results look correct, click OK.

11. To finish creating the MU, click Next, then Next again in the Object Security /
Policy Object step, and finally Finish.

12. To verify that the MU is populated correctly, select the newly-created MU in the
Console Tree. The Azure users reporting to Sam Smith must appear in the Active
Roles Console.

Configuring an Access Template to hide
Azure users

Once you set up the Managed Unit (MU) as described in Configuring a Managed Unit to hide
specific Azure users, you must create an Access Template (AT) that denies the read access
of the affected helpdesk users to the Azure users included in that MU.

To create the AT, perform the following steps. For more information on creating ATs in
general, see Creating an Access Template.

To deny access to the Azure users of a Managed Unit with an Access Template

1. Inthe Active Roles Console, in the Active Directory (AD) tree, navigate to
Configuration > Access Templates.
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2. Create a new container where you will store the AT. In this example, the container is
created in the Azure sub-container of the Access Templates node. Right-click
Access Templates > Azure, then click New > Access Template Container.

Figure 92: Active Roles Console - Launching the Access Templates
Container dialog
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3. Inthe Access Templates Container dialog, specify a Name, and optionally, a
Description for the new AT container.

« Name: Denied-Azure-Resources

e Description: Access Templates for the granular access of Azure
resources.

4. To create the new container, click Next then Finish.

5. To start configuring the new AT, right-click the Denied-Azure-Resources
container, then click New > Access Template.

6. Inthe New Object - Access Template dialog, specify a Name, and optionally, a
Description for the new AT.

e Name: DenyAzureUsers
e Description: AT to deny access to the specified Azure users.
To continue, click Next.

7. Inthe Access Template permission entries step, click Add. Then, in the Add
Permission Entries Wizard, select Only the following classes, and select EDS-
Azure-User from the list. To continue, click Next.
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Figure 93: New Access Template - Selecting the Azure user object class to
deny general access to them
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| TIP: If you cannot find the class in the list, select Show all possible classes.

8. Inthe Select permission category step, select Deny permission, then click
Finish. The permission then appears in the Access Template permission entries
step of the New Object - Access Template dialog.
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Figure 94: New Access Template - Verifying the deny permission
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9. To finish creating the AT, click Next, then Finish.

10. Assign the newly-created AT to the helpdesk users whose access you want to restrict.
To do so, check if the Advanced Details Pane option of the Active Roles Console is
selected. If not, open View, and select Advanced Details Pane.

11. To start the Delegation of Control Wizard, select the newly-created
DenyAzureUsers AT, then right-click in the Advanced Details Pane, and click Add.

Figure 95: Active Roles Console - Launching the Delegation of Control
Wizard from the Advanced Details Pane

W Active Roles [AR1.roles1.net] Mame
v ﬁ Configuration %&DenyﬁuureUsers
» [ Access Rules
w ] Access Templates
> fxd Active Directory Links for: DenyAzureUsers
> ] ADLDS (ADAM)
w [ Azure
s Special Add...
fsd Deny-Azure-Resources
%] Builtin Refresh
» ] Computer Resources

Trustee

@NE IDENTITY Active Roles 8.1.5 Administration Guide 335

by Quest Using rule-based and role-based tools for granular administration



12. Inthe Objects step of the wizard, click Add. Then, in the Select Objects dialog,

13.

(GNE IDENTITY

Browse for the Denied-Azure-Resources Managed Unit Container that you
created in Configuring a Managed Unit to hide specific Azure users, and select the
Denied-Azure-Users MU as the object managed by the AT. To add the Denied-
Azure-Users MU to the list of managed objects, click Add, then click OK.

Figure 96: Delegation of Control Wizard - Selecting the Managed Unit as
an administered object
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To continue, in the Objects step, click Next.

In the Users or Groups step, click Add, then select the users to which you want to
delegate the permission. In this example, the AT is delegated to the Helpdesk group
of an example Organizational Unit (OU). To add the group, click Add, then click OK.
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Figure 97: Delegation of Control Wizard - Selecting the Helpdesk
group as Trustee
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To continue, in the Users or Groups step, click Next.

14. In the Inheritance Options step, make sure that the This directory object
and Child objects of this directory object settings are selected. To
continue, click Next.

15. Inthe Permissions Propagation step, leave the Propagate permissions to
Active Directory setting in its default state. To continue, click Next.

16. To complete the wizard, click Finish.

Enabling or disabling the granular access to
Azure users

Once you configured the Managed Unit (MU) of the Azure users, and set up the Access
Template (AT) to deny access to those Azure users, the Helpdesk group to which the AT is
assigned can no longer read the Azure users included in the MU. Instead, when opening the
list of Azure Users on the Active Roles Web Interface, the Azure users included in the MU
will be hidden from the Helpdesk group members.
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This behavior is dynamic: adding new Azure users into the MU in the Active Roles Console
will result in those Azure users disappearing in the Active Roles Web Interface for the
affected helpdesk users once the changes of the Console are synchronized to the Web
Interface. Likewise, removing an Azure user from the MU will result in that Azure user
appearing for the affected helpdesk users in the Web Interface.

You can easily enable or disable the configured granular access later for the affected
helpdesk users by enabling or disabling the AT.

To enable or disable the configured granular access to Azure users

1. Inthe Active Roles Console, on the Console Tree, navigate to Configuration >
Access Templates > Denied Azure Resources.

Select the DenyAzureUsers AT.

In the Advanced Details Pane, right-click the configured link, and click Disable.

Figure 98: Active Roles Console - Disabling the configured Access
Template
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TIP: If the Advanced Details Pane does not appear for you, click View > Advanced
Details Pane.

Once the AT is disabled, the Azure users included in the associated Denied-Azure-
Users MU will appear in the Web Interface for the users to which the AT is assigned.

4. (Optional) To re-enable the AT, right-click the configured link again, and click
Enable.
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Example: Configuring high granularity
by showing only specific Azure users

This scenario describes how to use the Managed Units (MUs) and Access Templates (ATs) of
the Active Roles Console together to configure Azure user administration permissions with
high granularity. In this example, the MUs and ATs are used to grant a group of helpdesk
users read access only to a specific group of Azure users. You can achieve this by:

1. Configuring an MU containing all the Azure users that the helpdesk users should
access. For more information on this procedure, see Configuring a Managed Unit for
specific Azure users.

2. Configuring an AT to grant access only to those Azure users for the helpdesk users.
For more information on this procedure, see Configuring Access Templates to read
specific Azure users.

Prerequisites

To configure this example scenario, your organization must meet the following
requirements:

e To create MUs and ATs in the Active Roles Console, you must use an Active Roles
Administration Service account. For more information, see Configuring the
Administration Service account in the Active Roles Quick Start Guide.

e The organization must already have one or more Azure tenants configured and
consented for use with Active Roles. For more information, see Configuring a new
Azure tenant and consenting Active Roles as an Azure application.

e The users receiving the configured permissions must be on-premises or hybrid Active
Directory users. You cannot delegate the configured granular permission to cloud-
only Azure users.

Configuring a Managed Unit for specific
Azure users

To set up a highly-granular Azure user access logic, first you must configure a Managed
Unit (MU) that will contain the Azure users that the affected helpdesk users can read.

In this example, the membership of the MU is configured via group membership, specifying
that only Azure users that are members of a specific group (in this example, Engineering)
are included in the MU. For more information on the available membership rule options for

MUs, see Creating a Managed Unit.
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To configure a Managed Unit for specific Azure users

1. Inthe Active Roles Console, on the Console tree, navigate to Configuration >
Managed Units.

2. To create a new container for the configured MU, right-click on the Managed Units
node, then click New > Managed Unit Container.

Figure 99: Active Roles Console - Launching the Managed Unit
Container dialog
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3. Inthe Managed Unit Container dialog, specify a Name, and optionally, a

Description for the new MU container.
e Name: Allowed-Azure-Resources
e Description: Managed Units for the granular access of Azure resources.

4. To create the new container, click Next then Finish.

5. To start configuring the new MU, right-click the newly-created Allowed-Azure-
Resources container, then click New > Managed Unit.

6. Inthe Managed Unit Container dialog, specify a Name, and optionally, a
Description for the new MU container.

¢ Name: Allowed-Azure-Users
e Description: Managed Unit for the granular access of Azure users.
To continue, click Next.

7. To specify a new membership rule for the MU, in the Membership rule step,
click Add.

8. In the Membership Rule Type dialog, select the rule type used to populate
the MU. This example uses the Include Group Members rule type. Select it,
then click Next.
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Figure 100: New Managed Unit - Selecting the Include Group

Members rule type
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9. Inthe Select Objects dialog, select the M365 group whose members you want to

add to the MU.

Figure 101: New Managed Unit - Adding the members of an M365

Group to an MU
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In the Select Objects dialog, click Browse.

In the Browse for Container dialog, expand the Azure > <azure-tenant-
name> node (in this example, the Azure tenant is named
ARSExampleOrg.onmicrosoft.com).

c. Select the Microsoft 365 Groups node, and click OK. The M365 groups
existing in the Azure tenant will appear in the Select Objects dialog.

d. Inthe Select Objects dialog, select the M365 group you want to add to the
MU (in this example, the Engineering group).

e. To apply the selection, click Add and OK.

10. To finish creating the MU, click Next, then Next again in the Object Security /
Policy Object step, and finally Finish.

11. To verify that the MU is populated correctly, select the newly-created MU in the
Console Tree. The members of the Engineering M365 group must appear in the
Active Roles Console.

Configuring Access Templates to read
specific Azure users

Once you set up the Managed Unit (MU) as described in Configuring a Managed Unit for
specific Azure users, you must create two Access Templates (ATs) so that the affected
helpdesk users:

e Can read the Azure users of the configured MU.

e Cannot read any other Azure users in your organization.

To create these ATs, perform the following steps. For more information on creating ATs in
general, see Creating an Access Template.

To provide read access to the Azure user object class

1. Inthe Active Roles Console, in the Active Directory (AD) tree, navigate to
Configuration > Access Templates.

2. Create a new container where you will store the AT. In this example, the container is
created in the Azure sub-container of the Access Templates node. Right-click
Access Templates > Azure, then click New > Access Template Container.
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Figure 102: Active Roles Console - Launching the Access Templates
Container dialog
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In the Access Templates Container dialog, specify a Name, and optionally, a
Description for the new AT container.

« Name: Allowed-Azure-Resources

e Description: Access Templates for the granular access of Azure
resources.

. To create the new container, click Next then Finish.

. To start configuring the new AT, right-click the Allowed-Azure-Resources
container, then click New > Access Template.

In the New Object - Access Template dialog, specify a Name, and optionally, a
Description for the new AT.

e Name: ReadAzureUserObject
e Description: AT to read cloud-only Azure user objects.
To continue with specifying the required permissions, click Next.

In the Access Template permission entries step, click Add. Then, in the Select
object classes to apply permissions onto dialog, select Only the following
classes, and the EDS-Azure-User-Container class from the list.

| TIP: If you cannot find the class in the list, select Show all possible classes.
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8.

Figure 103: New Access Template - Selecting the Azure Users container
class to allow reading Azure users
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To continue, click Next.

In the Select permission category step, select Object access, then select the
List Object access permission from the list.
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Figure 104: New Access Template - Specifying the permission to read
allowed objects in the Azure Users container
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To finish configuring the permission, click Finish. Then, in the Access Template
permission entries step, click Add again.

9. Inthe Select object classes to apply permissions onto dialog, select Only the
following classes, then the EDS-Azure-User-Container class from the list again.
To continue, click Next.

10. Inthe Select permission category step, select Object property access, then
select the Read properties access permission from the list.
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Figure 105: New Access Template - Specifying the permission to read the
properties of the Azure Users container
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To continue, click Next.

11. Inthe Select object properties step, leave the All properties option selected,
then click Finish. The two permissions configured in the previous steps then appear
in the Access Template permission entries step.
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Figure 106: New Access Template - Listing the permissions to properly
read the Azure Users container
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12. To finish configuring the permissions of the AT, click Next, then Finish.

13. Inthe Create in step, select Display the object properties when this wizard
closes, and click Finish.

14. To assign the AT to the helpdesk users and the Azure user container of the Azure
tenant, in the Properties page that appears, click Administration > Links.

15. Inthe Links dialog, click Add, then specify the Azure Users container as the
directory object managed by this AT.
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Figure 107: New Access Template - Specifying the Azure Users container
as the directory object in scope
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To do so:
a. Inthe Select Objects dialog, click Browse.

b. Inthe Browse for Container dialog, expand the Azure > <azure-tenant-
name> node (in this example, the Azure tenant is named
ARSExampleOrg.onmicrosoft.com).

c. Select the Azure Users node, and click OK. The Azure Users container and
the users contained in it will appear in the Select Objects dialog.

d. Inthe Select Objects dialog, select the Azure Users container.
e. To apply the selection, click Add and OK.

The Azure Users container then appears in the Objects step. To continue
configuring the AT, click Next.

16. Inthe Users or Groups step, click Add, then select the users to which you want to
delegate the permission. In this example, the AT is delegated to the Helpdesk group
of an example Organizational Unit (OU). To add the group, click Add, then click OK.
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17.

18.

19.

Figure 108: Delegation of Control Wizard - Selecting the Helpdesk
group as Trustee

' Select Objects ? x

Lockin: |8l ExampleQU W Browse...

Mame 7 In Folder

roles1.net/ExampleCQU

@ Interactive
@ s

] Key Trust
@ Local Service
Mainﬁame roles1.net/ExampleCU

@Manager W
o

Add Chedk Names

Helpdesk

Carcel

To continue, in the Users or Groups step, click Next.

In the Inheritance Options step, make sure that the This directory object
and Child objects of this directory object settings are selected. To
continue, click Next.

In the Permissions Propagation step, leave the Propagate permissions to
Active Directory setting in its default state. To continue, click Next.

To apply your changes, click Apply and OK.

To restrict read access to the Azure users of a specific Managed Unit

1. Inthe Active Roles Console, in the Active Directory (AD) tree, navigate to
Configuration > Access Templates.
2. Right-click the Azure Cloud User - Read All Attributes built-in AT, and
select Copy.
3. Inthe Copy Object - Access Template wizard, specify a Name and optionally, a
Description for the new AT. This example uses the following values:
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« Name: AllowAzureUsers

» Description: AT to grant read access to the specified Azure users.
To continue, click Next.

4. Inthe Create in step, select Display the object properties when this wizard
closes, and click Finish.

5. To assign the AT to the helpdesk users and the Azure user container of the Azure
tenant, in the Properties page that appears, click Administration > Links.

6. Inthe Links dialog, click Add, then specify the Allowed Azure Users MU as the
directory object managed by this AT.

Figure 109: New Access Template - Specifying the Allowed Azure Users
MU as the directory object in scope
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To do so:
a. Inthe Select Objects dialog, click Browse.

b. Inthe Browse for Container dialog, select the Managed Units > Allowed-
Azure-Resources node, and click OK.

c. Inthe Select Objects dialog, select the Allowed-Azure-Users MU.
d. To apply the selection, click Add and OK.

The Allowed-Azure-Users MU then appears in the Objects step. To continue
configuring the AT, click Next.

7. Inthe Users or Groups step, click Add, then select the users to which you want to
delegate the permission. In this example, the AT is delegated to the Helpdesk group
of an example Organizational Unit (OU). To add the group, click Add, then click OK.
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Figure 110: Delegation of Control Wizard - Selecting the Helpdesk
group as Trustee
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To continue, in the Users or Groups step, click Next.

8. In the Inheritance Options step, make sure that the This directory object
and Child objects of this directory object settings are selected. To
continue, click Next.

9. Inthe Permissions Propagation step, leave the Propagate permissions to
Active Directory setting in its default state. To continue, click Next.

10. To complete the configuration of the AT, click Finish. Then, in the Links
dialog, click OK.

11. To apply your changes, click Apply and OK. Active Roles will create the copied AT in
the Configuration > Access Templates > Azure container.

12. Move the AT to the Configuration > Access Templates > Azure > Allowed-
Azure-Resources container. To do so, right-click the AT and click Move. Then, in
the Move dialog, navigate to the Allowed-Azure-Resources container, select it,
and click OK.
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Enabling or disabling the granular access to
specific Azure users

Once you configured the Managed Unit (MU) of the Azure users, and set up the Access
Templates (ATs) to allow access to those Azure users only, the Helpdesk group to which
the ATs are assigned can only read the Azure users included in the MU. When opening the
list of Azure Users on the Active Roles Web Interface, all other Azure users included in the
Azure tenant will be hidden from the Helpdesk group members.

This behavior is dynamic: adding new Azure users into the MU in the Active Roles Console
will result in those Azure users appearing in the Active Roles Web Interface for the affected
helpdesk users once the changes of the Console are synchronized to the Web Interface.
Likewise, removing an Azure user from the MU will result in that Azure user disappearing
for the affected helpdesk users in the Web Interface.

You can easily enable or disable the configured granular access later for all affected
helpdesk users by enabling or disabling the AllowAzureUsers and
ReadAzureUserObject ATs.

To enable or disable the configured granular access to specific Azure users

1. Inthe Active Roles Console, on the Console Tree, navigate to Configuration >
Access Templates > Allowed-Azure-Resources.

Select the AllowAzureUsers AT.

In the Advanced Details Pane, right-click the configured link, and click Disable.

Figure 111: Active Roles Console - Disabling the configured Access
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TIP: If the Advanced Details Pane does not appear for you, click View > Advanced
Details Pane.
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4. Select the ReadAzureUserObject AT, and disable it as you did with the
AllowAzureUsers AT.

Once both ATs are disabled, the users of the Helpdesk group can no longer read the
users included in the configured Allowed-Azure-Resources MU, and can no longer
see the Azure Users container in the Active Roles Web Interface either.

5. (Optional) To re-enable the granular access, select one of the ATs, right-click the
configured link, and click Enable. Then, enable the other AT similarly.

6. (Optional) To provide general read access to the entire Azure Users container of
the Azure tenant instead of the configured granular access, assign the built-in
Azure Cloud User - Read All Attributes AT (or a custom AT based on this built-in
AT) to the Helpdesk group. For more information, see Applying Access Templates
on a user or group.
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Workflows

Active Roles provides a rich workflow system for directory data management
automation and integration, allowing you to create, view, update or delete automation
and approval workflows.

For more information on workflows in general, see Workflows in the Active Roles
Feature Guide.

Key workflow features and definitions

This section summarizes some important concepts that apply to designing and
implementing workflows in Active Roles.

Workflow

A workflow is a model describing a process that consists of steps or activities. Workflows
describe the order of running activities and the relationship between activities required to
perform particular operations. In Active Roles, workflows provide a way to customize
operations of provisioning and overall administration of directory data. Thus, workflows can
be used to add approvals to user provisioning processes or integrate user provisioning
processes with external systems.

Workflow definition

Workflow definition is a representation of the workflow structure. The definition of a
workflow is stored as a single object in the Active Roles configuration data store, and can be
structured as an XML document defining the workflow start conditions, the activities, the
parameters for the activities, and the order in which the activities should run.
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Workflow start conditions

The workflow settings that determine which operations cause the workflow to start are
referred to as the workflow start conditions. For example, a workflow can be configured so
that any request to create a user account in a specific container starts the workflow.

Workflow instance

Starting a workflow creates a workflow instance based on the settings found in the
workflow definition. Each workflow instance stores the runtime data indicating the current
state of a single workflow that is in progress.

Workflow activity

A workflow activity is a logically isolated unit that implements a particular operational step
of a workflow. The logic incorporated in an activity takes effect both at design time, when
you add the activity to a workflow definition, and at runtime, when a workflow instance is
initialized. When all the activities in a given flow path are finished running, the workflow
instance is completed.

Workflow Designer

The Workflow Designer is a graphical tool provided by Active Roles for constructing
workflows. The tool represents the workflow definition as a process diagram, with icons
denoting workflow activities and directional arrows denoting transitions between activities.
Users drag activities from the activities panel onto the process diagram and configure them
using the pages provided by the designer interface. Separate pages are provided for
configuring workflow start conditions.

Workflow engine

Active Roles leverages the Microsoft Windows Workflow Foundation runtime engine for
creating and maintaining workflow instances. The engine can support multiple workflow
instances running concurrently. When a workflow is started, the engine monitors the state
of the workflow instance, coordinates the routing of activities in the workflow instance,
determines which activities are eligible to run, and runs activities. The workflow engine is
hosted in-process with the Administration Service, which enables workflows to
communicate with Active Roles at run time.
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Email notifications

Users are notified via email about specific situations that manifest within a workflow. A
notification message is generated and sent to the designated recipients to inform them that
a certain event has occurred, such as a new approval task has been submitted to the
approvers or the operation has been completed. A notification configuration involves such
elements as the event to notify of, the list of the notification recipients, and the notification
message template.

About workflow processes

The logic of an automated management process can be implemented by using
administrative policies in Active Roles. Yet creating and maintaining complex, multi-step
processes in that way can be challenging. Workflows provide a different approach, allowing
IT administrators to define a management process graphically. This can be faster than
building the process by applying individual policies, and it also makes the process easier to
understand, explain, and change.

The figure below shows a workflow process created in the Active Roles Console. In this
simple example, upon a request to add a user to a certain group, the workflow first checks
to see if the group has an owner. If the group has no owner, the requested changes are
denied and the workflow is complete; otherwise, the changes are submitted to the group
owner for approval.

When approval is received, Active Roles applies the changes, adding the user to the group.
On the process diagram, this step is referred to as Operation execution. If the owner
rejects the changes, the workflow finishes on the previous (approval) step so that the
changes are not applied. After the changes are made, the workflow sends an email
notification to the person who requested the changes, and then finishes.
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Figure 112: Workflow process in Active Roles
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In the above example, the workflow manages the process of adding a user to a group
according to the rules defined at design time. The rules constitute the workflow definition,
and include the activities that occur within the process and the relationships between
activities. An activity in a process definition can be a pre-defined function available out of
the box, such as a request for approval or a notification of conditions that require user
interaction, or it can be a custom function created using script technologies.

A workflow process starts when the requested changes meet the conditions specified in the
workflow definition. In the above example, the conditions may be set up so that the
workflow starts whenever an Active Roles user makes changes to the membership list of a
certain group. Once the conditions are fulfilled, the workflow process starts to drive the
changes through the workflow definition, performing automated steps and, if necessary,
requesting human interaction such as approval.

Workflow processing overview

In Active Roles, directory objects such as users, groups, or computers are managed by the
Administration Service. These objects can be created, changed, or deleted through
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requests made to the Administration Service. Every request initiates an operation to make
the requested changes to directory data. For example, a request to create a user or group
initiates the Create operation with the target object type set to User or Group, respectively;
a request to add users to a group initiates the Modify operation on that group.

Once an operation has been initiated, the Administration Service starts processing the
operation. Each operation is represented by a single object, usually referred to as the
Request object, which contains all information necessary to perform the operation.
Therefore, operation processing takes the form of passing the Request object through a
number of phases within the Administration Service.

The operation processing model in Active Roles is composed of four main phases: access
check, pre-run, run, and post-run. The Request object passes through these phases in the
following order:

e Access check: In this phase, the Administration Service checks to see whether the
user or system that issued the request has sufficient rights to make the requested
changes. If there are insufficient rights, the operation is denied.

e Pre-execution: During this phase, the Administration Service first runs the pre-
run workflow activities. These are the activities located in the upper part of the
workflow process diagram, above the Operation execution line. A typical
example includes Approval activities: It is at this point that approvers can permit or
reject the operation.

Then, after the pre-run activities are completed so that the operation is not rejected,
the Administration Service runs the pre-run policies. Typical examples of such
policies include property generation and validation rules and the functions
implementing so-called pre-event handlers in script policies.

« Execution: In this phase, the Administration Service performs the operation,
making the requested changes to directory data. For example, when the creation of a
user is requested, the user is actually created during this phase.

» Post-execution: During this phase, the Administration Service first runs the post-
run policies. For example, upon creation of a user, the provisioning of a home folder
or group memberships for that user occurs at this point. The functions that
implement post-event handlers in script policies are also run in this step.

Finally, after the post-run polices finish running, the Administration Service runs the
post-run workflow activities. These are the activities located in the lower part of the
workflow process diagram, beneath the Operation execution line. A typical
example is Notification activities that send out emails informing of the operation
completion.

The Administration Service runs the workflow activities one by one, in sequential order as
shown on the workflow process diagram, until the last activity finishes. If-Else activities
can be used to achieve conditional branching in workflows, which makes it possible to
switch the sequence of activities depending on the data involved in the request.

At the beginning of the pre-run phase, the Administration Service determines the
workflows to start. The request is compared to all the existing workflow definitions. In
order for a workflow to start, the requested operation needs to satisfy the start conditions
defined for that workflow. If the start conditions are satisfied, the workflow is matched to
the request.
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For a workflow that is matched to the request, the Administration Service runs the activities
found in that workflow during the corresponding phases of the operation processing. One
workflow or multiple workflows can be matched to a single request. In case of multiple
workflows, the Administration Service starts each of them one by one, and first runs all the
pre-run activities included in those workflows. Then, during the post-run phase, the
Administration Service runs all the post-run activities included in those workflows.

If multiple workflows are matched to a single request, then Active Roles uses the
edsalWorkflowPriority attribute of the workflow definition object to determine the order in
which to run the workflows. The activities of the workflow with a lower value of that
attribute are initiated prior to the activities of the workflow with a higher value of that
attribute. The workflows with the same priority value are initiated in ascending order of
workflow names. The edsalWorkflowPriority attribute is set to 500 by default. If the
edsaWorkflowPriority attribute is not set, Active Roles assumes that the workflow has the
priority value of 500.

You can change the value of the edsaWorkflowPriority attribute to ensure that a given
workflow takes precedence over other workflows. A lower value of that attribute indicates a
higher priority whereas a higher value indicates a lower priority. To view or change the
edsalWorkflowPriority attribute, use the Advanced Properties command on the workflow
definition object in the Active Roles Console.

About workflow start conditions

To deploy a workflow in Active Roles, you create a workflow definition, configure the start
conditions for that workflow, then add and configure workflow activities. When configuring
workflow start conditions, you specify:

e Atype of operation, such as Create, Rename, Modify or Delete; the workflow is
matched to the request only if an operation of that type is requested.

e Atype of object, such as User, Group or Computer; the workflow is matched to the
request only if the operation requests changes to an object of that type.

e For the Modify operation type, a list of object properties; the workflow is
matched to the request only if the operation requests changes to any of those
properties of an object.

e The identity of an operation requestor (initiator), such as a user, group, or service;
the workflow is matched to the request only if the operation is requested on behalf of
that identity.

e A container, such as an Organizational Unit or Managed Unit; the workflow is
matched to the request only if the operation requests changes to, or creation of, an
object in that container.

» (Optional) A filter that defines any additional conditions on entities involved in an
operation; the workflow is matched to the request only if the operation satisfies those
conditions. If no filter is set, then no additional conditions are in effect.

Upon a request for any operation that meets all the start conditions specified on a
workflow, the Administration Service matches the workflow to the request and runs the
activities found in the workflow.

@NE IDENTITY Active Roles 8.1.5 Administration Guide -

Quest Workflows



Workflow activities overview

Activities are units of work, each of which contributes to the accomplishment of a workflow
process. Active Roles offers a default set of activities that provide pre-defined functionality
for approval, notification, control flow, and conditions. Scripting can be used to have an
activity perform custom functions.

Activities are the primary building blocks for workflows. A workflow is a set of activities
organized in a process diagram. When you construct a workflow using the Workflow
Designer, you drag activities from the activities panel onto the process diagram and then
configure them there. The configurable settings common to every activity are:

« Name: The name is used to identify the activity on the workflow diagram.

» Description: This optional text can be helpful to distinguish the activity. The
description is displayed when you point with the mouse to the activity on the
process diagram.

Approval activity

An Approval activity, also referred to as an approval rule, represents a decision pointin a
workflow that is used to obtain authorization from a person before continuing the
workflow. Workflow start conditions determine which operations start the workflow and
the approval rules added to the workflow determine who is designated to approve the
operation, the required sequence of approvals, and who needs to be notified of approval
tasks or decisions.

Active Roles creates an approval task as part of the processing of an approval rule, and
assigns the task to the approvers. The approver is expected to complete the task by
making a decision to allow or deny the operation. Until the task is completed, the operation
remains in a pending state.

Approvers and escalation

Approvers are the users or groups of users designated to perform approval tasks. When
processing an approval rule, Active Roles creates an approval task and assigns it to the
approvers defined by the rule. The state of the task governs the workflow transition: The
task must receive the Approve resolution for the operation to pass the approval rule. If the
task has received the Reject resolution, the operation is denied and the workflow instance
is completed.

Approvers may be selected by browsing the available users and groups, or particular role
holders may be designated as approvers. For example, an approval rule can be configured
so as to require approval by the manager of the operation requestor or by the manager of
the group or container that is affected by the operation.
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An approval rule may define two or more approver levels, with each level containing a
separate list of approvers. Active Roles uses approver levels when escalating time-limited
approval tasks. For each approver level the approval rule can specify a certain time period.
If an approver of a given level does not complete the approval task within the specified time
period, then Active Roles can assign the task to the approvers of the next level. This
process is referred to as escalation.

Each approver level has the following configuration options:

» List of approvers: Specifies the users or groups of users that are designated as
approvers for the approver level in question.

A valid approval rule must, at a minimum, specify a list of approvers for the initial
approver level. Active Roles first assigns the approval task to the approvers of that
level. To enable escalation, a separate list of approvers must be specified for one or
more escalation levels.

e Approval task has no time limit: When this option is selected, the approval rule
does not require that the approvers of the given level complete the approval task
within a certain time period.

« Approval task has a time limit of <number> days <number> hours: When
this option is selected, the approval rule requires that the approvers of the given level
complete the approval task within the specified time period.

If the approval task is not completed within the specified time period, then,
depending upon the selected configuration option, the approval rule can either cancel
the operation waiting for approval or escalate the approval task. The latter option
requires a list of approvers to be specified for the subsequent escalation level.

e Allow approver to delegate approval task: When this option is selected, the
approver of the given level is allowed to assign the approval task to other persons.
On the pages for performing the approval task, the approver can use the Delegate
button to select the persons to assign the task to.

« Allow approver to escalate approval task: When this option is selected, the
approver of the given level is allowed to escalate the approval task. On the pages for
performing the approval task, the approver can click Escalate to assign the task to
the approvers of the subsequent escalation level. This option requires a list of
approvers to be specified for the subsequent escalation level.

Request for information

You can configure the Approval activity so that the approver will be requested to supply
certain properties of the object when performing the approval task. Suppose the creation of
a user is submitted for approval. The approver may be requested to supply certain
properties of the user in addition to the properties specified in the creation request. Thus,
you may configure the Approval activity to prompt the approver to specify the mailbox
database for the mailbox of the user to be created.

It is also possible to configure the Approval activity so that the approver will be requested
to review the object properties submitted for approval. One more option is to allow the
approver to make changes to those properties.
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The pages for configuring an Approval activity in the Active Roles Console include the
following options related to request for information:

e Show this instruction to the approver: When performing the approval task, the
approver will see this instruction on the page intended to review, supply, or change
the properties that are subject to the approval task. You can supply an instruction on
how to perform the task.

 Request the approver to supply or change these properties: When
performing the approval task, the approver will be prompted to supply or change the
properties specified in this option.

 Show the original request to the approver: This option adds a separate
section on the pages for performing the approval task that lists the properties
submitted for approval.

» Allow the approver to modify the original request: Unless this option is
selected, the approver is only allowed to view the properties submitted for approval.
You could select this check box to allow the approver to change those properties.

Customization

You can configure the Approval activity to specify how the approval tasks created by that
activity are to be identified in the Approval section of the Web Interface. The Approval
section contains a list of approval tasks, with each task identified by a header that provides
basic information about the task, including the title of the task and information about the
target object of the operation that is subject to approval. The title of the task is located in
the middle of the task header. The properties that identify the operation target object are
displayed above the title of the task.

The pages for configuring an Approval activity in the Active Roles Console provide the
following customization options related to the header of the approval task:

» Display this title to identify the approval task: When performing the approval
task, the approver will see this instruction on the page intended to review, supply or
change the properties that are subject to the approval task. You can supply an
instruction on how to perform the task.

» Display these properties of the object submitted for approval: These
properties will be displayed in the task's header area on the pages for performing the
approval task. You can add properties to help the approver identify the target object
of the operation submitted for approval.

» Display the operation summary in the task header area: This option extends
the approval task’s header area to provide summary information about the changes
that are subject to approval, including the type of the changes and the reason for
the changes.

You can configure the Approval activity to specify the actions the approver can take on
the approval task. On the pages for performing the approval task, in the Approval section
of the Web Interface, the task header contains the action buttons that are intended to apply
the appropriate resolution to the task, such as Approve or Reject. The action buttons are
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located at the bottom of the header area. Which buttons are displayed depends upon
configuration of the Approval activity.

The pages for configuring an Approval activity in the Active Roles Console provide the
following customization options related to the action buttons:

e Customize action buttons: Action buttons appear on the pages for performing the
approval task. Each button applies a certain action to the task. Normally, two built-in
buttons, titled Approve and Reject by default, are displayed for each approval task.
Other buttons may be displayed depending on the configuration of the approval
activity. You can add buttons to create custom actions.

Depending on the button’s action type, clicking a custom action button causes the
workflow to allow (Complete action type) or deny (Reject action type) the operation
that is subject to approval. If-Else activities can refer to a custom action button by
the button’s title and elect the appropriate branch of the workflow when the approver
clicks that custom action button.

e Show this instruction for action buttons: You can use this option to supply an
instruction on how to use action buttons. The approver will see this instruction above
the action buttons on the pages for performing the approval task.

» Suppress the confirmation dialog upon completion of approval task: If
this option is not selected, Active Roles requests the approver to fill in a
confirmation dialog box every time the approver performs an approval task. You
can select this option to prevent the confirmation dialog box from appearing so
that the approver can complete the task without having to supply a reason for the
completion of the task.

Notification

Notification is used to subscribe recipients to the notifications of approval-related events,
configure notification emails, and set up email transport. Approval rules provide email
notifications to workflow users in association with various events, such as the creation of
approval tasks upon operation requests. Thus, approvers can be notified of the requests
awaiting their approval via emails that include hypertext links to the approval-related
section in the Web Interface.

Workflow notification recipients

Notification recipients are the users or groups to which the activity sends emails. A
recipient can be any mailbox-enabled user or mail-enabled group. There are also a number
of options allowing you to select recipients based on their role, such as operation requestor,
approver, manager of operation requestor, or manager of object affected by the operation.

Notification delivery

The delivery options determine whether notifications are to be sent immediately or on a
scheduled basis. The option of immediate delivery causes the activity to generate a
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separate message upon every occurrence of the event to notify of. The option of scheduled
delivery can be used for aggregating notifications. If you select the scheduled delivery
option, all notifications about the event occurrences within a time period of your choice are
grouped and sent as a single message.

Workflow notification message

Notification messages are based on a message template that determines the format and
contents of an e-mail notification message, including the message subject and body. A
template is an HTML-formatted document that you can view or change as required to
customize notification messages. The template text may include dynamic content that is
generated at run time by retrieving information from the running instance of the workflow
process. Notification messages are created, and normally sent, in HTML format. You can
optionally configure the activity to format and send notification messages as plain text.

Web Interface address

The Web Interface address setting specifies the address (URL) of the Active Roles
Web Interface. The activity uses this setting to construct hyperlinks in the
notification messages.

Email server for workflow notifications

The email server setting determines the name and other parameters of the email server
that is used for delivery of notification messages.

Notification activity

A Notification activity in a workflow is used to subscribe recipients to the notifications of
the following events:

» Executing this activity: This event occurs upon running the Notification activity.
When configured to notify of this event, the activity creates and instantly sends an
email message about initiating the Notification activity. Notification of this event is
normally intended to inform that the workflow initiation process has reached the
Notification activity.

 Workflow completed successfully: When configured to notify of this event, the
activity creates a message to be sent upon workflow completion. When the workflow
is completed, Active Roles will send that message if no considerable errors occurred
during the running of the workflow.

 Workflow encountered an error: When configured to notify of this event, the
activity creates a message to be sent upon workflow completion. When the workflow
is completed, Active Roles will send that message if some errors occurred during the
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running of the workflow.

» Operation performed: When configured to notify of this event, the activity creates
a message to be sent upon workflow completion. When the workflow is completed,
Active Roles will send that message if the operation that started the workflow is
successfully performed.

The configuration of a Notification activity specifies the notification event and recipients.
When run by the workflow, the Notification activity prepares a notification message
appropriate to the specified event. Active Roles retains the message prepared by the
activity, and sends the message to the specified recipients once that event occurs. The
configurable settings of a Notification activity are similar to the notification settings of an
Approval activity.

Workflow notification recipients

Notification recipients are the users or groups to which the activity sends emails. A

recipient can be any mailbox-enabled user or mail-enabled group. There are also a number
of options allowing you to select recipients based on their role, such as operation requestor,
approver, manager of operation requestor, or manager of object affected by the operation.

Workflow notification message

Notification messages are based on a message template that determines the format and
contents of an e-mail notification message, including the message subject and body. A
template is an HTML-formatted document that you can view or change as required to
customize notification messages. The template text may include dynamic content that is
generated at run time by retrieving information from the running instance of the workflow
process. Notification messages are created, and normally sent, in HTML format. You can
optionally configure the activity to format and send notification messages as plain text.

Web Interface address

The Web Interface address setting specifies the address (URL) of the Active Roles
Web Interface. The activity uses this setting to construct hyperlinks in the
notification messages.

Email server for workflow notifications

The email server setting determines the name and other parameters of the email server
that is used for delivery of notification messages.
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Script activity

Script activities are typically used to perform automated steps in a workflow process. A
Script activity is defined by a Script Module created in Active Roles. Each Script Module
contains script code implementing certain functions. New Script Module can freely be
added and the Script contained in a Script can be developed and revised as necessary.
This provides a mechanism for creating custom functions, enabling the extensibility of
actions performed by a workflow.

The Script activity has the following basic configuration settings:

e Script to use: Identifies the Script Module to be used by the activity. Normally,
the script held in the Script Module implements at least two functions: the function
that will be run by the activity and the function that defines the activity parameters.

e Function to run: Identifies the script function that will be run by the activity.

» Function to declare parameters: Identifies the Script function that defines the
activity parameters. For each parameter, this function defines the name of the
parameter and other characteristics, such as a description, a list of possible values,
the default value, and whether a value is required. Normally, the parameters are
declared by a function named onInit.

 Parameter values: When Active Roles executes a Script activity, it passes the
parameter values to the script function being run by that activity. The actions
performed by the activity, and the results of those actions, depend upon the
parameter values.

Notification — Script activity

You can configure a Script activity to subscribe recipients to the notifications of the
following events:

» Activity completed successfully: When configured to notify of this event, the
activity causes Active Roles to send a notification email if no significant errors
occurred during the run of this activity.

» Activity encountered an error: When configured to notify of this event, the
activity causes Active Roles to send a notification email if any significant errors
occurred during the run of this activity.

The notification settings specify the notification events and recipients. When run by the
workflow, the activity prepares a notification message appropriate to the specified
event. Active Roles retains the message prepared by the activity, and sends the
message to the specified recipients once that event occurs. The notification settings are
similar to the notification settings of a Notification activity. For more information, see
Notification activity.

@NE IDENTITY Active Roles 8.1.5 Administration Guide see

Quest Workflows



Error handling - Script activity

When configuring a Script activity, you can choose whether to suppress errors
encountered by that activity. The following option is available: Continue workflow even
if this activity encounters an error. If this option is not selected (default setting), then
an error condition encountered by the activity causes Active Roles to terminate the
workflow. If you select this option, the workflow continues regardless of whether or not the
activity encounters an error condition.

If-Else activity

An If-Else activity is used to conditionally run one of two or more alternative branches
depending on the conditions defined on the branches. It contains an ordered set of
branches and runs the first branch whose condition evaluates to TRUE. You can add as
many branches as you want to an If-Else activity, and you can add as many activities as
you want to every branch.

Each branch of an If-Else activity may have an individual condition set on it. When an If-
Else activity starts, if evaluates the condition on its first (leftmost) branch. If that condition
is met, Active Roles runs the activities of that branch; otherwise, Active Roles evaluates the
condition on the next branch (from left to right), and so on.

When configuring If-Else branch conditions, consider the following:

e Active Roles runs only the first branch whose condition is evaluated to TRUE.

e An If-Else activity can finish without any of its branches being initiated, if the
condition of each branch is evaluated as FALSE.

If no condition is defined for a branch, Active Roles considers that branch to be always
TRUE. Therefore, the final (rightmost) branch normally must have no condition, so that it
is always evaluated as TRUE. This way, the final branch acts as the Else branch that runs if
the conditions on the other branches are not fulfilled.

TIP: To ensure that at least one activity is run from a branch, make sure that you define
no running condition for the last branch of an If-Else activity.

If-Else branch conditions

An If-Else activity is intended to select exactly one branch of the activity from a given set
of branches. For each branch, the activity checks the branch conditions and runs the first of
the branches whose condition evaluates to TRUE.

When you configure an If-Else branch, you need to add at least one condition, but you are
not limited in the number of conditions that you can add for a given branch. You can add,
delete, and group conditions using various operators. It is possible to nest condition groups
within other condition groups to achieve the results that you want.
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A condition group contains one or more conditions connected by the same logical operator.
By grouping conditions, you specify that those conditions should be evaluated as a single
unit. The effect is the same as if you put parentheses around an expression in a
mathematical equation or logic statement.

By default, a single, implied condition group is created when you add a branch condition.
You can create additional condition groups to group a set of conditions and nest grouped
conditions within other condition groups.

In a condition group, conditions are connected using the AND, OR, NOT AND, or NOT OR
logical operator:

e AND group evaluates to TRUE if all conditions in the group are TRUE.

* OR group evaluates to TRUE if any condition in the group is TRUE.

e NOT AND group evaluates to TRUE if any condition in the group evaluates to FALSE.
e NOT OR group evaluates to TRUE if all conditions in the group evaluate to FALSE.

By default, AND is the logical operator between the conditions in a condition group. Itis
possible to change the logical operator by converting the condition group to a different
group type: Click the name of the group, point to Convert condition group to, and then
click the option appropriate to the desired logical operator.

By default, AND is the logical operator between the conditions in a condition group. Itis
possible to change the logical operator by converting the condition group to a different

group type.

When you add a condition, the Workflow Designer first prompts you to specify what you
want the condition to evaluate. The following options are available:

e Property of workflow initiator: This option is intended to evaluate the value of a
certain property of the user whose request started the workflow. You can select the
desired property when you configure a condition.

o Activity execution status: This option evaluates whether Active Roles encountered
an error when running a certain activity. You can select the activity when you
configure a condition.

NOTE: This option requires the activity configuration to allow the workflow to
continue even if the activity encounters an error. For more information, see Config-
uring error handling for a CRUD activity.

 Workflow parameter value: This option is intended to evaluate the value of a
certain parameter of the workflow. You can select the parameter when you configure
a condition.

e Property of object from workflow data context: This option is intended to
evaluate the value of a certain property of the object that will be selected by the If-
Else activity on the basis of the data found in the workflow environment at the time
of executing the workflow. When you configure a branch condition, you can choose
the property and specify which object you want the activity to select upon evaluating
the condition at workflow run time.

e Value generated by rule expression: This option is intended to evaluate the
string value of a certain rule expression. By using a rule expression, you can compose
a string value based on properties of various objects found in the workflow
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environment at the time of executing the workflow. Active Roles calculates the value
of your rule expression upon evaluating the condition at workflow run time.

Within a change workflow, the following options are available in addition to the options
listed above:

Property of workflow target object: This option is intended to evaluate the value
of a certain property of the target object of the request that started the workflow. You
can select the property when you configure a condition.

Changed value of workflow target object property: This option is intended to
evaluate the value that is requested to be assigned to a certain property of the
workflow target object, which represents the requested change to the property of the
target object of the request that started the workflow. You can select the property
when you configure a condition.

Approver action choice: This option is intended to evaluate the name of the action
button applied by the approver to complete the approval task created by a certain
Approval activity. Use this option to determine which action button the approver
applied to allow the operation that was subject to approval. You can select the
Approval activity when you configure a condition.

Once you have specified the entity or field that you want the condition to evaluate, you
can choose a comparison operator and specify a comparison value. The list of options that
are available to specify a comparison value depends upon the entity or field you have
configured the condition to evaluate. The following table summarizes the comparison

value

options.

Table 39: Comparison value options

Condition to evaluate Comparison value options

e Property of workflow target object e Text string

e Property of workflow initiator » Property of workflow target object

e Changed value of workflow target e Property of workflow initiator
object property * Changed value of workflow target

e Workflow parameter value object property

e Property of object from workflow data » Workflow parameter value
context

» Property of object from workflow data
Value generated by rule expression context

* Value generated by rule expression

Activity initialization status * Not initiated

e Completed successfully

* Encountered an error

Approver action choice * The name of an action button

» Value generated by script
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For a brief description of comparison operators and comparison value options, see
Search filter.

Error handling — If-Else activity

When configuring an If-Else activity, you can choose whether to suppress errors
encountered by that activity. The following option is available: Continue workflow even
if this activity encounters an error. If this option is not selected (default setting), then
an error condition encountered by the activity causes Active Roles to stop the workflow. If
you select this option, the workflow continues regardless of whether or not the If-Else
activity or any activity within the If-Else activity encounters an error condition.

Stop/Break activity

A Stop/Break activity is used to immediately end all activities of a running workflow
instance. You can use it within a branch of an If-Else activity, so as to terminate the
workflow once a certain condition occurs.

An example is a requirement for the validation of the requested data changes to deny
certain operations because applying such operations would result in unacceptable data
being written to the directory. To address this requirement, you can use a workflow with an
If-Else branch that runs upon detection of unacceptable data in the requested operation,
and add a Stop/Break activity to that branch. In this way, your workflow will block the
unwanted operations, safeguarding the directory data.

The Stop/Break activity logs a message when terminating the workflow instance. You can
specify a message text as an activity setting to provide the reason for the workflow
instance termination. The activity includes that message in the event that is recorded to the
Active Roles event log on the computer running the Active Roles Administration Service.

Add Report Section activity

You can use the Add Report Section activity to add custom information to the change
history report (in case of workflow started by an operation request) or run history report (in
case of automation workflow). The activity adds a separate section to the Workflow
activities and policy actions area of the report. The section consists of a header and a
body. The activity provides the following options for configuring the text to be displayed in
the header and the body of the report section:

* You can specify whether the report section is intended to display information about
successful operation or error condition. In the latter case, the text of the header and
the body of the report section is displayed in red.
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e You can compose the header text of data entries that will be calculated during
execution of the activity. The activity offers various data entry types, allowing the
header text to include properties of objects involved in the workflow and related
objects, date and time of activity execution, and workflow parameters.

* You can configure the body text to include multiple strings, with each string
composed by using the same options that are available for the header text string.
Thus, in addition to literal text strings and formatting characters, the body text may
include information about object properties and other string values the activity will
calculate in workflow run time.

You can also add the Add Report Section activity to a certain If-Else branch to have the
report indicate that the workflow executed that branch of activities.

Search activity

A Search activity allows you to perform searches against directory data to find objects,
such as users or groups, that match the criteria you specify based on object properties,
object location, and other information available in the execution environment of the
workflow, and to pass these objects to other activities so that the workflow can perform the
appropriate actions on them. You can insert activities into a Search activity and have those
activities process the objects found by the Search activity.

The following topics cover the configurable settings of a Search activity:

e Search scenario

e Object type

e Search scope

e Search options

e Search for inactive accounts

e Search filter

» Notification

e Error handling — Search activity
e "Run as" options

» Additional settings — Search activity
e Stop Search activity

Search scenario

You can configure a Search activity to:
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e Search in the Organizational Unit or container: Search a certain OU or
container for objects that match your search criteria.

» Search for resources managed or owned by the user or group: Search for the
managed objects of a particular user or group that match your search criteria.
Managed objects of a user or group are those for which the user or group is the
primary owner (manager) or a secondary owner.

e Search the group for its members: Search for the members of a certain group
that match your search criteria.

o Search for direct reports of the user: Search for the direct reports of a particular
user that match your search criteria. Direct reports of a given user are the users for
which that user is the manager.

» Search within the attribute of the object (ASQ search): Search for the objects
listed in a certain attribute of a particular object that match your search criteria.

Object type

You can specify the type of the objects you want the activity to search for. The list
from which you can select the object type varies depending on the search scenario you
have selected.

Table 40: Search activity: Object type

Search scenario Object types to search
for
Search in the Organizational Unit or container. e Users
e Contacts
e Groups

¢« Computers

e Printers

¢ Organizational Units
e Shared Folders

¢ Exchange Recipients

* Inactive Accounts

e All Objects
Search for resources managed or owned by the user or » Users
group. e Contacts
-OR- « Groups

Search within the object's attribute (ASQ search). . Computers

¢ Printers
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Search scenario Object types to search
for

¢ Organizational Units
e Shared Folders

¢ Exchange Recipients
« All Objects

Search the group for its members. » Users
» Contacts
¢ Groups
« Computers
e Exchange Recipients
» All Objects

Search for direct reports of the user. » Users
¢ All Objects

Search scope

The search scope determines where to search for the objects of the specified type. The
search scope settings depend upon the search scenario, and are as follows.

Table 41: Search activity: Search scope

Search Search scope settings available

scenario

Search in the » Fixed container in directory: Search in the given OU or
Organizational container. You can select the desired OU or container in Active
Unit (OU) or Directory when you configure a Search activity.

container

 Parent OU of workflow target object: Search in the OU that
holds the target object of the request that started the workflow.

+ Object identified by workflow parameter: Search in the OU
or container specified by the value of a certain parameter of the
workflow. You can choose the desired parameter when you
configure a Search activity.

e Object from workflow data context: Search in the OU or
container that will be selected by the Search activity on the basis
of the data found in the workflow environment at the time of
executing the workflow. When configuring a Search activity, you
can specify which OU or container you want the activity to select
at workflow run time.
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Search Search scope settings available

scenario

Search for .
resources
managed or
owned by the
user or group

Search the .
group for its
members

(GNE IDENTITY

Quest

Object identified by DN-value rule expression: Search in
the OU or container whose Distinguished Name (DN) is specified
by the string value of a certain rule expression. By using a rule
expression you can compose a string value based on properties
of various objects found in the workflow environment at the time
of executing the workflow. You can create the desired rule
expression when you configure a Search activity.

Workflow target object: Search for resources managed or
owned by the target object of the request that started the
workflow.

Object identified by workflow parameter: Search for
resources managed or owned by the object specified by the value
of a certain parameter of the workflow. You can choose the
desired parameter when you configure a Search activity.

Object from workflow data context: Search for resources
managed or owned by the object that will be selected by the
Search activity on the basis of the data found in the workflow
environment at the time of executing the workflow. When
configuring a Search activity, you can specify which object you
want the activity to select at workflow run time.

Object identified by DN-value rule expression: Search for
resources managed or owned by the object whose Distinguished
Name (DN) is specified by the string value of a certain rule
expression. By using a rule expression, you can compose a string
value based on properties of various objects found in the
workflow environment at the time of executing the workflow. You
can create the desired rule expression when you configure a
Search activity.

Workflow target object: Search for members of the group
that is the target object of the request that started the workflow.

Object identified by workflow parameter: Search the group
specified by the value of a certain parameter of the workflow.
You can choose the desired parameter when you configure a
Search activity.

Object from workflow data context: Search for members of
the group object that will be selected by the Search activity on
the basis of the data found in the workflow environment at the
time of executing the workflow. When configuring a Search
activity, you can specify which group object you want the activity
to select at workflow run time.

Object identified by DN-value rule expression: Search the
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Search

Search scope settings available

scenario
group whose Distinguished Name (DN) is specified by the string
value of a certain rule expression. By using a rule expression,
you can compose a string value based on properties of various
objects found in the workflow environment at the time of
executing the workflow. You can create the desired rule
expression when you configure a Search activity.

Search for Workflow target object: Search for direct reports of the target

direct reports of object of the request that started the workflow.

the user

Search within
the object's
attribute (ASQ
search)

Object identified by workflow parameter: Search for direct
reports of the object specified by the value of a certain parameter
of the workflow. You can choose the desired parameter when you
configure a Search activity.

Object from workflow data context: Search for direct
reports of the object that will be selected by the Search activity
on the basis of the data found in the workflow environment at the
time of executing the workflow. When configuring a Search
activity, you can specify which object you want the activity to
select at workflow run time.

Object identified by DN-value rule expression: Search for
direct reports of the object whose Distinguished Name (DN) is
specified by the string value of a certain rule expression. By using
a rule expression, you can compose a string value based on
properties of various objects found in the workflow environment
at the time of executing the workflow. You can create the desired
rule expression when you configure a Search activity.

Fixed object in directory: Search in a certain attribute of the
given object. You can select the desired object in Active Directory
when you configure a Search activity.

Workflow target object: Search in a certain attribute of the
target object of the request that started the workflow.

Object from workflow data context: Search in a certain
attribute of the object that will be selected by the Search activity
on the basis of the data found in the workflow environment at the
time of executing the workflow. When configuring a Search
activity, you can specify which object you want the activity to
select at workflow run time.

Search options

The activity provides various options allowing you to refine your search. Which options are
available depends upon the search scenario and the object type to search for, as shown in

the tables that follow.
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The following table summarizes the search scenario-specific search options.

Table 42: Search activity: Search options

Search
scenario

Search options available

Search in the
Organizational
Unit (OU) or
container

Search for
resources
managed or
owned by the
user or group

Search the
group for its
members

Search within
the object's
attribute (ASQ
search)

Retrieve only immediate child objects of the
Organizational Unit or container: Use this option to restrict
the search to objects for which the given OU or container is the
immediate parent in Active Directory.

Retrieve any objects held in the Organizational Unit or
container: Use this option to search in the entire directory tree
rooted in the given OU or container.

Retrieve objects managed by the user or group (primary
owner): Use this option to search for objects that have the given
user or group specified in the Managed By property.

Retrieve objects for which the user or group is a
secondary owner: Use this option to search for objects that
have the given user or group specified in the Secondary Owners
property.

Retrieve objects managed or owned due to membership
in groups (indirect ownership): Use this option to search for
objects for which the given user or group is a direct or indirect
member of the group specified in the Managed By or
Secondary Owners property.

Also retrieve indirect members: Use this option for your
search results to include indirect members of the given group.
With this option, the activity searches not only for objects that
are directly added to the group (direct members) but also for
indirect members-objects that belong to the group because of
their membership in other groups which are direct or indirect
members of the given group.

Also retrieve pending members: Use this option for your
search results to include objects that are scheduled to be added
to the group by using the Temporal Group Memberships
capability of Active Roles.

Search within this attribute: Specifies the attribute for the
ASQ search. This must be an attribute that stores Distinguished
Names, such as the Member Of or Managed By attribute. The
search is performed against the objects that are identified by the
Distinguished Names found in that attribute. For example, a
search within the Member Of attribute of a user account looks
for groups in which the user is a member.

The following table lists the search options that are specific to the object type. The search
results contain only the objects that match the options you selected.
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Table 43: Search activity: Object type

Objects to Search options available

search for

Users Users with Exchange mailbox: Search for Microsoft Exchange
mailbox-enabled users.

Users with external e-mail addresses: Search for Microsoft
Exchange mail-enabled users.

Inactive user accounts: Search for user accounts that have not
been used to log on for more than a certain number of days, have old
passwords, or are expired.

Expiring user accounts: Search for user accounts that will expire
within a certain number of days.

Contacts Contacts with external e-mail addresses: Search for Microsoft
Exchange mail-enabled contacts.

Groups Mail-enabled groups .ge Search for Microsoft Exchange mail-
enabled groups (distribution lists).

Security: Search for security groups.

Distribution: Search for distribution groups.

Domain local: Search for domain local groups.

Global: Search for global groups.

Universal: Search for universal groups.

Dynamic Group: Search for groups that are configured as Dynamic
Groups in Active Roles.

Group Family: Search for groups that store Group Family
configurations for Active Roles (Group Family configuration storage
groups).

Controlled by Group Family: Search for groups controlled by
Group Family rules in Active Roles.

Empty: Search for groups that have no members.
Deprovisioned: Search for groups that are deprovisioned by using
Active Roles.

Computers Computer role: Search for computers in a certain role. You can

restrict the search to workstations and servers or to domain
controllers.
Inactive computer accounts: Search for computer accounts that
haven't been used to log on for more than a certain number of days,
have the password age of more that a certain number of days, or are
expired for more than a certain number of days.
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Objects to
search for

Search options available

Printers

Exchange
Recipients

Inactive
Accounts

Printer features: Search for printers with particular features, such
as the printer model, paper size, print resolution, print speed, and
other capabilities, for example printing double-sided or colored
documents, or stapling pages.

Users with Exchange mailbox: Search for Microsoft Exchange
mailbox-enabled users.

Users with external e-mail addresses: Search for Microsoft
Exchange mail-enabled users.

Mail-enabled groups : Search for Microsoft Exchange mail-
enabled groups (distribution lists).

Contacts with external e-mail addresses: Search for Microsoft
Exchange mail-enabled contacts.

Mail-enabled Public Folders: Search for Microsoft Exchange mail-
enabled public folders.

Query-based Distribution Groups: Search for Microsoft
Exchange query-based distribution groups.

Room mailboxes: Search for user accounts representing Microsoft
Exchange room mailboxes.

Equipment mailboxes: Search for user accounts representing
Microsoft Exchange equipment mailboxes.

Linked mailboxes: Search for user accounts representing Microsoft
Exchange linked mailboxes.

Shared mailboxes: Search for user accounts representing
Microsoft Exchange shared mailboxes.

Mailboxes on this server: Search for user accounts representing
Microsoft Exchange mailboxes hosted on a certain Mailbox server.
You can select the desired Mailbox server.

Mailboxes in this mailbox store or database: Search for user
accounts representing Microsoft Exchange mailboxes held in a
certain mailbox store or database. You can select the desired
mailbox store or database.

Account type: Search for user accounts only, computer accounts
only, or both user and computer accounts.

Criteria of inactivity: Search for accounts that have not logged on
in the past number of days, accounts whose password has not
changed in the past number of days, or accounts that expired more
than a certain number of days before the current date.
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Search for inactive accounts

If you choose the Search in the Organizational Unit or container option, then you can
configure the activity to search for inactive user or computer accounts. The Inactive
Accounts object type provides for the following search options:

e Account type to search for: You can choose to search for user accounts only,
search for computer accounts only, or search for both user and computer accounts.

» Search for accounts that haven’t logged on in the past number of days: This
option allows you to specify the period, in days, that an account is not used to log on,
after which the account is considered inactive. The search retrieves a given account if
no successful logons to that account have occurred for more days than specified by
this option.

The Search activity uses the lastLogonTimeStamp attribute to determine the last time
that a specific user or computer successfully logged in. Active Directory updates that
attribute only periodically, rather than every time that a user or computer logs in.
Normally, the period of update is 14 days. This means that the lastLogonTimeStamp
value could be off by as much as 14 days, so the true last login time is later than
lastLogonTimeStamp. Hence, it is advisable to choose the login inactivity period of
more than 14 days.

» Search for accounts whose password has not changed in the past humber
of days: This option allows you to specify the password age, in days, after which an
account is considered inactive. The search retrieves a given account if the password
of the account remains unchanged for more days than specified by this option.

» Search for accounts that expired more than a certain number of days
before the current date: This option allows you to specify the number of days
after which an expired account is considered inactive. The search retrieves a given
account if the account remains in the expired state for more days than specified by
this option.

The option to search for inactive accounts is also available when you configure the activity
to search for the Users or Computers object type. You can restrict the search to inactive
accounts by choosing the appropriate options to determine what accounts are considered
inactive. These options are the same as with the Inactive Accounts object type.

Search filter

The Search filter option allows you to refine your search to locate directory objects based
on the properties (attributes) of the objects. For example, you may want to find all the
team members in a certain department that report to the manager named John Smith or
you may be interested in computer accounts that were not used for a certain time period.
In either case, you can use a Search filter to look for specific values in the object
properties, thereby ensuring that the search results contain only the objects with the
specified properties.
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A Search filter is composed of conditions combined using AND or OR logic. Each condition
is a certain statement that specifies the criteria the activity must use to determine whether
a given object is to be included in the search results.

To create a filter, you need to add at least one condition, but you are not limited in the
number of conditions you can add. By using multiple conditions, you can create very
complex filters.

You can add, delete, and group filter conditions using different operators. You can even
nest condition groups within other condition groups to achieve the results that you want.
When the activity runs, the filter is evaluated to determine if the objects found by the
search meet the criteria you specified in the filter. If a given object meets the criteria, the
object is added to the search results; otherwise, the object is filtered out. If you do not
create a filter, then all objects found by the search are included in the search results.

A filter condition is composed of three parts: the name of a certain property, the
comparison operator, and the value to compare the property with (comparison value).
Some operators do not require a comparison value. When creating a condition, you first
choose a certain property. Then, you select the desired comparison operator and, if
necessary, specify the comparison value you want. The list from which to select a
comparison operator depends on the type of the property you are creating the
condition for.

Whether you have to specify a comparison value depends on the comparison operator.
The following tables summarize the comparison operators and comparison values that
are available.

The comparison operators from which you can choose when configuring a filter condition
are as follows.
Table 44: Comparision operators

Comparison Indicates that
operator

equals The property value of the object matches the comparison value.

does not equal The property value of the object does not match the comparison value.

greater or The property value of the object is greater than or equal to the

equal comparison value.

less or equal The property value of the object is less than or equal to the comparison
value.

contains The property value of the object contains the text specified by the
comparison value.

does not The property value of the object does not contain the text specified by

contain the comparison value.

starts with The text specified by the comparison value occurs at the beginning of

the object’s property value.

does not start  The text specified by the comparison value does not occur at the
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Comparison

Indicates that

operator
with beginning of the object’s property value.
ends with The text specified by the comparison value occurs at the end of the

does not end
with

object’s property value.

The text specified by the comparison value does not occur at the end of
the object’s property value.

is empty The property is not specified on the object.

is not empty The property of the object has a non-null value.

bitwise and Each bit of the object’s property value matches the corresponding bit of
the comparison value.

bitwise or Any bit of the object’s property value matches the corresponding bit of
the comparison value.

matches The object’s property value matches a certain regular expression. This

regular requires the comparison value to be a text string representing the

expression regular expression.

The comparison values from which you can choose when configuring a filter condition are
as follows.
Table 45: Comparison values

Comparison
value

Description

Text string A literal string of characters. You can type the string when you configure

a filter condition.

Property of
workflow
target object

The value of a certain property of the target object of the request that
started the workflow. You can select the property (typically, a string-
value property) when you configure a filter condition.

Property of The value of a certain property of the user whose request started the
workflow workflow. You can select the property (typically, a string-value
initiator property) when you configure a filter condition.

Changed value The value that is requested to be assigned to a certain property of the

of workflow target object of the request that started the workflow, which represents
target object the requested change to the property of the target object. You can select
property the property (typically, a string-value property) when you configure a

filter condition.

Property of
object from
workflow data
context

The value of a certain property of the object that will be selected by the
Search activity on the basis of the data found in the workflow
environment at the time of executing the workflow. When you configure
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Comparison
value

Description

Value
generated by
rule expression

Fixed object in
directory

Object from
workflow data
context

Object
identified by
DN-value rule
expression

Object
identified by
workflow
parameter

Workflow
initiator object

Workflow
target object

Fixed date and
time

Workflow date
and time

(GNE IDENTITY

a filter condition in a Search activity, you can choose the property and
specify which object you want the activity to select upon evaluating the
condition at workflow run time.

The string value of a certain rule expression. By using a rule expression
you can compose a string value based on properties of various objects
found in the workflow environment at the time of executing the
workflow.

A certain object, such as a user, group, or computer. You can select the
desired object in Active Directory when you configure a filter condition.
This comparison value is applicable to filter conditions for DN-value
properties.

The object that will be selected by the Search activity on the basis of
the data found in the workflow environment at the time of executing the
workflow. When you configure a filter condition in a Search activity, you
can specify which object you want the activity to select upon evaluating
the condition at workflow run time. This comparison value is applicable
to filter conditions for DN-value properties.

The object whose Distinguished Name (DN) is specified by the string
value of a certain rule expression. By using a rule expression, you can
compose a string value based on properties of various objects found in
the workflow environment at the time of executing the workflow. You
can create the desired rule expression when you configure a filter
condition. This comparison value is applicable to filter conditions for DN-
value properties.

The object specified by the value of a certain parameter. You can choose
the desired parameter when you configure a filter condition. This
comparison value is applicable to filter conditions for DN-value
properties.

The user account of the user whose request started the workflow. This
comparison value is applicable to filter conditions for DN-value
properties.

The target object of the request that started the workflow. This
comparison value is applicable to filter conditions for DN-value
properties.

A literal date and time value. You can choose the desired date and time
when you configure a filter condition. This comparison value is
applicable to filter conditions for Date/Time-value properties.

A certain point in time relative to the date and time of the Search
activity run. You have the option to specify a date that occurs a
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Comparison Description

value
particular number of days before or after the Search activity run. This
comparison value is applicable to filter conditions for Date/Time-value
properties.

True The literal Boolean value of True.

False The literal Boolean value of False.

Value The value returned by a certain script function. You can choose the

generated by script function when you configure a filter condition. The Search activity

script will execute that script function upon evaluating the condition at
workflow run time.

Workflow The value of a certain workflow parameter. You can choose the desired

parameter parameter when you configure a filter condition.

value

Notification

You can configure a Search activity to subscribe recipients to the notifications of the
following events:

o Activity completed successfully: When configured to notify of this event, the
activity causes Active Roles to send a notification email if no significant errors
occurred during the run of this activity.

» Activity encountered an error: When configured to notify of this event, the
activity causes Active Roles to send a notification email if any significant errors
occurred during the run of this activity.

The notification settings specify the event to notify of, and notification recipients. When
executed by the workflow, the activity prepares a notification message appropriate to the
specified event. Active Roles retains the message prepared by the activity, and sends the
message to the specified recipients upon occurrence of that event. The notification settings
are similar to the notification settings of a Notification activity. For more information, see
Notification activity.

Error handling — Search activity

When configuring a Search activity, you can choose whether to suppress errors
encountered by that activity. The following option is available: Continue workflow even
if this activity encounters an error. If this option is not selected (default setting), then
an error condition encountered by the activity causes Active Roles to stop the workflow. If
you select this option, the workflow continues regardless of whether or not the Search
activity or any activity within the Search activity encounters an error condition.
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"Run as" options

By default, the Search activity is executed under the user account specified by the “run as”
setting in the workflow options and start conditions. This could be the service account of
the Active Roles Administration Service or the account of the user who caused the workflow
to start. You can configure the activity to override the default “run as” setting by choosing
to run the activity under the service account or the account of the user who caused the
workflow to start. The account under which the activity is running determines the access
rights of the activity in the directory.

Additional settings — Search activity

A Search activity has the following additional configuration options:

« Terminate the search activity if the search returns more than <number>
objects: Use this option to specify the maximum number of objects the activity is
allowed to return when performing a search. If you want to receive all the objects
that match the search conditions, you can disable this option.

» Exclude or include request controls from the activity operation request:
Request controls are certain pieces of data in an operation request that can be used
to pass additional information to Active Roles on how to process the request. Request
controls are optional. If no request controls are added to a request, then Active Roles
determines how to process the request based solely on the type of the request. You
can configure the activity to add certain controls to its operation requests (include
request controls) or to ensure that certain controls never occur in the activity
operation requests (exclude request controls).

Stop Search activity

You can use a Stop Search activity within a Search activity to stop the search being
performed by the Search activity. Basically, a Stop Search activity is intended to be used
within an If-Else activity nested into a Search activity, in order to stop the search if certain
conditions occur. In this scenario, the If-Else activity analyzes data returned by the search,
and executes the If-Else branch containing the Stop Search activity if the data returned by
the search meets the conditions of that If-Else branch.

CRUD activities

Active Roles offers a number of workflow activities, collectively referred to as CRUD
activities, intended to create new objects, and modify or delete existing objects in Active
Directory. The CRUD abbreviation designates the key operations that can be performed by
using these activities: Create, Read, Update, Delete. The following CRUD activities are
available in the Active Roles Workflow Designer:
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e Create activity: Creates an object, such as a user, group, or computer, in
Active Directory.

e Update activity: Changes properties of an object, such as a user, group, or computer,
in Active Directory.

e Add to group activity: Adds an object, such as a user, group, or computer, to
specified groups in Active Directory.

e Remove from group activity: Removes an object, such as a user, group, or computer,
from specified groups in Active Directory.

e Move activity: Moves an object, such as a user, group, or computer, to a specified
container in Active Directory.

e Deprovision activity: Deprovisions a user or group, by applying the Active Roles
deprovisioning policy.

e Undo deprovision activity: Restores a user or group that was deprovisioned by using
Active Roles.

e Delete activity: Deletes an object, such as a user, group, or computer, in
Active Directory.

The following topics in this section provide an overview of the configuration settings that
are common to CRUD activities:

o Notification: Active Roles can notify via email about whether or not the activity has
encountered an error condition at run time.

e Error handling - CRUD activities: Determines whether or not the workflow is allowed
to continue if the activity has encountered an error condition at run time.

e "Run as" options: Determines the user account under which to run the activity.

e Additional settings — CRUD activities: Some advanced configuration options that
allow you to adjust the processing of the operation requested by the activity.

Create activity

The Create activity is intended to create an object, such as a user, computer, or group in
Active Directory. The activity allows you to configure the following characteristics of the
object to be created:

e Container: You can specify the Organizational Unit (OU) or container in which you
want the activity to create an object. The following options are available:

e Fixed container in directory: Create an object in the given OU or container.
You can select the desired OU or container in Active Directory when you
configure a Create activity.

 Parent OU of workflow target object: In case of a change workflow,
create an object in the OU that holds the target object of the request that
started the workflow.
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» Activity target object: Create an object in the OU or container created or
otherwise processed by another CRUD activity at the time of executing the
workflow. You can select the desired CRUD activity from the workflow definition
when you configure a Create activity.

e Object identified by workflow parameter: Create an object in the OU or
container specified by the value of a certain parameter of the workflow. You
can choose the desired parameter from the workflow definition when you
configure a Create activity.

e Object from workflow data context: Create an object in the OU or
container that will be selected by the Create activity on the basis of the data
found in the workflow environment at the time of executing the workflow.
When configuring a Create activity, you can specify which OU or container you
want the activity to select at workflow run time.

» Object identified by DN-value rule expression: Create an object in the OU
or container whose Distinguished Name (DN) is specified by the string value of
a certain rule expression. By using a rule expression you can compose a string
value based on properties of various objects found in the workflow
environment at the time of executing the workflow. You can create the desired
rule expression when you configure a Create activity.

» Object type and name: You can specify the type and the name of the object to be
created by the activity. When you configure a Create activity, you can choose the
appropriate object type and define how the activity will generate the object name
when creating an object. The following options are available:

e Text string: Use the given string of characters as the name of the object. You
can specify the string when you configure a Create activity.

« Name of workflow target object: In case of a change workflow, use the
name of the target object of the request that started the workflow.

« Name of workflow target object, followed by text string: In case of a
change workflow, use a certain text string prefixed with the name of the target
object of the request that started the workflow. You can specify the text string
when you configure a Create activity.

« Workflow parameter value: The name of the object is specified by the string
value of a certain parameter of the workflow. You can choose the parameter
from the workflow definition when you configure a Create activity.

* Property of object from workflow data context: The name of the object
is specified by the value of a certain property of the object that will be
selected by the Create activity on the basis of the data found in the workflow
run-time environment. When you configure a Create activity, you can choose
the property and specify which object you want the activity to select at
workflow run time.

e Value generated by rule expression: The name of the object is identified
by the string value of a certain rule expression. By using a rule expression you
can compose a string value based on properties of various objects found in the
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workflow environment at the time of executing the workflow. You can create
the desired rule expression when you configure a Create activity.

e Object properties: You can define how you want the activity to populate the
properties of the new object. When you configure a Create activity, you can choose
the properties you want the activity to populate and, for each property, specify the
value to be assigned to that property. The following options are available:

Text string: Use the given string of characters as the value of the property.
You can specify the string when you configure a Create activity.

Property of workflow target object: In case of a change workflow, the
value of a certain property of the target object of the request that started the
workflow. You can select the property when you configure a Create activity.

Property of workflow initiator: Use the value of a certain property of the
user whose request started the workflow. You can select the property when you
configure a Create activity.

Changed value of workflow target object property: In case of a change
workflow, use the value that is requested to be assigned to a certain property
of the workflow target object. You can select the property when you configure a
Create activity.

Workflow parameter value: Use the value of a certain parameter of the
workflow. You can choose the parameter from the workflow definition when
you configure a Create activity.

Property of object from workflow data context: Use the value of a
certain property of the object that will be selected by the Create activity on
the basis of the data found in the workflow environment at the time of
executing the workflow. When you configure a Create activity, you can
choose the property and specify which object you want the activity to select at
workflow run time.

Value generated by rule expression: Use the string value of a certain rule
expression. By using a rule expression you can compose a string value based
on properties of various objects found in the workflow environment at the time
of executing the workflow. You can create the rule expression when you
configure a Create activity.

The Create activity also has a number of configuration settings that are common to CRUD

activities:

o Notification: Active Roles can notify via email about whether or not the activity has
encountered an error condition at run time.

e Error handling — CRUD activities: Determines whether or not the workflow is allowed
to continue if the activity has encountered an error condition at run time.

e "Run as" options: Determines the user account under which to run the activity.

e Additional settings — CRUD activities: Some advanced configuration options that
allow you to adjust the processing of the operation requested by the activity.

@NE IDENTITY Active Roles 8.1.5 Administration Guide .

Quest Workflows



Update activity

The Update activity is intended to make changes to particular properties of a certain
object. This activity has the following configuration options:

» Activity target: This option lets you specify the object whose properties you want
the activity to change. You can select the object when you configure the activity, or
you can configure the activity to select the appropriate object at workflow run time.
For more information, see Activity target.

e Target properties: You can define how you want the activity to change the
properties of the object. When you configure an Update activity, you can choose the
properties you want the activity to change and, for each property, specify the new
value to be assigned to that property. For a multi-value property, you can choose to
add or remove the value from that property. The following options are available:

Text string: Use the given string of characters as the value of the property.
You can specify the string when you configure an Update activity.

Property of workflow target object: In case of a change workflow, use the
value of a certain property of the target object of the request that started the
workflow. You can select the property when you configure an Update activity.

Property of workflow initiator: Use the value of a certain property of the
user whose request started the workflow. You can select the property when you
configure an Update activity.

Changed value of workflow target object property: In case of a change
workflow, use the value that is requested to be assigned to a certain property
of the workflow target object. You can select the property when you configure
an Update activity.

Workflow parameter value: Use the value of a certain parameter of the
workflow. You can choose the parameter from the workflow definition when
you configure an Update activity.

Property of object from workflow data context: Use the value of a
certain property of the object that will be selected by the Update activity on
the basis of the data found in the workflow environment at the time of
executing the workflow. When you configure an Update activity, you can
choose the property and specify which object you want the activity to select at
workflow run time.

Value generated by rule expression: Use the string value of a certain rule
expression. By using a rule expression you can compose a string value based
on properties of various objects found in the workflow environment at the time
of running the workflow. You can create the rule expression when you
configure an Update activity.

The Update activity also has a number of configuration settings that are common to CRUD

activities:
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e Notification: Active Roles can notify via email about whether or not the activity has
encountered an error condition at run time.

e Error handling - CRUD activities: Determines whether or not the workflow is allowed
to continue if the activity has encountered an error condition at run time.

e "Run as" options: Determines the user account under which to run the activity.

e Additional settings — CRUD activities: Some advanced configuration options that
allow you to adjust the processing of the operation requested by the activity.

Add to group activity

The Add to group activity is intended to add a certain object, such as a user, computer,
or group, to particular groups in Active Directory. This activity has the following
configuration options:

» Activity target: This option lets you specify the object you want the activity to add
to groups. You can select the object when you configure the activity, or you can
configure the activity to select the appropriate object at workflow run time. For more
information, see Activity target.

e Groups: This option lets you define the groups to which you want the activity to add
the object. When you configure an Add to group activity, you can specify a list of
groups. For each of the groups in the list, the activity will add the object to that
group. To add a group to the list, you can choose from the following options:

» Fixed group in directory: You can select the desired group in Active
Directory when you configure an Add to group activity. A unique identifier of
the group is saved in the configuration of the activity. The activity will use that
identifier to select the group when calculating the list of groups at workflow
execution time.

e Object from workflow data context: The group will be selected by the
activity on the basis of the data found in the workflow environment at the
time of executing the workflow. When configuring an Add to group activity,
you can specify which group you want the activity to select at workflow
execution time.

» Object identified by DN-value rule expression: The Distinguished Name
(DN) of the group is specified by the string value of a certain rule expression.
By using a rule expression you can compose a string value based on properties
of various objects found in the workflow environment at the time of executing
the workflow. You can create the desired rule expression when you configure
an Add to group activity.

The Add to group activity also has a number of configuration settings that are common to
CRUD activities:

e Notification: Active Roles can notify via email about whether or not the activity has
encountered an error condition at run time.
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e Error handling - CRUD activities: Determines whether or not the workflow is allowed
to continue if the activity has encountered an error condition at run time.

e "Run as" options: Determines the user account under which to run the activity.

e Additional settings — CRUD activities: Some advanced configuration options that
allow you to adjust the processing of the operation requested by the activity.

Remove from group activity

The Remove from group activity is intended to remove a certain object, such as a user,
computer or group, from particular groups in Active Directory. This activity has the
following configuration options:

» Activity target: This option lets you specify the object you want the activity to
remove from groups. You can select the object when you configure the activity, or
you can configure the activity to select the appropriate object at workflow run time.
For more information, see Activity target.

e Groups - Remove the object from all groups: This options configures the
activity to remove the object from all groups in Active Directory.

NOTE: The Remove from group activity cannot remove the object from its
primary group. It can only remove the object from all other groups.

e Groups - Remove the object from these groups: This option lets you list the
groups from which you want the activity to remove the object. You can specify a list
of groups when you configure a Remove from group activity. For each of the
groups in the list (with the exception of the object’s primary group), the activity will
remove the object from that group. To add a group to the list, you can choose from
the following options:

e Fixed group in directory: You can select the desired group in Active
Directory when you configure a Remove from group activity. A unique
identifier of the group is saved in the configuration of the activity. The activity
will use that identifier to select the group when calculating the list of groups at
workflow execution time.

e Object from workflow data context: The group will be selected by the
activity on the basis of the data found in the workflow environment at the time
of executing the workflow. When configuring a Remove from group activity,
you can specify which group you want the activity to select at workflow
execution time.

e Object identified by DN-value rule expression: The Distinguished Name
(DN) of the group is specified by the string value of a certain rule expression.
By using a rule expression you can compose a string value based on properties
of various objects found in the workflow environment at the time of executing
the workflow. You can create the desired rule expression when you configure a
Remove from group activity.

The Remove from group activity also has a number of configuration settings that are
common to CRUD activities:
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e Notification: Active Roles can notify via email about whether or not the activity has
encountered an error condition at run time.

e Error handling - CRUD activities: Determines whether or not the workflow is allowed
to continue if the activity has encountered an error condition at run time.

e "Run as" options: Determines the user account under which to run the activity.

e Additional settings — CRUD activities: Some advanced configuration options that
allow you to adjust the processing of the operation requested by the activity.

Move activity

The Move activity is intended to move a certain object to a particular container in Active
Directory. The activity has the following configuration options:

» Activity target: This option lets you specify the object you want the activity to
move. You can select the object when you configure the activity, or you can configure
the activity to select the appropriate object at workflow run time. For more
information, see Activity target.

e Destination container: You can specify the Organizational Unit (OU) or
container to which you want the activity to move the object. The following
options are available:

» Fixed container in directory: Move the object to the given OU or container.
You can select the OU or container in Active Directory when you configure a
Move activity.

e Parent OU of workflow target object: In case of a change workflow, move
the object to the OU that holds the target object of the request that started
the workflow.

e Activity target object: Move the object to the OU or container created or
otherwise processed by another CRUD activity at the time of executing the
workflow. You can select the CRUD activity from the workflow definition when
you configure a Move activity.

* Object identified by workflow parameter: Move the object to the OU or
container specified by the value of a certain parameter of the workflow. You
can choose the parameter from the workflow definition when you configure a
Move activity.

e Object from workflow data context: Move the object to the OU or
container that will be selected by the Move activity on the basis of the data
found in the workflow environment at the time of executing the workflow.
When configuring a Move activity, you can specify which OU or container you
want the activity to select at workflow run time.

» Object identified by DN-value rule expression: Move the object to the OU
or container whose Distinguished Name (DN) is specified by the string value of
a certain rule expression. By using a rule expression you can compose a string
value based on properties of various objects found in the workflow
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environment at the time of executing the workflow. You can create the rule
expression when you configure a Move activity.

The Move activity also has a number of configuration settings that are common to CRUD
activities:

e Notification: Active Roles can notify via email about whether or not the activity has
encountered an error condition at run time.

e Error handling - CRUD activities: Determines whether or not the workflow is allowed
to continue if the activity has encountered an error condition at run time.

e "Run as" options: Determines the user account under which to run the activity.

e Additional settings — CRUD activities: Some advanced configuration options that
allow you to adjust the processing of the operation requested by the activity.

Deprovision activity

The Deprovision activity is intended to apply the Active Roles deprovisioning policies to a
particular user or group. This activity causes Active Roles to perform all the tasks
prescribed by the deprovisioning policies, thereby deprovisioning the user or group.

The activity allows you to specify the user or group object you want the activity to
deprovision. You can select the object when you configure the activity, or you can configure
the activity to select the appropriate object at workflow run time. For more information, see

Activity target.
The Deprovision activity also has a number of configuration settings that are common to
CRUD activities:

o Notification: Active Roles can notify via email about whether or not the activity has
encountered an error condition at run time.

e Error handling - CRUD activities: Determines whether or not the workflow is allowed
to continue if the activity has encountered an error condition at run time.

e "Run as" options: Determines the user account under which to run the activity.

e Additional settings — CRUD activities: Some advanced configuration options that
allow you to adjust the processing of the operation requested by the activity.

Undo deprovision activity

The Undo deprovision activity restores the user or group that was deprovisioned with
Active Roles. The activity causes Active Roles to roll back the changes made to the user or
group object by applying the Active Roles deprovisioning policies. As a result, the object
reverts to the state it was in before the deprovisioning-related changes were made.

The activity allows you to specify the user or group object you want the activity to
restore. You can select the object when you configure the activity, or you can configure
the activity to select the appropriate object at workflow run time. For more information,

see Activity target.
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The Undo deprovision activity also has a number of configuration settings that are
common to CRUD activities:

e Notification: Active Roles can notify via email about whether or not the activity has
encountered an error condition at run time.

e Error handling — CRUD activities: Determines whether or not the workflow is allowed
to continue if the activity has encountered an error condition at run time.

e "Run as" options: Determines the user account under which to run the activity.

e Additional settings — CRUD activities: Some advanced configuration options that
allow you to adjust the processing of the operation requested by the activity.

Delete activity

The Delete activity is intended to delete a particular object in Active Directory. The activity
allows you to specify the object you want the activity to delete. You can select the object
when you configure the activity, or you can configure the activity to select the appropriate
object at workflow run time. For more information, see Activity target.

The Delete activity also has a number of configuration settings that are common to CRUD
activities:

» Notification: Active Roles can notify via email about whether or not the activity has
encountered an error condition at run time.

e Error handling - CRUD activities: Determines whether or not the workflo